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Production Note 

THE MANUSCRIPT OF this book was writ
ten using W ordStar and Microsoft Word 
on several DOS computers. Screen shots 
were made on an AST Premium 286 com
puter using Hotshot from Symsoft and 
ScreenCP, a utility that is bundled with the 
Univation Turbo Ventura Publisher pack
age. Scanned images were created using 
PC Paintbrush Plus and a Canon IX-12 
scanner, controlled via a Tall Tree JLaser 
Plus board. The sample pages used in the 
tutorials were created as PostScript print 
files and then merged back into Ventura 
frames as Encapsulated PostScript graph
ics. Other illustrations were created using 
Ventura's drawing tools. 

The book was laid out entirely using 
Xerox Ventura Publisher 1.1, with no 
paste-up. Several display systems were 
used during the layout process: a Hercules 

Graphics board driving a Samsung amber 
. monitor, an Enhanced Graphics Adapter 
running a Hewlett-Packard Enhanced 
Graphics Display, and a Moniterm Viking 
I monitor. 

Master pages were produced on Ham
mermill Fore 9000-DP stock using a 
Hewlett-Packard LaserJet printer retrofit
ted with a Laser Connection PS Jet con
troller. Typeface families were Times and 
Helvetica. 

At the printer during creation of nega
tives, the 8.5- by II-inch master pages 
were photographically reduced by 18 per
cent, resulting in the final 7- by 9-inch 
trim size. The cover was designed and pro
duced using traditional graphic arts 
methods. The book was printed on a web 
press by Griffin Printing. 
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Introductinn 

I FIRST SAW Xerox Ventura Publisher in 
the spring of 1986, when Ventura Soft
ware president John Meyer and head pro
grammer Don Heiskell visited the PC 
World offices in San Francisco to show 
off a fledgling version of the program. At 
that time the agreement between Ventura 
Software and Xerox Corporation to 
market Ventura Publisher did not yet 
exist. Ventura Software was still just an 
unknown startup with a whistle and a 
song, one of a crowd of small companies 
claiming to do something new and differ
ent with words, pictures, and laser print-
ers. 

As Meyer and Heiskell set up their 
XT-compatible computer in PC World's 
glass-walled demonstration room, I re
flected on the irony that two years earlier 
this same room had been rigged up with 
peek-proof curtains to sequester a proto
type of the Macintosh computer while a 
small team of PC World staffers worked 
in secret to create the ftrst issue of M ac
world magazine. For the first year of its 
existence, the Macintosh had been widely 
ridiculed as a $2500 Etch-A-Sketch, a fun 
machine to play around with but hope
lessly devoid of any useful software. 

Now that little machine was showing 
it could throw fast balls too. With the in-

troduction of its LaserWriter printer and 
the advent of a new generation of slick 
page makeup software, Apple was open
ing up a vast new market, dubbed desk
top publishing by its enthusiasts, or CAP 
(computer-aided publishing) by the more 
acronymically minded. As yet, nothing 
existed on the PC-compatible side of the 
.industry to rival the Macintosh/Laser
Writer combination, a situation that was 
causing no small degree of consternation 
in places like PC World. 

With· various editors and production 
managers clustered around a long table in 
PC World's demonstration room, Meyer 
started up Ventura and immediately went 
into a· blistering tour. While the staff 
looked on, increasingly absorbed, he set 
up a document in multiple columns, 
added pictures, and demonstrated the use 
of Ventura's style sheet method of for
matting. 

I wasn't sure which was more aston
ishing, the speed of the program or the 
number of features that Meyer was show
ing. Compared to other PC programs then 
on the market that purported to provide 
desktop publishing capabilities ... well, 
th~re just was no comparison. 

Expressing the general sentiment in 
the room, someone jested, "You got a 
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Macintosh hidden in that computer?" 
Meyer only smiled, but the response was 
implied: That's obviously not possible
this program's way too fast. 

But it wasn't a comparison against 
the Macintosh that Meyer seemed to be 
interested in stressing, it was between two 
levels of pes. "I want to emphasize," he 
said, "that the speed you're seeing isn't 
the result of us using a souped-up com
puter. We're purposely showing the pro
gram on an XT-compatible rather than an 
AT-compatible. " 

Abruptly, the demonstration halted 
with an unexpected program crash. For a 
moment, even the garulous Meyer 
seemed at a loss for words, but Heiskell 
actually seemed to take a sort of perverse 
satisfaction in the blowout. He flashed a 
laid-back smile, leaned forward, and 
jotted a few notes on a legal pad. "That's 
the one I was trying to get on Sunday," he 
remarked, grinning. 

At the time of the Ventura demon
stration, I had just finished typesetting the 
book LaserJet Unlimited the old-fash
ioned way, that is, using Microsoft Word. 
With Word, you can easily incorporate 
various laser printer fonts in a document 
and format the appearance of text using 
flexible style sheets. However, when it 
comes to adding illustrations to a doc
ument, you have no alternative to the 
light table and the Exacto knife. Facing 
the prospect of repeating the manual 
pasteup ordeal with my next book, I 
couldn't wait to get my hands on Ventura. 

So What's It For? 

To make a long story short, I did get my 
hands on Ventura, I experimented with it, 
and I confirmed that it was indeed as 
good a tool as I had hoped. The book 
you're holding is physical evidence that 
Ventura is ideally suited for long docu
ments such as books, and also manuals, 
long reports, and other hefty publications. 
As of the latest release, there really aren't 
any serious limitations on document size. 
Version 1.1 can handle chapters with up 
to 500K of text, and you can chain as 
many as 128 chapters together into a pub
lication. 

But what about shorter documents 
like newsletters? Again, I can only refer 
to my own personal experience, which is 
that the longer I've used Ventura, the 
more I've found myself leaning on it for 
all kinds of jobs: designing flyers, run
ning off each week's invoice forms, type
setting poetry, designing business cards, 
making phone logs, you name it. 

About This Book 

This book, then, is a product of discover
ies I've made during my own explora
tions into Ventura, as well as those made 
by fellow explorers. Some of them have 
consented to being listed on the title page 
as contributors; others remain anony
mous. 

If you're new to Ventura, my advice 
is to first install Ventura on your com
puter, then place one hand firmly on your 
mouse and follow the step-by-step in
structions in Section I of this book, "Tu-



torials." This section is designed in keep
ing with the theory that most people learn 
best by diving right into something. You 
won't find much in the way of orientation 
here, and if you'd prefer more of a 
general overview before starting to use 
the program, skip to the next section. 

Section II, "Foundations," deals with 
the basic concepts underlying the pro
gram, the elements of assembling the 
hardware required for your particular 
publishing system, and strategies for or
ganizing your hard disk. 

Section III, "Using Ventura," pro
vides information on the techniques by 
which you create and format illustrated 
documents with Ventura. 

Section IV, "Special Topics," is a 
miscellany of information that hopefully 
will be of use as you attempt to "push the 
envelope," with Ventura: adding more 
fonts to your system, improving the pro
gram's innate hyphenation abilities, 
speeding up your work, overcoming 
memory limitations, and importing screen 
shots and PostScript illustrations. 

Finally, the book contains three ap
pendices. The first contains notes on a 
variety of software and hardware pro
ducts that work in conjunction with Ven
tura, as well as some additional resources 
such as books and periodicals. The sec
ond is a chart of operations, intended to 
help you quickly look up how to perform 
a particular task. The third is a glossary 
of typographic terms and terms used to 
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describe the operations of Ventura Pub
lisher. 

As you make your own Ventura 
discoveries, I hope you'll take the time to 
share them with me and/or with the Ven
tura Publisher User's Group, whose 
phone number is provided below. Please 
let me know what you think ought to be 
added to the book, where the explana
tions went astray, entries that should have 
been included in the index-whatever. 
The more detailed, the more downright 
picky your critiques, the better! 

Also, if you have bought this book 
from a bookstore or a dealer rather than 
directly from Peachpit Press, take a mo
ment to send us your name and address 
so we can drop you a line when the next 
edition comes out. Dealers of Ventura 
Publisher and Ventura trainers are espe
cially encouraged to contact Peachpit 
Press about promotions and quantity dis
counts. 

By the way, the phone number of 
VPUG, the Ventura Publisher User 
Group, is 408n78-1125. The phone num
ber of the Xerox Customer Application 
Support Center, which is set up to answer 
technical questions about Xerox Ventura 
Publisher, is 214/436-2616. My number 
at Peachpit Press (9 a.m. to 5 p.m. Pacific 
Time) is 415/843-6614. 

Good luck! 

Ted Nace 
Berkeley, California 
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Tutorial: A Business 
Report 

THE PURPOSE OF this chapter is to escort 
you, from start to finish, through the 
creation of a typical Ventura document. 
At this point we're not as concerned with 
the niceties of exactly how the page 
looks, rather, the aim is to help you get 
accustomed to the basic procedures to be 
followed in moving a document from 
start to finish. We won't spend any time 
at all talking about the why's and 
wherefore's of the process-just the 
process itself at this point. By following 
the steps spelled out below, you'll end up 
with a three-page business report that in
cludes a chart and a table. Even if you 
don't plan to use Ventura for business re
ports, you'll find that most other docu
ments are created using the same general 
method. They just happen to be longer, in 
most instances. 

In creating a document, the first 
steps involve developing your text and 
graphics outside Ventura using programs 
designed specifically for those purposes: 
word processors and graphics software. 

Once that is done, you will start Ventura 
and establish the appropriate file struc
ture. Next comes loading text and 
graphics into Ventura, followed by select
ing a style sheet and then attaching a tag 
from that style sheet to each paragraph 
text and then modifying the tags, if nec
essary, to change the appearance of the 
document. 

As you can see from Figures 1-3, the 
business report document combines four 
types of material: 

• Text created by a word processing 
program. 

• A table created in a word processing 
program. 

• A chart created in Lotus 1-2-3 (if 
you prefer, you can substitute a 
graphic from a different graphics 
program or use one of' the same 
graphics provided with Ventura). 

• Rules, boxes, and footers created 
with Ventura. 
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Figure 1 

Report on Virgil Corporation and Z-Calc 
Data 

Summary 
For the past five years, Finanswers Con
sultants have been providing management 
data and financial planning consulting ser
vices to two medium-sized Texas-based 
corporations in the high-tech Silicon 
Prairie industrial area near Austin. Virgil 
Corporation is a manufacturer of technical 
workstations for the biomedical research 
field. Z-Calc Data is a supplier and 
franchiser of payroll systems to small ac
counting firms. Both companies have 
emerged as clear success stories. Each has 
shown consistent, rapid growth over the 
period. More important, the two have 
successfully undertaken ambitious 
programs aimed at repositioning their 
operations for continued growth. 
Prospects for both companies appear to be 
excellent 

Background: Virgil Corp. 
Founded in 1961 by electro-oscilloscope 
inventor R. Stanley Mahanovich, Virgil 
Corporation developed into a manufac
turer of technical instrumentation for 
medical laboratories. In 1978, with 
Mahanovich still at the helm, the com
pany began to expand its scope toward 

VlrgllrL.Calc Report 
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designing and manufacturing an entire 
line of technical tools-including 
microcomputer work-stations-for both 
the medical and biotechnical fields. 
Today, Virgil supplies three turnkey 
workstation systems for researchers, in
cluding soft-ware and instrument 
peripherals. 

Background: Z-Calc Data 
Z-Calc Data was founded in 1977 by two 
computer science graduate students at the 
University of Texas, Roberta Orbison and 
Lucy Chin. Initially the fum was ex
clusively involved in accounting and 
payroll processing. After growing rapidly 
for five years, Z-Calc began shifting its 
activities to supplying payroll processing 
systems on a franchise basis throughout 
Texas, Oklahoma, Louisiana, and New 
Mexico to independent accountants and 
pay-roll firms. Meanwhile, the company 
has sold its own payroll processing busi
ness and reduced its miscellaneous ac
counting work. 

Pagel 
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Financial Snapshot: Virgil Corp. vs. Z-Calc Data 

Calendar 1986 

Revenues (thousands) 

Earnings (thousands) 

Revenue Growth 86/85 

Income Growth 86/85 

Margin 

Price-Earnings Ratio 

Revenue per Employee 

Five Year Performance 
Both Virgil Corporation and Z-Calc Data 
have posted solid gains since 1982. As 
shown in the Financial Snapshot table, 
Virgil grew from $36 million in revenues 
in 1982 to $81 million in 1986. Z-Calc 
grew somewhat more slowly, from $12 
million in revenues in 1982 to $41 million 
in 1986. 

Both companies have succeeded in taking 
advantage of the rapid general growth that 
has occurred in the Silicon Prairie area 
around Austin-Virgil by broadening the 
scope of its existing operations, Z-Calc by 
shifting into an area with a larger poten
tial for expansion. 

This Year's Performance 
Both companies showed enviable track 
records during the past year in posting 
positive financial indices. As the Finan
cial Snapshot shows, the two companies 
have nearly identical margins and revenue 
per employee. Currently, Virgil's price
earnings ratio is greater, possibly because 

Virgil Corp. Z-CalcData 

8054 4099 

890 311 

20% 18% 

106% 48% 

11% 8% 

13 11 
85,000 92,000 

of current investor optimism for growth in 
biotechnology, Virgil's income growth 
during 1986 was over twice as fast as Z
Calc's, mainly because Virgil's Model 
IX-3 advanced researcher's workstation 
went on the market in the second quarter 
of the year. Significant income from Z
Calc's new franchisees, on the other hand, 
is not expected until late 1987. 

Future Prospects 
Both companies have successfully shifted 
their activities to take advantage of new 
opportunities that have arisen in the past 
five years. With the expected growth in 
biotechnology over the coming decade, 
Virgil is currently well positioned for 
rapid expansion. Having developed a 
solid reputation for quality in the medical 
instrumentation field, it has superb 
prospects for selling a broader line of 
tools for biotechnical research. 

From its base as an independent payroll 
processing service, Z-Calc has successful
ly taken on the challenge of shifting into a 
completely different business that of 

~1~ Page 2 VirgillZ-Calc Report 
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Figure 3 

Revenue Growth 

1221 --

payroll systems franchiser. Despite the in
herent costs of such a transition, the com
pany has nevertheless maintained a solid 
revenue and income growth mte. Now 
that the shift has been accomplished, Z
Calc's prospects for rapid growth are ex
cellent 

Recommendation 
We strongly recommend that the existing 
advisory relationships that Finanswers 
Consultants have forged with both Virgil 
Corp. and Z-Calc Data be extended during 
the foreseeable future. In addition, the 
laudable track record that both these com
panies have posted can provide a model to 
many of Finanswers' other client corpora
tions. We also recommend that 
Finanswers Consultants continue to estab
lish new consultancy relationships with 
high-technology companies in the Austin 
area. 

VlrgillZ-Calc Report 

ISSl --_ ... 

Page3 



Preparing Text for Importing 

To prepare the text portion of the docu
ment, enter the text in Figure 4 using 
your standard word processor. The .J at 
the end of each line indicates a carriage 
return (i.e. pressing Enter). The <197> is 
a code that Ventura translates into an Em 
dash (-). This is necessary because the 
Em dash is not a regular keyboard 
character. Since the specific contents of 
the file are not relevant to the exercise, 
you can use any text file of 600 words or 
more. Make sure to remove any ex
traneous formatting from your file so that 
it looks like Figure 4. 

The following word processor for
mats are recognized by Ventura: Word
Perfect, Microsoft Word, WordS tar, Mul
tiMate, Xerox Writer, IBM DisplayWrite, 
XyWrite, or Samna. You can also use any 
other word processor, provided you save 
the text files in DisplayWrite DCA for
mat or in plain ASCII form. (To check 
that a word processor is saving a file in 
plain ASCII form, display the document 
using the DOS command TYPE 
filename. If no nonkeyboard characters 
such as the smiling face appear, the file is 
in plain ASCII form.) 

Although Ventura can handle various 
word processor formats, that doesn't 
mean it can successfully translate any 
type of formatting you might do within 
those files. To keep things simple, your 
best bet is to do no formatting within the 
word processor. Leave such operations as 
centering text, setting leading (line spac
ing), and establishing the widths of 
columns to Ventura. In particular, avoid 
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using tabs for paragraph indents.Note that 
the symbol .J indicates that you should 
press Enter. 

As shown in Figure 4, you can in
clude the command 

@PARAFILTR ON = 
as the first line of the text file. Including 
this command causes Ventura to filter out 
any double carriage returns that it en
counters. It allows you to press the Enter 
key twice between each paragraph to 
make your text more legible on the 
screen. 

Tables and other tabular material re
quire special attention. The best approach 
is to create a new file for a table. Separate 
each column with a single tab, but don't 
worry about setting the position of the 
tabs using your word processor. That too 
is best left up to Ventura. Figure 5 shows 
how to enter the table using your word 
processor. The arrows ( -7 ) indicate 
where you should press the Tab key. 

With WordStar, make sure that Vari
Tab is turned off when you create the 
table. Otherwise, Ventura will convert the 
tabs you enter in WordStar into five blank 
spaces. 

Preparing Graphics for 
Importing 

Ventura recognizes a number of graphics 
formats, including Lotus files, PC Paint
brush (PCX) files, GEM, Halo, Auto
CAD (SLD only), GEM Paint, MacPaint, 
HPGL, Mac Draw, VideoShow, Mentor 
Graphics, CGM, and Encapsulated Post
Script files. In this example, we use a 
Lotus graphic; however, you may substi-
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@PARAFILTR ON = ~ 
Report on Virgil Corporation and Z-Calc Data~ 
~ 

Summary~ 

~ 

For the past five years, Finanswers Consultants have been providing 
management data and financial planning consulting services to two 
medium-sized Texas-based corporations in the high-tech Silicon Prairie 
industrial area near Austin. Virgil Corporation is a manufacturer of 
technical workstations for the biomedical research field. Z-Calc Data 
is a supplier and franchiser of payroll systems to small accounting 
firms. Both companies have emerged as clear success stories. Each has 
shown consistent, rapid growth over the period. More important, the two 
have successfully undertaken ambitious programs aimed at repositioning 
their operations for continued growth. Prospects for both companies 
appear to be excellent.~ 
~ 

Background: Virgil Corp.~ 
~ 

Founded in 1961 by electro-oscilloscope inventor R. Stanley Mahanovich, 
Virgil Corporation developed into a manufacturer of technical 
instrumentation for medical laboratories. In 1978, with Mahanovich 
still at the helm, the company began to expand its scope toward 
designing and manufacturing an entire line of technical 
tools<197>including microcomputer workstations<197>for both the medical 
and biotechnical fields. Today, Virgil supplies three turnkey 
workstation systems for researchers, including software and instrument 
peripherals.~ 

~ 

Background: Z-Calc Data~ 
~ 

Z-Calc Data was founded in 1977 by two computer science graduate 
students at the university of Texas, Roberta Orbison and Lucy Chin. 
Initially the firm was exclusively involved in accounting and payroll 
processing. After growing rapidly for five years, Z-Calc began shifting 
its activities to supplying payroll processing systems on a franchise 
basis throughout Texas, Oklahoma, Louisiana, and New Mexico to 
independent accountants and payroll firms. Meanwhile, the company has 
sold its own payroll processing business and reduced its miscellaneous 
accounting work. ~ 
~ 

Five Year Performance~ 
~ 

Both Virgil Corporation and Z-Calc Data have posted solid gains since 
1982. As shown in the Financial Snapshot table, Virgil grew from $36 
million in revenues in 1982 to $81 million in 1986. Z-Calc grew 
somewhat more slowly, from $12 million in revenues in 1982 to $41 
million in 1986.~ 

Figure 4: Enter text in your word processor as shown here. 
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-I 
Both companies have succeeded in taking advantage of the rapid general 
growth that has occurred in the Silicon Prairie area around 
Austin<197>Virgil by broadening the scope of its existing operations, 
Z-Calc by shifting into an area with a larger potential for expansion. -I 
-I 
This Year's Performance-l 
-I 
Both companies showed enviable track records during the past year in 
posting positive financial indices. As the Financial Snapshot shows, 
the two companies have nearly identical margins and revenue per 
employee. Currently, Virgil's price-earnings ratio is greater, 
possibly because of current investor optimism for growth in 
biotechnology. Virgil's income growth during 1986 was over twice as 
fast as Z-Calc's, mainly because Virgil's Model Ix-3 advanced 
researcher's workstation went on the market in the second quarter of 
the year. Significant income from Z-Calc's new franchisees, on the 
other hand, is not expected until late 1987.-1 
-I 
Future Prospects-l 
-I 
Both companies have successfully shifted their activities to take 
advantage of new opportunities that have arisen in the past five years. 
With the expected growth in biotechnology over the coming decade, 
Virgil is currently well positioned for rapid expansion. Having 
developed a solid reputation for quality in the medical instrumentation 
field, it has superb prospects for selling a broader line of tools for 
biotechnical research.-I 
-I 
From its base as an independent payroll processing service, Z-Calc has 
successfully taken on the challenge of shifting into a completely 
different business that of payroll systems franchiser. Despite the 
inherent costs of such a transition, the company has nevertheless 
maintained a solid revenue and income growth rate. Now that the shift 
has been accomplished, Z-Calc's prospects for rapid growth are 
excellent.-I 
-I 
Recommendation-l 
-I 
We strongly recommend that the existing advisory relationships that 
Finanswers Consultants have forged with both Virgil Corp. and Z-Calc 
Data be extended during the foreseeable future. In addition, the 
laudable track record that both these companies have posted can provide 
a model to many of Finanswers' other client corporations. We also 
recommend that Finanswers Consultants continue to establish new 
consultancy relationships with high-technology companies in the Austin 
area. 
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tute your own graphic in one of the for
mats listed above or else use one of the 
sample graphic files provided with Ven
tura. 

If you've already had some practice 
loading graphics into Ventura using ver
sion 1.0 of the program, you'll find that 
things have changed a good deal in ver
sion 1.1. In version 1.0, Ventura did not 
always successfully handle the type used 
by Lotus for labels and captions, which 
necessitated going through the cumber
some procedure of labeling them after 
import into Ventura. In version 1.1, you 
should have no such problems. 

To prepare a Lotus graphic, use 1-2-
3 's Graph command to choose the type of 
chart and the title, legends, and labels. 
Use the Graph View command to pre
view the chart and the Graph Save com
mand to save the chart as a PIC file. 
There's no need to use 1-2-3's Print
Graph module at all, since you can load 
the PIC file directly into Ventura. 

Method Over Madness 

Now that you've created both the text 
and the graphics for the report, it's time 
to knit them together with Ventura. 
Before loading the program, it's a good 
idea to create a new subdirectory on your 
hard disk that will contain all the files as
sociated with that document. Copy the 
two text files (one for the report, the 
other for the table) and the graphics file 
(Lotus PIC or another graphic format of 
your choice) into this subdirectory. In this 
exercise we'll assume that the sub
directory you're using is called C:\RE
PORTI. 

Creating a new subdirectory for the 
files associated with a document is not 
strictly necessary, since Ventura does 
have the capability of knitting together 
files in multiple subdirectories. But it is 
advisable for two reasons. First is that it 
allows you to preserve the original ver
sions of your text and graphics files. Sec
ond, once your document is in its own 
unique subdirectory, you'll find it much 

Financial Snapshot: Virgil Corp. vs. Z-Calc Data~ 
Calendar 1986-)Virgil Corp.-)Z-Calc Data~ 
Revenues (thousands)-)8054-)4099~ 

Earnings (thousands)-)890-)311~ 

Revenue Growth 86/85-)20%-718%~ 
Income Growth 86/85-)106%-748%~ 
Margin-)11%-)8%~ 

Price-Earnings Ratio-)13-711~ 
Revenue per Employee-)85,OOO-)92,OOO 

Figure 5: Enter text for the table as shown here. The arrows indicate where you should press 
the Tab key. 



easier to remove files from your hard 
disk when it comes time to free up a few 
megabytes. 

With the text and graphics files 
moved into the new document sub
directory, you can start Ventura, load a 
new style, and save that style under a 
new name, as follows: 

• From the DOS prompt type 
VP 

to load Ventura. From the File menu 
select Load Diff. Style. 

• In the Item Selector dialog box, 
check to see that the Directory line 
reads C:\TYPESE1\* .STY. 
If it does, skip the next step. 

Click on the small black square 
several times until the scroll bar lists 
the drives on your computer (A:, B:, 
C:, etc., each preceded by a dia
mond). Select the drive that contains 
the TYPESET subdirectory, nor
mally the C: drive but sometimes the 
D: or E: drive. Then select the 
TYPESET subdirectory from the list 
of subdirectories. Now the Directory 
line should read 
C:\TYPESE1\*.STY. 

• The selection box at the left now 
shows a list of Ventura's prefor
matted style sheets (each preceded 
by an ampersand sign). Move the 
scroll bar down until you locate a 
style sheet with the name 
&PRPT-P2.STY. 

• Select &PRPT-P2.STY. There are 
three alternative ways to do it: (a) 
Place the cursor over the name and 
click twice rapidly; (b) Place the cur-
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sor over the name and click once, 
then select OK; (c) Place the cursor 
over the name and click once, then 
press Enter. 

The dialog box should now disap
pear and the name of the style will appear 
in parentheses at the top of the screen. 
Once this style has been loaded into Ven
tura, you should save it under a new 
name in the subdirectory you are using 
for this document. Saving the style under 
a new name is an important step because 
it allows you to adapt Ventura's prefor
matted style sheet while preserving an 
original copy of that style for future use. 
Do these steps: 

• From the File menu, select Save As 
New Style. 

• Click on the small black square until 
the Directory line reads C:\*.STY. 

• Select REPORT2 from the scroll 
box. The Directory line should now 
read C:\REPORT2\* .STY. 

• Choose a new name for the style and 
type it on the selection line. For ex
ample, type 
BUSREPRT 

• Select OK or press Enter. 

Now, we'll name the chapter and 
save it in the REPORT2 subdirectory. 

• From the File menu, select Save As. 

• In the Item Selector dialog box, click 
on the little black box until the 
directory line reads: C:\* .CHP. 

• Select REPORT2 from the scroll 
box. The directory line should now 
read C:\REPORT2\* .CHP. 
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• Type a name for the chapter on the 
selection line. Type 
BUSREPRT.CHP 

• Select OK or press Enter. 

Note the name of the chapter at the 
top of the screen and the name of the 
style sheet in parentheses. 

Tag Team 

Style sheets contain a variety of informa
tion. Most noticeable are the new set of 
tags that they provide. You can see these 
listed in the sidebar if you select the Tag
ging icon. Style sheets also contain infor
mation on page margins, number of 
columns, and other parameters. 

• From the View menu, select Re
duced. 

• Check to see that the Options menu 
is set so that column guides are 
shown. The two columns defined by 
this style sheet will be indicated on 
the page by dotted lines. 

As the column guides indicate, the 
margin at the left is wider than the mar
gin at the right. The extra room at the left 
edge is intended to allow room for bind
ing or stapling the report. 

Now you can load the text portion of 
the report. 

• From the File menu select Load 
Text/Picture. 

• In the dialog box select Text and 
then select the name of the word 
processor in which you created the 
text for this exercise. 

• Select OK or press Enter. 

• In the next dialog box, make sure 
that the directory is C:\REPORT2. 

• Select your file from the list of files 
that appears in the box. 

The name of the file you have 
selected will now appear in the box at the 
left of the screen. When you select that 
name, Ventura will load the document 
into the two-column format defined by 
your style sheet. Now you can proceed to 
"tag" the document. When you select the 
Tagging icon, the available tags in the 
style sheet will appear in the selection 
box on the left. 

Each such tag applies to a particular 
type of paragraph, such as regular body 
text or a subhead. Contained within the 
tag is a variety of information regarding 
the typeface, type size, leading (i.e. line 
spacing), indentation, standard ruling 
lines, and other characteristics of a para
graph. Tagging a paragraph is done by 
executing the following steps: 

• Select the Tagging icon. 

• Select the paragraph (pointing at it 
and clicking). 

• Select a tag from the Assignment 
List. Note that it's not necessary to 
tag every paragraph in the docu
ment; those paragraphs that are not 
tagged will automatically be given 
the Body Text tag. 

The tags contained in the style sheet 
for this document are Body Text, Bullet, 
Head levell, Head level 2, and Title. 
After you've tagged the entire document, 
you might decide to change one or more 
of the parameters associated with a style. 



For example, the following are the steps 
to change the font used in the title: 

• Select the title line of the document 
and then select the Title style. 

• From the Paragraph menu, select 
Font. 

• In the dialog box, select 24-point 
Times Roman (or Dutch for non
PostScript printers). 

• Select OK or press Enter. 

Now let's change some other charac
teristics of the title. 

• From the Paragraph menu, select the 
Spacing option. 

• Change the measurement units to 
picas & points. To do that, point the 
cursor directly at the measurement 
units (at the word "inches") and 
click until the units are picas & 
points. 
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• Change the space above the title line 
to 6,00 picas & points and the space 
below the title line to 6 picas as well. 

• Select OK or press Enter. 

From the Paragraph menu, select the 
Ruling Line Below option. 

Eliminate the ruling line by choosing 
None as the width of the line. 

• Select OK or press Enter. 

Footers 

Now let's create headers and footers for 
the document. With Ventura, you can 
have a different set of headers and footers 
for left and right pages. 

• From the Page menu, select Headers 
& Footers. 

Figure 6: The 
Headers and 

Footers dialog 
box. DeFine: !leFt Page Header ! ! Right Page Header! 

!leFt Page Footer! WMIMmd 
Usage: iii []EJ 
leFt: Virgil/Z-Cale Report _________ _ 

Center: 

Right: Page [PII1!1-____________ _ 

Inserts: ! Chapter II ! ~ !1st Match! !last Match! 

! Text Attr. ! ! Copy To Facing Page! 
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• In the dialog box (shown in Figure 
6) select Right Page Footer and 
Usage:On. 

• For the left side of the footer, type 
Virgil/Z-Calc Report 

• For the right side of the footer, type 
Page 

• Under Inserts, select Page #. 

This footer will now automatically 
appear on every right page, with the cor
rect page number automatically inserted. 
To have the footer also appear on every 
left page, select Copy to Facing Page at 
the bottom of the Headers & Footers 
dialogue box. 

Ventura automatically generates a 
tag called Z_Fo0 ter, which may not ap
pear in the Assignment List. To have it be 
included, select the Preferences option 
from the Options menu and select 
Generated Tags: Shown. 

To change the font or any other set
ting of the Z-Footer tag, follow the same 
procedure used for changing the parame
ters of any tag: 

• Select the Tagging icon. 

• Select the footer. 

• From the Paragraph menu, select the 
options you wish to change. 

Another Frame Job 

Inserting tables and graphics into a page 
of text is one of the simplest operations 
to perform. The procedure for either text 
or graphics is the same. We'll illustrate it 
with the table on the second page of the 
report. 

• Press PgDn to move to page two of 
the document. 

• Select the Frame icon. 

• Select Add New Frame. 

• From the View menu select Re
duced. 

• From the Options menu select Turn 
Column Snap On. This ensures that 
the edges of the frame you are about 
to draw will line up with the edges 
of your columns. 

• To draw the new frame, place the 
cursor on the upper left comer of the 
left column, then hold down the 
mouse button while pulling out the 
frame downward and toward the 
right. When you have drawn the new 
frame, the text below it will reformat 
automatically. 

• From the Frame menu, select Ruling 
Box Around. 

• Select Width: Frame. 

• If the measurement units shown are 
"inches," point at the word inches 
with the arrow and click twice to 
change the units to picas & points. 
You'll find that page layout goes 
much easier if you get into the habit 
of consistently using picas and 
points (six picas to an inch, twelve 
points to a pica). These units have 
one big advantage over working 
with inches or centimeters: you 
never have to worry about fractions. 

• Set Height of Rule 1 at one point 
(00:01). 



Now you can select the file contain
ing the table, following the same proce
dure that you used to load the main text 
file. Once the table is loaded, you will 
need to create several new tags to set up 
its formatting. 

To create a new tag in Ventura, ex
ecute the following steps: 

• Select the Tagging icon. 

• Select Add New Tag. 

A dialogue box appears asking you 
for the name of the new tag and the name 
of the tag to copy from. Ventura never 
lets you create a new tag from scratch. 
Instead, you copy the format from a pre
viously-created tag, and then alter the 
fonts, margins, and other parameters of 
the new tag to make it unique. 

• For the name of the new tag, type 
Table Title 

The next series of steps establishes 
the parameters of the Table Title tag. 

• Select the title line of the table. 

• From the Paragraph menu, select 
Font and choose 14-point bold 
Helvetica (or Swiss for non-Post
Script printers). 

• From the Paragraph menu, select 
Alignment. 

• In the dialog box, select Align
ment:Center and Overall 
Width:Frame-Wide. Make sure that 
the Fixed Indent is set at O. 

• From the Paragraph menu, select 
Spacing. 
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• Set Space Above at 3,00 picas & 
points, and Space Below at 2,00 
picas & points. 

You'll need two more tags to 
complete formatting the table, Table Text 
1 and Table Text 2. For Table Text 1 use 
the following settings: 

• Font: IO-point Helvetica (or Swiss). 

• Alignment: Left-Justified, . Frame
Wide, No Fixed Indent. 

• Spacing: Inter-Line: 01,04 picas and 
points; Inter-Paragraph: 0; In From 
Left 3,00 picas and points. 

• Tab Settings: first tab at 24,00 picas 
and points right-aligned, second tab 
at 32,00 picas and points right
aligned. 

For Table Text 2 the settings are the 
same except that In From Left spacing is 
set at 5,00 picas and points. 

The final step in creating the table is 
to place a ruling line around the table 
frame. 

• Select the Frame icon. 

• Select the frame containing the table. 
After it has been selected, the frame 
is "active" and is surrounded by 
small black rectangles. 

• From the Frame menu, select Ruling 
Box Around. 

• In the Ruling Box Around dialog 
box, select Width:Frame and set the 
Height of Rule 1 at 00,01 picas and 
points. 

• From the Frame menu, select Sizing 
& Scaling. 
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• Set Vert. Padding at 1,00 pica. That 
ensures there will be a margin of 
vertical spacing between the frame 
and the adjacent text. 

More Graphics 

N ow you can load the Lotus graphic (or 
another graphic of your choice). The 
steps will be quite similar to those you 
followed in merging the table. However, 
there is the additional work of position
ing the chart within the frame. 

• Press PgDn to move to the third 
page. 

• Draw a new frame across the top of 
the page. 

• From the File menu, select Load 
Text/picture. 

• In the dialog box, select Line-Art, 
Lotus. 

• Select OK or press Enter. 

• In the next dialog box, select the ap
propriate subdirectory and name of 
the .PIC file. If you don't happen to 
remember the name of a sub
directory or file, you can use the 
Backup Box in the upper left comer 
of the list at the left to check through 
any subdirectory available to your 
computer. Clicking on the Backup 
Box takes you upward in the hierar
chy of files until you are at the 
names of the drives. Clicking on the 
name of a directory in the list will 
display its subdirectories and files. 
In this way you can determine the 
name of any subdirectory or file 
without leaving Ventura. 

• The graph will appear in the frame, 
not yet properly positioned. From 
the Frame menu, select Sizing & 

Figure 7: These 
are the settings 

you should enter 
in the Sizing & 
Scaling dialog 

box. 

liD [Qill 

Upper left H: 07,o~ a I:::J Upper left Y: 05,19 a I:::J 
Frallle Width: 36,00 Frallle Height: 23,03 

Horiz. Padding: 01,00 Vert.~adding: 01,00 picas & points 

Picture Scaling: I Fit in Frallle I m!'lm. 
Aspect Ratio: IIMM' I Distorted I 

H Crop Offset: B5,OO [!] II Y Crop Offset: 00,00 a I:::J 
Scale Width: 24,09 Scale Height: 24,00 

ColuM Balance: ~ I!IiI 



Scaling. Enter settings to match 
those shown in Figure 7. 

Optional Step: Adding Shades 

With Ventura, it's easy to make a chart or 
a table stand out by filling it with one of 
eight levels of gray shading. To add shad
ing to the table, PgUp to page 2, select 
the frame containing the table, select 
Frame Background, from the Frame 
menu, and select Black pattern 1. 

Shading the Lotus graphic as shown 
is slightly more complicated. First select 
the frame associated with the bordering 
line. Fill this frame with Black pattern 1. 
Next, select Add New Frame and draw a 
new frame overlapping the chart, cover
ing the area that will not be shaded gray. 
Using the Frame Background option, 
select solid white for this frame. Initially, 
the solid white box will block out the 
chart. You now need to select the frame 
containing the chart itself and move it in 
front of the solid white frame. That way 
the solid white frame will block out part 
of the gray-filled frame, and the graphic 
will be on top of the solid white frame. 
To move the frame containing the chart 
to the front, select it (by holding down 
etrl while clicking within the frame 
boundary). Next press Del followed im
mediately by Ins. 

Box Text 

Another option is to replace the type au
tomatically generated for the title of the 
Lotus chart. To do this, select Framing 
icon, select the frame containing the 

TUTORIAL 1: A BUSINESS REPORT 33 

chart, select the Graphics icon, select the 
Box Text tool, draw a box covering the 
old title, from the Graphic menu select 
Fill Attributes, select White Solid 
Opaque, select the Text icon, place the 
cursor at the end of the words Box Text 
and backspace across them, type a title of 
your choosing, drag the cursor across the 
title to highlight it, select Set Font, 
choose a font for the title, select the 
Graphic icon, select the box, drag the box 
containing the title into the desired posi
tion, select the Line Attributes option of 
the Graphic menu, and select None. 
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Tutorialo· A Newsletter 
ALTHOUGH XEROX VENTURA Publisher 
is an ideal program for handling long 
documents such as technical manuals, the 
program also works quite nicely for 
shorter projects such as newsletters. This 
chapter illustrates the steps to follow to 
create a newsletter. 

One distinctive feature of newslet
ters is that they typically involve knitting 
together articles written by more than one 
author and stored in more than one text 
file. For example, one author may have 
used WordStar, another WordPerfect, and 
a third MultiMate. With Ventura, text 
from any of these programs can be auto
matically loaded into a document. 

As we'll see below, the technique for 
combining multiple text and graphics 
files on one page is to tum on Ventura's 
column guides, which appear on the 
screen as light dotted lines. You then use 
these guides to draw a frame to contain 
each text block or graphic image on the 
page. Next, you load text or pictures onto 
the page, one frame at a time. 

Typically, in a newsletter-style lay
out, text will need to jump from one loca
tion to another. With Ventura, this is an 

easy problem to handle. You merely 
select a frame and load text into that 
frame-Ventura will place as much into 
the frame as the frame can hold. You then 
select a a new frame, and load the same 
file again. Ventura will continue loading 
the same file, picking up where the pre
vious frame left off. In this way articles 
can jump from frame to frame, jumping 
as many times as necessary. Later, if you 
need to add or delete text from an early 
frame, text in frames down the line will 
adjust accordingly. 

This method of loading text into 
frames on the page is different from the 
method described in the previous chapter, 
which involved loading text directly onto 
the base page. Ventura aficionados refer 
to this method of drawing frames to hold 
text blocks as "PageMakering," since it 
mimics the PageMaker method of manu
ally "placing" text onto a page one 
column at a time. With Ventura you 
should avoid PageMakering for long 
documents such as manuals and books, 
because it will tend to slow down the pro
duction of such documents. Instead, fol
low the procedure shown in the previous 
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Ventura Scoop 
SPECIAL EDITION APTOS POST TYPOGRAPHY MARCH, 1987 

Xerox Shows Off 
Ventura Publisher at 
Conference 
BEVERLY HILLS (VP) - Xerox Corporation has introduced 

version 1.1 of its fll'st electronic publishing software product that 
runs on industry standard personal computers. Xerox chose the 
Seybold Conference to announce the price and availability of the 
new revision to the industry standard software package. Con
ference attendees were impressed by the eighty-one new fea
tures, all of which were added without compromising the speed 
of the product and its depth of functionality. 
Product now widely available. 
The Xerox Desktop Publishing Software Series: Ventura 

Publisher Edition is available through Xerox authorized dealers 
(including ComputerLand, Microage, and Pactel), and the Xerox 
Business Software Center via (800)-822-8221, and the Xerox 
general line sales force. Commented one observer, ''This breadth 
of distribution represents Xerox's commitment to the main
stream of the PC-based market." 
Ventura Publisher Edition allows personal computer users to 

merge text and graphics to create publishing-quality documents, 
such as newsletters, technical manuals, books, bids and 
proposals, that might otherwise be sent to a print shop or typeset
ter. The package runs on the Xerox 6065, IDM PC/XT, IDM 
PC/AT, and other PC compatibles. It supports popular laser 

Columbia! 

printers, including the Xerox 4045, the Apple LaserWriter and 
the HP Laser Jet. 
Pioneers in the ne1d 
"As one of the pioneers in the field of electronic publishing, 

Xerox fully understands users' requirements for a desktop pub
lishing software product," said James N. Brown, vice president, 
office systems marketing, Xerox Business Systems Group. 
Pricing for Ventura Publisher Edition is $895, with volume dis

counts available. For further information or to place an order, 
ca11800-822-8221. 

Version 1.1 Redefines 
Desktop 
Publishing-Again 
MORGAN HILL (VP) - Xerox Ventura Publisher Edition 

version 1.1 has added new meaning to the term "Desktop 
Publishing." Before the introduction of Ventura Publisher Edi
tion, desktop publishing referred primarily to advanced drawing 
packages that were extended to handle different text fonts. 
These types of packages were characterized by a hand-inten

sive approach that attempted to mimic what graphic artists and 
typesetters were used to doing using the personal computer 
screen as an electronic paste-up board. While this approach was 
easy for artists to pick up, it did not result in much time-saving 
because the user was still faced with the drudgery of hand-ad
justing each piece of text on the page. 
Fortunately, the software developers at Ventura Software Inc. 

recognized this and adopted a style sheet approach. In the same 



chapter. For newsletters, however, the 
method described in this chapter is ideal. 

Figure 1 shows the newsletter we'll 
create in this tutorial. It is a slightly 
simplified version of the Ventura Scoop 
document used as a demonstration by 
Ventura dealers. Those using non-Post
Script printers will not be able to print the 
72-point headline, but will instead see a 
24-point headline on their final printout. 
Conveniently, both the style sheet and the 
text files needed to produce this docu
ment are provided with Ventura and were 
automatically copied into the Typeset 
subdirectory of your hard disk when you 
installed the program. 

Preliminaries: Directories and 
Style Sheets 

To start the tutorial, you'll need to load 
Ventura and then load the Scoop style 
sheet, as follows: 

Figure 2 : You 
should set your 

options as 
shown here. 

Note the dotted 
lines on the 

page, which 
represent the 
edges of the 

columns. 
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• From the DOS prompt, type 
VP 
to load Ventura. 

• Pull down the Options menu and 
match the settings to Figure 2. If a 
setting does not match, move the 
mouse so the cursor is over it and 
click the mouse button once. In the 
remainder of this article, the term 
"selecting" will be used as shorthand 
for this operation of pointing and 
clicking with the mouse. Inciden
tally, if you accidentally pull down 
the wrong menu and want it to disap
pear, you merely click on any loca
tion outside the menu. 

• From the File menu, select Load 
Diff. Style. 

• In the Item Selector dialog box, 
che9k to see that the Directory line 
reads C:\TYPESE1\*.STY. If it 
does, skip the next step. 

Hide Side·Bar 
Hide Rulers 
Hide ColUM Guides 
Hide Pictures 
Hide Tabs & Returns AT 
Hide Loose Lines 
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• Click on the Backup Button (the 
small black square) several times 
until the scroll bar lists the drives on 
your computer (A:, B:, C:, etc., each 
preceded by a diamond). Select the 
drive that contains the TYPESET 
subdirectory. Then select the TYPE
SET subdirectory from the list of 
subdirectories. Now the Directory 
line should read c:\TYPE
SE1\*.STY. 

• Scroll down until SCOOP.STY ap
pears. 

• Select SCOOP.STY. There are three 
alternative ways to do it: (a) Place 
the cursor over the name and click 
twice rapidly; (b) Place the cursor 
over the name and click once, then 
select OK; (c) Place the cursor over 
the name and click once, then press 
Enter. 

It's a good idea to create a new 
directory on your hard disk to contain the 
chapter file, style sheet file, and other 
files associated with a particular docu
ment. That way, when you need to make 
room on your hard disk you can easily 
determine which files to erase or backup 
to a floppy. Create the new directory as 
follows: 

• From the File menu, select DOS File 
Ops. 

• In the dialog box, use the backspace 
key to erase the current file spec. 

• Type a new file spec: 
C:\NWSLTR 

• Select Make Directory. Note: when 
you do so there will be no confirma
tion by Ventura. 

• Select Done. 

Save the Scoop style sheet under a 
new name in this directory. That way you 
can preserve the original SCOOP. STY 
file intact. Do these steps: 

• From the File menu, select Save As 
New Style. 

• Click on the Backup Button until the 
Directory line reads C:\*.STY. 

• Select NWSL TR from the scroll 
box. The Directory line should now 
read C:\NWSLTR\*.STY. 

• Type a new name for the style on the 
selection line. For example, type 
NEWS.STY 

• Select OK or press Enter. 

Next, we'll name the chapter and 
save it in the NWSLTR subdirectory. 

• From the File menu, select Save As. 

• In the Item Selector dialog box, click 
on the little black box until the 
directory line reads: C:\* .CHP. 

• Select NWSL TR from the scroll 
box. The directory line should now 
read C:\NWSLTR\*.CHP. 

Type a name for the chapter on the 
selection line. Type 
NEWS.CHP 

• Select OK or press Enter. 

Note the name of the chapter at the 
top of the screen and the name of the 
style sheet in parentheses. 



Establishing Columns and 
Frames 

If you're not already in Reduced view, 
select Reduced from the View menu. On 
the screen, Ventura shows the outlines for 
three columns. To change to a two
column format, execute the following 
steps: 

• Select the Frame icon (the icon fur
thest to the left). 

• From the Frame menu, select Mar
gins & Columns. 

• Select 2 for # of Columns. 

• Select OK or press Enter. 

Dotted lines will now outline two 
columns on the screen. In laying out the 
newsletter, we will not pour text directly 
into these base page columns, as would 
be the case if this were a long document 
such as a book or a technical manual. 
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Base page formatting is appropriate for 
long documents, whereas a different 
method is appropriate for documents, 
such as newsletters, that contain more 
than one text file on a single page. 

For a newsletter, you can use the 
dotted lines that indicate the base page 
columns as guides for drawing frames on 
top of the base page. After switching to 
two columns, the next step is to draw 
seven frames on the page, the approxi
mate size and location of which are 
shown in Figure 3. Don't worry about 
drawing these frames precisely, since you 
can adjust them later. 

• Select Add New Frame. 

• Move the cursor to the upper left 
comer of the first column. Hold 
down the mouse button while pulling 
the cursor down and toward the 
right. When you reach the outside 
edge of the second column, release 

Desk File Edit View Page Frallle 
Figure 3: The 

frames you 
draw should be 

the 
approximate 

size and 
relative 

position of 
these boxes. 

1 

2 

5 
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the mouse button. As you can see, 
the frames you draw automatically 
snap to the column boundaries, since 
Column Snap has been turned on in 
the Options menu. 

• Select Add New Frame again. 

• Draw the second frame. 

• Repeat for the other frames. 

If you need to delete a frame, select 
the frame by clicking within its boundar
ies, then press Del. To move a frame to a 
new location, place the cursor within its 
boundaries and hold down the mouse 
button while you drag the frame. To 
change the size of the frame, place the 
cursor on one of the edge boxes and hold 
down the mouse button while you drag 
that edge. 

Loading Text and Pictures 

The next series of steps is to load text 
into the first frame. When you are load
ing text into frames rather than onto the 
base page, Ventura loads as much text as 
possible into the currently selected frame. 

• Select Frame I by pointing within its 
boundaries and clicking the mouse 
button. 

• From the File menu, select Load 
Text/picture. 

• In the Load Text/picture dialog box, 
select Text and ASCII. Select OK or 
press Enter. 

• In the Item Selector dialog box, 
scroll down until you find 

SCOOP1.TXT. Select SCOOPI
.TXT. 

• Select OK. 

What you see on the screen at this 
point depends on the type of printer you 
are using. If you have installed Ventura 
for use with a PostScript printer, the 
words Ventura Scoop will be in 72 point 
type. If you have installed Ventura for 
other types of printers, the words Ventura 
Scoop will be smaller, since these print
ers are for the most part limited to 24-
point or 3D-point type. 

Now you can load more of the 
SCOOPI.TXT file into the second, third, 
and fifth frames. 

• Select Frame 2. 

• Select SCOOP1.TXT (Le. click on 
the name) from the assignment list. 

• Select Frame 3. 

• Select SCOOP1.TXT from the as
signment list. 

• Select Frame 5. 

• Select SCOOPI.TXT from the as
signment list. 

You may wonder why the text has 
already been formatted, with the article 
headline in 24-point type and the article 
text in IO-point type. The reason is that 
the text files used in this tutorial have al
ready been tagged, that is, have already 
been assigned formats. These formats, of 
course, can be changed. 

If you switch from Reduced View to 
Normal View you can read IO-point body 
text. 

The next step in formatting the page 
is to load another text file into Frame 7. 



• Select Frame 7 by pointing within its 
boundaries and clicking the mouse 
button. 

• From the File menu, select Load 
Text/Picture. 

• In the Load Text/picture dialog box, 
select Text and ASCII. Select OK or 
press Enter. 

• In the Item Selector dialog box, 
scroll down until you find 
SCOOP2.TXT. Select SCOOP2.
TXT. 

• Select OK. 
You'll see that the the article "Ver

sion 1.1 Redefines Desktop Publishing
Again" does not conclude in Frame 7. 
You could continue it into a subsequent 
page, as described at the end of this ar
ticle. For the moment, leave it as is. Now 
you can load an illustration into Frame 4. 

Figure 4: 
Before 

inserting text, 
you first 

backspace 
across the 

words Box Text. 
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• Select Frame 4. 

• From the File menu, select Load 
Text/Picture. 

• In the Load Text/picture dialog box, 
select Line Art and GEM. Select OK 
or press Enter. 

• In the Item Selector dialog box, 
select COLUMBIA.GEM. 

• Select OK. 
To load a different illustration into 

Frame 6, repeat the above steps, but 
select NOZZLE.GEM. 

At this point the page is complete in 
its basic elements. You can now save the 
chapter and print it out to check your 
work so far. Then you can go on to en
hanceit. 

• From the File menu, select Save. 

• From the File menu, select To Print. 
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• In the Print Information dialog box, 
check the configuration to see that 
the correct printer is selected. If not, 
select Cancel and select Set Printer 
Info from the Options menu. In the 
Set Printer Info dialog box, select 
the correct printer name and then 
select Load Different Width Table. 
Select the desired width table from 
the Item Selector dialog box. 

• Check that your printer is turned on. 

• Select OK or press Enter to print the 
page. 

Enhancing the Page 

Having checked the current version of 
the page, you can begin to add enhance
ments. The first change we'll make will 
be to change the typeface used for head
lines from Helvetica (or Swiss, depend-

Figure 5: The 
jina/page. 

ing on your printer) to Times Roman (or 
Dutch). 

• Select the Tagging icon (second icon 
from left). 

• Select the headline "Xerox Shows 
Off Ventura Publisher at Confer
ence." Do this by placing the cursor 
on the headline and clicking. 

• From the Paragraph menu, select 
Font. 

In the dialog box, select a new font 
name (Times or Dutch, depending 
on your printer). 

• Select OK or press Enter. 

Now let's provide a title for the 
shuttle illustration. With Ventura, this can 
be done using the Anchors & Captions 
selection from the Frame menu. 
However, that option only allows cap
tions underneath or beside the frame con
taining the illustration. To place a title in-



side the illustration frame, you can use 
Ventura's Box Text tool from the 
Graphics palette. 

• Select the Frame icon. 

• Select the frame containing the 
shuttle. 

• Select the Graphics icon (icon fur
thest to the right, not the Graphic 
menu). 

• Select the Box Text tool from the 
palette. 

• Holding down the mouse, pull out a 
box inside the frame. The words 
"Box Text" will appear in the upper 
left corner of the box. This may be 
difficult to work with in Normal 
view. If necessary, select Enlarged 
from the view menu or press Ctrl-E. 

• Select the Text icon (second icon 
from the right). 

• Place the cursor between the final t 
of Box Text and the small marker 
box. Backspace to erase the words 
Box Text. (see Figure 4) 

• Type 
Columbia! 

• Select the Tagging icon. 

Select the word Columbia! by plac
ing the cursor on top of it and click
ing the mouse button. 

• In the Assignment Liston the left 
side of the screen, select the Head
line 2 tag. The word Columbia! 
should now be in 24-point type. 

• Select the Graphics icon (remem
ber-the furthest icon to the right, 
not the Graphic menu). 
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• Select the box containing the word 
Columbia! by placing the cursor in
side the box and clicking. 

• From the Graphic menu (not the 
icon-the menu), select Line At
tributes. If the Line Attributes option 
is in light gray, it means that the 
frame containing Columbia is not 
currently active. To activate that 
frame, select the Frame icon and 
select that frame. Then select the 
Graphics icon and select the box 
containing the word Columbia! once 
again. Now you can select Line At
tributes from the Graphic menu. 

• Select None for Thickness. This will 
eliminate the box surrounding the 
word Columbia! Select OK or press 
Enter. 

Move the word Columbia! to the 
desired location, by placing the cur
sor on it, holding down the mouse 
button, and dragging it. 

At this point the page should look 
like Figure 5. Now it's time to format the 
second page of the newsletter. I'll show 
just the initial steps of that process and 
leave the rest up to you. 

• From the Page menu, select In
sert/Remove Page. 

• Select Insert New Page After Cur
rent Page. 

• Select OK or press Enter. 

• Draw a small frame in the left 
column of the second page, using the 
Add New Frame command. 

• Select SCOOP2.TXT from the As
signment List. The final portion of 
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the SCOOP2.TXT file will load Into 
the frame you've drawn. 

• Press PgUp to return to page 1. To 
go back to page 2, press PgDn. 

Issue1\vo 

If this had been a real newsletter, you'd 
want to save this chapter as a template 
for the next issue. To create a template, 
you use the Remove Text/File option of 
the Edit menu to pull text and graphics 
off the page without disturbing the under
lying frame and column structure. Then 
from the File menu select the Save As 
option to give the template a new name. 
For the next issue, you simply open the 
template chapter and load a new set of ar
ticles and illustrations into the existing 
frames, moving and stretching frames if 
necessary for a slightly different layout. 
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Tutorial: A Form 
SO MUCH ATTENTION has been paid to 
Ventura's capabilities in handling long 
documents that many people have over
looked the fact that the program is superb 
at generating single-page forms. 

Most forms are best done using a 
technique that might be called the 
Grouped Box Text method. Essentially, 
the steps involved in this method are as 
follows: 

• Create a frame for each group of 
boxes. 

• Create the boxes with the box text 
command. 

• Add text to the boxes. 

• Specify shading and borders for the 
boxes. 

• Create tags for the text in the boxes 
and tag the text. 

U sing this method, you can create 
extremely complex forms, moving into 
enlarged mode when necessary for detail 
work. In this chapter, we'll walk through 
the creation of the very simple form 
shown in Figure 1. Chapter 12, "Docu
ment Layout Strategies," discusses some 

techniques for handling more complex 
forms. 

Preliminaries 

Execute the following steps to load Ven
tura, set the options, and load the default 
style sheet: 

• From the DOS prompt, type 
VP 
to load Ventura. 

• Pull down the Options menu and 
match the settings to Figure 2. 

• From the File menu, select Load 
Diff. Style. 

• In the Item Selector dialog box, 
check to see that the Directory line 
reads C:\TYPESE1\*.STY. If it 
does, skip to the next step. 

• Click on the Backup Box (the small 
black box) several times until the 
scroll bar lists the drives on your 
computer (A:, B:, C:, etc., each 
preceded by a diamond). 

• Select the drive that contains the 
TYPESET subdirectory. Now the 
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Directory line should read 
C:\TYPESE1\* .STY. 

• Scroll down until DEFAULT.STY 
appears. 

• Select DEFAULT. STY. There are 
three alternative ways to do it: (a) 
Place the cursor over the name and 
click twice rapidly; (b) Place the cur
sor over the name and click once, 
then select OK; (c) Place the cursor 
over the name and click once, then 
press Enter. 

As explained in the File Manage
ment chapter, it's a good idea to create a 
new directory on your hard disk to con
tain the chapter file, style sheet file, and 
other files associated with a particular 
document. Do so as follows: 

• From the File menu, select DOS File 
Ops. 

In the dialog box, use the Backspace 
key to erase the current file spec. 

Figure 2: The 
settings in the 
Options menu. 
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• Type a new file spec: 
C:\FORMDIR 

Select Make Directory. 

• Press Enter or select Done. Ventura 
will not give you any feedback that it 
has created the new directory. 

• Select Done. 

Save the default style sheet under a 
new name in this directory. That way you 
can preserve the original DEFAULT.STY 
file intact. Do these steps: 

• From the File menu, select Save As 
New Style. 

• Click on the small black square until 
the directory line reads C:\*.STY (or 
D:\*.STY). 

• Select FORMDIR from the scroll 
box. The directory line should now 
read C:\FORMDIR\*.STY. 

Hide Side' Bar 
Hide Rulers 
Hide ColuJlIn Guides 
Hide Pictures 
Hide Tabs 8 Returns "'T . 
Show Loose Lines 
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• Type a new name for the style on the 
selection line. For example, type 
INVOICE. STY 

• Select OK or press Enter 

Next, we'll name the chapter and 
save it in the FORMDIR subdirectory. 

• From the File menu, select Save As 

• In the Item Selector dialog box, click 
on the little black box until the 
directory line reads: C:\*.CHP 

• Select FORMDIR from the scroll 
box. The directory line should now 
read C:\FORMDIR\* .ClIP 

• Type a name for the chapter on the 
selection line. Type 
FORM.CHP 

• Select OK or press Enter 

The names of the chapter should 
now appear at the top of the screen with 

Figure 3: 
Drawing a box 

with the Box 
Text tool. 

the name of the style sheet in 
parentheses. 

The purpose of the next sequence of 
steps is to create the title for the invoice. 
Although this could be typed directly 
onto the base page, it's easier in the long 
run when producing a form to place all 
text in boxes created with the Box Text 
tool from Ventura's graphics palette. That 
way, if you need to move the text block 
to a new location you can simply drag it 
with the mouse. Of course, you don't 
want to have all text surrounded by 
boxes, but as we'll see below, one option 
of the Box· Text tool is to have the box 
boundary hidden. 

• Select the Graphics function (the 
furthest icon to the right, not the 
Graphics menu) 

• Select the Box Text tool from the 
graphics palette. 



Draw a box as shown in Figure 3. To 
do so, start at the upper left corner of 
the box and hold down the mouse 
button while you pull the cursor 
toward the lower right corner. When 
you release the button, the box will 
look like Figure 4. 

• Switch to Enlarged view. 

• Select the Text function. 

• Place the cursor between the final t 
of the word Box Text and the small 
box and click the mouse button. 

• Backspace across the word Box Text 
to erase the word. 

• Type 
INVOICE 

Executing the next series of com
mands creates a new tag for the word in
voice, causing it to be centered within the 
box in 24-point type. 

• 
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• Select the Tagging function. 

• Select Add New Tag. 

• In the dialog box, type 
Headline 
as the name of the new tag and select 
OK or press Enter. 

• Select the word INVOICE by plac
ing the cursor on top of it and click
ing with the mouse. 

• From the Paragraph menu, select 
Font. 

• Select 24-point Times (or Dutch, de
pending on your printer). 

• From the Paragraph menu, select 
Alignment. 

• In the dialog box, select Center and 
select OK or press Enter. 

• Switch back to Reduced view. 

• • 

Figure 4: After 
you draw the 

box and 
release the 

button, it will 
look like this. Box Texto 

• a 

a • • 
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• Select the box containing the word 
INVOICE, by placing the cursor 
within the box and clicking. 

From the Graphic menu, select Line 
Attributes (or type Ctrl-L). 

• Select Thickness: None. 

In the next series of steps, the boxes 
that make up the form are drawn. The 
boxes that contain text will be drawn 
with the Box Text tool and the boxes that 
contain no text will be drawn with the 
regular box tool. 

• Select Normal (or Enlarged) view. 

• Select the Graphics function. 

• From the Graphic menu, select Grid 
Settings. 

• Select Grid Snap: On. 

• If the measurement units shown are 
not inches, change them to inches by 
pointing the cursor directly at the 
words picas & points (or fractional 
pts or centimeters) and clicking until 
the word inches is shown. 

• Backspace across the existing set
tings for horizontal and vertical units 
and type 0.250 for both. Select OK 
or press Enter. 

• Select the Box Text tool. 

• Draw the top three boxes that make 
up the form. You'll notice that it is 
necessary to select the Box Text tool 
each time you draw a box. You can 
save time by holding down the Shift 
key while you draw a box, and the 
Box Text tool will remain selected." 

Later we'll replace the words Box 
Text in each box with the desired head-

ing. First, however, we'll draw the re
mainder of the form using the normal 
rectangle tool. 

• Select the rectangle tool. 

• Draw the first box. 

• Type 
ctrl-L 
and fill in the Line Attributes dialog 
box as follows: 

Thickness: Custom Width 0.003 
inches 
Color: Black 
End styles: squared ends. 
Defaults: Save To. 

• Select OK. 

• Type 
Ctrl-F 
and fill in the Fill Attributes dialog 

box as follows: 

Color: Black 
Pattern: Hollow 
Defaults: Save To 

• By selecting Save To, both the line 
and the fill attributes used for the 
first box will be used for subsequent 
boxes. Now draw the rest of the 
boxes in the form. 

• After drawing all the boxes, select 
the lower right box, press Ctrl-F, and 
change the Pattern from Hollow to 1. 

Now the form is complete except for 
entering the correct text in the boxes and 
formatting that text. 

• Select the Text function. 

• Backspace across the words Box 
Text in the first box and type 
QUANTITY 



• Change the words in the other two 
boxes to ITEM and AMOUNT. 

• Select the Tagging function. 

• Select the word Quantity. 

• Select Add New Tag. 

• Next to Tag Name to Add, type 
Center 14 

• From the Paragraph menu, select 
Font. 

• In the dialog box, Select Helvetica 
(or Swiss) 14-point. 

• From the Paragraph menu, select 
Alignment. 

• In the dialog box, select Alignment: 
Center. 

• From the Paragraph menu, select 
Spacing. 

In the dialog box, change the 
measurem~nt units to picas & points. 
Set Above spacing to 1,00 picas & 

Figure 5,' The 
page after 

selecting the 
block of boxes 

and de-selecting 
the title. 
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points. Select Add in Above: Al
ways. Select OK. 

At this point the form is complete 
and ready to print. However, you may 
want to make some adjustments, such as 
repositioning the group of boxes. To do 
that you need to select all the boxes to
gether so that you can move them as a 
single unit; at the same time, the word 
INVOICE should not be moved. 

The technique for moving the group 
of boxes is to use the Select All option of 
the Graphics menu and then de-select the 
box containing the word INVOICE. Ex
ecute the following: 

• From the Graphics menu, select 
Select All. Alternatively, you can 
type 
Ctrl-Q. 

• Now hold down the Shift key while 
clicking on the word INVOICE. 
That will de-select the box contain-
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ing the word Invoice. The page will 
now look like Figure 5. 

• Place the cursor on top of the group 
of boxes. Hold down the mouse but
ton while dragging it to a new loca
tion. 

Now you can print the form. First 
make sure you save it. 

• From the File menu, select Save. Al
ternatively, type 
Ctrl-S. 

• From the File menu, select To Print. 

• In the Print Information dialog box, 
check the configuration to see that 
the correct printer is selected. If not, 
select Cancel and select Set Printer 
Info from the Options menu. In the 
Set Printer Info dialog box, select 
the correct printer name and then 
select Load Different Width Table. 
Select the desired width table from 
the Item Selector dialog box. 

• Check that your printer is turned on. 

• Select OK or press Enter to print the 
page. 
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How Ventura Works 
"Everything should be made as 

simple as possible, but no simpler." 

SO SAID ALBERT Einstein in reference to 
physics, but the observation applies 
equally well to software. While learning 
Ventura does take effort, there's no get
ting around the fact that preparing docu
ments is an inherently complex task. 

Mastering Ventura requires hands-on 
practice creating documents such as the 
ones in the Tutorial exercises. However, 
it may also help to review some of the 
concepts that the program is based on. 

What Can Ventura Do? 

Before we get into exploring the work
ings of Ventura, let's take a brief in
ventory of what the program actually lets 
you accomplish. 

• It lets you merge text and graphics 
files created by other programs into 
a single document. Graphics can be 
scaled and stretched. Text blocks au
tomatically reformat to flow around 
inserted graphics. 

• It gives you full typographic controls 
over the appearance of text, includ
ing kerning, tracking, space band 
control, letter spacing, and leading. 
It also provides a variety of auto
matic ruling lines and boxes. Hy
phenation is by algorithm, backed up 
by an exceptions dictionary. 

• It provides batch pagination features 
such as automatic page, figure, and 
section numbering, index and table 
of contents generation, and chaining 
of multiple chapters at print time. 

• It provides a simple text editor that 
allows insertion and deletion as well 
as block moves. Any changes you 
make in text are reflected back in the 
original files. 

• It provides an internal graphics pro
gram that allows you to generate di
agonal lines and arrows, empty or 
shaded rectangles, and empty or 
shaded ellipses. 

• Results of formatting, including ac
tual typefaces and line breaks, are 
shown on the screen. Most monitors 
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Mode Icons; 
a/so called func
tion boxes. 
From left to right 
they are Fram
ing, Tagging, 
Text Editing, 
and Graphic 
Drawing. 

Current Selec
tion Box. In 
Frame mode 
it tells what 
file you are 
using. In Tag
gingmode 
what tag; in 
Text mode it 
tells if the cur
sor is on a 
text attribute; 
in Graphics 
mode it tells 
what kind of 
graphic is 
selected. 

Path and name of 
the current chapter 
(selected from the 
File menu). 

Current Page 
Box. 

Figure 1 a: The parts of the Ventura screen. 

Full Box. It makes the screen full 
size again after you shrink it with 
the resize box; not used unless you 
aCCidentally shrink the screen. 

Style Sheet currently loaded 
(selected from the File menu). 

+ 

Scrolling Bar. 
Use it when 
you want to 
jump down the 
page. 

Scrolling 
Arrow. Use it 
when you 
want to move 
down one line 
at a time. 



Addition Button. In Frame mode it 
must be selected before you draw a 
new frame. In Tagging mode it must 
be selected to create a new tag. In 
Text mode it reads Set Font and 
must be selected to change the at
tributes of a single letter, word, or 
phrase. In Graphics mode it is re
placed by the drawing tools. 

Assignment 
List. In Frame 
mode it lists text 
and graphics 
files contained 
in a document. 
In Tagging 
mode it lists 
tags. In Text 
mode it lists for
matting styles 
such as bold 
and italics. In 
Graphics mode 
it is replaced by 
the drawing 
tools. 
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Ruler. It can be turned off by select
ing Hide Ruler from the Options 
menu. The measurement units can 
be changed using the Set Prefer
ences option of the Options menu. 

Menu Line. 

-...................• 

of 

...................... \ ................... . 

Frame Handles (they 
indicate which frame 
is currently active). 

Column Guides. 
They can be 
turned off by 
selecting Hide 
Column guides 
from the Options 
menu. 

Resize Button (a relic of 
GEM: not normally 
used). 

Figure lb: The parts of the Ventura screen. 
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that work with the IBM PC are sup
ported by the program, including 
large-screen, high-r~solution dis
plays. 

• Output options include dot matrix 
and color inkjet printers, most popu
lar laser printers, and InterPress or 
PostScript compatible typesetters. 

Some History 

So far so good. We've noted what Ven
tura can do. But we still haven't estab
lished just what Ventura is. According to 
which magazine article you read, it has 
been variously described as a "super 
word processor," a "WYSIWYG batch
pagination program," and as a "page 
makeup" or "page layout" program. All 
these terms are more or less accurate, but 
they also apply to any number of other 
programs on the market. So why is Ven
tura, among all these other products, a 
runaway bestseller? 

To really understand the significance 
of Ventura, we need to look at the history 
of computer-based publishing. From the 
first use of computers for creating docu
ments, a gap existed between two types 
of systems. One type was systems that 
provided a what-you-see-is-what-you-get 
(WYSIWYG) view of the final page and 
allowed you to "paste up" text and 
graphics on-screen. This approach, which 
might best be described by the term 
"page makeup" (since the user created a 
document one page at a time) had its 
roots in the computer-aided design 
(CAD) and computer graphics tech
nology that moved from experimental to 

commercial during the 1960's. It came 
into use in the publishing industry in the 
1970's, when it was adapted for onscreen 
layouts of display advertisements. 

Meanwhile, other systems were 
being developed that used a non-WY
sIWYG' code-based approach. With 
these programs, documents were created 
in two stages. First, the user embedded 
typographic and pagination codes. (and 
macros representing sets of codes) III the 
text of a document. Then the program 
processed the codes all at once, automati
call y generating pages with the proper 
headers, footers, page numbers, and so 
forth. The advantage of this approach 
was that the user didn't have to create 
pages one at a time; the disadvantage was 
that these systems didn't provide the in
teractive visual feedback provided by 
page makeup programs. Only when the 
document was printed could the final re
sult be proofed. 

Before Ventura, many experts as
sumed that the page makeup and the 
batch approaches were irreconcilable. 
And indeed, as publishing systems were 
introduced for personal computers, they 
typically fell into one or the other camp. 
Some of the early Macintosh hits, such as 
PageMaker and ReadySetGo!, we~e 
strongly rooted in the page makeup tradI
tion. Other Macintosh programs, such as 
JustText, and programs for the PC such 
as ScenicWriter, TeX, and MagnaType, 
followed the batch approach. 

What sets Ventura apart is that it 
merges some aspects of both approaches. 
Just as in the typical page makeup sys
tem, you can work interactively with 



each individual page, watching the results 
of your formatting decisions on the 
screen. On the other hand, the program 
provides the speed of a batch program by 
automatically setting up as many pages as 
are required to compose your documents. 
In a real sense, with Ventura you get the 
best of both worlds. 

A Scenario 

Let's bring the discussion down to earth 
by describing a typical scenario. Ken is a 
freelance technical writer who writes and 
produces manuals under contract to 
several small robotics companies. The 
manuals combine text, scanned images, 
and simple diagrams. 

To create his text, Ken types it into 
WordS tar. To create his scanned images 
he uses PC Paintbrush Plus, which auto
matically drives his scanner and converts 
the photographs into PC Paintbrush 
(PCX) files. 

Once he has created the text and 
graphics files for a chapter of the manual, 
Ken loads Ventura and then loads a style 
sheet, using the operations in the file 
menu. While the screen is still blank, he 
uses the operations in the Page menu to 
select the type of paper he intends to print 
on. He then uses the Options menu to 
turn the column guides on. Next, he 
selects the Frame icon and uses the 
operations in the Frame menu to adjust 
the margins of the base page. By viewing 
the column guides, he checks that the 
margins are satisfactory. 

Next he loads text from his WordStar 
files onto the page. He then selects, the 
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Tagging icon and begins assigning a tag 
to each paragraph (paragraphs being 
blocks of text separated by carriage re
turns). If a tag is not to his liking, he uses 
the options in the Paragraph menu to ad
just such elements as font, first line in
dent, left and right spacing, spacing be
tween lines and paragraphs, ruling lines, 
and special features such as bullets. If no 
tag is available for a given purpose, he 
uses the Add New Tag option to create 
one. 

The work of tagging goes fairly fast. 
Most text doesn't need to be tagged at all, 
since Ventura automatically assigns the 
Body Text tag to any un tagged text. 

Once the text is completely tagged, 
Ken selects the Text icon and uses Ven
tura's built-in word processor to make 
minor insertions and deletions to accom
modate last minute ,changes in his text. 

Next, he selects the Frame icon 
again, clicks on Add New Frame, and 
draws several frames to accommodate 
pictures. He then uses the File menu to 
load scanned images into these frames. 
Next, he uses the Margins and Columns 
option of the Frame menu to place mar
gins between the pictures and the frames, 
and uses the Sizing & Scaling option of 
the Frame menu to adjust the scaling and 
cropping of the pictures. Then he uses the 
Anchors & Captions option of the Frame 
menu to add captions to the pictures. 

Selecting the Graphics icon, Ken 
now uses the Line Drawing and Box Text 
tools to label his pictures. Then he selects 
the Text tool to type the actual contents 
of the box text labels and the tagging icon 
to alter the formatting of the labels. 
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Having formatted the text and 
graphics on each page of the manual, he 
now uses the Page menu again to add 
Headers and Footers to his pages. Finally, 
he uses the File menu to give his docu
ment a chapter name and save it, and 
then to print it out. 

Modes: Five Programs in One 

As the above scenario illustrates, the 
process of creating a document with Ven
tura involves continually moving in and 
out of the four modes provided by the 
program and using the commands that 
are available in each. Once you have be
come experienced with Ventura, you'll 
find yourself choosing the right mode 
and looking into the right menu more or 
less automatically, and you'll find that 
the various modes work together quite 
seamlessly. However, in first attempting 
to grasp the way the program works, it's 
useful to recognize that the four modes 
actually represent four different programs 
merged into one. 

The first two programs are a page 
layout program and a pagination program 
(some functions of each assigned to the 
Frame and Tagging modes). The third 
program is a simple word processor (Text 
mode), and the fourth is a simple drawing 
program (Graphics mode). When you're 
in a given mode, some of the items in the 
pull-down menus are shown in black and 
can be selected, while others are shown 
in gray and cannot be selected. This is 
Ventura's way of allowing the four pro
grams to share the same set of menus. 

In addition to the four modes as
sociated with the four icons, there is actu
ally a fifth mode, consisting of global 
controls that can be accessed no matter 
which mode you happen to be in. These 
include commands for loading text or 
graphics into Ventura, printing docu
ments, and customizing the program's 
user interface. 

Analyzing the Operations 

Clearly, it's important to know the pur
poses served by each of Ventura's five 
modes. But to grasp the program we need 
to take a slightly different tack. Let's now 
look at Ventura's operations not in terms 
of what mode they are assigned to but in 
terms of what they let you accomplish. If 
you analyze Ventura's structure from that 
perspective, you'll see that the operations 
available to you fall into four categories: 

• Operations for importing and ex
porting various items such as text, 
graphics, and style sheets, 

• Operations for customizing the Ven
tura interface, 

• Text and graphics processing opera
tions, and 

• Formatting operations. 

Category 1: Bridges to the 
Outside World 

Before you can format a document you 
have to pull text and graphics into Ven
tura, and after you format the document 
you have to either print it or store it on 
disk. In addition, with any program there 



are various housekeeping chores that 
need to be attended to, such as saving 
style sheets and documents to use later 
on. 

This is where Ventura's "bridging" 
operations come into play. Most of these 
reside in the File menu, including com
mands for loading text or pictures into 
Ventura, saving documents that have 
been formatted, printing, and using DOS 
to create new subdirectories to hold docu
ments. Another menu is the Edit menu, 
which provides operations for removing 
text or pictures from a document. Finally, 
the Options menu includes a selection, 
Add/Remove Fonts, for increasing or re
ducing the number of fonts available for 
use in documents. 

Most of the bridging work occurs at 
the beginning and end of creating a docu
ment: at the beginning to load the appro
priate files and style sheets; at the end to 
print the document and save the com
pleted (or partially completed) chapter. 

Category 2: Customizing the 
Interface 

No user interface is perfect for every type 
of user and every type of document. For 
that reason, Ventura provides an exten
sive range of operations for customizing 
the appearance of Ventura's main screen 
as well as for controlling the type of feed
back provided about the status of a docu
ment. Such commands are mainly located 
in the Options menu. They include op
tions for hiding elements such as rulers, 
column guides, and pictures; flagging 
loose lines; turning column and line snap 
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on and off; adjusting the double-click 
speed of the mouse; and performing on
screen kerning. 

Another location of such operations 
is the View menu, which lets you specify 
the degree of magnification of the screen. 
Finally, the scroll bars on the right side 
and bottom of the screen let you control 
the portion of the page you are currently 
viewing. 

Category 3: Text and Graphics 
Operations 

Ventura's internal word processor and 
graphics generator are useful for making 
last-minute changes and for enhancing 
pictures generated by scanners, CAD pro
grams, drawing programs, and business 
graphics programs. 

The word processor is activated 
when you select the Text icon. Its com
mands are located in the Edit menu and 
in the sidebar. 

The graphics generator is activated 
when you select the Graphics icon. Its 
tools are selected from the sidebar, and 
additional operations are located in the 
Graphics menu. 

Category 4: Formatting 

While the operations we've discussed so 
far are certainly important, formatting 
lies at the center of what Ventura is all 
about. It is also the most complex of the 
capabilities provided by the program, 
with commands scattered in various 
menus. In the remainder of this chapter 
we'll go through the various tools pro-
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Most of the functions in the Edit menu are 
only available when you are in Text 
mode. The exception is a pair of com
mands for removing text and pictures 
from a page or renaming text files. 

Like the Page menu, the Paragraph menu 
is somewhat deceptively named. Its func
tions are only available in Tagging mode 
when a particular paragraph has been 
selected. This menu is used to control the 
typographic settings stored in each tag. 

The Desk menu 
is not used for 
any purpose ex
cept to list the 
names of the Ven
tura development 
team and to hide 
an obscure status 
report (described 
in Chapter 20). 

\ 

The options in the 
Page menu can be 
applied no matter 
what mode you are 
currently in. Contrary 
to its name, the Page 
menu mainly pro
vides functions that 
apply to the docu
ment as a whole. 

The Graphic menu's operations 
are available when the Graphics 
icon is selected. They control the 
appearance of graphics you have 
drawn with tools from Ventura's 
graphics palette. To change the 
line and fill attributes of a graphic 
elements such as a line or a box, 
you must first draw and then 
select that element. 

1 
Desk File Edit Viet~ Page Frar~e Paragraph Graphic Options 

/ 
The File menu is 
used for bringing text 
and pictures into Ven
tura documents, for 
loading or saving 
documents that you 
have already begun 
working on (called 
Chapters), and for 
loading and saving 
style sheets. 

No matter what mode you 
are in, the View menu can 
be used to zoom in or out. It 
also provides an alternative 
way to switch among Ven
tura's four modes. 

I 
The functions in the Frame menu are onlyavaila-
ble when the Frame icon is selected. They are 
applied to the currently active frame: either to the 
base page (which itself is a frame) or one of the 
additional frames you have drawn on the page. 
Among the settings controlled through this menu 
are the number of columns of text in a frame, the 
scaling and cropping of graphics imported into 
frames, the amount of padding surrounding a 
frame, the background shade of the frame, and 
the placement of vertical rules in a frame. 

The Options menu is used to control various settings for 
the user interface, such as whether a ruler is shown on 
screen. It also includes the Multi-Chapter options, which 
are used to backup chapters to disk, to print multiple chap
ters, and to generate a table of contents or an index. 

Figure 2: Notes on the Menu Line. 
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vided by Ventura for formatting various 
levels of the document. 

Style Sheets and Tags: 
Formatting At the Paragraph 
Level 

A style sheet might be thought of as a 
cookbook, a compilation of recipes 
(called "tags") for how individual para
graphs are to be formatted. For example, 
a tag called Subhead might specify that a 
given paragraph is to be centered in the 
column and set in I8-point Palatino Bold 
type, with 3 picas (half an inch) of lead
ing (vertical space) separating it from the 
previous paragraph and I pica separating 
it from the following paragraph. Every 
time you attach this tag to a paragraph of 
plain text, it will assume all the attributes 
stored in the tag. 

Much of the work of formatting a 
document in Ventura involves setting up 
the specifications for the various tags and 
then attaching these tags as needed 
throughout the document. 

Sounds simple enough. Unfor
tunately, the style sheet alone doesn't 
provide quite enough information to 
completely set up a document. What do 
you do when a single letter or word 
within a paragraph is formatted differ
ently than the rest of the paragraph? And 
what about formatting directions that 
transcend the individual paragraph, such 
as the margins for the entire page or the 
numbering scheme for the entire docu
ment? 

To take care of the issues of docu
ment formatting that extend above and 
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below the level of the individual para
graph, Ventura provides a number of 
tools. None of these tools works quite as 
simply as the style sheet concept, and the 
way the tools are organized within menus 
is at times confusing. Although it's not 
possible within this chapter to explain 
completely the relationship between these 
various tools, the following is a 
simplified synopsis of four levels of for
matting control that Ventura provides, for 
the document as a whole, for frames on 
pages, for words and phrases within para
graphs, and for graphics. 

Document Specifications 

Operations that affect the entire docu
ment are mainly located in the (somewhat 
inappropriately named) Page menu. 
These include the type of paper being 
used and whether the document is to be 
in portrait (upright) or landscape (side
ways) orientation; the numbering of 
chapters, pages, and subheads; and the 
contents of headers and footers. 

Generally, when you layout a docu
ment, the first menu to pull down is the 
Page menu. 

Frame Specifications 

Frames are one of the most confusing 
concepts in Ventura, since they serve so 
many different purposes. When you start 
any document from scratch, Ventura au
tomatically creates a frame that coincides 
with the dimensions of the paper and 
hence is called the "base page" frame. 
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Specifications that are set for the 
base page frame, such as margins and 
background shading, apply to the entire 
document. On the other hand, you can 
create smaller frames on individual pages 
to hold text or pictures. These frames 
must each be given individual settings for 
such things as margins and columns, and 
unlike the settings for the base page 
frames, the specifications you enter for a 
smaller frame on the page apply to that 
frame only. 

While the difference between the 
base page frame and additional frames 
tends to cause confusion, so does the fact 
that the scaling of graphics is handled in 
the same dialog box (the Sizing & Scal
ing option of the Frame menu) as the size 
specifications for frames themselves. 

Sub-Paragraph Specifications 

For altering the specifications of a letter, 
word, or phrase within a tagged para
graph, Ventura provides a special option 
called Set Font. This is not accessed 
through one of the menus at the top of 
the screen, but instead by clicking on the 
Set Font button that appears on the left 
side of the screen when the Text icon is 
selected. To make matters even more 
confusing, clicking on the Set Font but
ton produces no response unless you 
have already highlighted the passage of 
text you wish to alter by dragging the 
mouse across it with the mouse button 
held down. 

Graphic Specifications 

Ventura allows you both to import 
graphics and to generate graphics within 
the program. Generating internal 
graphics is done using the tools that ap
pear on the left side of the screen when 
the Graphics icon is selected. Once 
graphics are drawn, the options in the 
Graphics menu can be used to alter them: 
for instance, to change the thickness of a 
line or the background shade of an el
lipse. 

It is somewhat confusing that there 
is no menu specifically devoted to sizing 
and positioning graphics imported into 
Ventura from other programs. Some of 
the commands for doing that are accessed 
via the Sizing & Scaling option of the 
Frame menu (scaling and cropping the 
picture), others via the Margins and 
Columns option of the Frame menu (mar
gins around the picture). 

A Final Concept: Ventura As a 
Software Hub 

One of the insights designed into Ventura 
is the recognition that publishing is a 
modular effort; that is, it comprises dis
tinct series of stages such as writing, 
editing, proofing, layout, and preparation 
of graphics. In our scenario above, Ken 
was doing all the work himself. Typi
cally, however, publishing is a group ef
fort, in which various specialists merge 
their respective crafts towards a common 
end. 

Translated into the computer world, 
publishing's modular and sequential na-



ture means different people using differ
ent software tools. Ventura's design al
lows it to be a useful adjunct to almost 
any of the most popular tools in use. 

Most people are already comfortable 
with a word processing program and 
don't care to change. Ditto with respect 
to graphics programs. For instance, the 
preparation of the typical manual may in
volve one writer using WordPerfect, 
another using XyWrite, and an illustrator 
using AutoCAD, Publisher's Paintbrush, 
and perhaps other graphics programs as 
well. Not only does Ventura allow im.:. 
porting a diverse array of file formats, but 
it does so smoothly and easily. 

If Ventura only allowed files to be 
imported, you'd be faced with a difficult 
situation when it came time to update and 
revise a major document. Fortunately, the 
exchange is potentially bi-directional. If a 
document needs to be reworked, you can 
use Ventura's editing tools to make 
changes and those alterations will be re
flected back in the original files. 

The method chosen by Ventura's de
signers to implement the open systems 
concept is worth noting. For each docu
ment you generate with the program, 
Ventura creates a unique file with the ex
tension ClIP. This chapter file contains 
pointers to all the other files that together 
make up a document, including as
sociated files generated by Ventura and 
the original word processing and graphics 
files. Because of this scheme, Ventura 
does not need to generate an immense 
file containing the entire document, 
which helps the speed of the program 
while minimizing the demands it places 
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on your system's storage. Other files that 
Ventura uses are the INF file, which 
stores various settings in between your 
sessions with the program, and GEN files 
that Ventura creates to contain files it au
tomatically generates such as tables of 
contents and indexes. These files are dis
cussed in greater detail in Chapter 6, 
"Managing Files." 

The open system approach used by 
Ventura has two additional benefits. As 
noted, it allows easy revision of docu
ments, such as manuals and parts cata
logs, that move through multiple genera
tions. With Ventura, a document can be 
dynamic: revised and rewritten with each 
printing. The second benefit of the open 
system approach is that it allows those 
using Ventura to stay with the various 
personal computer programs they are al
ready comfortable with-not only a con
venience but a valuable savings for or
ganizations, which can avoid the expense 
of retraining. 

The drawback of the open system 
approach is that it leads to a proliferation 
of files for every document. While Ven
tura provides some techniques for 
managing these files and moving them 
about, the work of avoiding confusion on 
your hard disk requires a great deal of at
tention to detail and time-consuming file 
management. 

Putting It All Together 

Hopefully, this chapter has persuaded 
you that despite the seeming complexity 
of Ventura's structure, there's method in 
the madness. Although in future revisions 
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of th~ program the organization may be 
tightened up a bit, it's reasonable to as
sume (harkening back to Einstein's ob
servation), that a tool with as much flexi
bility and power as Ventura has will in
evitably be somewhat complex. On the 
positive side, you'll find that once you 
get used to the quirks of how operations 
are organized in menus, formatting docu
ments with Ventura is a speedy, natural 
process. In the end, you'll appreciate 
Ventura's power when you see the results 
on paper. In other words: the proof is in 
the printing. 



CHAPTER FIVE 

Hardware 
USING VENTURA AS the software hub, 
you can build a wide variety of publish
ing systems, depending on your budget 
and your needs. One of the beauties of 
the program is that it can run on a rela
tively cheap hardware system. According 
to Xerox, the minimum configuration is a 
PCIXT with 512K of memory, a mouse 
(of virtually any variety), a graphics 
monitor (of virtually any variety), and 
one to three Mb of extra hard disk 
memory. By today's standards that's a 
fairly modest, inexpensive system, one 
that can be had for around a thousand 
dollars, which makes Ventura one of the 
real bargains among the current crop of 
desktop publishing programs. 

When I first read those requirements, 
my reaction was one of skepticism. Like 
many other observers of the desktop pub
lishing scene, I was convinced that for 
Ventura to provide the sort of Wy
s�WYG interface and the speed of, say, a 
Macintosh program like PageMaker, 
you'd need to be running it on a com
puter with a bit more oomph than a 512K 
PC. I was also convinced that for Ventura 
to claim that the program could be run on 

a plain Color Graphics Adapter (200 by 
350 pixels) must be some kind of cruel 
joke. 

So, although I did have a more 
powerful computer available, I first tested 
the program on the minumum configura
tion: a 1983-vintage 576K IBM PC with 
a color graphics monitor and a modest 10 
Mb hard disk. To my surprise, Ventura's 
performance on the system, though a tad 
slow, was perfectly adequate. The only 
truly aggravating sluggishness came in 
loading the program to start with and 
moving graphics around the screen. 

Working with text was no problem. 
Also, the Color Graphics Adapter proved 
not to be the hindrance I'd expected. 
Despite its meager resolution, I found it 
easy to do fairly exacting work (by 
zooming in closer when necessary). The 
only real drawback with the CGA was 
not being able to read most text in Nor
mal view. 

Of course you can get better per
formance from systems with more 
memory, faster microprocessors, higher
resolution monitors, larger hard disks, 
and special RAM disk and disk caching 
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XTor AT? 

I've never much liked the phrase "works with." When they say that Ven

tura works with IBM XT computers as well as more powerful AT's, what 

exactly do they mean? As I'm sure you're aware, simply being able to 
run a program on a machine is not enough; it must run fast enough to 

make work go forward without too much finger tapping. 
I've used Ventura on a number of machines: an IBM PC with 576K 

of memory, a Compaq DeskPro, an Everex AT clone (10MHz, 1 wait 
state), a Hewlett-Packard Vectra AT compatible, and an AST Premium 
286 AT compatible (10 MHz, no wait states). The table on the following 
page shows the results of speed tests on several of these. Those 
figures, however, don't convey anything about the feel of the program, 
the subjective difference in performance from one machine environment 
to another. 

I found even the plain IBM PC to give fine performance, provided 
the document I was working on didn't include any graphics. Because that 
computer lacked much memory, it would resort to disk swapping to 
handle pictures, and the result was a tremendous wait. On the Compaq 
DeskPro, which uses the 8088 chip, Ventura zipped along quite nicely, 
and in fact the performance seemed just as good as on the HP Vectra, 
which uses the 80286 chip. Of course, on the 10 MHz machines the per
formance was yet another notch higher, but the striking similarity be
tween using Ventura on the DeskPro and the Vectra proved to my satis

faction that it isn't the microprocessor that counts so much as the speed 
of your hard disk. At the time I did the comparison my Vectra hard disk 
had become badly fragmented over time and had definitely become 
somewhat sluggish. 

The moral: Go ahead and use Ventura on an XT-class machine, and 
if considering the options for upgrading such a machine for better per
formance, invest in a faster hard disk. 
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Speed Tests 

(A) (8) (e) (D) (E) 

1. Load Ventura 39 24 19 9 4 
2. Load 3-p chapter 19 13 10 5 3 
3. Load bit-mapped image 10 8 5 3 2 
4. Load object graphic 11 6 5 3 2 
5. Move bit-mapped image 3 2 2 2 1 
6. Load 115K document N/A 18 18 13 12 
7. Jump to end of 25-p doc n/A 7 5 4 4 

Notes: All times are in seconds. The computers were (A) an IBM PC with a 
10Mb hard disk; (B) a 640K Compaq Deskpro with a 20 Mb hard disk; (C) a 
640K Hewlett-Packard Vectra with a 20 Mb hard disk; (O) a 640K Everex AT 
clone with a 40 Mb hard disk; and (E) the same Everex AT using the Flash 
disk caching program. 

Table 1: Comparative speeds of Ventura on various computer systems. 

utilities. By the time I was laying out this 
book, I had graduated to a fast AT with a 
VIking I 19-inch monitor-and I de
finitely appreciated the increased speed 
and the convenience of working on the 
full-page monitor. 

My own experience is that Ventura is 
flexible enough to adapt to your hardware 
resources. Assuming your budget has 
some limits, the question is: what sort of 
hardware investments will yield the most 
bang for the buck? In this chapter we'll 
start by looking at some hypothetical 
configurations. Then we'll look at each 
particular type of hardware in detail: 
scanners, laser printers, monitors, and 
personal computers. 

Five Configurations 

As the following brief case studies show, 
prices for a publishing system built 
around Ventura can range from $1,50.0 
for minimal system to $82,000 for a full
blown multi-workstation system, includ
ing Linotronic imagesetter. 

A Low-End System 

System A is used by a graduate student 
who plans to typeset her 240-page thesis 
with Ventura, as well as to create the 
questionnaires and other materials. Since 
her budget is quite limited, she makes use 
of the laser printers at the local desktop 
publishing service bureau, which pro-
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vides laser printers and computers on an 
hourly rental basis. Her computer is an 
IBM PC XT clone with a 20-Mb hard 
disk and a Hercules clone graphics card. 
She uses Ventura's optional keyboard 
controls but plans to add a mouse as soon 
as she can afford one. For output she uses 
an Epson dot matrix printer. Although 
the quality of Ventura's output on the 
Epson isn't good enough for master co
pies, it is sufficient for creating proofing 
copies. For final copies, the student rents 
time on an Apple LaserWriter, or 
possibly on a Linotronic 100, to produce 
the final version of her thesis. The price 
breakdown of her system is as follows: 

System A 
20 Mb XT clone 
dot matrix printer 
Total 

$1,200 
300 

$1,500 

An Inexpensive Laser Printer 
System 

System B is used by a business consult
ant who frequently designs forms for 
clients and prints reports containing busi
ness graphics and tables. He does not 
have the funds for options such as a full
page monitor or a high-end laser printer. 
His system is the least expensive laser 
printer system: 

System 8 
20 Mb XT clone 
LaserJet Series \I 
Total 

$1,200 
2,000 

$3,200 

A Medium-Priced System 
(Speed Oriented) 

System C is used by a freelance technical 
writer who prepares manuals for small 
software companies. Her priority is 
speed, not output quality, so she has 
chosen to spend most of her budget on a 
fast computer and a high-resolution 
monitor, and saved money by buying an 
inexpensive laser printer. She uses an 
IBM AT clone computer with a 40-Mb 
hard disk and a mouse, and a Wyse 
monitor. Because she can get by with the 
standard Swiss, Dutch, Courier, and 
Symbol typefaces provided with Ventura, 
she opted not to buy a PostScript printer, 
and instead bought a used QMS KISS 
printer and retrofitted it with a Laser
Master printer controller. This controller 
resides on a board installed in the com
puter and connected with an ultra-high
speed cable directly to the video interface 
of the printer, a scheme that allowss ex
tremely fast printing. The cost of her sys
tem: 

System C 
40 Mb AT clone 
Wyse monitor 
OMS KISS (used) 
LaserMaster controller 
Total 

$3,000 
700 

1,200 
1,500 

$6,400 

A Medium-Priced System 
(Type-Oriented) 

System D is used by the proprietor of a 
walk-in desktop publishing shop that pro
duces a wide range of materials: books, 
business reports, resumes, newsletters, 



forms, and manuals. Customers are 
generally businesses that provide him 
with files in WordS tar, WordPerfect, 
MultiMate, or Microsoft Word format. 
The shop does not have a scanner. When 
images need to be merged into docu
ments he advises clients to have halftones 
made at a graphic arts shop and then to 
paste them onto boxes that he creates 
with Ventura. Because of the variety of 
typefaces needed by customers, Kent 
uses a QMS PS-800+ PostScript laser 
printer, which includes about a dozen 
built-in scalable typefaces. Because his 
budget is limited, he uses a Hercules 
clone board with an AT clone computer, 
but plans to purchase a higher-resolution 
monitor as his next investment. His sys
tem: 

System 0 
40 Mb AT clone 
OMS PS-800+ 
Total 

A Higb -Priced System 

$3,000 
5,500 

$9,000 

System E was assembled by the manager 
of a department that produces all the 
manuals for a small but well-heeled en
gineering company. The company de
cided to pull out all the stops in setting up 
a desktop publishing system-well, al
most all the stops: they balked at her re
quest for a Linotronic imagesetter. The 
system includes a 386 computer with 80 
Mb of storage, an Apple LaserWriter 
Plus, a JLaser Plus board, a Viking I full
page display, and a Microtek sc'anner. 
The price of the system is as follows: 
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System E 
386 Computer 
Apple LaserWriter Plus 
JLaser Plus board 
Microtek scanner 
Viking I display 
Total 

Full-Blown Publishing 

$6,500 
5,500 
1,100 
2,500 
2,400 

$18,000 

System F is used by a task force that is 
developing prototype systems, proce
dures, and training materials for a For
tune 1000 company. The company in
tends eventually to invest in Ventura
based systems for its offices in numerous 
different locations in the United States 
and overseas. The system includes six 
AT clone workstations; three attached to 
PostScript printers, the other three to 
LaserJet series II printers. The group 
shares a single, scanner and a Linotronic 
imagesetter. The entire system is as fol
lows: 

System F 
Six 40-Mb AT clones 
Three Apple LaserWriter 
Plus printers 
Three LaserJet 
Series II printers 
Six Wyse displays 
One Microtek scanner 
One Linotronic 100 
imagesetter 
Total 
Price per workstation 

$18,000 

16,500 

6,000 
4,200 
2,500 

35,000 
$82,200 
$13,700 
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PSJet 

PS Jet is a conversion kit that provides non-PostScript printers with Post
Script capability. You can install PS Jet in any printer that has an internal 
controller and uses the Canon LBP-CX engine (HP LaserJet and LaserJet 
Plus, OMS Kiss and Big Kiss, OMS SmartWriter, Canon LBP-8 A-1 and A-2, 
and others). A version is also available for retrofitting printers with the Ricoh 
4080 engine. Included in the installation kit is a new interface with a 9-pin Ap
pleTalk port for Macintosh computers and a 25-pin serial port for IBM PC's. 
When you're done, you'll have a printer that is virtually identical to the Apple 
LaserWriter--same Canon engine, same PostScript brain. It contains the 
identical selection of built-in typeface families: Times Roman, Helvetica, 
Courier, and a symbol typeface. One improvement over the LaserWriter is in 
memory. The LaserWriter has 1.5 Mb of RAM, PS Jet sports 2 Mb. The addi
tional memory allows you to download more fonts into the printer and assists 
PostScript in storing graphics and PostScript prep files. 

The installation procedure involves unscrewing the top portion of the 
laser printer, disconnecting its cables, and installing a new top manufactured 
by the Laser Connection. On an HP LaserJet the removal portion of the task 
involves unscrewing 12 easily accessible exteral screws and one slightly diffi
cult internal screw, pulling out a plastic shield that is somewhat tough to 
budge, and disconnecting three cables. Installing the new top is the same 
process in reverse. While a practiced hand could probably make the switch in 
about 20 minutes, you should budget more time than that to the task and ap
proach it with caution. 

I performed the transplant operation twice, first on a OMS Big Kiss, then 
on an HP LaserJet Plus containing a connection to a Tall Tree JLaserPlus 
board. On the Kiss, the procedure took me a full hour and a half. The next 
time around, on the LaserJet, things went a bit faster: I had the new top in
stalled and printing in just under an hour. 

For the most part, the steps of the procedure are clearly described and il
lustrated by PS Jet's excellent manual. None is difficult, except the removal of 
a small screw within the printer, for which purpose the Laser Connection 
thoughtfully provides a magnetized screw driver with the PS Jet package. 
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I recommend that you not rely on the magnetic screw driver to hold the 
small screw. Just to be on the safe side, wrap a loop of tape around the end 
of the screw driver once you've loosened the screw a few turns. That way the 
screw will stay attached to the screwdriver until you've drawn it completely 
out, and you're less likely to get involved with a game of cat and mouse be
tween your needle-nosed pliers and a small screw rattling around inside your 
printer. 

Once you've installed the PS Jet, you'll be ready to print. The Laser Con
nection provides a disk with a menu-driven program that configures the PC 
and provides some demo PostScript files. Feeling in the mood to take a 
chance, I ignored the setup disk and found that I was able to immediately 
begin printing from Ventura anyway. I also was delighted to discover that my 
JLaser board worked just as well as always. 

An alternative to PS Jet is PS Jet Plus, which provides seven additional 
typeface families (ITC Avant Garde Gothic, ITC Bookman, Helvetica Narrow, 
New Century Schoolbook, Palatino, ITC Zapf Chancery, and ITC Zapf Ding
bats) and Hewlett Packard Graphics Language emulation. 

Of course, for all the attractions of having PostScript and HPGL emula
tion in your printer, there's still one fly in the ointment. What about all the 
LaserJet software you've got in your library? Will you have to give that up? 
With the version of PS Jet that I installed, the answer is yes. But with the PS 
Jet Plus, you can have your PostScript and in effect keep your LaserJet too 
too. Among the features of the new model is complete emulation of the Laser
Jet Plus (sans compatibility with HP's font cartridges). 

Conclusion 

Some interesting conclusions can be 
drawn from these scenarios. The first is 
that publishing systems based around 
Ventura start at around $4,000 (assuming 
the system includes a laser printer), but 
that a bare-bones configuration can cost 
as little as $1,500, provided you are 
willing to put up with the inconvenience 

of proofing on a dot matrix printer. On 
the other hand, if you decide to set up a 
no-holds-barred workstation with all the 
fixin's and buy the latest IBM-brand 
computers, your bill can run upwards of 
$18,000. With careful selection of com
puters, however, and sharing of typeset
ting equipment by a workgroup, you can 
have an even better system (since it in
cludes a typesetter) for under $13,000 per 
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workstation. Note that such a system is 
vastly superior to the the traditional mul
titerminal typesetting systems of yore, 
since each "terminal" is actually a power
ful personal computer rather than a dumb 
terminal serving the typesetting machine. 

Laser Printers 

In the Fall of 1983, an announcement 
was made at the immense Comdex Com
puter Show in Las Vegas that drew little 
notice at the time, but that in retrospect 
marked the firing shot of the technologi
cal revolution we now call desktop pub
lishing. That announcement was by 
Canon Corporation, a Japanese manufac
turer better known for its cameras than 
for its computer equipment. At Comdex, 
Canon offered to provide other compa
nies with laser printer engines for a price, 
when purchased in quantity, of under 
$1000. 

Printer Engines 

Unlike a car engine, a laser printer engine 
includes all the mechanical parts of the 
printer and usually the chassis as well-
everything but the microelectronics con
trolling the machine. Previously, a price 
of under $1000 for a laser printer engine 
would have been laughable. However, 
Canon had found ways of adapting the 
design of its low-cost office copiers, and 
was planning to push laser printers into 
the realm of mass production economies. 

Among the frrst to take Canon up on 
the offer was Hewlett-Packard, which de
signed its own controller to add to the 
Canon engine, called it the HP LaserJ et, 
and started selling the fast, quiet little 
printers to businesses for $3500 each. 
Eventually, several scores of companies 
were to do likewise, customizing their 
own particular laser printer around the 
Canon engine. 

To this day, laser printer manufac
turers have continued to follow the pat
tern set by Canon and HP. A relatively 
small number of Japanese firms create 
the laser printer engines. Canon and 
Ricoh are the leaders; others include Ky
ocera, Kentek, and Epson. American and 
Japanese companies then enhance these 
engines with their own controller de
signs--companies such as Apple (Laser
Writer family), QMS (KISS, Smart
Writer, PS 800 and 800+, PS Jet and PS 
Jet+), Hewlett-Packard (LaserJet family), 
and AST (TurboLaser). 

Since the engine is the physical 
mechanism of the printer, it affects such 
factors as print quality, durability, paper 
handling, and cost of replaceables such 
as toner. Since the controller is the brain 
of the printer, it controls such factors as 
availability of fonts and graphics capa
bilities. In general, most of the important 
matters to be concerned about are the 
controller's domain, since most of the 
printer engines (with some notable ex
ceptions) are capable of competent print
ing and paper handling. 

A number of criteria set them apart, 
including print quality (crispness of 
characters, quality of gray shades, black
ness of blacks), paper handling, speed, 



availability of fonts, graphics capabilities, 
compatibility with typesetting machines, 
and quality of graphics. 

Among laser printer engines, the 
most basic difference is whether the 
printer uses write-black technology 
(Canon LBP-CX and LBP-SX, Kyocera) 
or write-white (Ricoh 4080 and Xerox 
4045) marking technology. In a write
black engine, the portions of the drum 
marked by the laser are identical to. the 
areas of black produced on the page. In a 
write-white engine, a reverse-imaging 
technique is used in which the portions of 
the drum marked by the laser are identi
cal to the areas of white produced on the 
page. Write-black engines produce round 
pixels and are better at printing fine lines 
and serifs. Write-white engines produce 
diamond-shaped pixels and have trouble 
with fine lines and serifs; to compensate, 
write-white printers need specially de
signed fonts which have more pixels on 
serifs. 

Canon LBP-CX Engine 

A year ago, the vast majority of laser 
printers were based on the Canon LBP
CX, the original engine sold to other 
manufacturers by Canon. It is used in the 
HP LaserJet, HP LaserJet Plus, HP Laser
Jet 500 Plus, Apple LaserWriter, Apple 
LaserWriter Plus, Cordata LP-300, QMS 
PS 800, QMS PS 800+, and many others. 
The LBP-CX has proved to be highly re
liable and capable of crisp, clean output. 
The engine had some annoying draw
backs, notably small input and output 
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paper trays and blacks that weren't quite 
black. 

Ricoh 4080 Engine 

These days a variety of printer engines 
are available, many designed to over
come some of the drawbacks of the LBP
CX. A competitor is the Ricoh 4080 en
gine, a heavy-duty beast used in the AST 
TurboLaser, the Texas Instruments Om
niLaser, the Quadram Quadlaser, the 
OASYS LaserPro, and others. It's bigger 
and designed for longer service than the 
Canon LBP-CX. It also has larger paper 
trays and black areas are a true black, 
rather than the mottled and streaked black 
produced by the LBP-CX. The 4080 has 
two drawbacks. One is that it uses write
white printing technology, a departure 
from the write-black technology featured 
in the LBP-CX. In write-white printers, 
those areas of the light-sensitive printer 
drum that are not "spotted" by the laser 
beam attract toner and consequently are 
printed; in write-black printers, those 
areas of the drum that are spotted by the 
beam are printed. 

In theory, it shouldn't matter whether 
a printer uses write-black or write-white 
technology. In practice, however, the 
write-black technology used by the LBP
CX engine seems to do a better job of 
producing fine lines and serifs (the tiny 
embellishments at the tips of characters). 
In addition, the output of some printers 
that use the Ricoh engine shows discern
ible clouds of stray toner, especially 
around boldface type. 



76 VENTURA TIPS AND TRICKS 

PRINTER CAPABILITY PAGE 

(Print This Flle On Your Printer To See What You Get) 
This page will help you understand the capabilities of your particular printer. It illustrates the use 

of white text on black baclcgrOlmd and other features which not III printers have. 

Reverse Text 

Ta'I"Ph'" 
Tn'I"Ph'" 

'Ibo box to IIIe Iefhbould be bllcIt willi the wordI"RcVerlO Tul" printed in 
whilO on top oflt Ifyourprinler C&DIIOlprinl whilO !exlon I blackbac:kground. 
you will ... DIlly a black box. 

The word "Uncld' Cram the phruo "Texl Under Orlphia" .bould be ann
ploidy obacurod by tho opaq .... emle 011 lop of it 

'Ibo word "Under" Crem the phruo "Text Under Orophia" .bould be partial
ly obacurod by IIIe lIIIlSparent c:irde 011 lOp oCit On PoatScriplmb""", oilier 
printen which C&DIIollwxlle IraIIIpll'Olll grapbia. IIIia piCI\IrO will look iden
tical II> tho OlIO direclly abov ... 

",,,,.1,,4.1824.3 648.72 
'Ibollumben II> theleflrepresen!a 
nnge of painl .ilJea between 6 and 
72painITimea(orOuu;b).IfthBw.. 
iJ nOlavailable in your printer. IIIe 
Ilumber will prinl ill the l1OarOlI 
avai1lblelize. 

The box outliIlOtotholeftiJ dnwn 
willi 3 black rulin& 1inea and ill 
10werri&hllwldc:omeriJ annpleto
Iyobacured by anopaq .... circlo (i. .... 
grapbia). 

ThiI rulin& \ino around thB paao 
1001 ri&hl II> edgo DC !lie physical 
paa'" When prinlOd. the while IFICO 

oullido tho rulin& line ropruellllllle 
"dead" IFICO II> which your prinlOr 
C&II'lprinL 

Figure 1: This is the printer capabilities test provided with Ventura. To use it, you 
load the CAPABILI.CHP from the \TYPESEI'subdirectory. Printing out this page on 
your printer shows you what the boundaries of the imaging area are, what sizes of 
fonts are available, whether your printer can handle transparent graphics, whether it 
can print reversed type, and whether it can print opaque shaded graphics on top of 
ruling lines of varying thicknesses. 



Kyocera Engine 

Besides the Canon LBP-CX and the 
Ricoh 4080, several newer printer en
gines have appeared that are worthy of 
note. One is the Kyocera engine, which is 
used in Kyocera's own laser printers as 
well those printers sold by Mannesman 
Tally. It has excellent printing quality, 
paper handling, and durability. Toner is 
added separately from the belt and hence 
is not quite as convenient (or as neat and 
tidy) as the all-in-one cartridges used by 
the HP LaserJet family and other Canon
engine printers. 

Ricoh 1060 Engine 

A second new engine is the Ricoh 1060 
engine, used in the Epson CQ-3500, the 
Okidata Laserline 6, the Epson GQ-3500 
and the Ricoh PC Laser 6000. Print qu
ality of the Ricoh 1060 is excellent, with 
crisp serifs and black blacks. Printers that 
use the new Ricoh engine weigh only 
about 36 pounds, compared to 71 pounds 
for printers that use the Canon LBP-CX. 
Compared to the 8 page per minute rating 
of most laser printers on the market, the 
Ricoh 1060 is capable of six pages per 
minute. 

Canon LBP-SX Engine 

A third new engine is the Canon LBP
SX, a major redesign of the LBP-CX. 
The first printer to use this engine is the 
HP LaserJet series II, but more manufac
turers are expected to adopt the engine in 
the near future. Like the LBP-CX, the 
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LBP-SX has excellent print quality, and 
like the CX has all its replaceable sup
plies, including toner, in a single con
venient cartridge. The new cartridge lasts 
for 4000 copies, compared to the 3000 
copies of the old cartridge. Print quality 
is improved over the LBP-CX: the new 
engine retains the former one's crisp 
handling of serifs and fine lines, but now 
prints blacks that are truly black. An im
portant feature is a toner intensity con
trol, which lets you adjust the darkness of 
type to your liking. At 50 pounds, the 
LBP-SX is 30 percent lighter than the 
LBP-CX. However, paper trays are larger 
and paper emerges in the correct order 
(i.e. face down). 

Blacker Blacks? 

Advertisement after advertisement em
phasizes the ability of this printer or that 
one to print "blacker blacks." As is well 
known, the printing of the first low-cost 
laser engine, the Canon LBP-CX, was too 
light for most people's liking, and sub
sequent laser printer designs have all 
cOJ;npensated for the problem. 

However, perhaps more important 
than whether a printer can print true 
black is whether the printer provides a 
way of controlling the print intensity. 
This turns out to be extremely important 
if you are producing master copies on 
your laser printer that will be reproduced 
on a photocopying machine or at a print 
shop. As a general rule, master copies 
should be as light as possible without 
beginning to fade. That's because all re
production methods tend to darken type. 



78 VENTURA TIPS AND TRICKS 

Type that looks acceptable on the master 
tends to become excessively dark after 
reproduction. 

Moral: When you buy a laser printer, 
check to see that it has an intensity con
trol. 

400 and 600 DPI Printers 

While 300 dpi has become the de facto 
standard for laser printers, there is no rea
son that desktop laser printers should not 
graduate toward higher resolutions. The 
resolution of most laser printers is 300 
dots per inch, which many people feel is 
slightly too coarse for replacing actual 
typeset output in most situations. On the 
other hand, printing at 1200 dpi, the low 
end of phototypesetting, is far more ex
pensive. Some sort of technology is 
needed to bridge the gap between 300-
dpi laser printing and 1200 dpi phototy
pesetting. That technology is now ap
pearing in commercial products. 

Three such high-resolution laser 
printers are the Compugraphic laser 
printer (400 dpi PostScript), the Varityper 
laser printer (600 dpi PostScript), and the 
Printware laser printer (600 by 1200 dpi, 
LaserJet Plus emulation and PostScript 
clone board). These machines are all 
priced at $18,000 or more and are rated 
at up to 10 pages per minute. The Com
pugraphic and the Varityper sport the 
Atlas PostScript controller, which is 
faster than the PostScript controllers used 
by the Apple LaserWriter and other 300-
dpi PostScript laser printers. 

Raising the resolution to 600 dpi 
quadruples the number of dots per square 

inch, with a corresponding improvement 
in the clarity of type and illustrations. 

RIPs and PDLs 

The laser printer controller is the "brains" 
of the printer, the part that endows the 
printer with its ability to generate 
graphics and characters. It is also known 
as the raster image processor (RIP). In 
most cases, the RIP is located inside the 
printer itself. The AST Turbolaser, the 
Cordata laser printer, the IBM Personal 
Pageprinter, and some others locate their 
RIPs on circuit boards within the com
puter. 

The capabilities of printer RIPs vary 
widely. As a result, some laser printers 
are capable of printing only one or two 
monospaced fonts and have no graphics 
capabilities, while others can print fonts 
of virtually any style or size as well as 
graphics of any sort. The difference is in 
the software used by the RIP, which is re
ferred to as the page description language 
(PDL). 

Ventura works with virtually all the 
page description languages on the 
market, including Adobe's PostScript, 
HP's Printer Command Language or 
PCL, and Xerox's InterPress. However, 
the capabilities of Ventura will vary, de
pending on which page description lan
guage your printer is running. Let's now 
look at each page description language in 
turn. 



PostScript 

PostScript is by far the most important 
page description language. It was 
developed by Adobe Systems, which in 
tum sells other companies the rights to 
incorporate PostScript into their laser 
printers and typesetters. So far, the list of 
PostScript printers includes the Apple 
LaserWriter and LaserWriter Plus, the 
QMS PS 800 and PS 800+, the PS Jet 
and PS Jet Plus, the IBM Personal Page
printer, the Texas Instruments Om
niLaser, the 400 dpi Compugraphic laser 
printer, the 1250-dpi Allied Linotronic 
lOOPS phototypesetter, the 2400-dpi 
Allied Linotronic 300PS typesetter, and 
many others. 

The fust notable feature of Post
Script is that it allows device inde
pendence; that is, files created for any 
one of the printers listed above can be 
printed on any other (with certain excep
tions related to differences in the amount 
of RAM built into the printers). 

The second notable feature of Post
Script is that it uses fonts generated from 
outlines. This method is vastly superior 
to the alternative, which is to store the ac
tual pattern of dots in each font as a bit 
map. With PostScript's outline method, 
fonts of any size can be generated from a 
single outline, and only one master out
line file needs to be stored for each type
face. 

As this book was being written, the 
large library of high-quality PostScript 
fonts was being converted into IBM PC 
format by Adobe Systems. The Adobe 
collection includes scores of commercial 
typefaces licensed from the lTC, Mergen-
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thaler, Stempel, and Haas type collec
tions. 

PostScript makes it possible to apply 
various graphic effects to type, including 
rotation, stretching, filling with patterns, 
and distorting. However, Ventura does 
not provide commands to exploit these 
talents. Similarly, PostScript's extraordi
nary abilities with graphics are not tapped 
by Ventura. The one exception is the En
capsulated PostScript option included in 
Version 1.1 of Ventura, which allows 
special effects written in PostScript to be 
incorporated into documents. At this 
writing, the only way to create the neces
sary Encapsulated PostScript code, aside 
from programming it yourself, is to 
create graphics on a Macintosh using 
high-level graphics programs such as 
Adobe Illustrator and Cricket Draw, and 
then transfer them to a PC. In the near fu
ture, however, PC programs will begin to 
support encapsulated PostScript, and at 
that point the graphics capabilities of 
PostScript printers in conjunction with 
Ventura will increase dramatically. For 
more information on the encapsulated 
PostScript format, see Chapter 15, "En
capsulated PostScript." 

InterPress 

Developed by Xerox Corporation, Inter
Press is the page description language 
used by some versions of the Xerox 2700 
and 9700 printers, which are supported 
by Ventura. The language exists in three 
implementations: the Commercial Set, 
the Publications Set, and the Professional 
Graphics Set. These differ in the sophis-
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tication of their graphics capabilities. The 
Commercial Set is the implementation 
supported by Ventura. It lacks such 
sophisticated features as rotation of text 
and graphics, boundary clipping, and 
curved lines-but these features are not 
needed to support Ventura's capabilities 
anyway. 

Although InterPress uses the same 
basic imaging model as PostScript, the 
two have found their way into different 
markets. PostScript is supported by a 
larger number of vendors and is prevalent 
on low-end 8 page per minute laser print
ers. InterPress's forte is very high speed 
printing, such as that provided by the 120 
ppm Xerox 9700. To support such high
speed printing, the language includes a 
variety of special features, such as encod
ing of bit maps. 

peL 

PCL, or Printer Command Language, is 
Hewlett-Packard's designation for the set 
of internal commands used by the Laser
Jet and the LaserJet Plus. Becaqse of the 
popularity of the LaserJet family of print
ers, numerous other printer manufac
turers have introduced printers that emu
lated the LaserJet or the LaserJet Plus. 

Among these PCL printers, or 
"LaserJet clones," are the Kyocera 
FriOIO, the Mannesman Tally MT9IO, 
the Qume LaserTEN, the Quadram 
Quadlaser, the Genicom, the Epson, and 
the OASYS LaserPro. In addition, the 
newest generation of PostScript printers, 
including the PS Jet Plus and the QMS 

PS 800+, have a LaserJet emulation op
tion. 

Having selected Ventura's LaserJet 
Plus 300-dpi or I50-dpi driver, you can 
substitute a LaserJet Plus clone for a 
LaserJet Plus or a LaserJet series II when 
installing Ventura. Because these PCL 
printers are not certified by Hewlett
Packard, some differences tend to crop 
up from time to time. Generally speak
ing, the compatibles have no problem in 
handling fonts in HP format, including 
the fonts supplied with Ventura. As long 
as your documents are text-only, using a 
LaserJet Plus clone is a safe bet. 

With graphics, clones frequently 
show subtle differences from the LaserJet 
Plus. These include streaking in scanned 
graphics or clip art, anomalous vertical 
lines, difficulties producing all eight 
shades of gray, and problems producing 
graphics in landscape orientation (Le. 
across the length of the paper). 

One big advantage of the LaserJet 
Plus clones is that they typically come 
configured with more RAM than the 
standard LaserJet Plus or LaserJet Series 
II. 

Ventura's Internal RIP 

A number of printers that work quite well 
with Ventura-including the AST Tur
boLaser, the Cordata laser printer, and 
printers retrofitted with the JLaser 
board-don't use PostScript, InterPress, 
or peL. How does Ventura manage to 
work with all these printers? The answer 
is that built into Ventura itself is a raster 
image processor, in effect a full-blown 



laser printer controller. Ventura's PDL 
builds a bit map of each page and then 
transmits it directly to the RAM of the 
printer. 

Since a full-page bit map requires 
one megabyte of RAM, this means that 
Ventura's RIP must generate and transmit 
to the printer a full megabyte of data for 
every page that is printed. If that data had 
to be ~ent over a normal serial or parallel 
connection it would simply take too long 
to be practical. Therefore, Ventura's RIP 
is only used in conjunction with laser 
printers whose controllers are located 
within the computer itself, as is the case 
with the AST, the Cordata, and the 
JLaser. 

Typesetter Proofing 

Since Ventura drives typesetting ma
chines, it is possible to use a laser printer 
for proofing a document before having it 
typeset on a PostScript phototypesetter 
such as the Linotronic 300. For example, 
you can use the program with the JLaser 
board but select the PostScript width 
table. In the Options menu, select Set 
Printer Info. Click on the JLaser option, 
then click on Load Different Font Width 
and select PostScript. The resulting print
outs will be accurate in showing the cor
rect line endings and word breaks that 
will ultimately be printed on the typeset
ter. Thus, you can can proof your copy 
inexpensively on a laser printer before 
sending the document out for more costly 
typesetting. 
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Speed 

Speed is a major issue when using a pro
gram like Ventura. You want to be work
ing on your document, not sipping coffee 
while the printer takes its time printing a 
page. The time it takes to print a docu
ment can vary tremendously from printer 
to printer. A page that requires 4 minutes 
on one printer may take 20 seconds on 
another.Two factors determine the speed 
of a printer. 

The biggest factor affecting the 
speed of printing is the transmission 
channel between computer and printer. 
Many printers, such as the HP LaserJet 
and the Apple LaserWriter, are connected 
to the printer via a serial cable operating 
at 9600 baud. That may seem fast when 
you compare it to the typical 300 baud of 
older modems or 1200 to 2400 baud of 
newer modems. But actually, 9600 baud 
is terribly sluggish for handling the type 
of pages that Ventura produces. This is 
the slowest kind of printing option. Much 
faster is a parallel channel, an option with 
the LaserJet Plus and the Xerox 4045. 

Faster yet are printers that place the 
RIP in the computer and connect it to the 
printer via an ultra-high speed interface. 
These include the AST TurboLaser, the 
Cordata, and printers retrofitted with the 
JLaser board or the LaserMaster control
ler. 

The second factor affecting printer 
speed is the efficiency of the RIP and the 
type of page description language used 
by the printer. PostScript printers tend to 
be somewhat slower than other laser 
printers; PostScript typesetting machines 
are infamous for their sluggishness. The 
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situation for PostScript is gradually im
proving, however. The new Atlas control
ler used by some PostScript equipment is 
notably faster than the previous genera
tion. In addition, it should be noted that 
Ventura's own PostScript driver has been 
souped up in Version 1.1 and is now rated 
at 30 percent faster than before. 

Currently, the fastest option for 
printing with Ventura appears to be the 
LaserMaster controller, followed by the 
JLaser board and the AST TurboLaser. 
For an unbeatable combination of speed 
and quality, install a JLaser board or 
LaserMaster controller in a PC and con
nect it with an Apple LaserWriter Plus, 
QMS PS 800+, or PS Jet Plus. Then in
stall Ventura for both the JLaser ( or 
LaserMaster) and the PostScript printer. 
When you select the JLaser option, you'll 
have speed; when you select the Post
Script printer you'll have a wide selec
tion of fonts. 

Monitors 

As ecumenical with monitors as it is with 
laser printers, Ventura gives you options 
ranging from the the 80 by 35 dpi resolu
tion of the IBM Color Graphics Adapter 
(CGA) standard up to the 150 by 150 dpi 
resolution of the most expensive full
page monitors. Prices also vary widely, 
from a mere $200 or so for a Hercules
clone graphics board and an accompany
ing amber monitor, to $2500 or more for 
a 19-inch full-page monitor such as the 

Viking I. At the low end, some standards 
exist that make it simple to mix and 
match equipment. At the high end, shop
ping and installation is complicated due 
to the absence of standards and the fact 
that such monitors tend to push personal 
computers to the limits of their perform
ance. 

In addition to the general informa
tion here on monitors, you can find infor
mation on specific monitors in the Pro
duct Guide at the end of the book. 

Monitor Lingo and Standards 

Every monitor comes in two parts: the 
monitor itself and the adapter (also called 
the controller), a board in the computer 
that is connected via cable to the monitor. 
Monitors are generhlly classified accord
ing to their resolution, which is measured 
in horizontal pixels by vertical pixels. 

Virtually every kind of monitor used 
with the IBM PC can be used with Ven
tura, except the Monochrome Display 
Adapter (MDA), the text-only "green 
screen" commonly used for word pro
cessing. The lowest resolution is pro
vided by the Color Graphics Adapter 
(CGA). Its resolution is 640 by 240 pix
els, or about 80 by 35 pixels per square 
inch. 

Surprisingly, the resolution of Ven
tura on a CGA, though somewhat coarse, 
is still adequate for some types of work. I 
used Ventura on a CGA for several 
months and found the resolution accept
able even for creating complex layouts 
such as forms and brochures. The big 
drawback of using Ventura in CGA mode 



is that you can't read most text in Normal 
view, which is possible in EGA and HGC 
(Hercules Graphics Card). Another an
noying problem with the CGA is that 
when you attempt to select and move a 
small frame or a small box text graphic, 
you may inadvertently change its size. 
Otherwise, the CGA works well: when 
you need to read text, you merely switch 
into Expanded view. ' 

One step above the CGA on the scale 
of resolution are the Enhanced Graphics 
Adapter (EGA) and the Hercules 
Graphics Card (HGC). The EGA pro
vides a resolution of 640 by 350 pixels, 
or about 80 by 51 pixels per inch. The 
resolution of the Hercules Graphics Card 
is slightly better: 720 by 348 pixels, or 
about 90 by 51 pixels per inch. 

Using Ventura with an EGA or a 
HGC board is much more comfortable 
than using it with a CGA board. With the 
EGA or the HGC, most text in normal 
view, ruling lines and frame boundaries 
are crisper, and it's much easier to move 
or stretch frames and boxes. 

The advantage of the Hercules card 
over the EGA is that it can be used with a 
standard IBM Monochrome Monitor or 
an inexpensive monochrome monitor 
such as a Samsung, priced at around 
$100. In addition, many makers of IBM 
XT or AT clones provide a Hercules 
clone board as standard equipment on 
their machines. 

Large-Screen Monitors 

The big drawback of using standard 
monitors with Ventura is that you have 
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only a portion of your page on the screen 
at once. As a result, when you're working 
on a page, you suffer the annoyance of 
making lots of mouse trips over to the 
scroll bar to move the page up and down. 
Ironically, as explained below, large
screen monitors won't necessarily free 
you entirely of those trips to the scroll 
bar. But the ability to work with larger 
portions of the page at once and to read 
very small type is definitely a boon to 
producti vity. 

Large-screen monitors divide into 
two strata. The lower tier, which includes 
the Wyse, the Xerox, and the Genius, are 
priced as low as $700 (the street price of 
the Wyse, which is also sold under the 
Amdek label). These monitors are 
smaller and do not let you see the full 
page in Normal view, so you still do quite 
a bit of scrolling. 

The higher tier cost in excess of 
$2000. Most of these monitors, including 
the Viking I, the Sigma LaserView, and 
the Cono Vision 2800, use the 14-inch 
wide by l1-inch tall screen made by 
Moniterm Corporation and also used in 
workstations such as the Apollo and the 
Sun. Frequently, these monitors are 
called "19-inch monitors," a reference to 
the 19 inch diagonal measurement of the 
Moniterm screen. 

19-inch monitors have drawn a tre
mendous amount of flak in the computer 
press recently, mainly because companies 
have tended to introduce models before 
all the software drivers were completely 
polished. It's important to keep in mind 
that what's frequently being criticized is 
faulty software rather than flawed hard
ware. For example, an article in PC 
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World severely criticized the Viking I 
·monitor. However, after that article was 
written, Moniterm released new Ventura 
drivers and a consequently another ma
gazine, Publish! singled out the Viking I 
as "the clear winner" among the five PC
compatible monitors it tested. This book 
was laid out on a Viking I monitor, and I 
can attest that using the monitor made the 
process of laying out pages at least twice 
as fast as working on a normal Hercules 
display. In addition, the Viking I per
formed flawlessly in emulating my word 
processor in normal monochrome mode 
and in emulating a Hercules display 
when I used PC Paintbrush Plus. 

While I worked on this book with 
the Viking I, occasionally I would visit 
another writer who was attempting to 
break in a Sigma LaserView. Like the ini
tial software for the Viking I, the La
serView's drivers and screen fonts at first 
were substandard. But eventually, a new 
disk arrived and my friend's complaints 
subsided into purrs of contentment. 

My bottom-line opinion on large
screen monitors is that despite the high 
prices, they are a tremendous value be
cause of how much faster you can work 
and how much less tired you are at the 
end of a work session. At the same time, 
because of the various issues described 
below (especially speed and quality of 
screen fonts) you should never buy one 
of these products until you have a chance 
to really try it out under realistic condi
tions (i.e. with a document that you typi
cally work with). For specific product in
formation on large-screen monitors, refer 
to Appendix A, "Product Information." 
The following are some general factors 

that you should consider as you check 
out systems: 

SCREEN FONTS: It's essential that 
your monitor have screen fonts in the 
standard sizes you use for type, such as 
10 and 12 points. Without screen fonts, 
Ventura has to draw each character in
dividually. Not only does this result in 
type that is difficult to read, but more se
riously it drags down the speed of the 
display dramatically. Don't get involved 
with any monitor that doesn't have a full 
set of screen fonts. 

ASPECT RATIO OF PIXELS: Some 
monitors have square pixels, others rec
tangular ones. For desktop publishing, 
square pixels are definitely preferable, 
since laser printers and typesetting ma
chines universally use square pixels. If 
your monitor doesn't have square pixels, 
your image of the final page will be dis
torted--either stretched vertically or hori
zontally. 

SIZE OF DISPLAY: The reason large
screen monitors are known as "full page 
displays" is that all of them can display 
an entire page of text-66 lines-when 
used with a word processing program. 
The benefit here is obvious: if you can 
work with an entire page at a time, you 
don't have to scroll up and down the 
page. Most of the "full page" monitors 
don't actually let you see an entire page 
when used with Ventura in Ventura's 
Normal View mode. For example, the 
Xerox monitor cuts off about an inch on 
the side of the page; the Wyse cuts off 
about an inch at the bottom of the page. 

FLICKER: Large screen monitors 
have to display an immense number of 
pixels; to do so, some use a technique 



called "interlacing," which means that 
every other scan line is refreshed during 
each cycle. Interlacing is apt to produce 
annoying flicker, though noninterlaced 
displays may also produce flicker if they 
don't refresh the screen often enough. 

HEAT AND POWER: Large screen 
monitors and the boards that drive them 
draw lots of power and tend to produce 
lots of heat. If your computer is aheady 
running a bit on the hot side, you may 
need to install a larger power supply to 
handle the new monitor. 

SOFTWARE COMPATIBILITY: Some 
monitors, such as the Wyse and the 
Genius, have been around long enough so 
that drivers now exist for many popular 
programs. With monitors that have been 
introduced more recently, you may find it 
difficult to use your favorite graphics 
program. Note that it's not enough to 
verify that your software will work with 
the monitor. You'll also need to find out 
whether the quality of the display is ade
quate. For example, when some monitors 
are emulating the eGA or EGA stand
ards, they squeeze the display area into 
the upper left portion of the screen, 
making text excessively small. Make sure 
that you're buying something you can use 
with your software. 

PRIMARY VERSUS SECONDARY 
DISPLAY: Some full-page monitors are 
designed to be used as the only monitor 
with your system. These are called "pri
mary displays." Other monitors, called 
"secondary displays," can only be used if 
a standard graphics board (usually an 
EGA board) is installed in your computer 
as well. Make sure you know what kind 
of monitor you are getting. 
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EASE OF INSTALLATION: Some 
monitors require a substantial level of 
technical expertise to install and operate 
effectively. For example, if you have 
Above Board memory and are installing 
the Viking I, you may have to adjust the 
hexadecimal codes of the Above Board 
memory addresses to avoid a conflict be
tween that memory and the Viking I con
troller. While the installation manuals for 
some monitors are quite good, most are 
poorly written and excessively technical. 

CONTRAST: Some monitors allow 
contrast to be adjusted, a desirable fea
ture in dealing with various lighting con
ditions. 

CABLING: Surprisingly, some large 
screen monitors come with relatively 
short cords, a real drawback if you want 
to use the monitor for teaching purposes 
or move it aside so that you can run 
another monitor. 

COMPUTER COMPATIBILITY: If 
you are using an IBM compatible or 
clone, you can generally expect to run 
into some compatibility difficulties when 
you attempt to install a full-page monitor. 
Make sure the vendor has tested the 
monitor with the type of computer you 
intend to use it with. 

EDGE EFFECTS: Some monitors, 
such as the Genius, run the image right 
up to the edge of the screen, which can 
cause some distortion at corners and 
edges and make it difficult to work on 
those parts of a page. Other monitors, 
such as the Viking I, leave a roomy mar
gin surrounding the active area of the 
screen and hence avoid such distortion. 

ORIENTATION: For creating docu
ments, it makes sense to have a monitor 
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that is taller than it is wide (since that's 
the shape of the page itself). Some moni
tors, including the Xerox and the Genius, 
are of the tall variety but may be slightly 
too thin, since they cut off some of the 
right edge of the page in Normal view. 
The 19-inch Moniterm tube would be ex
cellent if turned sideways so that it is tal
ler than wide-and that is precisely what 
Moniterm has announced plans to do in 
future versions of its Viking I. 

SPEED CONSIDERATIONS AND 
GRAPIDCS COPROCESSORS: Although a 
large-screen monitor is supposed to make 
you more productive, some put such a 
large computational burden on the com
puter's CPU that they slow down Ven
tura's operations to an unacceptable de
gree. The answer is a new generation of 
graphics coprocessor chips, introduced 
by Intel, Texas Instruments, Hitachi, and 
others. At this point the Viking I is the 
only monitor on the market that has any 
track record using such a chip (the Hita
chi 63484), but the situation is changing 
fast. Whatever you do, don't burden a 
normal XT with a large-screen monitor 
that lacks a coprocessor. 

USE WITH A MOUSE: Some moni
tors provide drivers for a variety of mice; 
others support only one mouse, a factor 
that can be a major nuisance if you don't 
happen to have that mouse. With some 
mice, such as older versions of the Mi
crosoft Mouse, when you switch over to 
a large-screen scanner, you may find that 
the speed of your mouse has become a 
major bottleneck. The reason for that is 
that the mouse is preprogrammed with a 
"sensitivity factor" that causes the cursor 
to move a certain number of pixels on the 

screen for every inch that the mouse it
self travels on the desktop. With the 
smaller pixels of the large-screen moni
tor, it make take more rolling on the table 
to get the mouse to the menu line and 
back. The answer to this problem is to 
speed up the mouse by altering the sensi
tivity factor. Your mouse manual should 
describe the procedure for making that 
change. 

Scanners 

The purpose of a scanner is to convert a 
two or three dimensional image into a 
digital form that can be processed by 
computer software. Scanners can be 
classified into two varieties, optical and 
video, depending on the method they use 

~ to convert a continuous image into a digi
tal form. In the optical method, a bright 
light is scanned back and forth across a 
page, recording the intensity of the image 
at each point in a fine grid. Such scanners 
may provide a flat bed on which you 
place the image to be digitized; others re
quire you to feed the image through the 
machine. 

Video scanners work in conjunction 
with a video camera, processing the 
video signal into a digital one. The 
advantage of video scanners is that they 
can be used to process three-dimensional 
images. The advantage of optical scan
ners is that they are faster and more pre
cise. 



Scanning Software 

Some scanners are used with special con
trolling software provided by the scanner 
manufacturer. Generally with Ventura, 
however, you use a scanner in conjunc
tion with a graphics program such as PC 
Paintbrush Plus, Publisher's Paintbrush, 
or Halo DPE. 

With these programs the scanner is 
controlled using commands in a menu. 
For example, to scan an image from PC 
Paintbrush Plus, you select the Scan op
tion from the Page menu. This brings up 
a dialog box that lets you specify bright
ness, contrast, scanning mode, type of 
dithering, and resolution. Once you have 
selected the options you wish to use, you 
select OK. The scanner then scans the 
picture and loads it automatically into PC 
Paintbrush Plus. With either of these pro
grams there is an option on the menu that 
allows you to select the area of the page 
you want scanned. This pre-cropping is 
extremely useful, since it allows you to 
save storage space on your hard disk by 
saving less than the full 8.5 by 11 inch 
area. You also can specify whether you 
are scanning line art or images, and select 
a dithering pattern. 

After you have used Paintbrush to 
scan the image, you can use Paintbrush's 
graphics tools to clean up stray pixels or 
otherwise alter the image. Then you can 
save it as a PCX file, a format recognized 
by Ventura. 

At this point the scanned image has 
been converted into a digital image that 
can be altered using any of PC Paintbrush 
Plus's erasing or drawing tools. You can 
then save the image as a PCX file, a for-
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mat recognized by Ventura. Other for
mats that can be used to store scanned 
images are the GEM IMG format and the 
MacPaint format (for images scanned via 
a Macintosh). 

Synthetic Halftones and 
Dithering 

Scanners work in two modes, one for 
black and white images, the other for im
ages with intermediate shading. Images 
that are black and white, such as graphic 
symbols and logos, hold up well under 
the scanning and printing process. The 
task of recording and then reproducing 
images that contain intermediate shading 
is a much more difficult one. 

The trick is for the scanner and the 
laser printer to preserve the illusion of in
termediate shades using only black and 
white dots. Various techniques are used 
for doing this, and they are referred to as 
synthetic halftones or dithering. All such 
techniques create various types of pat
terns to simulate gray. 

For example, in spiral dithering, dots 
are printed in an even grid on the page. 
The darker the gray at a given point in 
the gray, the larger the dot is allowed to 
be at that point (i.e. the more laser printer 
spots are joined together to create the ap
pearance of larger dots). In effect, the 
purpose of spiral dithering is to create a 
twofold illusion. The first illusion is that 
dots are a different size, depending on the 
shade of gray being rendered. (In reality, 
the dots that can be printed by a 300 dpi 
laser printer are uniform in size; to create 
the illusion of different sized dots, vary-
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ing numbers of dots are fused together). 
The second illusion is that different 
shades of gray are being printed. (When 
you look more closely, you can see that 
the illusion is created by the fact that dots 
differ in size, depending on the shade of 
gray being simulated.) 

Scanner Limitations 

In conjunction with a 300 dpi laser 
printer, the quality of halftones (i.e. pho
tographs and other images containing in
termediate shades) rendered by digital 
scanners is quite poor. The reason is that 
the laser printer simply does not have 
enough dots at its disposal to simulate the 
subtle gradation of dots necessary for 
halftones of the type used by newspapers 
and magazines. The traditional halftone 
method-photographing a continuous 
tone image through a screen-used 
screens of from 65 to 150 dots per inch. 
Those numbers may seem coarse com
pared to the 300 dpi of the laser printer; 
however, when you consider that the dots 
could vary continuously in size, that res
olution was quite adequate to produce the 
necessary illusion. 

In contrast, no matter what software, 
scanner, and laser printer you use, con
tinuous images digitized by a scanner and 
printed on a laser printer will invariably 
have a "computer-generated" look. That's 
alright for some types of publications, 
and may even be desirable as a special 
effect; however, in most circumstances 
it's best to forgo the new technology in 
the interest of quality. The alternative is 
to create a block marking where the 

image is to be placed, take the photo
graph to a graphic arts shop, and have a 
halftone made. 
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Managing Files 
IF YOU'RE LIKE most people, your first 
exposure to personal computing was 
through word processing. When you use 
a word processing program, keeping 
track of files is simple, since each docu
ment you create is stored in exactly one 
file. When you need to send a document 
in the mail or over a modem, you merely 
transfer that file onto a floppy disk using 
the DOS COpy command. 

With Ventura, file management is no 
longer so simple. Any document you 
create will comprise at least several files, 
and in many cases a dozen or more. 
Some of these are the text and graphics 
files you created with other programs and 
now are merging together with Ventura. 
Others are files generated by Ventura it
self. 

A Document Is a Family of 
Files 

It's easy-too easy, perhaps-to generate 
one document after another and never 
pay any particular attention to the various 
seemingly obscure files that Ventura 

generates as you go about your work. 
Eventually, however, you will have to 
learn what those files are and deal with 
them directly. Here are two examples of 
when that might be necessary: 

• If storage becomes tight on your 
hard disk, you'll need to start remov
ing some of the documents stored 
there, which means removing the 
family of files associated with each 
document. One of the notable over
sights in Ventura's design is that the 
program provides no easy way to de
lete a chapter and all its files. You'll 
have to do it using DOS commands. 

• If you begin working with long 
documents or documents that in
clude multiple graphics, you'll prob
ably run into difficulty at some point 
getting a chapter to load. In that sit
uation, a potential solution (de
scribed in detail in the tips at the end 
of this chapter) is to rename or move 
certain files associated with the 
chapter. 

The first thing to note in becoming 
proficient at managing files is that every 
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Text Files 

MultiMate or MS Word (DOC) 
WordStar (WS) 

ASCII or XyWrite(TXT) 
Xerox Writer (XWP) 
WordPerfect (WP) 

DisplayWrite and Samna (DCA) 

Bit-Mapp,ed Graphics Files 

PC Paintbrush (PCX) 
GEM Paint and Halo DPE (GEM) 

MacPaint (PNT) 

/ 
Chapter File (CHP) 

Contains pointers to text, graphics, 
and internally generated files. 

/ 
Object Graphics Files 

Lotus and VideoShow (PIC) 
CGM (CGM) 

MacDraw (PCT) 
AutoCAD Slide (SLD) 

Encapsulated PostScript (EPS) 
Hewlett-Packard Graphics 

Language (HPG) 
GEM Draw (GEM) 

Mentor Graphics (P ~ 

Files Generated By Ventura 

Style Sheets (STY) 
Captions and Box Text (CAP) 

Program Status (INF) 
Publications (PUB) 

Backups ($~ 
Indexes and Tables of Contents 

(GEN) 
Print to Disk Files (COO) 
Internal Graphics (VGR) 

Figure 1: This schematic shows how the chapter file knits together other types o/files, 
including text files , graphics files, andfiles generated by Ventura itself. 



document is a family of files. At the head 
of the family is the chapter file (ClIP), 
which contains pointers to the location 
and contents of the other files. The cate
gories and extensions of the other files 
shepherded by the chapter file are shown 
in Figure 1. 

The Chapter File 

Having taken this summary tour of Ven
tura's user interface, let's take a step or 
two back and consider a bit more ab
stractly how Ventura organizes the infor
mation it needs to generate a document. 

The key concept underlying Ven
tura's design is that a desktop publishing 
program should act as a hub for other 
programs, rather than being an all-power
ful megaprogram. Hence Ventura does 
not replace existing tools such as word 
processors and graphic programs; in
stead, it provides avenues for you to im
port existing text files and pictures into 
the program. 

This "don't reinvent the wheel" 
philosophy is key to understanding the 
function of Ventura's chapter and style 
sheet files. 

The job of the chapter file is to act as 
master of ceremonies for the document. It 
contains pointers that keep track of the 
following: 

• The text and graphics files that make 
up the contents of a document. 

• The style sheet file in which Ventura 
stores the names of all the tags and 
the formatting information as
sociated with each tag. 
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• The files generated by Ventura itself 
to store the contents of captions and 
headers, internally generated 
graphics, and other internal informa
tion. 

Because Ventura's chapter file 
merely contains pointers to other files, 
rather than absorbing them into one 
enormous master program, you can con
tinue to edit and change those files even 
after you have merged them to create a 
Ventura document. No matter how much 
you scale or distort a graphic within the 
Ventura document, the graphics file itself 
remains completely unaltered. Text files 
are altered somewhat, in that Ventura in
serts the names of tags it uses to format 
them as well as other sorts of formatting 
information to indicate character at
tributes such as boldface. Generally 
speaking, the changes Ventura makes in 
original text files do not get in the way of 
reusing the same files when you have to 
revise the document-a real boon if you 
are creating manuals that need to be peri
odically updated. 

Another real benefit of Ventura's use 
of the chapter file as the hub is that the 
text, graphics, and style sheet files used 
for a document need not all be located in 
a single subdirectory on the hard disk. 
The chapter file keeps track of the other 
files not only by name but by location. 
Thus, you might use one picture for 
several different documents, or apply the 
same style sheet to two different chap
ters. 
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The Style Sheet File 

Style sheet files, identifiable by their 
STY extension, are devoted mainly to 
storing the attributes of tags. In addition 
to storing tag specifications, the style 
sheet file contains the page size and 
orientation, widow and orphan settings, 
autonumbering settings, footnote set
tings, and margin and column settings for 
the underlying page. 

Each chapter uses one style sheet
you can't have more than one style sheet 
attached to a single chapter at a time, 
even if the chapter comprises several text 
files. On the other hand, you can switch 
style sheets after you have formatted a 
chapter. 

The VP.INF File 

While the chapter and style sheet files are 
the two main files created by Ventura 
when you layout a document, a third file 
should also be noted. It is the VP.INF 
file, which is located in the \ Ventura sub-
directory. . 

Have you noticed that Ventura al
ways remembers what preferences you 
have for whether a ruler is shown on the 
screen, what subdirectory you last looked 
into to find a graphics file, or whether 
pictures are shown or hidden? Even if 
you quit the program and load it again, 
and choose a different chapter to work 
on, those settings will remain in force. 
Keeping track of the myriad of user
selectable options is the job of the INF 
file. 

The Pub File 

Most documents consist of a single chap
ter. At times, however, you may want to 
group chapters together to take advantage 
of Ventura's multichapter capabilities 
(sequential numbering, indexing, auto
matic table of contents). In that case, 
you'll work with the Multichapter selec
tion of the Options menu to create a Pub
lication (PUB) file. Note that you don't 
have to create a publication file every 
time you generate a document with more 
than one chapter. You can simply print 
one chapter at a time. As long as you're 
not interested in automatic numbering, 
indexing, and table of contents genera
tion, you'll have no need to create a pub
lication file. 

Other Files 

Here are some of the other files that Ven
tura automatically generates as it formats 
a document: 

• Caption files (CAP extension). 
These store not only text entered into 
captions, but also headers, footers, 
empty frames, and text boxes. 

• Backup files ($** extension). These 
files are automatically created by 
Ventura as you work on a chapter, 
and are useful for reconstructing 
your document if the system locks 
up or crashes. 

• Generated files (GEN extension). 
These are text files created by Ven
tura when you use the program's 



capability to generate an index or a 
caption. 

• Print to Disk files (COO extension). 
This type of file is created on your 
hard disk when you direct Ventura to 
print to a file rather than sending in
formation directly to the printer. It 
allows you to create documents on a 
computer that lacks an attached 
printer. Later, you can print the file 
by typing 

COpy filename.COO LPT1: 

• Ventura Graphics files (VGR exten
sion). These store graphics that you 
create using Ventura's graphics 
tools. 

Pros and Cons 

At this point it may already seem to you 
that Ventura's way of splitting documents 
up into numerous files is needlessly com
plicated. The obvious question is: Why 
not simply have all the parts of a docu
ment combined into one single document 
file? 

That, in fact, is the method used by 
PageMaker and many other desktop pub
lishing programs. From the standpoint of 
easily keeping track of things the method 
clearly has its merits. Ventura's scheme, 
however, has these advantages: 

• It is one of the major factors ac
counting for the program's unrivaled 
speed, due to the fact that the com
puter can get in and out of small files 
much faster than large ones. 

• It allows for files to be modified 
after they have been merged together 
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in a document. That way, you can 
make a small change in a drawing or 
chart at the eleventh hour, or con
tinually update a manual even after 
you've laid it out. Trying managing 
stunts like that with PageMaker. 

But while Ventura's family-style 
way of dealing with files has its distinct 
benefits, it also places a burden on you to 
organize your hard disk in such a way 
that all those files don't lead to utter 
chaos on your hard disk. We'll now turn, 
therefore, to a review of the tools at your 
disposal for handling files, and to some 
suggestions regarding an architecture for 
organizing those files on your hard disk. 

Refresher on DOS 

If you've avoided until now the chore of 
learning about how directories, paths, ex
tensions, and filters work, you'll need to 
acquaint yourself with these terms as well 
as several DOS commands. 

The DOS operating system provides 
a simple method for organizing computer 
files. At the highest level of organization 
are the floppy and hard disk drives used 
by your system, which are assigned let
ters, followed by a colon. Normally 
drives A and B are floppy disk drives. 
Drive C is normally a hard disk drive. 
Since DOS cannot handle drives larger 
than 20 Mb, a 40 Mb hard disk is typi
cally partitioned into drive C and drive D. 
In addition, a block of RAM can be set 
up to appear to the system as a very fast 
drive. Such a drive is referred to as a 
"RAM drive" and is normally designated 
driveD orE. 
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ITEM SELECTOR 

Directory: D:\TYPESET\* ,CHP ______ _ 

8BOOK·P1,CHP 
8BOOK • P2 ,CHP 
8BRO·l2 ,CHP 
8BRO· P3 ,CHP 
8INV·P1 ,CHP 
8lSm·P2,CHP 
8lTR1 ·P1 ,CHP 
SHAG· P3 ,CHP 
&NEWS·P2,CHP 

ITEM SELECTOR 

Selection: ~._ 

Directory: D:\*,CHP ________ _ 

Selection: ~,_ 

• C: 
• D: 

m 
I Cancel I 

ITEM SELECTOR 

Directory: A:\*,CHP ________ _ 

Selection: HARDWARLCHP\ 

--'-
--'-

--'-
--'-
--'-
--'-
--'-

ITEM SElECTOR 

Directory: D:\*,CHP ________ _ 

Selection: ~,_ 

.11 __ ,_ 
• CCPIH_,_ 
• FIHAl_,_ 
• FORHDIR_,_ 
• GlYPHIX_,_ 
• NEWSlETR,_ 
• NWSlTR_,_ ::::::::: 
• PCLPAK_,_ 
• REPORT2_,_ 

ITEM SELECTOR 

Directory: A:\*,CHP ________ _ 

Selection: ~,_ 

I~ARD!IIARE ,CHP 

--'-
--'-
--'-
--'-
--'- m ---
--- I Cancel I --'- ~ 

Figures 2A - 2E. This sequence shows the 
use of the Backup Button to change 
directories and select a file. Once the 
correct file is shown on the Selection 
line, you can select it by pressing OK. 
Alternatively, you can click twice while 
selecting or press Enter. 



Each drive, such as C or D, may 
contain files and directories. Each 
directory may in turn contain additional 
directories or files. Any file can be de
scribed in terms of the subdirectory or 
subdirectories in which it is located, and 
this is known as the path to the file. Files 
are further identified by their names (up 
to eight characters) and an extension of 
three characters, which typically de
scribes the type of program that created 
the file. 

Creating Directories 

To create a new directory on drive C, 
let's say NEWDOCS, you type the fol
lowing from the DOS prompt: 

MD C: \NEWDOCS 
You can also do this within Ventura 

via the DOS File Ops option in the Files 
menu. To create the NEWDOCS file 
from Ventura, execute the following 
steps: 

• From the File menu, select the DOS 
File Ops option 

• Backspace across the existing File 
Spec and type 

C:\NEWDOCS 

• Select MAKE DIRECTORY. 

U sing a similar procedure, you could re
move the directory. However, in order to 
remove the directory you must first delete 
all the files in the directory. 

Once you have created a directory, 
you can create a subdirectory within that 
directory. To create the subdirectory 
C:\NEWDOCS\MARCH from the DOS 
prompt you type 
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MD C:\NEWDOCS\MARCH 
Alternatively, you can use Ventura's 

File Ops option. Remember that you 
can't create the subdirectory C:\NEW
DOCS\MARCH' until you have created 
the directory C:\NEWDOCS. 

Paths and Filters 

When you're using the DIR command in 
DOS to view the contents of a directory, 
you can tell the difference between files 
and subdirectories because files usually 
have three-letter extensions, whereas sub
directories are followed by the phrase 
DIR enclosed in angle brackets. When 
using Ventura dialog boxes to view the 
contents of a directory, subdirectories are 
recognizable because they are preceded 
by a diamond. 

When searching for a file, the con
cepts of wildcard characters and filters 
come in handy. The asterisk (*) is a wild
card that can be used to hold the place of 
either the file name or the extension. A 
filter is a description of a file containing a 
wildcard. By learning to use filters, you 
can learn to quickly find any type of file. 
For example, to see all the style sheet 
files (those with the STY extension) in 
the TYPESET directory, you can type the 
following from the DOS prompt: 

DIR C:\TYPESET\*.STY 
DOS responds by listing all the files 

with the STY extension. 

The Backup Button 

Many DOS operations, especially 
searches for files using filters, can actu-
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ally be conducted from within Ventura. 
Whenever you load a text file, a chapter, 
a style sheet, or an illustration, you can 
save a great deal of time if you learn to 
use Ventura's easy "stepladder" method 
of climbing up and down subdirectory 
hierarchies. The method, which can be 
used in any dialog box that contains a 
Directory line on top and a Selection line 
on the right, is shown in Figures 2A-2E. 

Let's say you're looking for a chap
ter file (one with the CHP extension) but 
aren't sure where it is located on the hard 
disk. Do the following steps: 

• From the File menu, select Open 
Chapter. Notice that Ventura auto
matically displays the * .CHP filter 
on the Directory line. 

• Place the cursor on the small black 
square, known as the Backup But
ton, in the corner of the scrolling list. 
As shown in Figures 2A-2E, each 
time you click on the Backup But
ton, you move one rung up the lad
der; i.e., one level upward in the 
hierarchy of directories. After you 
click on it once or twice, the scrol
ling box will list the drives on your 
system-A, B, C, etc. 

The diamond in front of the A, B, 
and C indicates that these are directories, 
not files. Now you can climb back down 
the directory hierarchy and see the con
tents of a particular drive. 

• Select the drive on which you in
stalled Ventura. In most cases that 
will be drive C. 

• The scrolling box will now list all 
the directories in the C drive, as well 

as all the files in the root directory of 
the C drive with the CHP extension. 

• Select the TYPESET directory. The 
scroll bar now displays the list of 
chapter files in that directory . 

• You can now select a chapter from 
that list. The name will appear in the 
Selection line at the right. You can 
choose that file by pressing Enter or 
selecting OK. 

Hands Off \TYPESET 

When you install Ventura 1.1, two direc
tories are automatically created on your 
hard disk: VENTURA and TYPESET. 
The former contains all the program files 
and fonts, the latter the sample chapter 
files and style sheets. 

You'll find yourself frequently using 
the style sheets provided with the pro-' 
gram, since it's generally easier to mod
ify an existing style sheet than to create 
one from scratch for the specific sorts of 
documents you are formatting. Be care
ful, however, to always save a modified 
style sheet under a new name. Also, it's 
highly recommended that you save the 
modified style sheet in a directory other 
than TYPESET, as described below. 

By renaming style sheets before you 
save them, you'll preserve the original 
style sheets for future use. If, however, 
you have already modified one of those 
style sheets and wish to restore the origi
nal version to the TYPESET directory, 
you can copy it from the Examples disk 
(#2). 
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Root 
directory 

Subdirectories 
(each contains 
one chapter) 

Contents of 
a 

subdirectory 

Figure 3: A suggested directory structure for single-chapter documents such as 
newsletters,forms, and directories. 

1\vo Organization Strategies 

As I mentioned above, it's not a wise idea 
over the long run to save the chapters and 
style sheets you create in the TYPESET 
subdirectory. Doing so will very quickly 
cause the number of files in that directory 
to grow to an unmanagable size and 
cause real problems later when you have 
to move files off your hard. disk. There
fore, you need to develop an effective 
structure for files on your hard disk so 
that you can easily locate the family of 
files that makes each chapter. Of course, 
no single method of organizing a hard 
disk is appropriate for every type of 

work. I'll suggest two here; you may find 
others that work better for your needs. 
The point is to have a deliberate system. 

Plan I: A File Strategy for 
Short Documents 

Perhaps the simplest way of avoiding 
confusion on your hard disk is to by 
means of the following method: 

• Create a directory on your hard disk 
to contain all your Ventura docu
ments; 

• Within that directory, create a 
unique subdirectory to hold all the 
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files associated with a particular 
chapter. 

This method is good for fairly short 
documents-i.e., those consisting of a 
single chapter. This applies to forms, bus
iness reports, short technical manuals, 
and newsletters. Later in this chapter, 
we'll cover a different method that is sui
table for longer documents, such as 
books and technical manuals. 

Figure 3 illustrates this method. On 
the hard disk, ,the subdirectory that holds 
all the Ventura documents is VPDOCS. 
Within that subdirectory, a subdirectory 
is created to hold each new chapter. 
These subdirectories are given names 
that identify the type of document within. 
For example: FORMl, FORM2, BKl, 
BK2, BK3, BK8, etc. If necessary, you 
might set up even more levels. 

Within each subdirectory are all the 
files associated with a given chapter: 
document files, a chapter file, caption 
files, a style sheet file, image files, etc. 

One big benefit of isolating all the 
files associated with a document is that it 
automatically provides protection for the 
style used with that document. Other
wise, if you make a change to a tag 
within one publication, perhaps to make 
the text fit the needs of that document's 
pagination, you will also affect any other 
publications you have saved that share 
the same style sheet. 

Another benefit of the one chapter 
per subdirectory principle is that it allows 
you to easily move documents from one 
system to another or to take documents 
off the hard disk for floppy disk archiv-

ing when more room needs to be created 
on the hard disk. 

Here are the specific steps to take to 
implement the system I've described 
above: 

• From the DOS prompt, create a 
directory for all your Ventura docu
ments. Type 

Me \VPDOCS. 

• Before beginning work on a docu
ment with Ventura, create a new 
subdirectory to hold the document. 
For example, if the document is a re
port, type 
Me \VPDOCS\REPORTl 
Copy all text and graphics files into 
the document subdirectory. 

• After you enter Ventura, load the 
master style you want to use from 
the TYPESET subdirectory by 
selecting Load Diff. Style from the 
File menu. Place the cursor on the 
Directory line, press Escape to re
move the entry that is already there, 
and type 
C:\TYPESET\ *.STY 
to see the list of styles. Select the 
style you want to use as the master 
template for this document. With 
that style showing on the Selection 
line, select OK or press Enter. 

• Select Save As New Style from the 
File menu. Place the cursor on the 
Directory line, press Escape to clear 
the line, and type 
C:\VPDOCS\REPORTl 
Then on the Selection line type 
REPORT1.STY 
and select OK. 
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Subdirectories 
(each 

contains one 
publication) 
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subdirectories for 

chapter (and 
style), picture, 
and text files 

Chapter, 
style sheet, 
and Ventura 
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files 

I CHAP1.CHP 

i 
CHAPSTYL\ 

i 
PUS1\ PUS1.STY 

C:\ PICTURES\ 
PUS2\ CHAP2.CHP 

TEXT\ 
PUS3\ CHAP3.CHP 

CHAP3.CAP 

Figure 4: A suggested directory structure/or mulitple-chapter documents such as books 
and technical manuals. 

• From the File menu, select Save 
As... Enter C:\ VPDO CS\REPORT 1 
on the Directory line. On the Selec
tion line type 
REPORT1.CHP 
and select OK. 

If you follow the above steps, each 
chapter you create will have its own 
unique subdirectory, containing all the 
text and graphics files associated with 
that chapter, along with all the files 
generated by Ventura itself. 

Plan II: A File Strategy for 
Long Documents 

Now let's consider a different procedure 
that is more appropriate for long docu
ments containing many chapters. It is il
lustrated in Figure 4. In this method you 
still create a new subdirectory for each 
document, but not for each chapter of that 
document. Instead, within the document 
subdirectory you create a subdirectory for 
all text files, a subdirectory for all 
graphics files, and a subdirectory for all 
style sheets and chapter files. Other files 
generated by Ventura will automatically 
be stored with the chapter files. 
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Archiving and Transfering 
Documents 

Often it is necessary to transfer all the 
files associated with a document from 
one computer system to another. This 
might be necessary, for example, if the 
computer used to create the dOGument is 
not hooked up to a laser printer. Another 
task that is frequently necessary is to ar
chive all the files associated with a docu
ment onto a floppy disk to clear some 
room on the hard disk. 

If you have stored all the files as
sociated with a document in a single sub
directory unique to that document, it is a 
relatively simple matter to use the DOS 
Copy command to transfer all the files 
from that subdirectory onto a formatted 
blank disk. But watch out: when you later 
recopy these files onto another computer 
or back onto the same computer, they 
must be placed back into a subdirectory 
with the identical name. For example, if 
they were originally in C:\ VPDOCs\
BOOKS on computer A, they will have to 
be copied into subdirectory C:\ VP
DOCS\BOOKS on computer B. 

Why is it necessary to replace them 
in an identical subdirectory when you use 
the DOS Copy command to move them? 
The reason is that Ventura's master file, 
the .CHP file, keeps track of all the files 
that make up a document both by name 
and by subdirectory. If one of the text 
files that makes up a document is moved 
to another subdirectory, the program will 
not be able to find it. 

There's another way to transfer 
documents, which has the advantage of 

not requiring you to have the same sub
directories on both the source and the 
destination computer. It is to use Ven
tura's Multi-Chapter option. 

Using Multi-Chapter for 
Backups 

In general, moving the files for a chapter 
onto a floppy and then back onto a hard 
disk is best done with the Multi-Chapter 
selection in the Options menu. Despite its 
name, the Multi-Chapter selection can 
and should be used even for backing up a 
single chapter. Its usefulness is that it au
tomatically finds all the files associated 
with a given chapter, transfers them to 
the new location, and alters the pointers 
in the CHP file to reflect that new loca
tion. 

You should use the Multi-Chapter 
selection no matter which direction 
you're going: both when you copy a 
document from a hard disk onto a floppy 
disk, and when you copy a document 
from a floppy disk onto a hard disk. Also, 
you can use it to copy a document into a 
new subdirectory if you reorganize your 
hard disk and find this necessary. 

Here are the steps to follow in using 
the Multi-Chapter selection to copy all 
the files associated with a chapter onto a 
floppy: 

• Select the Options menu. 

• Select the Multi-Chapter option. 

• Select Add Chapter in the dialog 
box. 

• Select the appropriate Chapter file, 
just as you would to open a chapter. 



(for example, on the Directory line, 
press Esc to clear the line and then 
type the name of the subdirectory 
containing the chapter you wish to 
move, followed by \*.CHP. The 
name of that chapter should appear 
in the list of files. Select the name 
and then select OK.) 

• The screen will now show the name 
of the Chapter file you have selected. 
Use your mouse to click on the 
Chapter name. If you do not confrrm 
your selection by clicking on the 
Chapter name, you will not be able 
to access the Copy All feature. 

• When Copy All lights up on the 
selections menu to the right, select 
Copy All. 

• The screen should list as Source the 
letter of your hard disk, the sub
directory that your chapter file is in, 
and the name of your chapter file. 
Change the first destination point to 
A: You can save time by selecting 
the option to Make All Directories 
the Same. Select OK. Then sit back 
and relax while Ventura copies your 
files. 

Restoring a Chapter from a 
Floppy to a Hard Qisk 

Restoring a chapter back onto a hard disk 
is similar to the above operation, but it is 
a little more complicated. The steps are 
as follows: 

• From the Options menu, select 
Multi-Chapter. 
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• Select Add Chapter. The dialogue 
box will display the drive letter of 
the hard disk together with a sub
directory name. Click on the Backup 
Button until the selection box lists 
the four drives. Then select drive A. 

• Ventura will display a list of the 
chapter files on the floppy . You can 
now select the one you wish to copy 
and select OK. That chapter will ap
pear in the MultiChapter list. To 
make Copy All light up, select the 
chapter name. If you don't click on 
the chapter name, the Copy All func
tion will not become available. 

• Select Copy All. 

• A dialogue box will appear indicat
ing a source and a destination. The 
source should be the name of your 
chapter file in drive A. Type the 
desired location in the first line and 
then select Make All Directories the 
Same As the First. Select OK. 

Tips on File Management 

Tip: The Whereis Utility 
Because the various files that make up a 
document can be stored in different sub
directories, you may at times find it diffi
cult to locate a particular file. A handy 
utility for such circustances is 
WHEREIS.COM, which is available 
from most public domain software col
lections. To locate any file on your hard 
disk, you type WHEREIS filename, and 
WHEREIS lists all subdirectories con
taining that file. You can also use 
WHEREIS with wildcards. For instance, 
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WHEREIS * .PCX will show you the 10-
calion of all your files in PC Paintbrush 
format. 

Tip: Watch Out for Ventura's Long 
Reach 
As you know, Ventura throws its own 
embedded commands back into your text 
file. Therefore, any change you make to a 
text file while it is a part of a chapter file 
will have a permanent effect, when you 
save your chapter. Since this is a bit com
plicated in the abstract, consider the fol
lowing example. 

A technical writer wanted to make 
three somewhat different versions of a 
technical manual for three somewhat 
different models of a product. At first, 
she thought that the substitutions were so 
minor she might as well make them 
directly in Ventura. But she soon realized 
that if she did, she would corrupt the 
original version of the manual (which she 
wanted to keep intact). So she did the fol
lowing instead: 

• She kept her original chapter intact. 

• She quit Ventura. 

• She went into her TECHDOCI sub
directory (where she kept not only 
her document files but also Word
Star command files). 

• She used the DOS COpy command 
to make a duplicate copy of her text 
file by another name. 

• She used WordStar's word pro
cessing features such as Search and 
Replace to make the changes that 
were necessary in her text file. 

• She returned to Ventura and loaded 
up the original chapter file. 

• She used the Edit pop down menu to 
REMOVE TEXT FILE; that is, to 
remove her original chapter's text 
file from the list of files. 

• She loaded her new text file. 

• From the File menu she selected 
Save As and saved the chapter under 
a new name. All her formatting fea
tures were preserved. In this case, 
she had two manuals that included a 

. number of picture files, and as luck 
would have it, the manuals were so 
similar that she could even leave the 
pictures as originally placed. By just 
making some very minor changes, 
she had two manuals done. 

Tip: Protect Those Style Sheets 
If you use the same style sheet for more 
than one publication, be careful. Anytime 
you make a change to a style sheet and 
you are not sure if you want to discard 
the existing style sheet with that name, be 
sure to save the new style under a differ
ent name. If you have inadvertently made 
a change, you may still be able to catch 
yourself before permanent damage has 
been done by selecting Quit from the File 
menu and abandoning the changes. 

Archiving style sheets on floppies is 
an additional step that may be prudent if 
you are working in a multi-user environ
ment-that is, if anyone other than you 
has access to the same computer. It is in
sidiously simple for one of your co-work
ers to thoroughly mess up your style 
sheet in a matter of seconds without real-



izing it, since the last style sheet to be 
used automatically pops up on the screen 
when someone sits down and types VP. If 
you have saved your style sheet onto a 
floppy, you can simply copy back the 
correct version. 

Tip: Keep Wordstar in the Same 
Subdirectory with Text Files. 
WordStar versions prior to release 4 were 
not capable of recognizing files in differ
ent subdirectories. The solution is simple: 
keep a copy of the word processor in the 
same subdirectory. 

The advantages of keeping a copy of 
. your word processor in your document 

subdirectory are numerous. Your word 
processor probably has a number of 
editing features that are not present in 
Ventura, such as Search and Replace. 
When you want to do some serious 
editing or rewriting, you quit Ventura and 
change into the subdirectory containing 
the document. When you have finished 
making the changes, you simply save the 
file and go back into Ventura. You don't 
even have to reload the file. Since Ven
tura stores a marker of where the file is 
located rather than the file itself, it will 
automatically incorporate your latest re
visions into the existing chapter file. 

Tip: What to Do When a Chapter 
Won't Load 
I hope this never happens to you, but it 
frequently happens with me that Ventura 
will simply refuse to load a chapter. 
When I select Open Chapter from the 
File menu, the program starts to load the 
chapter but then freezes, forcing me to re
boot. I've talked to other people who ex-
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perience the same thing, or who report 
that the program crashes all the way back 
to the DOS prompt. In any event, if this 
occurs, the first thing to do is simply try 
one more time. Often whatever was jam
ming the system turns out to have been a 
mysterious but transient fluke. 

If the problem persists, try the fol
lowing. 

• Rather than open one chapter 
directly from another, try selecting 
New from the File menu and then 
pulling down some of the menus. 
This falls under the category of 
"Voodoo Tricks." It works for me 
and it may work for you. 

• If your chapter uses lots of graphics 
and chapters files, try copying these 
into a different subdirectory or onto 
a floppy disk and then deleting them 
(or alternatively give them new 
names temporarily). Then attempt to 
reload. Ventura will object that it 
can't find all the constituent parts of 
your document, but it will possibly 
go ahead and load your new, 
slimmed-down chapter. 

• Go into the Ventura subdirectory and 
find the VP .INF file. This is the file 
that preserves the current default 
state of various settings, mainly 
those in the Options menu. Delete 
the file. If it can't find the INF file, 
Ventura will revert to its original de
faults. I've found this trick enabled 
me to load chapters that otherwise 
froze the system. Again, this borders 
on the occult, but it's worked for me 
and it's worked for others. 
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• If all else fails, find the most recent 
backup of your chapter. It will have 
the same name as your chapter file 
but will have the extension $lIP 
rather than ClIP. (You did select 
Keep Preferences: Yes in the Set 
Preferences menu, didn't you?) De
lete your ClIP file and change the 
$lIP extension to ClIP. This file 
should boot up, but be prepared for 
the fact that it will contain an earlier 
version of your chapter (the way it 
was when you saved 10 minutes or 2 
hours ago). 

Tip: When to Use DOS Copy Rather 
Than the Multi·Chapter Option 
You can save time by using the DOS 
Copy command to move a chapter from 
one computer to another under the fol
lowing conditions: 

• If all the files used for the chapter 
are located in a single subdirectory. 

• If that subdirectory is the same on 
computer A as on computer B. 

If both conditions conditions are 
met, you can simply use the command 
COpy *. * to copy the contents of the 
subdirectory onto a floppy disk, and then 
use COpy *.* again to copy them from 
the floppy onto the second computer. 



III 

Using Ventura 





CHAPTER SEVEN 

Preparing, Loading, 
and Tagging Text 

WHILE GRAPHICS ARE certainly a big 
part of Ventura, text is the meat and po
tatoes of publishing. Even if it were un
able to handle graphics at all, there's no 
doubt that Ventura would be an ex
tremely successful program merely on 
the basis of its virtuosity with text. This 
chapter covers the basics of preparing 
text with a word processor, importing it 
into Ventura, and then applying tags from 
a Ventura style sheet. It doesn't cover the 
typographic or page layout aspects of 
creating a Ventura style sheet-for infor
mation on those topics, refer to Chapter 
8, "Typographics," and Chapter 12, 
"Document Layout Strategies." 

Preparing Text 

To create text you can use any of the 
most popular word processing programs. 
In addition, you can use Ventura's native 
text editor to type text directly into a 
document. As of Version 1.1, the list of 
word processor file formats that can be 

imported includes WordPerfect, WordStar 
3.3 and 3.4, WordStar UK, Microsoft 
Word, Windows Write, MultiMate, Xerox 
Writer III, and Xywrite III and IV. In ad
dition, files in DCA (Document Content 
Architecture) can also be imported. Word 
processors that can produce text in DCA 
format include Displaywrite III and IV, 
Volkswriter 3, Office Writer, WordStar 
2000, Samna Word, and Lotus Manu
script. 

Finally, Ventura can load plain 
ASCII text, which means that you can 
format Sidekick note files, Lotus 1-2-3 
spreadsheets, dBASE files, and files 
created by other spreadsheet and database 
programs. Generally, converting the out
put of such programs into ASCII format 
is done by creating a print file, that is, by 
specifying a file on your hard disk rather 
than the printer itself as the printing 
destination. For example, in Lotus 1-2-3, 
the command sequence to create a print 
file is /Print File. When you create a print 
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Text Preparation Guidelines 

Text Attributes 

Text attributes that carry 
over into Ventura: 

• boldface, superscript, sub
script, strikethrough, under
line, discretionary hyphen, 
and nonbreaking space. 

Attributes that Ventura ig
nores: 

• justification, margins, cen
tering, headers, and fonts. 

Tabs 

• Tab characters are carried 
over, but positions set for 
tabs in the word processor 
are not. 

Line Endings 

ASCII Text 

• Separate paragraphs with 
two carriage returns. 

• Import into Ventura as an 
ASCII file. 

Word Processed Text 

• Separate paragraphs with 
one carriage return; 

or 
Separate paragraphs with 
two carriage returns and in
clude @PARAFILTR ON = 
as the first line of the file 
before importing. 

• Import into Ventura under 
the appropriate word proc
essor format. 

Table 1: The main rules of thumb for preparing text prior to importing it into Ventura. 



PREPARING, LOADING, AND TAGGING TEXT 109 

file, make sure you fIrst set your margins 
to zero. 

automatically carried over when that file 
is loaded into Ventura: boldface, super
script, subscript, strikethrough, underline, 
discretionary hyphen, and nonbreaking 
space. Discretionary hyphens are hy
phens that will only be printed if they 
occur at a line break. Nonbreaking spaces 
are spaces that will not be broken by au
tomatic word wrap; they are used if you 

Attributes: Converted and 
Ignored 

In preparing text that will later be im
ported into Ventura, the following at
tributes in the word processed file will be 

Size of 
Imported 
Files 

Numberof 
Paragraphs 
Per Chapter 

Number 
of Tags Per 
Chapter 

Text Limitations 

SOOK 

8,000. 

128 

If the size of the file exceeds available 
memory, it will be spilled out to the hard disk 
(or to a RAM disk). When this happens, you'll 
notice a definite reduction in performance 
even if the file is smaller than SOOK. 

This is an approximate figure that depends on 
how much memory is taken for other uses 
such as graphics. 

The number of tags that can be included in a 
style sheet is 128. This includes tags you 
have created and tags generated by Ventura. 
In addition, if the text you are importing in
cludes tags that are not included in the cur
rent style sheet, they too will be counted and 
if the total is more than 128 the file will not be 
loaded. 

Table 2: Limitations for imported jiles, paragraphs per chapter, alld tags per chapter. 
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Embedded Codes 

Breaks and Spaces 

Line Break 
Discretionary Hyphen 
Non-Breaking Space 
Thin Space 
Figure Space 
En Space 
Em Space 

<R> 
<-> 
<N> 
<I> 
<+> 
<"'> 
<-> 

Character Attributes 

Boldface 
Italics 
Medium Weight 
Light Weight 
Small 
Underline 
Double Underline 
Overscore 
Superscript 
Subscript 
Turn Off Special Attributes 

<B> 
<I> 

<M> 
<l> 
<S> 
<U> 
<=> 
<0> 
<1\> 
<v> 
<D> 

Typeface (where nnn is the typeface number) 
Point Size (where nnn is the point size) 

<Fnnn> 
<Pnnn> 

Special Codes 

Footnote 
Picture Anchor (same page) 
Picture Anchor (below) 
Picture Anchor (above) 
Hidden Text 

<$Ftext> 
<$&anchor name> 

<$&anchor name[v]> 
<$&anchor name[I\]> 

<$!text> 

Table 3: These codes can be used to format text with a word processor prior to 
importing. 
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want to keep a particular combination of 
words all on the same line. 

Other formatting done using the 
commands provided by your word pro
cessing program in your word processed 
files will not carry over once you have 
loaded a document into Ventura. And 
when you save the chapter containing 
that file, the formatting will be lost in the 
original file. This implies that when you 
prepare text for Ventura you shouldn't 
waste time setting margins, centering 
headlines, and the like. 

Preformatting 

On the other hand, it is possible to embed 
a variety of special formatting codes in 
text files, a procedure known as "prefor
matting." Preformatting may be appro
priate in work environments where writ
ers and editors need to specify certain 
formatting information to the production 
staff. By embedding the appropriate 
codes in their text files, they can specify 
words to be printed in boldface, for ex
ample, or lines to be bulleted. The topic 
of embedded codes is covered below. 
First, however, we need to mention a 
couple of peculiarities in how Ventura 
handles line endings and tabs. 

Line Endings 

In standard ASCII format, line endings 
are indicated with a carriage return, the 
same character used by Ventura to denote 
the end of a paragraph. Obviously, it 
wouldn't make sense for Ventura to make 
each line of the ASCII text file a separate 

paragraph, so Ventura simply ignores any 
isolated carriage returns it encounters. 
When the program encounters two car
riage returns in a row, however, it substi
tutes a paragraph break. Thus, when 
creating an ASCII file, press Enter twice 
to separate your paragraphs. 

With spreadsheets, you do want 
every line of information to constitute a 
separate paragraph once the file is im
ported into Ventura; otherwise, separate 
lines would run together and wrap around 
continuously rather than breaking. The 
solution here, after creating a print file 
from Lotus, is to load the file into Ven
tura as a WordStar file. For more sugges
tions on how to properly save and load 
Lotus worksheets and graphics, see 
Chapter 16, "Lotus Worksheets and 
Graphics. " 

Unlike ASCII, most word processor 
formats do not use a carriage return to in
dicate a new line. Like Ventura itself, 
they reserve the carriage return command 
to indicate new paragraphs. Thus, Ven
tura doesn't have to filter out solitary car
riage returns from such files. With ASCII 
files, it was recommended above that you 
press Enter twice between each para
graph. With files in word processor for
mats, that's not necessary; in fact, if your 
files do have two carriage returns be
tween every paragraph those carriage re
turns will result in an extraneous blank 
paragraph once the file has been im
ported. 

Many people, of course, are in the 
habit of pressing Enter twice between 
paragraphs in order to make the text more 
readable. You can continue to do that if 
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you embed the following command on 
the fIrst line of your text fIle: . 
@PARAE'ILTR ON = 
with spaces both before and after the 
equal sign. When it encounters this com
mand, Ventura will automatically replace 
double carriage returns with paragraph 
breaks. 

Beware of Tabs 

Ventura does allow you to include tabs in 
your word processed document. How
ever, as discussed in Chapter 8, "Typo
graphics," tabs are handled differently by 
Ventura than by word processing pro
grams. For example, a tab placed in 
justified text will be ignored. And a tab 
placed in unjustifIed text will prevent that 
text from wrapping onto a second line. 
So, unless you need to use them for a 
table or for some other special purpose, 
avoid including tabs in the fIles you im
port. In particular, do not use a tab to in
dent the fIrst line of a paragraph. Instead, 
use the In/Outdent setting from the 
Alignment dialog box (in the Paragraph 
menu) to set your indents. 

WordStar tabs are a special case. If 
Vari-Tab is turned on in WordS tar, the 
program will insert spaces into a docu
ment rather than a true tab. Then, after 
the document is loaded into Ventura, the 
"tab" will show up as five or six fixed 
spaces on the screen (denoted by a 
marker that looks like an upward point
ing staple). To turn Vari-Tab off, use Ctrl
o Ctrl-V. Also, when preparing text with 
VlordStar you should turn soft hyphens 
and hyphen help off. 

Embedding Formatting 
Information 

Embedded formatting is a topic that you 
don't need to concern yourself with while 
you are learning Ventura. At fIrst, you 
can simply create your text with your 
word processing program and do all the 
formatting within Ventura. However, 
after you become profIcient at formatting 
within Ventura, you may decide to ex
plore the possibilities for embedding 
special formatting codes in your original 
text fIles. There are two possible reasons 
for using embedded formats: 

• In organizations where one work 
group prepares text and a different 
work group lays it out with Ventura, 
embedded formatting may provide a 
way of giving the first work group a 
larger role in formatting text. 

• Embedding codes, especially with 
the aid of a keyboard macro pro
gram, is frequently faster than doing 
the formatting within Ventura. 

The following types of formatting 
can be done with embedded codes: 

• Breaks and Spaces. For example, to 
force a line break you would insert 
<R> at the point where you want the 
line break to occur. To insert a dis
cretionary hyphen, insert <->. For 
other codes, see Table 3. 

• Character Attributes. Examples in
clude uppercase or boldface. The 
codes for such attributes are shown 
in Table 3. Note that to format a 
word with <B> you must end the 
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Nonkeyboard Character Codes 

128 c; 151 U 174 « 197 -
129 ii 152 Y 175 » 198 0 

130 e 153 0 176 a 199 A 
131 it 154 D 177 (5 200 A 
132 a 155 ¢ 178 0 201 13 
133 a 156 £ 179 ~ 202 E 
134 (\ 157 ¥ 180 re 203 E 
135 ~ 158 c 181 <E 204 i 
136 e 159 f 182 A. 205 f 
137 e 160 a 183 A 206 i 
138 e 161 i 184 6 207 I 
139 1 162 6 185 § 208 0 
140 i 163 U 186 :!: 209 6 
141 i 164 fi 187 t 210 6 
142 A 165 N 188 ~ 211 S 
143 A 166 il 189 © 212 S 
144 E 167 Q 190 ® 213 U 
145 re 168 l, 191 TM 214 U 
146 iE 169 " 192 215 U " 
147 0 170 " 193 216 Y ... 
148 0 171 < 194 %0 217 B 
149 0 172 > 195 • 218 Z 
150 ii 173 i 196 -

Table 4: The code assignments for the nonkeyboard characters of Ventura's 
International character set. To embed these characters in a file prior to importing the 
file into Ventura, type the code number in angle brackets. For example, to insert:t in 
text, type <186>. Once the file is loaded into Ventura, you can embed a nonkeyboard 
character into text by holding down the Alt key while typing the code on the numeric 
keypad. For example, to insert :t from within Ventura, type Alt-186. To see the code 
assignments for Ventura's Symbol typeface, load the chapter CHARSET.CHP from the 
TYPESET directory. 
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formatting with <D>, not with a sec
ond<B>. 

• Special Codes. You can embed for
matting information for footnotes, 
anchors, and hidden text. See Table 
3. 

• Nonkeyboard Characters. Only those 
characters in the ASCII range below 
127 are displayed on the keyboard, 
yet many fonts include characters 
numbered from 128 to 255. These 
include symbols needed by 
European alphabets, graphics sym
bols, typographic symbols, and 
special symbols. To embed a non
keyboard character in text, insert its 
ASCII code within angle brackets. 
For example, to insert the © sign, in
sert <189> at the appropriate place 
in your text. A list of codes is pro
vided in Table 4. 

An Example 

Here's the sequence that was used to pre
pare the text files for this book: 

• First, text was created in normal 
fashion using a word processor. 

• Next, text was run through the word 
processor's spelling checker. 

• Third, a search and replac~ was done 
to replace every occurrence of two 
consecutive hyphens (--) with the 
ASCII characters for a true dash (
), <197>. 

• Fourth, a search and replace was 
done to replace every occurrence of 
a space followed by a straight quota-

tion mark (") with the ASCII 
character for a left quotation mark 
("), <169>. 

• Fifth, a search and replace was done 
to replace every remaining occur
rence of a straight quotation mark 
with the ASCII character for a right 
quotation mark ("), <170>. 

• Sixth, tags such as "@BULLET = " 
and "@SUBHEAD = " were 
embedded in the text. We'll cover 
embedded tags later in this chapter. 

Loading Text 

Once you have created a text file using 
your word processor (or by generating a 
report file or print file with your database 
program or spreadsheet), you can load 
the file into Ventura. The procedure for 
loading text files into Ventura is sum
marized briefly as follows. For a more 
detailed description, please refer to the 
tutorial chapters in Section I of this book. 

• Create a frame on a Ventura page, or 
select the base page. 

• Select Load Text/Picture from the 
File menu. 

• Select the appropriate file type in the 
Load Text/Picture dialog box. 

• Use the Backup Button (the small 
black square) to select the directory 
containing the file. For a detailed ex
planation of the Backup Button, see 
Chapter 6, "Managing Files." 

• The text file will now be listed in the 
list of files. To load it into the cur-
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rent frame, point to the name of the 
file and click the mouse button. 

• If the file is not immediately loaded 
onto the page, select the Framing 
icon, select the frame you wish to 
load it into and again select the name 
of the file. 

Ventura's Text Editor 

Having loaded a text file into Ventura, 
you can alter it using Ventura's internal 
text editor, which is activated when you 
select the Text icon. Note that any 
changes made using Ventura's text editor 
will be reflected in your original text file, 
so if you want to preserve the original 
version of that file, be sure to make a 
copy before editing it with Ventura. 

The operation of Ventura's text edi
tor is simple and intuitive. To insert text, 
you place the cursor in the desired spot, 
click once to insert the text editing cur
sor, and begin typing. You can move the 
text editing cursor by using the keyboard 
cursor keys. Forward deletion is done 
with the Del key; backward deletion with 
the Backspace key. To highlight a block 
of text you hold down the mouse button 
while dragging it across the desired text. 
Alternatively, you place the text cursor at 
one end of the block, then move the 
mouse cursor to the other end and hold 
down the Shift key while clicking. 
Blocks can be deleted to the buffer by 
pressing Del, and can be inserted into a 
different location by pressing Ins. Table 5 
summarizes these and other operations 
that are available in text editing mode. 

Tagging Text 

As described in Chapter 4, "How Ventura 
Works," Ventura stores information about 
a document in three locations: the chapter 
file (ClIP), the Ventura information file 
(INF), and the style sheet file (STY). ~he 
style sheet file contains some informatIon 
that applies to the document as a whole, 
such as the settings for size and orienta
tion of the paper. Mainly, however, it 
stores a list of tag names and the format
ting information associated with each tag. 

To tag text, you first have to load a 
style sheet. This is done by selecting 
Load Diff Style from the File menu. 

If you load one of the style sheets 
provided with Ventura (co~ta~ned in t.he 
Typeset subdirectory and mdicated wIth 
an & as the first character), you should 
make sure to save it under a new name 
before you make any modifications. That 
way, the sample style sheet will remain 
intact for future use. 

Once you have loaded a style sheet, 
its name is shown in parentheses at the 
top of the screen. Now you can start tag
ging. 

Tags can only be applied to entire 
paragraphs. To format a portion of a para
graph, such as changing a single word to 
a different font, use the procedure de
scribed below under "Formatting Words 
Within a Paragraph." 

The procedure for tagging text is as 
follows: 

• Select the Tagging icon. 

• Select a paragraph. 

• Select a tag name from the Assign
ment List. 
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Ventura'S Text Editing Operations 

DEL - Deletes one character to the 
right of the cursor. Or, if you 
have selected a passage by 
dragging a cursor across it, the 
Del key places the selected 
passage in the scrap (i.e. saves 
it for later insertion). You can 
use this for moving blocks of 
text. 

INS - Inserts material from the scrap 
at the cursor point. 

BACKSPACE - Deletes one character 
to the left. 

CURSOR KEYS - Once you have 
clicked the mouse while the 
cursor is within a passage of 
text, a separate text cursor ap
pears on the screen (a thin ver
tical line). You can move this 
with the cursor keys. 

HOME AND END - Move you to the 
first or last page of the docu
ment. 

PGUP AND PGDN - Move you to the 
previous page or the next page. 

ENTER - Starts a new paragraph. 

CTRL·ENTER - Inserts a line break 
(i.e. starts a new line without 
starting a new paragraph). 

CTRL·HYPHEN - Inserts a discretion
ary hyphen. 

CTRL·SPACEBAR - Inserts a non
breaking space. 

CTRL-SHIFT·F - Inserts a figure space 
(1/4 the width of an Em space). 

CTRL·SHIFT·N - Inserts an En space 
(1/2 the width of an Em space). 

CTRL .. SHIFT·M - Inserts an Em space 
(measured as the same width 
as the current font; for example, 
in 12-point text an Em space 
measures 12 points in width, or 
1/6 inch). 

CTRL·SHIFT·[ or CTRL·SHIFT·] Inserts 
a left or right quotation mark. 

CTRL·L· Inserts an En dash 

CTRL·] - Inserts an Em dash. 

CTRL·SHIFT·T - Inserts a thin space. 

CTRL·SHIFT·C - Inserts ©. 

CTRL·SHIFT·R - Inserts ®. 

CTRL.SHIFT.2 - Inserts ™ 

Table 5: The text editing commands provided by Ventura when you select the Text icon. 
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Altering the attributes of a tag is 
done by selecting a paragraph and then 
selecting options from the Paragraph 
menu. To create a new tag, select the Add 
New Tag button and copy the attributes 
of a similar tag. Then use the menu op
tions to customize the tag. 

The options for customizing a style 
sheet are discussed in Chapter 8, "Typo
graphics," Chapter 9, "Using Fonts," and 
Chapter 11, "Graphics." 

Tagging With the Function 
Keys 

Within Ventura, it is also possible to 
speed up tagging by using the Assign 
Function Keys option in the Paragraph 
menu. You can assign up to ten tags to 
the ten function keys and perform tagging 
without leaving text mode. Select the As
sign Func Keys option of the Paragraph 
menu (or press Ctrl-K). 

Tagging With a Word Processor 

You can attach tags to the elements of a 
document before importing it into Ven
tura from any word processor. Simply 
type the @ symbol, the name of the style 
in capital letters, a space, the = sign, and 
another space. Thus, all tags take the 
form @tagname = . Better yet, use a key
board macro program such as SuperKey. 
With such a program you can assign any 
string of characters to a single key com
bination. For example, store the phrase 
"@SUBHEAD = " as Alt-S. To format all 
subheads, you merely type Alt-S at the 
beginning of each. 

Note: when you insert tags with your 
word processor, the @ sign must be the 
fIrst character in the line. Otherwise it 
will not be recognized as a tag. 

Generated Tags 

When you create text within Ventura 
using the box text, caption, header, and 
footer operations, Ventura automatically 
creates tags called generated tags. These 
tags all begin with the letter Z and are not 
listed in the sidebar unless you select 
Preferences from the Options menu and 
specify Generated Tags: Shown. 

You can alter generated tags in the 
same manner used to alter other tags. You 
can also assign new tags to boxed text 
and captions; headers and footers, 
however, can only be tagged with the 
generated Z tags. This allows text in two 
different boxes, or text for two different 
captions, to be formatted with different 
fonts and typographic attributes. 

Formatting Words Within 
Paragraphs 

Although tags apply only to entire para
graphs, you can use the Set Font option 
to make formatting changes within a par
agraph. The procedure is as follows: 

• Select Text mode. 

• Select a passage of text by dragging 
the mouse cursor across it. 

• Select one of the attributes in the as
signment list. 
or 
Select the Set Font option. 
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• Enter the desired font settings in the 
dialog box. 

Tips 

Tip: Removing Tag Names from Text 
Files 
Like cats, most documents go through 
many lives. Typically, not long after a 
technical manual is written and printed, a 
writer begins work on the next revision. 

With Ventura, any changes made up 
and saved in the chapter file are reflected 
back in the original document file. That 
provides a great deal of convenience in 
keeping the document up to date. The 
one drawback of Ventura's way of work
ing is that the numerous tags embedded 
in a document become distracting. 

Let's say you've completed printing 
out a document and now wish to remove 
all the tags from the original text file so 
that you can continue editing it without 
the distraction of the embedded @ signs, 
tag names, and = signs. Obviously, you 
could go through the file with your word 
processing program and manually delete 
all the tags. But there is a quicker proce
dure: 

• From the File menu, select Save As. 

• Enter a new chapter name on the 
Selector line. 

• Select OK or press Enter. 

• From the File menu, select Load 
Diff Style. 

• Click on the Backup Button (the 
small black box) to return to the root 

directory, then select the TYPESET 
directory. 

• From the list of styles, select DE
FAULT.STY. 

• From the File menu, select Save. 

• Quit from Ventura, load your word 
processor, and load the document. 
All the tags will be removed. The 
reason is that the DEFAULT style 
sheet only uses the Body Text style, 
which is not embedded in the docu
ment (since it is the default style for 
all style sheets). 

Tip: Reminding Yourself of the 
Function Key Assignments 
For a quick reminder of the function key 
assignments, press Ctrl-K. This will show 
you the names of the function keys and 
the tag assigned to each. 

Tip: Tagging with Microsoft Word 
When using Microsoft Word to prepare 
pre-tagged text for Ventura Publisher, the 
F3 key can be used for rapid tagging of 
paragraphs. Save each tag name, 
preceded with an @ and followed by a 
space, an equal sign, and another space; 
for example 
@HEADLINE = 
in a glossary and assign each glossary a 
one or two letter name. To do that, type 
the passage you wish to assign to a glos
sary, highlight the passage, and press Esc 
for the Word command line and then C 
for the Copy command. When Word 
prompts you with Copy to: {}, type a one 
or two letter name. To apply this tag to 
the passage, place the cursor at the begin
ning of the first line of the paragraph, 
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press the key combination assigned to 
that tag, and immediately press F3. 

Tip: Reusing a Layout. 
If you use the same format over and over, 
such as printing a monthly newsletter, 
you can save time by reusing your layout. 
Most newsletters are best formatted by 
setting up a two or three-column master 
page, and then drawing a frame for each 
column. After printing out the newsletter, 
remove the text files from the frames and 
then save the chapter. Next time you for
mat the newsletter, you merely insert new 
text files into frames and adjust the 
lengths of the frames. 

Tip: Ventura's Default Style Sheet. 
Often it's easier to start from a scratch 
style sheet (i.e., one containing no tags) 
than to adapt one of the style sheets pro
vided with Ventura. When you need to 
start with a blank style sheet, select DE

FAULT.STY from the \TYPESET directory. 
This style sheet only contains one tag, the 
one for Body Text. 

Tip: Saving Formatting Information 
If your word processing file contains for
matting information that Ventura does not 
recognize when it loads the file, that in
formation will be stripped away and lost 
during the loading process. If you want to 
preserve the formats of your original 
document, save a new copy under a 
different name before you load it into 
Ventura. 

Tip: Keeping Track of Tags 
In the sidebar, tags are listed in alphabeti
cal order, and those that begin with num-

bers precede those that begin with letters. 
By paying attention to how you name 
your tags, you can make sure that the 
ones you use most frequently are closest 
to the top of the list. If you are using a 
single style sheet for a multiple chapter 
document such as a book or a manual, it 
makes sense to group the tags generated 
specifically for one of the chapters in the 
document together. For example, when 
you're working in Section 5 of your 
manual, make S5 the first two characters 
of any tag you create. That way, if the 
style sheet grows to be too long and you 
have to use different versions for differ
ent chapters, you'll be able to tell which 
tags need to be preserved in which ver
sions of the style sheet. 

Tip: Converting Text Files 
A common problem in offices is convert
ing documents from one word processing 
format to another-for instance from 
MultiMate to WordPerfect. You can use 
Ventura for this routine task. Load the 
text file into a chapter, then select File 
Type/Rename from the Edit menu. You'll 
be given the option to choose a new sub
directory, name, and word processing for
mat for the file. 

Tip: Changing Generated Tags 
When you use the Box Text tool, Ventura 
automatically creates a tag called Z_BOX

TEXT. This tag won't be listed in the side
bar unless you select the Preferences op
tion from the Options menu and specify 
Generated Tags: Shown. Other generated 
tags include Z_LABEL CAP, Z_CAPTION, 

Z_FOOTER, and Z_HEADER. 
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Although Ventura starts out auto
matically formatting any boxed text with 
Z_BOXTEXT, you can assign other tags 
to boxed text. Thus, text in one box can 
look one way and text in another box can 
look another way. That is not the case 
with headers and footers, however. 

Tip: Using Shift-Select 
In Text mode, the problem often arises 
that after dragging the mouse across a 
passage of text, you realize that the 
highlight didn't include all the text you 
intended. To pick up the remaining 
characters, leave the passage selected and 
release the mouse button. Move the 
mouse so that the mouse cursor is posi
tioned just in front of the additional text 
you wish to select. Now hold down the 
Shift key while you click the mouse but
ton. The area selected will increase to in
clude the new portion. 

Tip: Exceeding the Tag Limit 
Sometimes, when trying to load a text 
file into a chapter, you may get the error 
message, "You've used 128 tags, files, or 
chapters" even if there are less than 128 
tags in your current style sheet. The rea
son for this seemingly erroneous error 
message is that when Ventura counts 
tags, it includes the tags you created in 
your style sheet; the tags automatically 
created by Ventura itself for captions, box 
text, and other attributes; and the tag 
names embedded in your text files, even 
if they're not included in the current style 
sheet. To correct the problem, use your 
word processor to remove tag names 
from the text file that are not included in 
your current style sheet. 

Tip: Fixing Problems With the Cursor 
on Large-Screen Monitors 
Ventura provides screen fonts for com
mon text sizes, including 10, 12, 14, 18, 
24, and 36 points. If you're editing text in 
other point sizes, however, the characters 
may look rough and you may run into 
difficulties positioning the cursor. To 
overcome those problems, you can use 
DOS's Debug utility to generate fonts in 
odd sizes such as 9, 11, and 13 points. 

The procedure to create a 13-point 
font for Times Roman is as follows: 

• Locate the file IBIvlET121.EGA in 
the VENTURA directory. 

• Type 
COpy ~BMET12~.EGA ~BMET13~.EGA 

• Type 
DEBUG ~BMET13~.EGA 

• Debug will provide you with a new 
prompt (-). Type 

-d and press <Enter> 
-e 0102 and press <Enter> 

• You'll now see oc. Type 

OD and press <Enter> 
following the OC. What you're 

doing is substituting hex 13 for hex 12 in 
the third byte of the file. Now type 

-wand press <Enter> 
-q and press <Enter> 
to save your work and quit. Follow 

the same procedure to create 9- and 11-
point type from la-point, IS-point type 
from 14-point type, etc. Don't create un
necessary screen fonts, however, because 
each screen font in the system reduces 
the amount of memory available for 
holding text and graphics. 



PREPARING, LOADING, AND TAGGING TEXT 121 

Tip: Problems Changing Text 
Attributes 
Sometimes when you try to apply text at
tributes to a word or phrase, using the list 
of attributes in the Text mode sidebar, 
you'll find that the attributes won't take 
effect. The first thing you should do is 
highlight the passage, select Normal from 
the list of attributes, and then select your 
attributes again. If this does not work, the 
problem is that hidden attribute settings 
are preempting the attributes you wish to 
to apply to the text. For example, when 
you highlight a passage and select Bold, 
the text will remain in italics. In that case, 
position the cursor just in front of the 
material you are attempting to reformat 
and press Del. When know you're in the 
right location when you see the words 
Attr. Setting in the Current Selection 
Box, located in the lower left corner of 
the screen. 

Tip: A void Double Spaces 
If you ever took a typing course, you 
were probably taught to type two spaces 
after every sentence. When preparing text 
for Ventura, you should avoid doing so or 
else do a search and replace to get rid of 
double spaces. The reason is that Ventura 
converts the first space into a normal 
space but converts the second space into 
a non-breaking space. 

Tip: Suppressing Hyphenation 
You can keep Ventura from hyphenating 
a word by placing a discretionary hyphen 
«-» directly in front of the word when 
you prepare text with your word proces
sor. 

Tip: Fixing an Isolated Paragraph 
Mark 
After you load text into Ventura you'll 
sometimes notice a blank line with noth
ing on it but the paragraph sign (~). This 
is caused if you press the Spacebar after 
the period of a sentence and then press 
Enter. To get rid of the the unwanted 
blank line, select the Text icon, place the 
cursor in front of the paragraph mark, and 
press Backspace. 

Tip: Beep 
When you're loading text, you may hear 
a beep. This occurs if there are more than 
128 text files in the directory you are 
loading text from. The purpose of the 
beep is to notify you that only the first 
128 files in the directory are being listed. 

Tip: Text Selection Won't Go Away 
Sometimes when you highlight a passage 
of text and then attempt to highlight a 
different passage, the first passage will 
stay highlighted. The solution is to press 
PgDn and then press PgUp. The un
wanted highlighting will disappear. 

Questions 

Q: After I tagged some text in a frame it 
disappeared. VVhathappened? 

A: The problem is one of the following: 
(1) You switched to a font that was too 
large for the frame. Ventura won't display 
or print any characters that it can not fit 
entirely character within a frame. (2) You 
specified additional space above the text, 
which pushed the text out of the frame. 
To fix the problem you need to change 
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the specifications associated with the tag. 
This might seem impossible, however, 
since the text is no longer visible. If you 
haven't selected any other paragraphs, 
the paragraph you were working ,:i~h 
should still be selected even though It IS 
not visible. If the paragraph is no longer 
tagged, you can still fix the problem by 
tagging another paragraph with the sa~e 
tag and changing the font or the spacmg 
for that paragraph. The change will auto
matically apply to the disappeared text 
and it will appear again. 

Q: I drew a frame, selected the File 
menu, selected the Load Text/Picture 
option, and selected a text file to load. 
However, the text did not load into the 
frame and the frame remained blank. 
How do I get the text to load into the 
frame? 

A: After you select the text file to load 
using the Load Text/Picture option, its 
name should appear in the Selection 
Menu on the left side of the screen. 
Select the frame you want to pour the 
text into. When you point at its name in 
that menu and click with the mouse, it 
will appear in that frame. 

Q: I'm laying out a newsletter that has 
articles in several different files. I 
loaded them into Ventura by selecting 
the Load Text/Picture option from the 
File menu. In the Load Text/Picture 
dialog box I selected # of Files: Several. 
Then I selected three files. However, 
only one of them appeared in the 

document. How do I put multiple text 
files in a chapter? 

A: If you are loading text onto the base 
page, you can only put one text file in a 
chapter. To create a chapter with multiple 
text files, such as a newsletter, you need 
to following a different layout method. 
Instead of loading text onto the base 
page, draw a frame for each column of 
your newsletter. Then load text files into 
these frames. An example of this way of 
working is in the tutorial chapter on lay
ing out a newsletter. 

Q: Why are some lines highlighted in 
black? 

A: This is a new feature of Version 1.1 
that shows "loose lines." Loose lines are 
lines in which Ventura has been forced to 
exceed the Maximum Space Width value 
in order to justify a line. Several solu
tions are available to correct a loose line. 
One is to insert hyphenate words in adja
cent lines. Another is to select Typo
graphic Controls option from the Para
graph menu and set Letter Spacing on. 
This causes Ventura to adjust the spacing 
between characters within words, as de
scribed in the Chapter 8, "Typographics." 
Note, however, that after you tum letter 
spacing on, the loose lines will still be 
highlighted. 

Q: I want to have two captions that are 
different. How can I do this, since they 
both use the Z_Caption tag? 

A: When you generate a caption it is au
tomatically assigned the Z_Caption tag. 
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However, you can then apply a different 
tag to a particular caption. 

Q: My footer appeared fine on the 
screen. However, when I printed the 
document it disappeared. 

A: The problem is that the footer is lo
cated in the unprintable area for your 
laser printer. This unprintable area varies 
for different printers. To find out the 
boundaries of the printable area, print 
CAPABILI.CHP, which is located in the 
Typeset subdirectory. You can print your 
footer if you either change the bottom 
margin of the underlying page or else 
change the top margin of the footer. 

Q: I tagged some text before loading it 
into Ventura by typing an @ followed by 
the name of the tag and an equal sign. 
However, the effect was that the name of 
the tag printed rather than causing the 
text to be formatted? Why? 

A: The most likely reason is that the @ 
sign was not positioned as the first letter 
of the line (perhaps you preceded it with 
a space or a tab). To be recognized by 
Ventura, the @ sign must be in the first 
line and the first column of a paragraph .. 
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Typographies 
TO BE ABLE to meet the demands of pro
fessional typographic applications, a 
desktop publishing program must have 
the flexibility to control spacing on a 
number of levels, must be able to create 
ruling lines, and must provide for selec
tion of fonts. In this chapter we cover 
spacing and ruling lines. Fonts are 
covered separately in Chapter 9, "Using 
Fonts," and Chapter 13, "Adding Fonts." 

The fITst level of spacing control is 
between the individual letters within 
words. That means being able to tighten 
up the spaces between pairs of letters to 
create a better pairwise fit (kerning), 
globally tightening up the spacing be
tween letters (tracking), and adjusting the 
spacing between letters on a line-by-line 
basis to assist the justification process 
(letter spacing). 

Second, such a program must pro
vide for controlling the spacing between 
words, termed spaceband or space width 
control. And it must provide the operator 
with the ability to embed spaces of a pre
determined, unalterable width in a line. 

Third, the program's typographic 
controls must allow control of the vertical 

spacing between lines and paragraphs 
(leading). 

Fourth, the program must allow con
trol of indents, tabs, margins, and spaces 
around illustrations and ruling lines. And 
it must provide such specialized features 
as large first capitals and bullets. 

With regard to generating rules, a 
program must be able to create a variety 
of vertical and horizontal rules of any 
thickness, and allow these lines to be 
freely positioned in absolute positions on 
the page as well as in positions relative to 
text. 

As of Release 1.1, Ventura does a 
very complete job of meeting all these 
demands of traditional typography. This 
chapter surveys the program's typo
graphic controls and then provides some 
tips on how you can use these features 
most effectively. 

Spaces Between Letters 

The spacing between characters is con
trolled primarily by a width table that is 
part of a font. Unless you are using a font 
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editor to create entirely new characters, 
there's no need to worry about this width 
table. Because of the width table, Ven
tura automatically performs proportional 
spacing, assigning more space to an i, for 
example, than to a W. For altering the 
spacing between letters, Ventura pro
vides four types of controls: (l) manual 
kerning, (2) automatic kerning, (3) track
ing, and (4) letter spacing. 

MANUAL KERNING: It is easiest to 
do manual kerning while you're in En
larged View. To perform manual kerning 
you select the Text function, then hold 
down the mouse button and drag the cur-

sor across the letter immediately to the 
right of the letter space that you wish to 
close up. Next, select the Set Font but
ton. A dialog box appears that allows you 
to type a value next to the word Kern. 
That value is the amount of space by 
which the highlighted letter and all letters 
to the right of it will be shifted to the left. 
If you don't want to use the units shown, 
point directly at the units with the mouse 
and click. For example, if the units 
shown are picas & points, you should 
change them to something else, to give 
yourself finer control over the placement 
of the letters. 

1 Kerning Options 

Menu/Option 

Page Menu: 
Page Layout 

Paragraph 
Menu: 
Typographic 
Controls 

Set Font 

Applies To 

Global Kerning 

Kerning at the 
Tag Level 

Manual Kern
ing 

Table 1: The three methods of kerning. 

Notes 

Selecting Globally On does not 
cause the document to be 
kern ed, it merely allows the au
tomatic kerning specified in each 
tag to go forward. Selecting 
Globally Off overrides the auto
matic kerning specified in each 
tag. It does not affect manual 
kerning. 

Selecting Automatic Kerning: On 
activates kerning for any para
graph assigned this tag. 

This option is used in Text 
mode. It moves the selected 
characters to the left. 



AUTOMATIC KERNING: Ventura 
provides two controls for automatic kern
ing. To control kerning on a tag-specific 
basis, select the Tagging function, then 
select a paragraph. From the Paragraph 
menu select the Typographic Controls op
tion. Select Automatic Kerning: On. Note 
that automatic kerning will only be per
formed if the font width table you are 
using includes a matrix of kerning values. 
Adobe's PostScript fonts do include that 
information; most other fonts do not. You 
can globally override the automatic tag
ging specified in the tags by selecting 
Kerning: Globally Off from the Page 
Layout option of the Page menu. Note 
that selecting Kerning: Globally On does 
not cause your entire document to be au
tomatically kerned; it merely turns off the 
override and allows kerning to occur in 
those paragraphs so tagged. 

TRACKING: The difference between 
kerning and tracking is that kerning 
means tightening up particular pairs of 
characters whose shapes allow them to fit 
more closely together, while tracking re
fers to uniform tightening up of the text 
in an entire paragraph. To change the 
tracking settings for a single tag, select a 
paragraph. From the Paragraph menu 
select the Typographic Controls option. 
Select the Looser or Tighter options, and 
enter an amount (always measured in 
Ems). The size of an Em is relative to the 
size of the font in the selected paragraph. 
One Em equals the point size of the font. 
So if the paragraph is set in 12-point 
type, an Em is 12 points, or 1/6 inch, 
wide. Setting the tracking to 0.050 Ems 
tighter would reduce the amount of space 
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between each character by .6 points, or 
1/60 inch. 

LETTER SPACING: In normal typo
graphy, adjusting the lengths of lines to 
create justified text is normally done by 
adding or subtracting the amount of space 
between words. Of course, adding too 
much space between words may give text 
an undesirable appearance. Lines in 
which the amount of space between 
words exceeds a certain desirable maxi
mum are referred to as "loose lines." To 
deal with a loose line, a typographic sys
tem can resort to increasing the amount 
of space between letters within words. 
This is known as "letter spacing." 

Here's how Ventura goes about set
ting lines. First, it tries to justify lines by 
adding space between words. If the 
amount of space between words exceeds 
a specified limit, you have a "loose line." 
The specified limit is the Maximum 
Space Width setting shown in the Typo
graphic Controls dialog box, selected 
from the Paragraph Menu. As long as you 
have chosen not to activate letter spacing, 
Ventura will go ahead and print loose 
lines, that is, lines in which spaces be
tween words exceed this maximum. 
However, if you turn the letter spacing 
option on, Ventura will attempt to fix the 
loose line by adding spaces between let
ters. 

To turn letter spacing on, start by 
selecting a paragraph. From the Para
graph menu select the 1Ypographic Con
trols option. Select Letter Spacing: On 
and enter a figure next to "Up to:" This 
controls the maximum amount of space 
that Ventura will add to the already ex-
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isting spaces between characters to try to 
fill out the line. 

To see which lines in a document are 
in need of letter spacing, select the Show 
Loose Lines option of the Options menu. 

Spaces Between Words 

Ventura provides several ways of con
trolling the spaces between words, 
known in typography as spacebands. 
These are as follows: (1) setting align
ment to ragged, in which all spacebands 
are of equal width, or to justified, in 
which spacebands are adjusted to make 
all lines of equal width; (2) minimum, 
normal, and maximum settings for space 
widths (these indicate the range of space
bands within which Ventura can adjust 
word spacing to justify lines); (3) four 
fixed spaces, which are unchangeable 

spaces inserted into text like characters; 
and (4) customized fixed spaces, a trick 
for creating spaces of any width using 
white type. 

Alignment and Spaceband 
Control 

The first way to vary the spaces between 
words is by choosing ragged or justified 
alignment. Start by selecting a paragraph. 
From the Paragraph menu select the 
Alignment option. Left, Center, and 
Right are all ragged alignments; if you 
select one of these the word spacing will 
be constant throughout the paragraph. It 
will be equal to the Normal Space Width 
setting in the Typographic Controls 
dialog box. 

If you select Justified in the Align
ment dialog box, Ventura will make all 

Figure 1.' The 
Typographic 

Controls dialog 
box. 

"Chapter n" TYPOGRAPHIC CONTROLS 

Autolllatic Keming: []IT] _ 
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letter Spacing: []I[] I!lII Up to: 0.100 Ellis 

Tracking: O.OS~ EllIs I looser I ImD 
0.600 • (space width) = 0.150 ElliS 
1.000 • (space width) = 0.250 ElliS 
2.000 • (space width) = 0.500 Ens 

Overscore Height 0.019 Shift t By: 0.333 inches 
Strike-Thru Height 0.019 0.104 
Underline 1 Height 0.019 Shift, By: 0.919 
Underline 2 Height 0.019 O.OSB 



lines the same length by squeezing the 
amount of space between words or by 
adding space between words. Minimum 
spacing will never be smaller than the 
setting indicated in the Typographic Con
trols dialog box under Minimum Space 
Width. If necessary to justify a line, Ven
tura will exceed the Maximum Space 
Width setting. Lines where that maxi
mum is exceeded are highlighted if you 
select the Show Loose Lines option of 
the Options menu. 

Fixed Spaces 

If you want to place spaces that are of a 
fixed width and will not be squeezed or 
expanded by Ventura, you can do so 
using several fixed space options. Ven
tura provides the following types of fixed 
spaces: figure spaces, Em spaces, En 
spaces, and thin spaces. 

FIGURE SPACE: The width of a fig
ure space is the same as the width of a 
numeral (traditionally in typesetting, all 
digits from 0 to 9 are given the same 
width). Such spaces can be used for 
aligning tables of numbers. To insert °a 
figure space into a passage using Ven
tura's text editor, hold down the Alt key 
while pressing the Spacebar. To insert a 
figure space into a passage using your 
own word processor, type a + surrounded 
by angle brackets. 

EM SPACE: The width of an Em 
space is the same as the point size of the 
font in use. Thus, an Em space is a pas
sage of 12-point Times Roman is 12 
points wide, or 1/6 of an inch. To insert 
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an Em space into a passage using Ven
tura's text editor, hold down the Shift and 
Ctrl keys while pressing the M. To insert 
an Em space into a passage using your 
own word processor, type an underline 
surrounded by angle brackets. «-». 

EN SPACE: The width of an En space 
is half the width of an Em space. Thus, a 
thin space in a passage of 12-point Times 
Roman is 6 points wide, or 1/12 of an 
inch. To insert an En space into a passage 
using Ventura's text editor, hold down the 
Shift and Ctrl keys while pressing N. To 
insert a figure space into a passage using 
your own word processor, type a tilde 
surrounded by angle brackets « ..... ». 

THIN SPACE: The width of a thin 
space is half the width of an En space. 
Thus, a thin space in a passage of 12-
point Times Roman is 3 points wide, or 
1/24 of an inch. To insert a thin space 
into a passage using Ventura's text editor, 
hold down the Shift and Ctrl keys while 
pressing T. To insert a thin space into a 
passage using your own word processor, 
type a I surrounded by angle brackets. 

CUSTOMIZED FIXED SPACES: Al
though Ventura provides four types of 
fixed spaces, you can create more simply 
by typing a character and setting its color 
to white. To do so, select the Text func
tion. Then type the character from the 
keyboard and highlight it with the mouse 
by dragging the mouse across it while 
holding down the mouse button. Select 
the Set Font button. From the font setting 
dialog box, select White as the color. On 
the screen the character will not be seen, 
but its place will be kept in the text. 
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How to Calculate Spacing Between Paragraphs 

Case 1 
When paragraph A and para
graph B have the same tag 

+ 

+ 

+ 

Interline space 

Interparagraph space 

Above space for A or 
Below space for B 

(whichever is greater) 

Width of ruling lines 

Total space between 
paragraphs 

Case 2 
When paragraph A and para
graph B have different tags 

+ 

+ 

+ 

Interline space for 
paragraph A 

Interparagraph space 
(only if identical for A 

and B) 

Below space for A or 
Above space for B 

(whichever is greater) 

Width of ruling lines 

Total space between 
paragraphs 

Table 2: The amount of space that Ventura places between two paragraphs is 
determined by four factors: interline spacing, inter paragraph spacing, above/below 
spacing, and width of ruling lines. 



Spaces Between Lines and 
Paragraphs 

Spacing between lines and paragraphs, 
termed leading in typography, is control
led by the Spacing option of the Para-. 
graph menu. For each tag, you can 
specify the spacing above the paragraph, 
below the paragraph, between lines of the 
same paragraph, and between two para
graphs with the same tag. In practice, the 
interaction of these various kinds of spac
ing becomes rather complex, but by 
knowing the rules Ventura uses to com
bine different kinds of spacing you can 
learn to control precisely the desired dis
tance between lines and paragraphs. 

Spacing is always measured from 
baseline to baseline. Thus, the space be
tween two lines is measured from the 
baseline of the first to the baseline of the 
second. Similarly, the space between two 
paragraphs is measured from the baseline 
of the last line in the first paragraph to 
the baseline of the first line in the second 
paragraph. 

INTERLINE SPACING: To set the in
terline spacing for a paragraph, select the 
Tagging function and select a paragraph. 
Select the Spacing option from the Para
graph menu. The Spacing dialog box will 
appear. Enter the desired figure for Int~r
line spacing. The figure you enter wIll 
determine the distance from the baseline 
of one line to the baseline of the next 
line. Since type is measured in points, it 
is generally best to use points as your 
measuring units. To change measurement 
units, point at the units themselves with 
the mouse and click. For example, to 
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change from inches to picas & points, 
point at the word inches and click. 

SPACING BETWEEN PARAGRAPHS: 
Any two paragraphs will automatically 
be separated by at least the amount of 
line spacing specified for the previous 
paragraph. Additional paragraph s~acing 
can be specified via three controls III the 
Spacing dialog box. To set these controls, 
first select the Tagging function and then 
select a paragraph. Select the Spacing op
tion from the Paragraph menu. The Spac
ing dialog box will appear. The three con
trols are (1) Above, (2) Below, and (3) 
Inter-Paragraph. 

To master Below, Above, and Inter
Paragraph spacing, you need to know the 
rules for combining the two. These rules 
are summarized in Table 2. 

In working with text, the Rule of 
Thumb is that you should set Above and 
Below Spaces as the amount of additional 
space (besides normal interline spacing) 
that you want to have between para
graphs. Set Interparagraph Spacing to O. 

Margins and Indents 

In the case of spaces between lines and 
paragraphs, people tend to get confused 
because they're not sure whether they 
should add two settings together or take 
the greater of the two. With margins and 
indents, the confusion is much less: you 
simply add all the settings to determine 
the entire amount of indent. The diffi
culty comes in knowing where the set
tings are located, since they are scattered 
among several menus. 
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The best way for how Ventura deter
mines the location of a particular para
graph relative to the edge of a page is to 
calculate its distance from the edge. You 
can use the following formula: 

Distance of a line from left edge of 
page=A+B +C+D 

Where: 
A = Upper Left X position of the 

Frame within which the text is located. 
This is set by selecting the Frame func
tion, selecting the Frame itself, selecting 
the Sizing & Scaling option of the Frame 

Calculating the Horizon
tal Position of a Line 

Upper left X position of 
the frame 

+ Left margin of the frame 

In From Left setting for 
+ the tag 

+ 
First line(s) indent 
setting for the tag 

Distance from left edge 
of the paper 

Table 3,' Determining the distance of a 
line from the edge of the paper. 

menu, and specifying a value for Upper 
LeftX. 

B = The Left margin of the Frame 
within which the text is located. This is 
set by selecting the Frame function, 
selecting the Frame itself, selecting the 
Margins & Columns option of the Frame 
menu, and specifying a value for Left 
Margin. 

C = The In From Left space 
specified for the tag of the paragraph of 
that text. This is set by selecting the Tag
ging function, selecting the paragraph, 
selecting the Spacing option of the Para
graph menu, and entering a value for In 
From Left. This indent is referred to as a 
"temporary indent," since it can change 
from one paragraph to the next. 

D = the Indent Width. This only ap
plies to the first line (or several lines) of 
a paragraph. To set it, you start by select
ing the Tagging function, selecting the 
paragraph, selecting the Alignment op
tion of the Paragraph menu, and entering 
values for In/Outdent Width and In/Out
dent Height. In addition, you can specify 
a Relative Indent, which causes the line 
to be indented so that it starts at the verti
cal point at which the previous line 
ended. 

More on Tabs 

The way Ventura handles tabs is quite 
logical, but since it is different than the 
methods used by most other programs it 
tends to cause confusion. Here are some 
things to keep in mind about Ventura 
tabs: 



• Tabs are measured from the edge of 
the current column (not the edge of 
the text in that column). To find out 
where the edge of the column is lo
cated, select Show Column Guides 
from the Options menu. 

• Tabs cannot be set in justified text. 
For ideas on how to get around this 
limitation, see the tips below. 

• Once a tab is set, Ventura no longer 
performs word wrap for that para
graph. That means you cannot use 
tabs for fIrst line indents. 

• Ventura will preserve tabs set in 
your word processor, but not the set
tings for the tab. Instead, it will sub
stitute its own settings. W ordStar 
tabs are not preserved, but instead 
are converted into fixed spaces. 

• With decimal tabs, the tab aligns 
with the decimal, a useful feature for 

Figure 2: The 
Tab Settings 
dialog box. 
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columns for money amounts. In 
European currencies, a comma rather 
than a period is used for the decimal 
point. Since Ventura looks for a pe
riod, you need to select Set Prefer
ences from the Options menu and 
specify a new Decimal Tab 
Character. The comma is decimal 
44. 

Tabs, Breaks, or Box Text? 

There are three ways of setting up tabular 
material, illustrated in the two passages 
shown below. The first method is to use 
tabs; the second is to use breaks; the third 
is to use boxed text. 

Tabs should be used when the mate
rial in each column does not need to wrap 
within that column, such as the passage 
shown below. For the tags to work, the 
paragraph must be formatted as left-

Tab tfunber: a [I] m II1II1 m [I] [I] 
lIJDI1[[]mJDII[]][J[]1J[] 

Tab Type: I Off I IIiI I Center I I Right I I Decimal I 
Tab Display: Shown as Open Space I Shown as leader Char I 

Tab location: 92.9~ inches 

leader Char: EIII Q D I Other I 932 (ASCII) 

I!Immmrn[[]lI1[[]m 
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justified. In the following example, the 
first tab is a left tab at 6,06 picas and 
points and the second is a right tab at 18 
picas. 

column 1 column 2 column 3 

column 1 column 2 column 3 

columnl column 2 column 3 
Breaks rather than tabs should be 

used when the material in each column 
needs to wrap, as in the example below. 
To set up such material you first type it as 
separate paragraphs and create three tags. 
The settings for the three tags are as 
shown in the columns. 

To create the 
first tag, se
lect the Align
ment option 
from the Par
agraph menu 
and set Align
ment to 
Justified and 
Indent Width 
to O. Select 
the Spacing 
option of the 
Paragraph 
menu and set 
In From Left 
to 0 picas 
and In From 
Right at 13 
picas. Select 
the Breaks 
option and 
select Before 
but not After 
and Normal 
for Next Y 
Position. 

To create the 
second tag, 
select the 
Alignment 
option from 
the Para
graph menu 
and set Align
ment to Justi
fied and 
I n/Outde nt 
Width to O. 
Select the 
Spacing op
tion of the 
Paragraph 
menu and set 
In From Left 
at 6,06 picas 
and In From 
Right at 6,06 
picas. Select 
the Breaks 
option and 
select None 
and Normal 
for Next Y 
Position. 

To create 
the third tag, 
select the 
Alignment 
option from 
the Para
graph menu 
and set 
Alignment to 
Justified 
and In/Out
dent Width 
to O. Select 
the Spacing 
option of the. 
Paragraph 
menu and 
set In From 
Left at 13 
pleas and In 
From RIght 
at 0 pleas. 
Select the 
Breaks op
tion and se
lect After 
and Normal 
for Next Y 
Posit/on. 

The most complex layouts, such as 
that shown below, are most easily 
handled by using the Box Text tool in 
graphics mode, typing text into the 
boxes, and then setting Line Attributes at 
None to eliminate the boundaries of the 
boxes. The drawback of this method is 
that surrounding text does not flow 
around boxes, so you'll have to create 
empty space or draw a frame to contain 
the boxes. 

Frame Padding 

Frame padding is a new feature of Ver
sion 1.1 that corrects the problem of text 
running right up against frames inserted 
in text blocks containing pictures or ta
bles. To specify padding, select Frame 
mode, select the frame you want to place 
padding around, select Sizing & Scaling 
from the Frame menu, and type settings 
for Frame X Padding and Frame Y Pad
ding. Frame X Padding sets up a "no 
entry" zone on either side of the frame; 
Frame Y Padding sets up a "no entry" 
zone above and below the frame. 

Reference Points 

The position of text is always measured 
relative to the edge of the paper, even if a 
particular printer is not capable of print
ing all the way to the edge of the paper, 
as is normally the case with laser print
ers. Ventura does not stop you from 
specifying margins from frames that go 
into the unprintable edges of the paper; if 



you do so that portion of your page will 
simply be cut off. 

Simulating Tabs in 
Justified Text 

Ventura doesn't allow you to place nor
mal tabs in justified text. If you do, the 
program will simply ignore them. Some
times, however, it is necessary to format 
text with a hanging indent, such as the 
following: 

Section J. The right of citizens of the 
United States to vote shall not 
be denied or abridged by the 
United States or by any State 
on account of race, color, or 
previous condition of servi
tude. 

With many word processors, you 
would format this paragraph by specify
ing a negative indent for the ftrst line of 
the ,paragraph, then creating a tab that is 
the same as the indent for the rest of the 
paragraph. With Ventura you need to sep
arate the paragraph into two separate par
agraphs, typing them as follows: 
Section I. 
The right of citizens of the 
United States to vote shall 
not be denied or abridged by 
the United States or by any 
State on account of race, 
color, or previous condition 
of servitude. 

Select the Tagging icon, select the 
first paragraph, and select Breaks from 
the Paragraph menu. If the dialog box 
shows Line Break: No or Line Break: 
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Before, then you don't have to make any 
changes. Press Cancel. 

If the dialog box shows Line Break: 
After or Line Break: Before and After, 
press Cancel, then press the Add New 
Tag button. Type the previous para
graph's tag next to Tag Name to Copy 
From, and type a new tag name next to 
Tag Name to Add: 

Select the Breaks option of the Para
graph menu and change the setting to 
Line Break: Before. Press Enter. 

Now select the second paragraph, 
and press the Add New Tag button. Type 
the previous paragraph's tag next to Tag 
Name to Copy From, and type a new tag 
name next to Tag Name to Add: 

Select Spacing from the Paragraph 
menu and enter the amount of the indent 
next to In From Left. 

Select Breaks and specify Line 
Break: After. 

Ruling Lines 

Ventura allows the creation of a variety 
of ruling lines: horizontal, vertical, sur
rounding frames, dashed, and shaded. 

Ventura lets you add ruling lines to 
either a frame or a paragraph tag. The 
choices are either Ruling Line Below, 
Ruling Line Above, or Ruling Box 
Around. In each of these cases, you must 
specify the line height within the dialog 
box. You can indicate up to three ruling 
lines by indicating I-Ieight of Rule 1, 
Height of Rule 2, and Height of Rule 3. If 
you just want one line, simply specify a 
Height of Rule 1 and leave the other 
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heights blank. When you specify the 
Height of Rule, a line or lines with the 
specified line height(s) will appear smack 
inside the dialog box. If you do not see a 
line inside the dialog box, you will not 
see a line in your document either. 

If you have specified Height of Rule 
for more than one line, you will have to 
indicate a Space Below Rule dimension 
also. If you don't, the lines will merge 
into one thick line. The ruling lines op
tions give you a good deal of feedback 
right inside the dialog box. You can im
mediately see the effect of your line 
height, spacing, and color pattern without 
even going to the page. However, note 
that the width of the line shown in the 
dialog is not the actual width it will ap
pear on the screen. Instead, it is relative 
to the total amount of vertical space 
available to the three ruling lines. 

Note: In the Ruling Line menus, you 
must also be sure to specify a line width. 

If you let the width default to None, your 
ruling lines will not appear on the page 
even though you can see them inside the 
dialog box! 

Tips on Typographies and 
Ruling Lines 

Tip: Font Support for Automatic 
Kerning 
Automatic kerning only works if the 
fonts you are using include kerning infor
mation. All PostScript fonts from Adobe 
have such information. Most LaserJet 
fonts do not. When you buy a font, check 
with the vendor to see that it includes a 
built-in table of kerning pairs. 

Tip: Feathering 
Feathering is a typesetting term that re
fers to adding small amounts of leading 
between lines and paragraphs to slightly 

Figure 3: The 
Ruling Line 

Above dialog 
box. Width: I None I I Text I I Margin I I ColuMn I I Frame I I1!m!I 

Color: I White IIiIB I Red II Green II Blue II Cyan II Yellow II Magenta I 

Space Rbove Rule 1: 88,8_ _ _ 
Height of Rule 1: 80,81 

Space Below Rule 1: 00,01 __ 
Height of Rule 2: 80,01 

Space Below Rule 2: 80,06 
Height of Rule 3: 88,09 

80,80 ac::J 
81,87 

1 

Dash Width 00,10\ 
Dash Spacing 80,82 

Custom Indent 04,04 a c::J 
CustOM Width 14,08 

83,08 picas & points 



lengthen a column. The easiest way to ac
complish this is to create a tag called One 
Point. Move the cursor between the para
graphs, press Enter, and select the Tag
ging function. Select the paragraph sign 
between the two paragraphs, select Add 
New Tag, name the tag One Point, select 
the Spacing option in the Paragraph 
menu, and set interline spacing to one 
point. The effect will be to add an addi
tion point of leading between the two 
paragraphs. 

Tip: When to Use Tracking and Letter 
Spacing 
With normal body type set in wide 
columns, tracking and letter spacing are 
not necessary. Tracking, which uniformly 
tightens up the spaces between 
characters, is used in the following situa
tions: 

• In headlines and other text that uses 
large fonts (such as the chapter titles 
in this book). Normally, large type 
sizes are too loose without tracking. 

• With italic fonts, which sometimes 
appear too loose without tracking. 

• How to Squeeze Copy Within a 
Given Area. 

Letter spacing, which allows Ventura 
to add space within words to make up for 
too much space between words, is gener
ally used in text set in very narrow 
columns. 

Tip: Using Ctrl-Enter for New Lines 
When setting more than one line using 
the same tag, such as in a headline or a 
table, use Ctrl-Enter rather than Enter. 
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That way, Ventura will not start a new 
paragraph and spacing will remain the 
standard interline distance. For multiple
line headlines, this avoids the problem of 
having the Space Above and Space 
Below distances added between every 
line. 

Tip: Using Fixed Spaces Instead of 
Tabs 
Occasionally, you want to tab a line a 
certain distance that does not correspond 
to one of the tabs that have been set for 
that tag. Rather than setting up a new tab 
(which will affect other paragraphs with 
the same tag), try using fixed spaces to 
achieve a tabbing effect. After inserting 
the fixed spaces, use the Set Font button 
to convert them to 12 point type. That 
way their widths will be the following: 

Thin Space (Ctrl-Alt-Spacebar): 3 
points or 1/24 inch. 

En Space (Alt-Spacebar): 6 points or 
1/12 inch. 

Em Space (Alt-Shift-Spacebar): 12 
points or 1/6 inch. 

Fixed spaces are also handy to sub
stitute for tabs in justified text, since Ven
tura does not allow tabs in justified text. 
To insert an indent into a single para
graph without affecting other paragraphs, 
use em-spaces. For a one-inch indent, in
sert six em-spaces by pressing the Alt
Spacebar combination six times. 

Tip: Line Snap 
To activate line snap, select Line Snap 
On from the Options menu. Line snap 
sets up an invisible grid on the page. The 
width of this grid is the interline spacing 
used by the Body Text tag. The reference 
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point is the baseline of Body Text set on 
the base page. Unlike standard typo
graphic programs, Ventura measures that 
baseline from the bottom of the descend
"ers of type on a line. You can use line 
snap for the following: 

• Creating a thin frame that is exactly 
the same height as a single line. 
Such a frame can be used to adjust 
vertical spacing in a column of text. 

• Making text in adjacent columns line 
up. 

• Allowing two frames to adjoin each 
other exactly. 

Tip: Setting Text on a Skew 
To set text on askew, as shown in Figure 
4, select the Graphics function and select 
the line drawing tool, then draw a diago
nal line to mark the skew. Select the 
Frame function and select Tum Line 
Snap On in the Options menu. Using the 

Figure 4: 
When setting 

text on a skew, 
draw a 

diagonal line 
for a guide, 

then draw 
small frames in 

a stairway 
pattern. 

line you have drawn as a guide, you can 
draw a stairway of frames, each one line 
in height, from the left margin to the 
skew line. Text will reformat to flow 
around the stairway and thus will align 
with the skew line. 

Tip: Marker Characters 
Ventura uses a variety of markers to indi
cate the hidden characters used for tabs, 
paragraph endings, discretionary hy
phens, etc. These marks will be shown on 
the page if you press Ctrl-T or select 
Show Tabs & Returns from the options 
menu. 

Tip: Customized Fixed Spaces 
Ventura provides four different fixed 
spaces: Em space, En space, figure space, 
and thin space. In addition, you can 
create your own customized fixed spaces. 
For example, to insert a fixed space the 
width of the letter W, type that letter, 



highlight the letter by dragging the cursor 
across it while holding down the mouse 
button, select Set Font, and in the dialog 
box select White as the color of the type. 
Since its color is white, the letter will not 
print, but Ventura will hold its place in 
the text passage. 

Tip: Frame Breaks 
In Ventura, there is no Frame Break op
tion to automatically push subsequent 
text to the next Frame. To create a frame 
break effect, create a new tag and call it 
Frame Break. To create the tag, select the 
Text function, press Enter, select the Tag
ging function, select the paragraph mark, 
select Add New Tag, type Frame Break, 
select Breaks from the Paragraph menu, 
and select Page Break: After. You can 
use this tag when you are loading text 
into multiple frames on the same pages 
and you wish to break text to the next 
frame on the same page. 

Tip: Decimal Tab Characters 
Normally, when you specify a decimal 
tab (from the Tab selection of the Para
graph menu), it is for the purpose of 
aligning columns of dollar figures at the 
decimal point. Another use of the deci
mal tab character is to create an invisible 
marker to arbitrarily align lines of text. 
The best character to use for that purpose 
is I (ASCII 124). You can "hide" this 
character in a line of text by using Set 
Font to change its color from black to 
white (since it takes up barely any hori
zontal space). By using the decimal tab 
option to in conjunction with this hidden 
character, you can position horizontal 
lines freely without using fixed 
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characters or generating multiple tags. 
Remember that text containing tags must 
be left justified. 

Tip: Changing the Size of the Bullet 
If you don't like the size of the bullet, 
you can create a larger one. Tag the para
graph and select Special Effects from the 
Paragraph menu. Select Bullet and select 
Set Font Properties. By indicating a 
larger point size, you'll get a larger bullet 
even though the size of your text will re
main the same. If you select a large point 
size for your bullet, you'll also have to 
use the Shift option to nudge it down 
slightly. 

• Small 

• Medium 

• Large 

e Humongous 

• Brobdingnagian 

Tip: Solid Box 
You can create a tag that places a 
solid black box at the beginning 
of a paragraph. To do this you'll 

need to first type press Enter in the line 
above the paragraph to create a blank 
paragraph. You next need to create two 
tags, one to format the blank paragraph 
into the box and the other to format the 
text so that it is indented to make room 
for the box. Call the first tag Box and set 
Breaks to Before. The select the Ruling 
Lines Above option and enter the settings 
as follows: Custom Width selected; Solid 
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Pattern; Height of Rule 1 equal to the 
desired height of the box (the example 
shown here used 3 picas for the height); 
Custom Width set equal to height; and 
Space Below Rule 3 slightly greater 
(3,04 picas and points in this example, 
more or less depending on the size of the 
box). For the paragraph itself, use the 
Alignment option to specify an indent 
width slightly larger than the width of the 
box, and to specify the desired number of 
lines to be indented. 

TIP: SMALL CAPS 
Small caps are capital letters set one 
point size smaller than the size of current 
text. Among other purposes, they are use
ful for making acronymns less conspicu
ous. In Ventura, creating small caps is 
easy. Type the text as normal, then 
highlight it (still working in Text rather 
than Tagging mode) and select Upper 
Case and Small from the Assignment 
List. For an enhanced effect, keep the ini
tialletters of words that would otherwise 
be capitalized in normal type, as shown 
above. 

Tip: Vertical Dashed Lines 
Ventura has no command for vertical 
dashed lines, such as you would use to 
indicate cutting out a page. Make a frame 
of zero width and surround it with dashes 

ip: White on Black 
To create white type on a black back
ground, use the Ruling Line Above op
tion and set Height of Rule 1 to a value 
slightly larger than the point size of the 
current font. Enter the same value for 

Space Below Rule 3 and select the minus 
sign (-). 

Tip: Disappearing Rules 
If your ruling line doesn't show, you 
probably forgot to specify height of 
ruling line. Ventura will show you a 
ruling line right inside the dialog box 
once you specify the line height. 

Tip: Making Mistakes with Picas and 
Points 
When you're entering measurements for 
picas and points in dialog boxes, it's easy 
to neglect both decimal places reserved 
for points. For example, you might make 
the mistake of typing 1,6 instead of 1,06. 
Ventura will interpret the 1,6 as 1 pica 
and 60 points. 

Tip: Rule To End ••••••••• 
Here's how to make a ruling line extend 
from the end of the current line to the 
outer margin. First, select the Tagging 
icon, select the paragraph, and select Add 
New Tag. If it is Body Text, rename it 
Body Text (R). 

From the Paragraph menu, select 
Breaks and set Line Break to Before. 
Select OK. 

Select the Text icon, place the cursor 
at the end of the line, and press Enter and 
then press the Tab key to create a blank 
line containing a single tab. Select the 
Tagging icon and select the blank line. 
Select Add New Tag and name the tag 
Line to End. From the Paragraph menu, 
select Breaks and set Line Break to After. 
From the Paragraph menu, select Tabs 
and make the settings for Tab Number 1 
as follows: 



• Tab Type: Right 

• Tab Display: Shown as Leader Char 

• Tab Location: (distance to right mar
gin) 

From the Paragraph menu, select 
Alignment and set Relative Indent to 
Length of Previous Line. 

From the Paragraph menu, select 
Ruling Line Above and set width to Text, 
Height of Rule 1 to 12 points, and Space 
Below Rule 1 to 12 points. Select the 
minus sign and select OK. 

Questions 

Q: How do you make one paragraph 
slightly different without affecting all 
the other ones that have the same tag? 

A: .Select the paragraph, then select Add 
New Tag. When the dialog box appears, 
type in a new name. Now, any settings 
you choose for the new tag will apply 
only to that single paragraph (and any 
others that you subsequently tag with the 
new tag). 

Q: How do I change the font for just 
one word in a paragraph? 

A: Switch to Text mode and select the 
word (by dragging the cursor across it 
while holding down the mouse button). 
Select Set Font. The Font Setting dialog 
box will now appear, allowing you to 
change the font for the selected text. 
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Q: How can I make a headline that goes 
across several columns? 

A: Select tagging mode. Tag the head
line. Select the Paragraph menu. Select 
the Alignment option. Select Overall 
Width: Frame-Wide. 

Q: When I select the Font option from 
the Paragraph menu, the Kern control is 
in light gray. How can I get kerning to 
work? 

A: Kerning cannot be done via the Para
graph menu. Manual kerning is done in 
Text Mode using Set Font and automatic 
kerning' is done from the Typographics 
option of the Paragraph menu. To per
form manual kerning, select the Text 
icon, highlight the character to the right 
of the space you wish to tighten, and 
select Set Font. 

Q: I turned kerning on in the Page 
Layout dialog box of the Page menu, but 
doing so did not cause the text to be 
kerned. Why not? 

A: In order for automatic kerning to func
tion, the font you're using must include 
spacing information for each kerning pair 
(each pair of characters that is to be auto
matically kerned). Such information is 
part of PostScript fonts but not of the 
other fonts provided by Ventura for the 
HP LaserJet Plus, the AST TurboLaser, 
or the Cordata laser printer. 

Q: What's the way to make dotted leader 
characters? 

A: Use the Tab Settings dialog box of the 
Paragraph menu. 
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Q: What is the difference between 
tracking and space width? 

A: Tracking is a way of globally tighten
ing up the distance between characters. 
Space width settings provide a minimum, 
an optimum, and a maximum allowable 
amount of space between words. 

Q: Kerning looked fine on the screen 
but did not print correctly. 

A: This is an unavoidable side effect of 
the fact than that the resolution of 
graphic displays is so much lower than of 
output devices. At the level of character 
spacing, true WYSIWYG is still in the 
future. 

Q: What does Letter Spacing: On/Off 
mean in the Typographic Controls 
dialog box of the Paragraph menu? 

A: As long as letter spacing is turned off, 
Ventura will only adjust the spaces be
tween words as it justifies lines of text. If 
the program does not succeed in keeping 
these interword spaces within the limits 
you have specified for maximum space
band values, it will highlight the line as a 
"loose line." By turning on letter spacing, 
you can then allow the program to adjust 
the spacing between letters within words, 
so that the spaces between words can be 
narrowed. Note that even after you turn 
letter spacing on, the lines will still be 
highlighted as loose. 

Q: Some of the measurements in the 
menus are shown as --.-- rather than 

as numbers. What is the meaning of 
these marks? 

A: They denote that the measurement is 
out of range. "Generally, this occurs when 
you are using fractional points as your 
measurement units. Any number larger 
than 99.99 points (about 1.4 inches) will 
be shown as --.-- fractional points. The 
solution is to change measurement units, 
which is done by pointing directly at the 
words fractional points and clicking with 
the mouse. 
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Using Fonts 
AMONG all the desktop publishing pro
ducts on the market, Ventura's support 
for fonts is remarkable in several re
spects. First, for most laser printers the 
program provides a set of high quality 
fonts from Bitstream, guaranteeing all 
users-no matter what printer they're 
using-with a solid typographic founda
tion. (The only exception is that as of 
Version 1.1 the program supports only 
one of the lIP LaserJet cartridges-the F 
cartridge.) Second, the program supports 
more laser printer standards than any 
other. Third, for most of these laser print
ers, Ventura provides a way of adding 
more fonts to those already provided with 
the program and of converting fonts from 
one printer format to another. 

In this chapter it's assumed that 
you've installed Ventura for at least one 
printer and thus have a set of fonts to 
work with. The next chapter explores 
ways of increasing the number of fonts at 
your disposal. 

Font Terminology 

Generally, the word "typeface" refers to a 
particular type design, such as Times 
Roman italic or Helvetica. "Font," on the 
other hand, refers to the source from 
which type is generated, usually a file on 
a computer disk. A "type family" refers 
to variations on a typeface, such as bold, 
light, roman (i.e. normal), compressed, 
extended, obliqued (i.e. slanted), and 
italic. 

Typefaces can be divided into 
several groups. Display faces are 
specially designed for use in titles and 
headlines. Generally, such faces are bold 
and dramatic. Decorative faces are highly 
distinctive, used for special-purposes 
such as advertisements and diplomas. 

Text faces are designed for maxi
mum readability. In most cases, text 
should should be in a serif face. (At one 
time it was thought that serifs enhance 
readability by providing the eye with 
helpful visual "clues." More recently, stu
dies have shown that serif type is more 
readable for those who grew up with serif 
type, and sans serif type is more readable 
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for those who grew up with sans serif. In 
this country, of course, virtually everyone 
is accustomed to reading text set in serif 
type.) 

The standard unit of font measure
ment is the point, of which there are 6 to 
a pica or 72 to an inch. The point size of 
a font is generally measured from the top 
of the highest ascender to the bottom of 
the lowest descender. Point size is decep
tive at times because it understates the 
size of fonts with short ascenders and de
scenders. 

Bit Map Fonts and Outline 
Fonts 

Both laser printers and digital typesetters 
are raster devices. That is, the text and 
images they print are actually patterns of 
dots on a very fine rectangular grid. Prior 
to being printed, the arrangement of dots 
that constitutes a single character is 
stored as a corresponding arrangement of 
digital bits, or bit map, in the memory of 
the laser printer. 

Laser printers with sophisticated 
page description languages such as Post
Script and InterPress store type as sets of 
mathematic descriptions of the character 
outlines. When called upon to print a 12-
point Times Roman italic, the printer 
uses the outline to generate the appro
priate bit map, or pattern of dots. 

One advantage of the outline method 
is that type of any size can be generated 
from a single set of outlines, thereby pro
viding the ultimate in flexibility while 
consuming relatively little storage space. 
A slight disadvantage of the outline 

method is that the computations neces
sary to generate bit maps from outlines 
exact a toll on printer performance; 
however, PostScript automatically stores 
bit maps generated from outlines in a 
temporary font cache, which generally 
makes it unnecessary for the system to 
generate a bit map each time a particular 
character is needed. 

A second advantage of outline fonts 
is that they are resolution-independent. 
The same fonts can be used on a 300-dpi 
laser printer or a 2400-dpi typesetter; in 
either case, type will be printed at the 
maximum resolution available. 

The alternative method of storing 
fonts, used by the lIP LaserJet, the AST 
TurboLaser, and most other non-Post
Script printers, is to work with a separate 
set of bit maps for each font size, rather 
than generate all sizes of a font from a 
single master outline. The advantage of 
the bit map method is that size-specific 
bit maps can produce higher quality than 
fonts generated from outlines. The draw
back of the bit map method is storage 
space, since you must use a separate file 
for every font. 

Let's say that you want the roman, 
italic, bold, and bold italic versions of 
Garamond in every size from 6 points to 
36 point. With a printer that uses the out
line method, you have to store four out
line files: one for roman, one for italic, 
one for bold, and one for bold italic. With 
a printer that uses the bit map method, 
however, you'd need 124 separate fonts 
(31 sizes times 4 styles). The size of a 
single bit map file ranges from about 
12K for a six point font to 32K for a 12 



point font and 10SK for a 24 point font. 
Notice that the amount of memory in
creases faster than the point size. Above 
30 points, bit map font files become so 
large as to be unwieldy. 

Generally, printers that use bit 
mapped rather than outline fonts are a 
good deal less expensive than PostScript 
and other printers that use outline fonts, 
but the drawback of using such printers is 
that your range of sizes and styles is more 
restricted. 

One way around the restriction, if 
your printer uses bit mapped fonts and 
you do have an occasional need for larger 
type than 30 points, is a new type of soft
ware that provides outlines and can pro
duce bit maps in the appropriate format 
for printers such as the HP LaserJet. Such 
bit map generating software is discussed 
later in this chapter. 

Storage Requirements 

The file containing a font outline or bit 
map may be stored in one of severalloca
tions: in the printer, in a plug-in cartridge, 
or in the computer. Some fonts, desig
nated as resident, are permanently stored 
in printer ROM and hence are always 
available for use. In the Apple Laser
Writer, for example, Times Roman, 
Helvetica, Courier, and Symbol are resi
dent in the printer. The LaserWriter Plus 
has those four plus an additional seven 
typefaces: Zapf Dingbats, Zapf Chancery, 
Century Schoolbook, Palatino, Helvetica 
Narrow, ITC Bookman, ITC Avant 
Garde. The HP LaserJet Plus and Series 
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II store Courier l2-point medium and 
bold, and 8-point Line Printer. 

A closely related method of font 
storage is plug-in ROM cartridges. No 
PostScript printers on the market use 
such cartridges. The HP LaserJet, Laser
Jet Plus, and LaserJet Series II do have a 
slot for font cartridges and approximately 
two dozen are available from Hewlett
Packard. Ventura, however, can be used 
only with the F font cartridge, which con
tains 14.4-point bold Helv, 10-point TMS 
RMN medium, bold, and italic, 8-point 
TMS RMN medium, and 8.S-point Line 
Printer medium. 

A third method of storing fonts is on 
floppy or hard disks in the computer. 
These are called soft fonts. A set for the 
HP LaserJet Plus, the AST TurboLaser, 
the Cordata, and the JLaser board are 
provided with Ventura. Additional soft 
fonts are available from a variety of ven
dors. 

The amount of storage space you'll 
need on your hard disk for font files var
ies considerably, depending on whether 
the fonts are in outline or bit mapped for
mat. In the case of the the AST Tur
boLaser, the Cordata laser printer, or the 
JLaser board, 1.2 Mb are required. In the 
case of the HP LaserJet Plus or Series II, 
or the Xerox 4045, the amount of storage 
necessary is twice that much-2.4 Mb
because these printers require that each 
font be stored separately in portrait and 
landscape orientation. 
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Selecting Fonts in Ventura 

There are two ways to specify type 
characteristics within Ventura-we'll call 
them the Tag Method and the Set Font 
Method. The Tag Method is done in tag
ging mode and sets the font for the entire 
paragraph; the Set Font Method is done 
in text mode and sets the font for a por
tion of the paragraph, such as a single let
ter, a word, or a group of words. You can 
also use your word processor to embed 
the codes used by Ventura for specifying 
type. 

TAG METHOD: When you select a 
paragraph ill: tagging mode and then 
select a tag, the font characteristics stored 
in that tag are automatically applied to 
the entire paragraph. To change the font 
information stored in a tag, select a para
graph, select the Font from the Paragraph 
menu, and choose the Face, Size, Style, 
and Color from the dialog box. 

Under Face, the menu displays the 
typefaces available for the printer whose 
width table you are currently using. Note 
that the width table need not be the same 
as the printer you are using. We'll discuss 
the implications of that later in this chap
ter. 

With printers that use bit mapped 
fonts, the size menu shows you the op
tions you have available. With PostScript 
and InterPress printers, you can select 
any custom size (Figures 1). Under the 
Styles heading, those styles that are 
available in a particular size are shown in 
black; others are shown in gray. For other 
printers, the size options are listed in the 
scroll bar. 

You can also use this dialog box to 
indicate the color of type. Selecting white 
causes Ventura to save the amount of 
space that would be taken up if the text 
were printed, or prints the characters in 
white if the background is gray or black. 

Figure 1,' The 
Font Setting 
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the PostScript 
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This is an extremely useful capability 
with many possible applications, such as 
preparing color separations, printing 
white on black, and creating custom fixed 
space characters (see the tips below). 

You'll notice that the controls for 
vertical shifting and for kerning are 
shown in gray in the Font dialog box. 
These controls are only accessible with 
the Set Font method of setting fonts. 

SET FONT METHOD: Use this 
method when you want to change a 
single letter, word, or group of words 
within a paragraph to a different font, or 
when you want to vertically shift or kern 
a single word. 

To use the text method, select the 
Text function, then hold down the mouse 
button while you drag the mouse across 
the characters you wish to select. Alterna
tively, click the mouse button once at 
your starting point the move it to your 
ending point and click again. The pas
sage, which must be contiguous text, will 
be highlighted in black. Now select Set 
Font. The dialog box that appears is iden
tical to the dialog box used by the Tag 
method, except that now the shifting and 
kerning controls are available. 

Shifting means simply that the 
selected characters are moved up or down 
the specified distance. Kerning means 
that characters are moved to the left to 
tighten up spaces within the word. The 
most frequent use of kerning is in situa
tions where large type is used, such as 
titles. 

When using the shift or kern con
trols, you should normally work in frac
tional points. If the measurement units 
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are different, change them to fractional 
points by pointing the cursor directly at 
the word inches, centimeters, or picas & 
points and clicking. With kerning, the 
number you type determines the distance 
that Ventura will move the two characters 
closer together. 

Manual kerning should not be con
fused with automatic kerning, which is 
also possible in Ventura provided that the 
font vendor has included the relevant 
kerning information in the font width 
table. 

PREFORMATTING TYPE SPECIFI
CATIONS: In addition to using Tags or 
the Set Font option to specify type, you 
can also embed codes directly in text files 
using a word processor. This option is de
scribed in Chapter 7, "Preparing, Load
ing, and Tagging Text." 

Downloading Fonts 

Since soft fonts are not resident in the 
printer or stored on cartridges, they must 
be downloaded from your hard disk into 
the printer each time the printer is turned 
on. Ventura handles this task automati
cally: each time you print a chapter the 
program will download the fonts used in 
that chapter. 

While the automatic downloading 
feature is certainly convenient, you may 
want to tum it off. For example, typically, 
it is necessary to print a document several 
times before you finally get it just right. 
Particularly if your printer uses a serial 
port, you'll find that waiting for the fonts 
to be downloaded each time is more time 
consuming than you'd wish. One of the 
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Figure 2: The 
Set Printer Info 

dialog boxfor 
the PostScript 

width table. 
I HP lJ+, 300dpi II Interpress I IHUiij;JIQI 
I XEROX 4045, 300dpi I 
EG~ (Use those lIIatching this file extension.) 

D:\lJENTURA\OUTPUT .WID ________ _ 

Command: load Different Width Table (i.e., Font Metrics) 

Quality: Ultimate 

tips below explains a method for creating 
a font downloading file that you can send 
to the printer when you turn it on. You 
can then turn off the automatic 
downloading feature. 

Draft and Ultimate Printing 

One of the benefits of PostScript printers 
is their device independence. This means 
that you can generate draft copies on a 
PostScript laser printer and then print the 
final copy of the same copy on a Post
Script typesetter. Except for the higher 
resolution of the typesetter, the two co
pies will be identical. Thus, the draft 
copy will give you an accurate preview 
of your final master. 

What if you don't h~tve access to a 
PostScript printer, but instead are using a 
more inexpensive laser printer such as a 
LaserJet Series II? With Ventura, there is 

still a way to produce accurate draft co
pies on the LaserJet that will closely 
match the final output of the PostScript 
typesetter. Letter spacing will not match 
up, but line breaks will be the same. 

To set the system up for printing 
draft copies, select Set Printer Info from 
the Options menu. Select the LaserJet as 
your draft printer. Then select the Load 
Different Width Table command, as 
shown, in Figure 3. The Item Selector 
dialog box will appear. Now select the 
PostScript width table from the list of 
files. If that width table is not shown as 
an option, change the Directory line to 
read: C:\VENTURA\*.WID. 

Since the LaserJet has been selected 
as the printer, you'll be able to print Ven
tura documents on that printer as usual. 
However, since you've selected a Post
Script width table, the space allotted to 
each character will be the same as if you 



USING FONTS 149 

Making a Laser Jet Download File 

If you have a LaserJet Plus, LaserJet Series II, or LaserJet 2000, you can 
download fonts into the printer. The best tool for creating LaserJet 
download files is Hewlett-Packard's PCLPak utility, though other tools 
like SoftStyle's Printworks for Lasers (800/367-5600) can be used as well. 

Let's say you want to have two fonts, 18-point and 24-point Swiss 
bold downloaded automatically to the printer when you type the name of 
the batch file, SWI824.BAT. 

To create this batch file, first load PCLPak by copying PCLPAK.EXE 
and USENG.CAT from the PCLPak disk to the Ventura subdirectory. 

• Place the PCLPak disk in drive A 

• Type COpy A:\PCLPAK.EXE C:\VENTURA 

• Type COpy A:\USENG.CAT C:\VENTURA 

• Type 2 to select LaserJet+, M to select ManageFiles, D to select Desti-
nation 

• Typec:\VENTURA\SW18B 

• Type Q for Quitmenu, F for Fonts, D for Download, F for Filename 

• Type HLVB3018 .SFP 

• Type I for ID 

• Type 1 

• Under current settings, check to see that temp/perm is set to per
manent. If not, type T to toggle the setting to permanent. 

• Type G for Go. This will create the file sw 18b in your Ventura 
directory. Now repeat the procedure to create the file sw24b in the 
same directoy. Exit PCLPak by typing Q, Q, Q, Y. 

• You should now be in the Ventura subdirectory. Type the following 

COPY CON SW1824.BAT 
COPY/B SW18 LPT1: 
COPY/B SW24 LPT1: 
"Z 
Now, when you first tum on your printer you can type SW1824 to 

download both files to the printer. They will remain there as permanent 
fonts until it is turned off again. 
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were using a PostScript laser printer or 
typesetter. Thus, line breaks will all be 
accurate. 

Here's another case in which you 
can take advantage of Ventura's ability to 
use one printer's width table with another 
printer. If you have a PostScript laser 
printer, you'll find that printing pages 
that contain illustrations is slow because 
these printers use a serial connection to 
the computer. You can speed up a Post
Script printer considerably if you install a 
JLaser board in your computer, which 
uses a high-speed interface cable that by
passes the PostScript controller and con
nects directly to the printer engine. 

Once the JLaser board is installed, 
you'l1 have two cables connecting your 
computer to your printer. When you need 
high-speed printing you can choose 
JLaser as your printer; when you want 
higher quality printing you can choose 
PostScript. For drafts, you can choose the 
JLaser as your printer and specify the 
PostScript width table. Letter spacing 
will not be accurate, but line breaks on 
the draft copies will be correct. 

Tips on Using Fonts 

Tip: Creating a Download File for the 
LaserJet 
With the LaserJet Plus or Series II, you 
can download all the fonts you need for 
the day and then tum off Ventura's auto
matic downloading. As a result, you 
won't have to wait while Ventura 
downloads fonts each time it prints out a 
chapter. This approach is especially rec
ommended if you have added to the 

512K base memory of the printer with 
one of HP's memory expansion options. 

The procedure for creating a 
download file and loading it into the 
printer at the beginning of each work ses
sion is shown in the sidebar, "Making A 
LaserJ et Download File." 

Once you have created a download 
file, you also need to modify the 
HPLJPLUS.CNF file in the Ventura dir
ectory. HPUPLUS.CNF is an ASCII file 
that lists the fonts you have downloaded 
as well as the ID number assigned to 
each. Each font is listed as follows: 

permfont(n fontname) 
Where n is the ID number and font

name is replaced by the full name of the 
font, including the SFP or SFL extension. 

Now select Add/Remove Fonts from 
the Options menu and change all the 
fonts included on the download file to 
"Resident." Select Save As New Width 
Table. Henceforth, Ventura will no longer 
download those fonts each time it prints a 
document. 

Tip: Big First Character 
Big first characters are the large capital 
letters traditionally used in magazine and 
book publishing to open an article or a 
chapter. In Ventura, you can make a big 
first character a part of your FIRSTPAR 
tag. From the Paragraph menu, select 
Special Effects. Select Set Font Proper
ties and specify the font to be used for 
the large character. Ventura automatically 
takes care of indenting the remainder of 
the paragraph to make room for the big 
character. 



You have the option of selecting 
either Normal or Custom spacing for the 
fIrst character. If you choose Normal, 
Ventura will align the top of the big 
character with the top line of text. If you 
choose Custom and x lines, it will align 
the bottom of the character on the base of 
the xth line. In other words, if you select 
Custom and 3 lines, it will rest the big 
character on the baseline of the third line 
of text. 

T his paragraph shows the result of 
selecting 36-point Times Roman 
bold and Normal Spacing in text that 

is 13-point Times Roman on 15 points of 
leading. 

T his paragraph shows the result of 
selecting 36-point Times Roman 

bold and Custom Spacing (set to 2 lines) 
in text that is 13-point Times Roman on 
15 points of leading. 
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T his paragraph shows the result of 
selecting 50-point Times Roman 

bold and Custom Spacing (set to 2 lines) 
in text that is 13-point Times Roman on 
15 points of leading. 

O
hiS paragraph shows the result of 
selecting 54-point Times Roman 
bold and Custom Spacing (set to 3 

lines) in text that is 13-point Times 
Roman on 15 points of leading. The color 
of the Big First Character is set to White. 
The black box is created by using the 
Ruling Line Above, with settings shown 
in Figure 3. 

Figure 3: The 
settings in the 

Ruling Line 
Above dialog 

box for creating 
the white on 

black drop cap 
shown above. 
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Pagination 
IN THE JARGON of word processing, 
pagination refers to the capability of a 
program to automatically print a page 
number on each page. In publishing par
lance, however, the word refers more 
broadly to the process of assembling the 
parts of a page and then assembling 
pages together into chapters and entire 
documents. 

This chapter is about the ways in 
which Ventura handles the pagination 
process. While many other desktop pub
lishing programs leave you to handle the 
pagination task more or less manually, 
Ventura automates the work to a large de
gree. 

Headers and Footers 

You can create a header or a footer at any 
point after loading a document. To create 
a header, select Headers & Footers from 
the Page menu. Select whether the 
header/footer is for a right or left page, 
select Usage: On, and type the material 
you want contained in the header/footer. 
The three lines-left, center, and right-

are for material that will be aligned left, 
centered, or aligned right in the header. If 
you select Chapter # or Page #, Ventura 
will insert the chapter or page number 
within the header/footer. 

The 1 st Match and Last Match com
mands allow you to select material from 
your page to include in the header. This is 
especially useful in references such as the 
phone book, where the name of the first 
person listed on the page is also included 
in the header for that page. If you select 
1 st Match or Last Match, Ventura inserts 
a marker that contains the words "tag 
name." You must backspace across these 
words and type the name of the tag that 
you wish to have as the 1 st Match or Last 
Match. 

When you select Text Attr, Ventura 
inserts a D surrounded by angle brackets. 
You can replace the D with any of the 
text attribute codes listed in Appendix D 
of the manual. These codes allow you to 
change the font or type attributes of a 
single word within a header. For ex
ample, to make a single word appear in 
bold weight, include a B on the left side 
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of the word and an M (to return to me
dium) on the right side of the word. 

When you select Copy To Facing 
Page, Ventura translates your header to 
the opposite page, switching the left and 
right entries of the header/footer to make 
facing pages symmetrical. 

Tagging Headers and Footers 

Once you have created a header or footer, 
Ventura automatically creates a tag, 
either Z_Header or Z_Fo0 ter. The Z 
marks it as a "generated tag." Such tags 
can be altered by means of the same pro
cedure used for altering any other tag. If 
you do not see any generated tags in the 
Assignment List when the Tagging func
tion is selected, select the Set Preferences 
option of the Options menu and then 
select Generated Tags: Shown. 

Figure 1,' The 
autonumbering 

dialog box 
Usage: iii [][] 

Just as with any other tag, you can 
alter the font, alignment, spacing, and 
other features of the header or footer tag. 
The only limitation is that a header or a 
footer can have no more than two lines of 
text. 

Header and Footer Spacing 

The relation between header or footer 
spacing and the margins set for the rest of 
the page can be confusing. Generally, 
you should think of the two as being 
completely separate. No matter what you 
specify as the spacing above and below a 
header, the margin for the rest of the page 
will continue to be constant. In other 
words, once you set the margins for the 
rest of the page, they will not be affected 
no matter what settings you choose for 
the header or footer. 

level 1: [*Major Hepding, 1] 
level 2: [*tag nalllep 1] ________ _ 
level 3: 
level 4: 
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level 6: 
level 7: 
level B: 
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There is one exception to the inde
pendence between headers/footers and 
the rest of the page. It is that if the above 
and below space set for the header 
exceeds that of the margin, the margin 
will be expanded. 

One source of confusion for those 
setting header/footer margins is that the 
Z_Header and Z_Footer tags alone do not 
completely determine the distance be
tween the tags and the top of the page. 
For every header and footer, Ventura also 
generates a new frame and automatically 
sets up top, bottom, left, and right mar
gins for that frame. So the margin above 
the header is the top margin of the header 
frame (set by selecting the Frame func
tion, selecting the header frame, and 
selecting Margins & Columns from the 
Frame menu) plus the Space Above set
ting in the Z_Header tag (set by selecting 
the Tag function, selecting the header, 
and selecting Spacing from the Paragraph 
menu.) 

Widows and Orphans 

Another function of the pagination 
process is making sure that isolated lines 
do not appear at the top or the bottom of 
pages. Such lines are referred to as 
widows when occurring at the top of the 
page, or as orphans when occurring at the 
bottom. The Widows & Orphans selec
tion of the Page menu allows you to 
specify the minimum number of lines that 
may be isolated at the top or the bottom 
of the page. Normally, this should be set 
to 2 for both orphans and widows, since 
this will prevent single isolated lines. 
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Automatic Numbering 

With Ventura, you have the capability of 
automatically numbering chapters, pages, 
subheads, and captions. These options are 
controlled with the Chapter Counter, 
Page Counter, Autonumbering, and Re
number Chapter options of the Page 
menu. Of these, the most important 
dialog box is Autonumbering. 

Although it is straightforward, the 
autonumbering process requires a good 
deal of attention to detail. The procedure 
is as follows: 

• Select Auto-Numbering from the 
Page menu. 

• Select Usage: On. 

• Select 1,2; A,B; a,b; I,ll; or i,ii to in
dicate the type of numbering you 
want. 

• Replace the word "tag name" with 
the name of the tag you wish to have 
numbered in your document. 

• If you wish to start numbering at a 
number other than 1, type a comma 
and the number (as an arabic 
numeral, e.g. 3) just inside the right 
bracket. 

• If you wish to have any text or punc
tuation accompanying the number, 
type it to the right or left of the 
bracketed portion. 

• If you want to have part of the auto
matically generated material appear 
in a different font, select Text Attr. 
Ventura will insert a D surrounded 
by angle brackets. You can replace 
the D with one of the formatting 
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codes shown in Chapter 7 of this 
book or in Appendix D of the Ven
tura manual. 

• If you don't want the numbers for 
higher levels combined with the 
number for a lower level, move the 
cursor to the beginning of the line 
and select Suppress Previous Level. 

• Once you have completed filling out 
the lines of the Auto-Numbering 
dialog box, select OK or press Enter 
to execute the Auto-Numbering. 

• If you wish to change the font or 
spacing of the number, select the 
Tag function and select the number. 
It will have a tag such as Z_Sec 1. 
Using the options in the Paragraph 
menu, you can change the font, the 
spacing, the alignment, and other 
features of the number. 

• If you want the number to appear on 
the same line as the following text, 
select the Tag function, select the 
number, select Breaks from the Para
graph menu, and set Line Break to 
Before. Then select the following 
paragraph and set Line Break to 
After. Adjust the indentation of the 
fIrst line of the paragraph to avoid 
overlap. Next, change the tags of 
other paragraphs to Line Break: 
After, to avoid overlaps with those 
paragraphs. 

• Automatic numbers are not auto
matically adjusted if text is edited. If 
you do perform any text editing, 
such as deleting a few paragraphs, 
select Chapter Counter from the 
Page menu. Contrary to the sound of 

its name, this does not renumber the 
chapters in a publication, but rather 
resets the automatic numbering used 
within a chapter. 

Frame Anchoring 

Frame anchoring is a useful feature that 
is new in Ventura 1.1. In the previous 
version, frames remained stationary un
less you manually changed their position. 
This created problems in long docu
ments, where the addition or deletion of a 
few paragraphs on page 1 might cause 
text to flow away from the accompanying 
illustrations in subsequent pages of the 
document. 

By using the frame anchoring capa
bility, you can keep illustrations with 
their accompanying text. The procedure 
for anchoring a frame to a passage of text 
is as follows: 

• Select the Text function. 

• Place the cursor in the paragraph to 
which you want to anchor the frame 
and click. 

• Select InsertlEdit Anchor from the 
Edit menu. 

• Give the frame a name, and select 
whether you want it to remain on the 
same page as the anchor, below the 
line containing the anchor, or above 
the line containing the anchor. 

Select the Frame function. 

• Select the frame you want to anchor, 
and select Anchors & Captions from 
the Frame menu. Type the Anchor 
name. (Note: Ignore the remainder 



of this dialog box; the above, below, 
left, right selections apply to cap
tions rather than anchors.) 

Ventura will not automatically adjust 
the position of anchored frames unless 
you specifically direct it to. If changes in 
the text cause frames to flow away from 
their anchor points, select Re-Anchor 
Frames from the Page menu. Ventura will 
attempt to move the frames into the des
ignated positions relative to their anchor 
points. Frequently, frames will end up in 
the margins of the page. In that case, 
you'll have to adjust them manually. 

Automatic Text Insertion 

You can use the auto-numbering feature 
of Ventura to place a standardized pas
sage of text in front of every paragraph 
with a designated tag. By deleting the 
number within the brackets, no number
ing will occur; however, any text you 
print on that line will be printed at the 
beginning of every paragraph with that 
tag. Up to 35 characters of specified text 
can be automatically inserted using this 
technique. 
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Graphics 
IN CONTRAST TO the typographic 
nuances and annoyances of formatting 
text, the process of loading graphics into 
Ventura is simple and straightforward. 

In working with graphics, the fIrst 
distinction to keep in mind is the differ
ence between bit-mapped graphics 
(which Ventura refers to as images) and 
object graphics (referred to as line art). 

Images, which are produced by scan
ners and by most painting programs, are 
stored in the computer as patterns of O's 
and 1 'so The digital pattern in the com
puter has a one-to-one correspondence to 
the pattern of dots in the image. 

Line art is produced by CAD pro
grams such as AutoCad and by most bus
iness graphics programs. Here, the pic
ture is stored in the form of a compact 
mathematical description. 

The advantage of line art over im
ages is that line art can be scaled to any 
extent without degradation, while images 
look ragged when scaled. When printed 
on a high-resolution output device such 
as a typesetter, diagonal lines in line art 
become smooth, whereas such lines in 
images show noticeable "jaggies.?' 

Scanning Images 

In conjunction with 300-dpi laser print
ers, digital scanners provide a great deal 
of utility but also pose some distinct 
drawbacks. The area in which these dev
ices are of the greatest use is in convert
ing pictures that are black and white only 
with no intermediate shades of gray 
(what graphic artists refer to as "line 
art"-though that term has a different 
meaning within Ventura Publisher). The 
quality of such images stands up well 
when converted into a computer file by 
the scanner and printed on the laser 
printer. In contrast, pictures containing 
shades of gray, such as photographs, are 
poor candidates for scanning, due to the 
inherent limitations of a 300-dpi output 
device. For publications that must stand 
up to commercial standards of quality, 
you should always have photographs 
screened using traditional methods at a 
graphic arts shop and then paste the half
tone into your document. 

To be imported into Ventura, a 
scanned image must be in one of the for
mats recognized by Ventura-either PC 
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Paintbrush (PCX), Gem, or MacPaint 
(PIC). Most PC scanners can be operated 
by software that generates files with the 
PCX or the GEM extension. For ex
ample, the Eye-Star software that drives 
the Microtek MS-300A scanner can pro
duce either GEM or PCX format. The 
Publish Pac software that drives the Dest 
Corporation PC Scan Plus scanner can 
produce PCX files. In addition, both PC 
Paintbrush Plus (or Publisher's Paint
brush) and Halo DPE can drive scanners 
directly. 

o 
To digitize the Peachpit 
Press logo shown here, I 
used PC Paintbrush Plus 
to drive a Canon IX-12 
scanner. To operate the 
Canon (or other scanners 
supported by PC Paint

brush, such as the Dest PC Scan, the 
ShapeScan, the Datacopy 730, and the 
HP ScanJet), you select the Scanning op-

tion from the Page menu, as shown in 
Figure 1. After you select a scanning 
area, the scanner automatically feeds the 
image and PC Paintbrush displays the 
final picture, as shown in Figure 2. You 
should make the scanning area as small 
as possible, since even though PC Paint
brush performs some data compression, 
each square inch of an image can take up 
as much as 11K on your hard disk. As 
shown in Figures 3 and 4, you have two 
levels of zoom available for editing the 
individual pixels that make up the image. 
After you alter or clean up the image 
with pixel editing, you can save the 
image as a PCX file. 

Loading Graphics 

To load a graphic into a Ventura docu
ment, follow these steps: 

Style Size Pick Mise 
Figure 1,' To 

scan a picture, 
you select the 

Scanning com
mand from the 
PC Paintbrush 

Plus or Publish
ers Paintbrush 

Page menu. 

• 



Figure 2: After 
you scan the 

graphic, it ap
pears on the PC 

Paintbrush 
screen as shown 

here. 

Figure 3: After 
you select the 

zoom-in option 
from PC Paint

brush's Misc 
menu, you can 
edit individual 

pixels. 

Figure 4: With 
the ZOOM-IN op

tion, you can 
work even more 

closely at the 
pixel level. The 

portion of the pic
ture being en

larged is shown 
in the upper left. 
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Undo Page Edit Style Size Pick Hisc 

Undo Accept 
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Programs That Use CGM Format 

20/20 - Access Technology 

AlGRAPH - Donovan Data Systems 

Allspice - Acotech 

Apollo - ABA Groups 

ARC+ - Architecture and Computer Aids 

ASI Font System - Analytical Software 

Business Strategist and Business Simula-
tor - Reality Development Corporation 

CADTEC - Itautec Information S/A 

Cadwrite - IBM 

CASE Manager - Computer Aided Struc-
tural Engineering 

COGO Pac - Maptech 

Concept 100 - Concept Technologies 

CustornlQC - Stochos 

DaVinci Business Graphics Package - Pro-
fessional Research Consultants 

Display - ISSCO 

ESTIMATION/Automatics - Tipnis 

Excalibur - Communication Dynamics 

Fortgraph APA - Digital Communications 
Associates 

Freelance - Lotus 

GAF - Simulation Software Systems 

GPOS-7 - Planmetrics 

GRAFTIME - Genigraphics Corporation 

Graph 6 Application Development Facility -
Honeywell Corporation 

Graphics Operating System - University of 
Texas 

Harvard Presentation Graphics - Software 

Publishing 

Hornet 5000 - Claremont Controls 

IRMAGRAF - Eastman Kodak 

Labtech Notebook - Laboratory Technology 
Corporation 

LARSA - Innovative Analysis 

LLCOGO - Lewis and Lewis 

MathPlan 3.0 - Wordperfect Corporation 

Matrix-X - Integrated Systems 

Mavis - Robinson Associates 

Metal Building Program -International 
Structural Engineers 

Micro Cadam - CADAM 

MicroCAD - Imagimedia Technologies 

MicroCUBE - McDonnell Douglas 

MicroTrak - SofTrak Systems 

OPTEC - Sciopt Enterprises 

Opus - Optim Electronics 

PC Link A Graph - ISSCO 

PC-DOE - CA Systems International 

pcEXPRESS - Information Resources 

Personal Engineer - Computervision Cor-
poration 

PlotTrack - SofTrak Systems 

PMS80 - Pinnell Engineering 

PROCAD 4.02 - Interactive CAD Systems 

Q.E.D. DAC - Hart Scientific 

R:BASE Graphics - Microrim 

Redliner - Auto-Trol Technology 

Route Assist - Logistics Resource 

Table 1: Programs that create files in CGMformat (Source: VPUG). 



Sigma-Plot and Sigma-Scan - Jandel Scien-
tific 

Simscript 11.5 - CACI 

SIPSURF - Delfts Spline Systems 

Sound Presentations - Communication Dy-
namics 

SPC-PC - Quality America 

SPD - Tektronix 

ST-PC Translator - Sangamo Weston 

Super Sceptre - Austria Microsystems 

Surface Display System - Design Profession-

Table 1 (continued). 
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als Management Systems 

Technology Futures Software Library - Tech-
nology Futures 

TextCharts - Hewlett-Packard 

Timepiece - Communications Dynamics 

VIA - Tektronix 

Viewpoint Graphics - Computer Aided Man
agement 

VSA Software - Applied Computer Solutions 

XICAMM - Xiris Corporation. 

Programs That Use VideoShow Format 

Autumn - Zenographics 

Microsoft Chart - Microsoft 

ChartMaster - Decision Resources 

Ego - Zenographics 

EnerGraphics - Enertronics 

FlexDraw - TNET 

Freelance - Lotus 

Graphwriter - Lotus 

Graphic Decision Support System - Data 
Business Vision 

Hot Shots - New Vision Technologies 

Image Management System - Electronic Cot
tage 

Impressionist - ExecuComp 

Mirage - Zenographics 

orgCHART - TNET 

PC Presents! - Imedia 

PC Slide Showmaker - Management 
Graphics 

Picturelt - General Parametrics 

PicturePak Eye Openers - Marketing 
Graphics 

PicturePak Business World - Marketing 
Graphics 

PicturePak Maps - Marketing Graphics 

SignMaster - Decision Resources 

Speaker Support Plus - Meta-4 

VideoS how - General Parametrics 

VI P - Matrices 

Visual Express - Visual Media 

Table 2: Programs that support VideoShow format (Source: VPUG). 
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• Prepare the graphic with your 
graphics program or scanner soft
ware. 

• Load Ventura and open the chapter 
into which you want to place the 
graphic 

• Create a new frame for the graphic 
by selecting the Frame icon, select
ing Add New Frame, and then draw
ing the frame on the page. 

• Select Load Text/picture· from the 
File menu. The Load Text/Picture 
dialog box will appear. 

• Select Line-Art or Image, then select 
the appropriate format. The Item 
Selector dialog box will appear. 

• Enter the name of the path and ex
tension on the Directory line, and 
enter the name of the file on the 
Selection line. For shortcut methods 
of selecting paths, extensions, and 
file names, refer to Chapter 6, 
"Managing Files." 

Types of File Formats 

Ventura can import the following formats 
for line art: GEM, AutoCAD SLD, Lotus 
and Symphony PIC, Mentor Graphics, 
VideoShow, MacDraw and other Macin
tosh PICT, Computer Graphics Metafile 
(CGM), Encapsulated Postscript Stand
ard Format (EPSF), and Hewlett-Packard 
Graphics Language (HPGL). 

Table 1 lists the programs that can 
produce files in VideoShow format. Table 
2 lists programs that produce files in 
CGMformat. 

Cropping, Scaling, and 
Positioning 

More controls have been provided in 
Ventura 1.1 for handling graphics. Pre-

, viously, it was not possible to crop line 
art, for example. Now all the operations 
for that apply to images apply to line art 
as well. 

Once a graphic has been loaded into 
a frame, you can proceed to crop, scale 
and position it. Select the Frame icon and 
select the. frame containing the graphic. 
Next, select the Sizing & Scaling option 
of the Frame menu. All the controls for 
manipulating imported graphics are lo
cated in the Sizing & Scaling dialog box, 
shown in Figure 5. 

Sizing the Frame 

Underneath the text flow control, which 
allows you to specify whether you want 
text to make room for the new frame, the 
next set of controls is for changing the 
position and size of the frame itself and 
for creating a margin around the frame. 

The figures shown for Upper Left X, 
Upper Left Y, Frame Width, and Frame 
Height are the current parameters of the 
frame you have drawn. The Upper Left X 
coordinate measures the distance of the 
upper left corner of the frame from the 
left side of the page and the Upper Left Y 
coordinate measures the distance of the 
frame from the top of the page. By enter
ing new settings for the upper left corner 
of the frame and for its width and height, 
you can move a frame or position it more 
precisely. By using the two settings for 



padding, you can create additional space 
around the frame. 

To the right of Vertical Padding is 
the unit of measurement unit that applies 
to all settings in the Sizing & Scaling 
dialog box. You can change this by plac
ing the cursor directly on top of the unit 
of measurement (i.e. the word inches, 
picas & points, etc.), and clicking the 
mouse button. 

Scaling and Aspect Ratio 

Underneath the settings that control the 
position and size of the frame are settings 
that let you scale and crop the graphic. If 
you choose Fit in Frame, Ventura will 
make the picture as large as possible 
without exceeding the boundaries of the 
frame. If you also choose Distorted, Ven
tura will enlarge it to both the horizontal 
and the vertical edges of the frame; if you 
choose Maintained, the program will pre-

Figure 5.' The 
Sizing & Scaling 

dialog box. 
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serve the original ratio of its horizontal 
and vertical dimensions. 

Selecting the By Scale Factors op
tion lets you crop an image and manually 
enter its width and height. The X Crop 
Offset moves the picture to the left if you 
select the plus sign, and to the right if you 
select the minus sign. The Y Crop Offset 
moves the picture up if you select the 
plus sign and down if you select the 
minus sign. 

Another way of cropping is to hold 
down the Alt key while holding down the 
mouse key and moving the mouse. 

Internal Graphics 

To use Ventura's internal graphics, you 
select the Graphics icon and then select 
the tool you wish to use. After creating 
the graphic, such as a line or a box, select 
the Line Attributes or Fill Attributes to 
set the thickness, color, or end styles (in 

Flow Text Around: m []ill 
Upper left K: 1B,O~ a c:J 

Frilflle Width: 2B,04 
Upper left Y: 12,B2 a c:J 
Fra/lle Height: 1B,B2 

Horiz. Padding: BO,OB Vert. Padding: BB,BO picas B points 

Picture Scaling: I Fit in Fra/lle I wmtjiifiB4. 
Aspect Ratio: 11M.' I Distorted I 

K Crop Offset: BB,BB ac:J Y Crop Offset: 00,00 ac:J 
Scale Width: 24,B4 Scale Height: 24,04 

ColUIVI Balance: ~ I!IiI 
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Figure 6: By sub
stituting other 

tags for the Box 
Text tag, you can 

vary the format 
of text contained 

in boxes on the 
same page. 

Figure 7: Label
ing graphics with 

box text "post
Its." 

~oxText[] I 

I BoxTextc 

Box lexla 



the case of lines), or color, fill pattern, 
and opaqueness or transparency (in the 
case of boxes and circles). 

If you want to draw a series of 
graphics and have them all be the same 
attributes (such as five arrows), select the 
attributes for the fITst arrow and select 
Defaults: Save To. From then on, all the 
graphics of that type that you draw will 
have the same attributes. 

After you use a graphic tool, the 
selection defaults to the selector arrow. If 
you want to quickly draw several lines or 
boxes without· selecting the line or box 
key each time, hold down the Shift key 
while you draw the graphics. 

Selecting Graphics 

Once you have drawn a graphic, you can 
always go back and change its appear
ance, stretch it, or move it. To do so, 
simply select the pointer icon (the one 
that looks like an arrow) and point at the 
graphic. Six small black boxes will ap
pear around the graphic to indicate that it 
is selected. 

Once selected, a graphic can be 
stretched by selecting one of the edge 
boxes, holding down the mouse button 
and dragging that edge inward or out
ward. It can be moved by placing the cur
sor within the graphic, holding the mouse 
button down, and dragging the graphic to 
a new location. Finally, once selected, 
you can change the settings for the 
graphic from the Graphic menu. 

After printing a draft of a document, 
you will no longer be able to select 
graphics that you previously were work-
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ing with. The reason is that Ventura de
faults to the base page frame after print
ing. To select a graphic after printing, 
select the Frame icon, select the frame to 
which the graphics are attached, then 
select the Graphics icon again. 

It is possible to select multiple 
graphics. This allows you to change all 
their settings together or to drag them as 
a group. There are two ways to select 
multiple graphics: 

• Hold down the Shift key while 
selecting them one at a time. 

• From the Graphics menu, Choose 
Select All. Then hold down the shift 
key while de-selecting those 
graphics you don't want in the 
group. 

Graphics and Frames 

An important point to note is that every 
graphic you draw is "attached" to the 
most recent frame that you selected. 
However, the graphic does not have to 
actually be within the boundaries of the 
frame. That allows arrows to be drawn 
pointing into an imported graphic. It also 
provides the basis for some useful tricks 
described below. 

A second important point to note is 
that graphics drawn directly on the base 
page frame will be repeated on every 
page. 

Box Text 

The box text drawing tool allows you to 
draw boxes that can also contain text. To 
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use box text you select the box text tool 
and then hold down the mouse key while 
drawing the box. The words Box Text 
should appear in the box. Switch to text 
mode, place the cursor within the phrase, 
backspace across it, and type any text. 

Initially, Ventura generates its own 
tag Z_BOXTEXT, for the text you type 
in a box. However, you can label boxes 
with other tags instead of Z_BOXTEXT, 
just as you would tag any other text. In 
fact, if your box contains two paragraphs 
you can use two different tags within the 
box, as shown in Figure 6. 

Labelling Graphics 

Box text is especially useful for labeling 
graphics, as shown in Figure 7. Notice 
that it is not necessary for the boxed text 
to be within the frame containing the 
graphic. After you create the box, you 
can specify Line Attributes: None so that 

Figure 8: Each 
set of disks in the 
PC Quik-Art col
lection is devoted 

to one topic. 
Among the sub

jects included are 
holidays, sports, 

advertising tools, 
religion, business 
and finance, and 

cartoons. This 
image is taken 

from the US and 
World Maps disk. 

the box itself disappears and only the 
frame is left. If you select the frame con
taining the graphic while drawing the 
boxes and arrows, the labels and arrows 
will move if you move the frame to a 
new location. 

Creating Tables 

Another useful application of box text is 
for creating forms and complex tabular 
material, as illustrated in Chapter 2, "Tu
torial: A Form," and Chapter 8, "Typo
graphics." When using box text for forms 
and tables, you can have the option of 
using different line and fill attributes, or 
of eliminating the box lines entirely. 

Frames or Box Text? 

When should you use frames and when 
should you use box text? Generally, you 



should only draw a frame on a page to 
hold text when you are loading text from 
a word processed file, when the text must 
be in multiple columns, or when the text 
must jump to another frame. Otherwise, 
you should use box text because of the 
greater control provided by the grid set
tings feature and because a group of 
boxes can all be moved together, retain
ing their relative positions, when you 
select and drag the frame to which they 
are attached. 

Clip Art 

Clip art refers to collections of non-copy
righted professional illustrations used by 
graphic artists. With the advent of Mac
Paint on the Macintosh and similar pro
grams on the PC, large clip art collections 
have been assembled on disk. Because of 
Ventura's ability to import images in 
MacPaint, MacDraw, PC Paintbrush, and 
other formats, these large collections can 
now be utilized in Ventura documents. 

Images on Macintosh disks, of 
course, must be transferred to PC for
matted disks using a conversion setup 
such as TOPS from Centram or PC Mac
Bridge from Tangent Technologies. 
However, some Macintosh clip art com
panies have stated the intention of pro
viding their graphic images on PC disks 
as well. 

Although less clip art is available in 
PC graphics software formats than in 
Macintosh formats, some of it is of excel
lent quality and is worth investigating. 
The largest collection of PC Paintbrush 
images is the one sold by PC Quik -Art in 
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Athens, Georgia (800/523-1796), which 
has converted over 40,000 commercial il
lustrations from SCW Services, an estab
lished graphic arts supplier. Information 
on other products is included in the Pro
duct Information appendix. 

One thing to find out before you pur
chase a clip art collection is whether each 
piece of art is contained in a separate file. 
Collections in which several pieces of art 
are in each file are difficult to use be
cause you have to go through the trouble 
of cropping out the unwanted images. 

Tips on Graphics 

Tip: Using a Scanned Graphic for Large 
Type 
Many non-PostScript printers cannot 
print large type. For example, the AST 
TurboLaser, HP LaserJet Plus, and the 
Cordata laser printer are limited to type 
of 30 points or smaller, and the JLaser 
board is limited to type of 48 points or 
smaller. If you were printing a monthly 
newsletter and wanted very large type for 
your masthead, you could have the mast
head prepared at a typeshop, use a scan
ner to convert it into a graphic image, and 
then load it into Ventura as an image. 
This option, of course, is only practical 
for something that is used over and over, 
like the newsletter masthead. 

Tip: Precise Positioning of Graphics. 
If you want to precisely position a 
graphic, one way is to use the current 
position indicators, the small dotted lines 
on the rulers. An even more precise 
method, however, is to create a special 
position marker on the page. To do so, 
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Figure 9: This 
scanned image 

provides a tem
plate for tracing 
using Ventura's 
graphics tools. 

Figure 10: After 
using Ventura's 

graphics tools to 
trace the image, 

you can remove it 
from the page 

using the Remove 
Text/File option 

of the Edit menu. 

Desk File 

o 
• 



draw a small frame. From the Frame 
menu, choose the Sizing & Scaling op
tion. Type the _coordinates you wish to 
mark next to Upper Left X and Upper 
Left Y. You now know the precise loca
tion on the page of the upper left comer 
of this "positioning frame." Deactivate 
the frame by clicking on a different one, 
so that the positioning frame will be used 
for reference purposes only, rather than 
to hold the graphic you are about to draw. 
After drawing the graphic, you can reac
tivate and delete the frame, which has 
served its purpose as a reference point. 
This is a handy trick for placing crop 
marks at odd locations, like 1.3 inches 
from the top and left sides of the paper. 

Tip: Using a Tracing Template 
It is possible to load a scanned image into 
a frame and then trace on top of it using 
Ventura's drawing tools, as shown in 
Figures 9 and 10. After you finish trac
ing, you can then select Remove 
Text/File from the Edit menu to remove 
the image. By holding down the Shift key 
while drawing with the Line tool, you can 
rapidly generate a traced sketch on top of 
the scanned image. To enhance the qu
ality of the result, trace it larger than you 
intend to print it, then shrink it to the 
desired final size. 

Tip: Making Room Around Graphics 
Ventura automatically flows text around 
graphics frames, but the fit may be too 
tight for your liking. To create some extra 
space, use the new padding option of the 
Sizing and Scaling menu. 
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Tip: Trouble Selecting Graphics 
In graphics mode, if you have trouble 
selecting a graphic element such as a box 
or a circle, select the Frame icon, select 
the frame containing the graphic, then re
turn to graphic mode. 

Tip: Moving Objects Without Distortion 
Often when you click on a small graphic, 
the cursor will take the shape of a point
ing hand and immediately distort the ob
ject before you move the mouse. To 
make it easier to move such hard-to-grab 
graphics, create a box in the same frame 
and choose Select All from the Graphics 
menu. When you move the box, the small 
graphic will also be moved. 

Tip: Lotus 1-2-3 Graphics 
With most laser printers, the Lotus 123 
PrintGraph program is limited to a crude 
75 dot-per-inch resolution. However, 
once a graph has been loaded into Ven
tura it will print at a full 300 dpi. Simply 
draw a frame on a blank page, load the 
Lotus graph, and then stretch the edges of 
the frame to make it any size you want. If 
you're not satisfied with the chart labels 
and titles imported from Lotus, create 
your own with Ventura's Box Text tool 
format them using tags or Set Font: 
choose an opaque white background, and 
drag them into place to cover up Lotus's 
labels. 

Tip: Cropping a Graphic 
There are two ways to crop a graphic. 
One is to create an eraser box to mask 
part of the graphic, as described in the 
tips above. The other is to move the 
graphic so that part of it is hidden by the 
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Figure 10: Margins 0, fit in frame, 
distorted. 

Figure 12: Margins 0, by scale factors, 
aspect ratio maintained, width 15 picas, 
no crop. 

Figure 11: All margins 3 picas, fit in 
frame, distorted. 

Figure 13. All margins 1 pica, by scale 
factors, aspect ratio maintained, width 
15 picas, Y crop -8 picas. 



boundary of the frame or by the frame 
margin. Figures 10-13 show the shuttle 
image with six different settings for mar
gins, crop offsets, picture scaling settings, 
and aspect ratio settings. 

Tip: Speed up Ventura By Hiding Pictures 
After loading a picture on a page, you 
should activate the "Hide Pictures" op
tion in the Options menu. This allows 
Ventura to perform scrolling and other 
operations more quickly. You can even 
keep the pictures hidden while drawing 
labeling arrows and working on captions. 

Tip: Graphic Groups 
If you want to create a group of graphics 
that you can select and move as a group, 
"tie" the group to a frame. They don't ac
tually have to be placed within that 
frame, and the frame can be very small. 
In fact, you can place the actual frame off 
to the side and then draw the graphics 
directly on the page. Unlike other 
graphics drawn directly on the page, they 
will not be repeated on subsequent pages 
because they are not attached to the base 
page. To select the group as a whole, you 
can activate the frame, then select the 
Graphics icon, and type Ctrl-Q to select 
the group as a whole. 

Tip: Erasers 
You can use opaque white boxes as er
asers to cover up small portions of text or 
graphics. Select the Graphics icon, and 
select the box tool. Draw a box. From the 
Graphics menu select Line Attributes and 
set Thickness to None. From the 
Graphics menu select Fill Attributes and 
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set Color to White, Pattern to Solid, and 
Result to White. 

Tip: Placing and Removing Graphics 
After you load a picture, it may not im
mediately appear on the screen. You'll 
notice that its name is shown in the As
signment List, however. To make the pic
ture appear, select the Frame icon, select 
the frame into which it is to be loaded, 
and select the name from the Assignment 
List. 

To remove a picture from a frame, 
select the Frame icon, select the Frame 
containing the picture, select Remove 
Text/File from the Edit menu, and indi
cate List of Files or Frame. If you choose 
List of Files, the image will be entirely 
removed from Ventura. If you choose 
Frame, the image will still be listed in the 
Assignment List and you can reload it by 
selecting its name. 

Tip: The Ballot Box 
A small empty box, known as a "ballot 
box," is frequently needed for creating 
check-off boxes on forms. However, it is 
not included in the fonts provided by 
Ventura. To create such a box, type an 
Em space (Ctrl-Shift-M) followed by 
Enter to make the Em space the only 
character in its own paragraph. Select the 
Tagging icon and tag the Em space. 
Select Add New Tag and name it Ballot 
Box. From the Paragraph menu, select 
Ruling Box Around and select Text, with 
the Height of Line 1 equal to half a point. 
To make the ballot box be on the same 
line as the following text, set its Breaks at 
before and the Breaks for the following 
paragraph at After. To make the Ballot 
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Box the right size you may need to adjust 
the size of the font. Use the Set Font op
tion to do that as well as to shift the box 
down slightly, if necessary, to make it 
align proper! y. 

A quicker way to create a ballot box, 
whose size cannot be adjusted, is to 
select the Graphics icon, select the 
Graphic menu, select Grid Settings, 
select Off, select the Box Text tool, point 
the cursor at the location of the desired 
ballot box, and click the mouse button 
once without dragging the mouse. The re
sult will be a square box, 1 pica tall and 
one pica wide. 

Tip: Moving Graphics Between 
Documents 
You can copy any frame and its contents 
from one document to another. Select the 
Frame icon, select the frame to be 
copied, press Shift-Delete, load the new 
chapter, and press Ins. 

Tip: Drawing a Perfect Circle 
With many monitors the pixels are not 
square and hence the aspect ratio is not 
1: 1. That means a circle that looks per
fectly round on the screen will actually 
print as an oval. To create a circle that 
will print round, first activate the ruler. 
Next, from the Options menu select Set 
Ruler and make sure the horizontal and 
vertical units of measurement are the 
same. Select the Graphics icon, select the 
Circle tool, and move the cursor onto the 
page, and note the position of the vertical 
and horizontal hairlines on the rulers. 
Now press the button and pull the mouse 
down and to the right. Move it until the 
distance you have moved on the vertical 

and horizontal rulers is equivalent. Then 
release the button. 

Tip: Centering a Graphic. 
Normally, when you ftrst load a graphic 
into a frame, it will run up against the 
edges of the frame. To center the graphic 
within the frame you could select the 
Sizing & Scaling option from the Frame 
menu and adjust the X and Y Crop Offset 
settings; however, a better method is to 
select Margins & Columns from the 
Frame menu and enter equivalent values 
for top, bottom, left, and right margins. 
Ventura will then automatically resize 
the graphic to ftt within those margins. 

Questions 

Q: I'm making a crossword puzzle and 
want to create numerous boxes identical in 
size. How do you make multiple copies of a 
graphic such as this? 

A: The method for making copies of 
frames and of graphics is exactly the 
same. Select the frame or the graphic. 
Press Shift-Del. Now drag the frame or 
graphic to the location you want to copy 
it to. Press Ins. The frame or graphic will 
reappear at its old location and you'll 
now have two copies. 

Q: I'm using a PC AT and am having 
trouble using Shift-Del to copy a graphic. I 
hold down the Shift key and then press Del, 
and when I do so the graphic simply 
disappears. 

A: On the AT keyboard there are two Del 
keys. The one that works for copying 



graphics is on the numeric pad; the other 
Del key does not work properly. 

Q: I'm having trouble selecting graphics. 
When I point at them and click, nothing 
happens. 

A: The problem is probably that the 
frame to which the graphics are attached 
is not selected. Even if you have selected 
the frame, it can become de-selected 
when you print a page or when you select 
the Text icon (to edit the contents of a 
Box Text, for instance). To re-select the 
frame, select the Frame icon, and then 
select your frame again. Then select the 
Graphics icon and select the graphic. 

Q: What's the difference between line snap 
and grid snap? 

A: Tum Line Snap On is an option in the 
Options menu. Grid Settings is an option 
in the Graphic menu. Line snap applies to 
text and frames placed on a page, which 
will automatically be aligned to the 
nearest text baseline, based on the lead
ing set in the Body Text tag. The Grid 
Settings option sets up an invisible grid 
that applies only to graphics. It is espe
cially useful in creating tables. For ex
ample, to create a form that will be filled 
out by people using typewriters, set the 
vertical portion of Grid Snap to 1 pica. 

Q: I created a graphic, labeled it with 
arrows, then moved it. The arrows stayed 
behind. How can I get the arrows to move 
with the graphic? 

A: Make sure that when you are creating 
them, the same frame is selected at all 
times. If they are all attached to the same 
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frame, they will all move together when 
you reposition the frame. 

Q: I need vertical dashes to indicate a 
cutout page in a book. How can 1 make 
them? 

A: The usual method for generating verti
cal lines is with the Vertical Rules ... op
tion of the Frame menu. However, it does 
not allow dashed lines to be specified. 
The way to create a vertical dashed line is 
by creating a Frame with no width and 
surrounding it with a dashed boundary. 
Draw a thin, tall frame. Then in the 
Sizing & Scaling dialog box in the Frame 
menu, select 0 as the Frame Width. In the 
Ruling Box Around dialog box, select the 
Ruling Box Around option in the Frame 
menu. Select Width: Frame and Pattern: 
Dashes On. To select the frame "holding" 
the dashed line, select the Frame icon, 
hold down the Ctrl key while pointing 
close to the frame, and keep clicking until 
that frame has been selected. 

Q: I created a very small box and now want 
to move it. However, every time I point at it 
and click 1 see the pointing finger symbol 
on screen (for stretching boxes) rather than 
the four-way arrow symbol (for moving 
boxes). How can 1 move the small box? 

A: Create a larger box near the small box. 
Then hold down the Shift key while you 
select both. Now, when you move the 
larger box, the small box will move with 
it. You can use this technique to move 
the small box into the exact location you 
want. 
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Q: When I print a Lotus graphic, the type is 
tiny. 

A: Ventura substitutes its own fonts to 
match those of Lotus 1-2-3. When a 
graph is imported into the program, the 
font it picks is a 2-point Helvetica 
(Swiss). You cannot tag this text. The 
only way to make it larger is to cover it 
up with larger type that you create using 
Box Text. 

Q: I drew a frame, selected the File menu, 
selected the Load Text/Picture option, and 
selected a graphics file to load. However, 
the picture did not load into the frame and 
the frame remained blank. How do I get the 
picture to load into the frame? 

A: After you select the graphics file to 
load using the Load Text/picture option, 
its name should appear in the Assignment 
List on the left side of the screen. Select 
the frame you want to load the picture 
into. When you point at its name in that 
menu and click with the mouse, it will 
appear in that frame. 

Q: Some of the graphics options recognized 
by Ventura are for MacPaint and 
MacDraw. How can I transfer graphics 
from a Macintosh to a PC? 

A: One way is to use TOPS, a network
ing program from Centram Systems 
West. With this product, you can easily 
shuttle files back and forth from the Mac
intosh to the PC. Another way is to trans
fer the file containing the image with a 
telecommunications program. 

Q: Is it possible to place padding around 
captions? 

. A: Yes. Select the Frame icon. Select the 
caption frame (not the picture frame), 
select the Sizing & Scaling option of the 
Frame menu and specify padding set
tings. 

Q: I want two pictures to overlap, but I 
can't load them into the same frame. 

A: You can't load two pictures into one 
frame, but you can draw two overlapping 
frames and load a picture into each. 

Q: When I loaded the graphic into the 
document I couldn't see it any more. 

A: Select the Frame icon, select the 
frame where the graphic is supposed to 
be located, select the name of the graphic 
from the Selection List. If the graphic 
still doesn't appear in the frame, select 
the Sizing & Scaling option of the Frame 
menu and check the settings for X and Y 
crop offset. If these settings are too large, 
the picture will have been been pushed 
out of the frame. 

Q: What's the largest graphic I can print 
with a Laserlet Plus? 

A: In the best possible case, where 
no fonts have been loaded into the 
printer, the largest graphic you can print 
is 32 square inches. However, if you 
select the 150 dpi LaserJet Plus option 
you can print a full page of graphics. 
From the Options menu, select Set 
Printer Info, and from the dialog box 
choose HP LJ+, 150 dpi. 



Q: I use a PostScript printer and am 
finding it takes much too long to print 
pages containing graphics. What are my 
options for speeding things up? 

A: Since PostScript printers use a serial 
connection to the printer, they are the 
slowest at printing graphics. To speed 
things up, you can buy a LaserMaster or 
a JLaser board. Both provide a high 
speed interface that bypasses the Post
Script controller and can print graphics 
extremely quickly. Unfortunately, on 
pages that you print via the LaserMaster 
or JLaser board, you won't be able to use 
PostScript fonts. 

Q: I set margins for the frame but the 
graphic didn'tfit within them. 

A: From the Frame menu, select Sizing & 
Scaling. Set Picture Scaling to Fit in 
Frame. 

Q: I selected the Graphics icon and then 
selected the arrow tool, but was unable to 
draw arrows. 

A: There is no arrow tool per se. The tool 
that looks like an arrow is actually the 
selection tool, which is used for stretch
ing or moving graphics. To draw arrows, 
select the line icon, then use the Line At
tributes option of the Graphic menu to 
specify an arrow line end. 

Q: Often, when I select a left pointing 
arrow in Line Attributes dialog box, I end 
up with an arrow that points to the right. Is 
this a bug? 

A: Ventura always considers "left" to be 
the starting point of the line you drew and 
"right" to be the ending point. If you're 
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arrow is pointing in the wrong direction, 
draw it over again, this time starting at 
the other end. 
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1)ocu~nt~yout 
Strategies 

You CAN USE Ventura to produce vir
tually any type of document: forms, busi
ness reports, books, technical manuals, 
business letters, brochures, catalogs, 
newsletters-the list is endless. For
tunately, you don't have to master a 
completely different set of techniques for 
each document. 

There are three basic layout strate
gies that apply to almost all documents. 
Each strategy is appropriate for certain 
types of materials but not for other types. 
A large part of mastering Ventura is in 
knowing how to classify a job, and then 
bringing the right set of techniques to the 
task. 

This chapter starts by describing the 
three layout strategies that are available 
with Ventura. It then reviews the proce
dure to follow in laying out several types 
of documents, and finally includes some 
layout tips. 

Layout Strategies 

Although one might devise other terms, 
we'll refer to the three layout strategies 
as base page, newspaper style, and free 
form. The three tutorial chapters at the 
beginning of this book provide an ex
amples of each strategy. The business re
port uses a base page layout, the newslet
ter uses the a newspaper-style layout, and 
the form uses a free-form layout. 

Base Page Strategy 

The most common type of documents are 
those in which you use a word processor 
to create text, then load the text directly 
onto the base page in Ventura. Ventura 
then automatically creates as many pages 
as are needed to hold the entire text file. 
Any settings you specify for number of 
columns, margins, headings, and so forth 
are automatically reflected throughout the 
document. 
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The base page layout method is ap::' 
propriate for books, technical manuals, 
catalogs, and other lengthy documents 
that can be divided into chapters and in 
which each chapter contains a single long 
text file. To see an example of how to set 
up such a document, see Chapter 1, 
"Business Report." Additional notes on 
books, manuals, and catalogs are pro
vided below. 

Newspaper-Style Strategy 

Some documents differ from base page 
documents in that they require text from 
several different files to be joined up on 
the same page. You could do this by 
merging the word processed files to
gether before importing them into Ven
tura, but that would not solve the prob
lem of articles that leapfrog each other, 
for example starting on page 1 and jump
ing to page 7. 

This need for stories to temporarily 
pause on one page with a "continued 
on ... " and then resume on a different 
page calls for a different strategy. The 
method used to format newspaper-style 
documents is to draw frames, using the 
column boundaries on the base page as 
guidelines. You then load text into these 
frames rather than directly onto the base 
page. 

When asked to load text into a 
frame, Ventura loads as much of the text 
file as will fit and then stops. To continue 
the file into a new frame you select that 
frame and then select the name of the file 
from the Assignment List. Ventura starts 
where it left off and continues loading 

text onto the second frame until it again 
runs out of space. 

The newspaper-style layout strategy 
is appropriate for newspapers, newslet
ters, and magazines, and sometimes for 
books and brochures. 

Free-Form Strategy 

While the newspaper-style strategy pro
vides more layout flexibility than the 
base page method, some documents re
quire even more flexibility. For example, 
in forms and flyers, small blocks of text 
and even individual words are arranged 
freely on the page. Sometimes the text is 
surrounded by boxes, as in tax forms; 
other times it accompanies graphics, as in 
the typical flyer. 

For such documents it would be too 
impractical to create each piece of text as 
a separate file and import each into its 
own frame. Instead, the free-form 
strategy calls for the use of Ventura's Box 
Text tool, which allows text to be entered 
in boxes and then moved freely around 
the page. 

Of course, you could do roughly the 
same thing by drawing small frames on 
the page and entering text in these, but 
entering text in boxes has several advan
tages over entering it in frames. First, 
you can use the Grid Snap feature when 
drawing boxes, which makes it easy to 
layout boxes of uniform height when 
creating forms. Second, when you type 
text into boxes you don't have to set up a 
new text file each time, which is the case 
when you type text into frames. Third, 
with the Select All option of the Graphics 



menu, you can select groups of boxes and 
move them together, a process that is 
more difficult in the case of multiple 
frames. Finally, with the Box Text feature 
you can store the line and fill attributes of 
a box and use them to make numerous 
boxes with the same attributes. 

Designing Documents 

The three strategies outlined above all 
beg the more fundamental question of 
document design. Although a full-blown 
discussion of that topic is obviously out
side the scope of this book, before pro
ceeding we'll now take a summary look 
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at it and list to some reference materials 
on the subject. 

In traditional publishing, the job of 
designing a document is kept rigidly sep
arated from the jobs of typesetting and 
pasteup. The organization of labor is this: 
frrst the designer creates a set of specifi
cations for all the elements of the docu
ment, based on his or her own sketches 
and mockups. Next, the typesetter creates 
galleys according to the specifications, 
and the pasteup artist-also following the 
directions of the designer-cuts and 
pastes these onto boards along with il
lustrations. 

Those new to publishing often tend 
to minimize the importance of having a 

Books About Graphic Design 

Layout by Allen Hurlburt, (1977) 
Watson-Guptill Publications 
1 Astor Plaza, 1515 Broadway 
New York, NY 10036 
800/526-3641, 212fi64-7518 
List price: $22.95 

Do-/t-Yourself Graphic Design by John 
Laing (1985) 
Macmillan Publishing 
Front and Brown Streets 
Riverside, NJ 08370 
800/257-5755,212fi02-2000 
List price: $9.95 

Editing by Design by Jan V. White 
(1986) 
R.R. Bowker 
245 W. 17th St. 

Table 1 

New York, NY 10011 
800/521-8110,212/916-1600 
List price: $29.95 

The Graphic Designer's Handbook by 
Alastair Campbell (ed.), (1983) 
Running Press 
125 S. 22nd St. 
Philadelphia, PA 19103 
800/428-1111, 215/567-5080 
List price: $14.95 

Macintosh Desktop Design by John 
Baxter (1987) 
The Baxter Group 
Box 61672 
Sunnyvale, CA 94086 
408/248-8308 
List price: $15.95. 
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formal design for a document. 
Frequently, the attitude is: "I'll feel my 
way through, designing as I go along." 

A compromise between ad lib de
signing and the formal design approach is 
to use Ventura itself to design your docu
ment, creating mockups of each different 
kind of page that the document will con
tain. 

As the designer, there are two kinds 
of consistency that you must enforce: 
first, consistency within pages; second, 
consistency from one type of page to the 
next. For example, even though the index 
pages are quite different from chapter 
title pages, the margins and the place
ment of headers and page numbers must 
be exactly the same in both. 

If you've never designed documents 
before, the best way to learn the basics is 
simply to copy the designs of existing 
documents. In addition, there are a num
ber of excellent books on the subject, 
some of which are listed in Table 1. 

Universal Procedure 

Assuming you have at least a preliminary 
design for your document and have deter
mined which of the three layout strate
gies to use, the next step is to get to the 
work of setting up the appropriate file 
structure, style sheets, frames, etc.-in 
short, laying out the document. The pro
cedure is basically the same no matter 
what type of document you are creating. 

• Prepare text and graphics, as de
scribed in Chapter 7, "Preparing, 
Loading, and Tagging Text," and 
Chapter 11, "Graphics." 

• Prepare a directory structure to hold 
Ventura's own files and the text and 
graphics files. This is covered in 
Chapter 6, "Managing Files." 

• Design the document. Some docu
ments are laid out according to pre
cise specifications created by a de
signer. For others no formal design 
is ever done. With most documents, 
some sort of design is done in ad
vance and then adjusted and fine
tuned as the document is tagged and 
draft copies are printed. 

• Load Ventura. 

• Establish a new style sheet. You can 
do this either by creating your own 
style sheet from scratch or by modi
fying one of Ventura's style sheets. 
To start from scratch, load the DE
FAULT style sheet from the Typeset 
subdirectory and then save it under a 
new name in a different sub
directory. Then begin creating tags. 
Alternatively, you can load one of 
the style sheets provided with Ven
tura (located in the Typeset sub
directory and designated with & as 
the first character), and save it under 
a new name in a different sub
directory. Always work with the 
style under its new name to preserve 
Ventura's original style. 

• Select the desired defaults under the 
Options menu, particularly the Set 
Preferences selection of that menu. 

• Select a paper size, using the Page 
Layout option of the Page menu. 
Note: this is the size of the paper you 
are using in your laser printer, not 



the final size of the pages of your 
document. For now, ignore the other 
selections from the Page menu. 

• Select reduced view so that you can 
view the entire page as you prepare 
the grid. 

• Remove any ruling lines or boxes 
from the base page. This is done 
from the Frame menu. 

• If necessary, use the Sizing & Scal
ing option of the Frame menu to 
change the size of the base page 
frame to match the trim size of your 
final document. Use the Set Ruler 
selection of the Options menu to 
change the 0,0 point of the ruler so 
that it begins at the comer of the 
base page frame. 

• Draw crop marks, if needed, to mark 
the comers of your base page frame. 

• Establish a grid, i.e., the margins, 
columns, alleys between columns, 
and gutters for the page (see "Notes 
on the Grid" below). 

• If working with a newspaper-style 
layout, draw a frame to cover each 
column. 

• Load text onto the base page (in a 
base page layout) or into each sepa
rate frame (in a newspaper-style lay-
out). ' 

• Tag text and use the Add New Tag 
as needed to create new tags. Use the 
options from the Page and Paragraph 
menus to change the formats stored 
in each tag. 

• Add headers and footers (Page 
menu). 
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• Draw frames to hold pictures or 
special text such as tables. 

• Add captions to frames (Frame 
menu). 

• Use Ventura's internal graphics tools 
to add arrows, labels, and other en
hancements to imported graphics. 
Make sure that the correct frame is 
selected when you create these 
added graphics, so that if you have 
to move the frame the arrows and 
labels will maintain their positions 
relative to the graphics. 

• Print a draft of the chapter. 

• If this is the fIrst of a multi-chapter 
document, save' it as CHAP
TER1.CHP, then convert it into a 
template for other chapters. To do 
that, remove the text and graphics 
fIles from the chapter using the Re
move Text/File option of the Edit 
menu, and save the chapter as TEM
PLATE.CHP. 

• Load the text for the next chapter 
into the template chapter. Save it as 
CHAPTER2.CHP. 

Notes on the Grid 

The grid is the invisible set of lines that 
guide the layout process, allowing differ
ent types of pages to fall within standard 
boundaries. In setting up your grid, you'll 
fInd it easier to work in picas than in 
other measurement units, since you can 
usually do everything in single picas and 
avoid the need for working with frac-
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tions. For example, an 8 1/2- by ll-inch 
page comes to 51 by 66 picas. 

TRIM SIZE: The trim size is the final 
size of the pages after they are printed, 
bound, and then trimmed. With technical 
manuals, the base page is frequently the 
standard 8 1/2- by II-inch sheet. When 
you print a book, you have to indicate the 
comers of this trimmed page, preferably 
by placing cross marks at each comer. 

CROP MARKS: When you take the 
camera-ready pages to a printer, they 
must each have four crop marks indicat
ing the comers of the trimmed page. At 
the printer, a film negative will be made 
of each page, and the crop marks will 
provide a reference point for the camera. 

There are two ways to place crop 
marks on your printed pages. One is to 
have Ventura automatically generate the 
crop marks by selecting the Print option 
from the File menu and then selecting the 
Crop Marks option in the dialog box. 
When you select this option you won't 
actually see the crop marks on the screen, 
but they will appear on the printed page. 

Unfortunately, automatic crop marks 
are placed outside the base page frame, 
and they won't appear when your base 
page frame is the same size as your 
paper. In particular, when you are print
ing on 8.5- by ll-inch paper and not al
terring the size of the base page frame, 
you won't be able to use the automatic 
crop mark feature. 

Incidentally, here's how to change 
the size of the base page frame. Select 
the Frame icon and then select the base 
page. Select the Sizing & Scaling option 
of the Frame menu. Enter values larger 

than 0 for the Upper Left X and Upper 
Left Y, settings and values smaller than 
8.5 inches for the frame width and 
smaller than 11 inches for the frame 
length. 

The other way to create crop marks 
is to draw them using Ventura's graphics 
tools. Before you draw the crop marks on 
the page, remove any ruling lines on the 
page. For example, if you are adapting 
the &Book-Pl style or the &Book-P2 
style, you will need to remove the ruling 
box around the frame by selecting the 
Ruling Box Around option of the Frame 
menu and selecting Width: None. 

To draw the crop marks, select the 
Graphics icon, then select Graphics Set
tings from the Graphics menu. Set Grid 
Snap On and set horizontal and vertical 
spacing to approximately .250 inches. 

L 



Draw a horizontal line at one of the 
comers. Select Line Attributes from the 
Graphics menu and choose settings for 
the line. Then select Defaults: Save To to 
make these settings apply to the re
mainder of the crop marks you draw. 
Draw crop marks at all four comers of 
your trim. 

Fortunately, you only have to draw 
the crop marks once-on the fIrst page. 
Ventura automatically copies any 
graphics placed on the base page onto all 
subsequent pages. 

Gutter 
The gutter is a thin margin that is added 
to the spine edge of each page to com
pensate for the portion of the page hidden 
by the binding. On left-hand (usually 
even-numbered) pages the gutter is added 
to the right; on right-hand (usually odd
numbered) pages the gutter is added to 
the left. For bound materials, an extra 2 
or 3 picas is a suitable gutter. 

According to publishing convention, 
documents start on a right page and all 
right pages have an odd number. From 
the Frame menu select Margins and 
Columns. Set the Right Margin equal to 
the desired margin and the Left Margin 
equal to the right margin plus the gutter. 
Select Copy To Facing Page and press 
Enter. Now the dotted lines that indicate 
the column or margin also indicate the 
active area. 

Margins 
In traditional book design, margins are 
sized so that the bottom margin is the 
largest, the outside margin the next 
largest, the top margin the next largest, 
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and the inside margin the smallest. 
(These days, of course, those guidelines 
are routinely ignored by designers.) The 
top margin normally marks the top of 
text, and the header is placed within this 
margin. Likewise, the bottom margin 
marks the bottom of text, and the footer 
is placed within this margin. No matter 
what type of publication you are working 
with, the top margin should be fIxed, 
with text columns hanging from it like 
curtains. The bottom margin is much 
more open to adjustment. Many ma
gazines and newsletters run "ragged bot
tom." 

Margins are set in the Margins and 
Columns selection of the Frame menu. 
Because we have already adjusted the 
edge of the frame to be the edge of the 
trim, the margins are measured from the 
edge of the trim rather than from the edge 
of the paper. 

Active Area 
The active area is the area within the 
margins. The active area is the portion of 
the page on which text and graphics are 
normally placed (on occasion something 
may be placed outside this active area, 
but normally the active area is not 
exceeded). Headers, footers, and page 
numbers, however, do fall outside the ac
tive area. 

Alley 
The alley is the space between the 
columns, which is set using the Margins 
and Columns option of the Frame menu. 
Somewhat confusingly, Ventura refers to 
the alley as the "Gutter." One pica is 
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normally a sufficient measure for the 
alley. 

Columns 
The width of the columns is set in the 
Margins and Columns selection of the 
Frame menu. The maximum and min
imum desirable width for text columns 
depends on the size and typeface of the 
font. For multicolumn documents, de
signers recommend a minimum line 
length of 20 characters, an optimum of 
40 or 50 characters, and a maximum 
length of around 60 characters. Lines 
longer than 60 characters are occasion
ally used in book designs; however, text 
set in long lines can be difficult to read 
because of the tendency of the eyes to 
lose their place when they complete one 
line and scan back to the left for the next. 

Helvetica (Swiss) 

Point Size Characters/Plea 
10 point. .................................... 2.68 
11 point .................................... 2.46 
12 point .................................... 2.24 

Times Roman (Dutch) 

Point Size Characters/Plea 
10 point. .................................... 2.86 
11 point ..................................... 2.62 
12 point. ................................... 2.38 

Table 2: Average character counts per 
pica for Helvetica and Times Roman 

If you do need to set wide lines, use 
a wide font that has a small number of 
characters per pica. Typefaces whose de
signs make them suitable for wide 
columns include Schoolbook, Goudy, and 
Korinna. Faces with more narrow 
characters include Times and Galliard. 
Table 2 shows the average character 
counts per pica (including uppercase and 
lowercase letters), for the two typefaces 
provided with Ventura. 

Books and Manuals 

Overview 

The procedure for laying out books and 
manuals is the same, except that with 
manuals there is more use of Ventura's 
automatic numbering feature. As de
scribed above under "Universal Pro
cedure," the basic strategy is to work on 
the first chapter until you are satisfied 
with the appearance, then remove the text 
and graphics from the chapter and save it 
as a template for the rest of the manual or 
book. Once you have created the initial 
style sheet and template chapter, laying 
out additional chapters is merely a matter 
of loading them into the template, tag
ging text from the style sheet,-and adding 
graphics. 

At first you may wonder why it is 
necessary to create a template chapter in 
addition to a new style sheet. After all, 
doesn't the style sheet contain all the for
matting information necessary to make 



every chapter look the same? Not quite. 
What's lacking from the style sheet are 
the margins and contents for headers and 
footers (although the tags for the headers 
and footers are saved in the style sheet). 
Also, if your document contains a num
ber of illustrations all the same size, the 
template file is a useful place to store 
properly-sized and captioned master 
frames. 

Preliminaries 

As described above under "Universal 
Procedure," the first thing you need to do 
after creating the text and graphics for 
your document is to organize your direc
tories. You should create a new sub
directory to contain your book or manual. 
We'll call it BOOK. Within this directory 
you should create three subdirectories, 
BOOK/DOCS (for text files), 
BOOK/ILLUS (for graphics files), and 
BOOK/VEN (for chapter files, style sheet 
files, and other files generated by Ven
tura). By copying all your text and 
graphics files from their original loca
tions into the appropriate directories, 
you'll have duplicate copies of each, in
cluding copies of your text files that 
don't include any tags. 

Starting a New Style Sheet 

Load Ventura and start a new chapter. 
From the File menu, load either Ventura's 
one-column or two column style sheet 
(&BOOK-Pl.STY or &BOOK-P2.STY). 
Save the style sheet under a new name, 
let's say MyBook. 
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You can now change the size of the 
base page frame, if desired, using the 
Sizing & Scaling option. of the Frame 
menu and entering new values for Upper 
Left X and Y and for the page length and 
width. A word of warning, however: 
when you work with a format other than 
a full-page base page frame, Ventura does 
not automatically move the header and 
footer to align with the new, smaller base 
page frame. That's not a serious problem 
for the header, since you can simply in
crease the top and left margins. But if 
your design calls for a footer you'll find 
that you may not be able to position it at 
the bottom of your page. 

Another option is to produce the 
master pages of your book at an enlarged 
size. This method, which was used in 
producing this book, is described in 
Chapter 18, "Two-Up, Saddle-Stitch, and 
Other Formats." 

Establishing the Grid 

Assuming you don't alter the size of the 
base page frame, the next series of steps 
is to place crop marks on the base page 
frame, and select margins for your 
columns and alleys between the columns. 
Note that the top and bottom margins are 
measured from the edge of the page to 
the top and bottom of your text. Headers 
and footers have separate margins and are 
positioned within the overall margins. 
Left and right margins will normally be 
different to allow a gutter on the spine 
side of the page. By selecting Copy To 
Facing Page from the Margins & 
Columns menu, you can have your set-
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tings for right pages mirrored in left 
pages, and vice versa. 

Headers and Footers 

Once you have set up your margins and 
columns, use the Headers & Footers op
tion of the Page menu to select the con
tent of your headers and footers. Ventura 
will create frames to hold these elements, 
and to specify margins for those frames 
you need to select the frames themselves 
and then use the Margins & Columns op
tion of the Frames menu. 

Using the Template 

Having created the headers and footers, 
the next step is to load the text for your 
first chapter and tag the text, experi
menting with the various options for in
dents, fonts, ruling lines, leading, etc. 
When text is formatted to your satisfac
tion, draw and size frames to hold the 
graphics, using the line snap and column 
snap options to align these frames with 
the text columns. 

Graphics should be added quite late 
in the process, after the text is tagged to 
your satisfaction. One reason is that you 
need to know the position of references 
to illustrations in order to position them 
correctly. If you place the pictures too 
early and then make more revisions in 
your text, you'll find that you need to 
move the picture frames. Often in techni
cal manuals, there is a standard-size 
graphic that is used over and over again. 
Rather than draw and size the frame to 
hold this standard size over and over 

again, you can create it once and then cut 
and paste it as needed. 

When the chapter is completely for
matted and proofed, save it, then use the 
Remove Text/File option of the Edit 
menu to remove all the graphic and text 
files. The headers and footers will re
main, as will the frames that contained 
graphics. You can now save this skeleton 
chapter as a template. For the next chap
ter, load the text file into the template, 
then copy the frames for graphics 
wherever needed (or delete them if not 
needed). Save this chapter under a new 
name and start the third chapter, again, 
from the template. 

Numbering Chapters 

A common misconception is that Ven
tura's Multi-Chapter option can be used 
to automatically number the chapters in a 
manual or book. This is not the case: 
you'll need to add those numbers manu
ally. Nor does Multi-Chapter take care of 
page numbering: when you print a multi
ple-chapter document you'll also have to 
use the Page Counter option of the Page 
menu to manually set the page number at 
the beginning of each chapter; otherwise 
it will revert to 1 every time it begins a 
chapter. 

Ancillary Sections 

Although most of the work that goes into 
designing laying out a book or a manual 
is in creating the chapters, such a docu
ment is actually a set of designs: cover, 
copyright and permissions page, acknow-



ledgements, preface, table of contents, 
section division pages, index pages, ap
pendix pages, and other front and back 
matter. Each separate ancillary section re
quires its own design and style sheet. 

For the table of contents, you can 
use Ventura's Multi-Chapter option to 
create the text, then load the file created 
by Ventura (using the Generated File op
tion in the Load Text/picture dialog box) 
and format it with a style sheet. 

Newsletters 

Unlike books, most newsletters use 
standard letter-size paper, making it un
necessary to change the size of the base 
page frame from 8.5 by 11, and also 
making it unnecessary to draw crop 
marks. What makes newsletter layouts 
different from books and manuals is that 
various text files must be merged within 
a single chapter. 

The basic procedure for setting up a 
newsletter is described in the ftrst tu
torial. The steps are as follows: 

• Follow the universal procedure de
scribed at the beginning of this chap
ter to set up a ftle structure, establish 
a style sheet, remove any ruling 
borders or vertical lines from the 
page, and select a page size. 

• Select the base page frame and indi
cate the number of columns that the 
newsletter will contain. Enter the 
desired widths for these columns, the 
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alley (gutter) between them, and the 
top, bottom, left, and right margins 
for the page. Make sure that the cal
culated width-the sum of the 
widths and gutters-equals the ac
tual frame width. 

• Select Show Column Guides, Tum 
Column Snap On, and Turn Line 
Snap On in the Options menu. 

• Select Add New Frame and draw a 
horizontal frame to hold the newslet
ter headline. Then draw two vertical 
frames to hold articles. 

• Select InsertlRemove Page from the 
Page menu to create the second page 
of the newsletter (still blank). Create 
more pages, if desired. You may 
have to remove vertical lines again. 
Draw frames on these columns. 

• Press PgUp to return to the ftrst 
page. 

• Select the first frame and load a text 
ftle into it. Ventura will load as 
much of the file as it can into that 
frame. 

• Press PgDn to go to the jump page. 
Select a frame and select the text ftle 
name from the assignment list to 
continue the article. Ventura will 
continue placing text, starting where 
it left off. You can keep on going in 
this manner for as many frames as 
you want. 

• Add a headline by using a large font 
(with PostScript printers) or a 
scanned graphic of a typeset head
line (if your printer lacks large type). 
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• Add a thin horizontal frame to con
tain the date, issue number, ~tc. 

Type this directly into the frame. 

• Add headers and footers. 

• After printing an issue, use the Re
move Text/File option of the Edit 
menu to save the layout as a tem
plate for the next issue. Next time 
you format the newsletter, you 
merely insert new text files into 
frames and adjust the lengths of the 
frames. 

Continued On •.. , Continued 
From ... 

When a newsletter story jumps to a new 
page, you have to insert the phrase "con
tinued on" at the bottom of one frame 
and "continued from" at the top of 
another. It's possible, but rather nerve
wracking, to attempt to embed the phrase 
directly in the text at the end of the 
column. The problem is that if you adjust 
the text in any way you'll find that the 
phrase will have moved and you have to 
repeat the process. A better way is to 
create a caption for the frame and type 
Continued On... as the caption. Select 
Below for the caption's position. Then 
tag the caption and create a new tag to 
substitute for the automatically generated 
caption tag. Call your substitute tag Con
tinued On. Follow the same procedure 
for the Continued From ... but position the 
caption above the frame this time and 
create a new tag called Continue From. 

Forms 

The best way to create most forms is with 
the Free-Form method. Set up the base 
page frame with no ruling boxes or lines, 
one column, and column guides not 
showing. If the form consists of a single 
clump of continuous boxes, such as the 
example in the tutorial chapter, you can 
use the Box and Box Text tools from the 
graphics palette to draw the boxes you 
need directly onto the base page. In most 
forms, however, there are groups of 
boxes clumped here and there on the 
page. In that case, the best way to work is 
to create a frame for each group of boxes 
and then draw your boxes within that 
frame. 

The advantage of this way of setting 
up the page is that if you have to reposi
tion a group of boxes you can do so 
easily by dragging the frame they belong 
to. The drawback is that you have to 
make sure that you keep the correct 
frame selected while you draw its con
tents. Every time you print the document 
or switch from graphics mode for one of 
the other modes the selection switches 
back to the base page and you have to 
once again select the frame you're work
ing with. 

The basic procedure is as follows: 

• Create a frame for each group of 
boxes. 

• Create the boxes with the Box or 
Box Text tools. 

• Add text to the boxes. 



• Specify shading and borders for the 
boxes. 

• Create tags for the text in the boxes 
and tag the text. 

Using this method, you can create 
extremely complex forms, moving into 
enlarged mode when necessary for detail 
work. 

Drawing Boxes 

To draw the boxes that make up your 
form you can draw either plain boxes or 
Box Text boxes. The difference is that 
you can type directly into Box Text 
boxes using Ventura's editing com
mands. Simply place the cursor at the end 
of the words Box Text that Ventura has 
generated, backspace across them, and 
substitute your own text. 

Tagging Box Text 

Ventura will automatically generate a tag 
called Box_Text. However, you can tag 
the text within a box with any other tag. 
The best way to work is to create a 
special Box Text style sheet, complete 
with an array of tags for different sorts of 
alignments and fonts. 

Box Text Style Sheet 

None of the style sheets provided with 
Ventura really lends itself to the special 
requirements of tagging forms created 
with the box and box text commands. 
You'll need to create your own Box Text 
style sheet. To do so, load the DE-
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FAULT.STY style sheet from the TYPE
SET subdirectory. Save it under the new 
name: BOXTEXT.STY. 

In a typical form, you'll have some 
text right aligned within boxes, some left 
aligned, and some centered. Various fonts 
may be used, but Helvetica and other 
sans serif faces are the most common. 
What you need in your style sheet is a tag 
for each kind of alignment and typeface. 
as shown in Figure 1. 

+ 

Desk File Edit View 

SW:1;!;;!; 101'" c~n 

Sw:1;!;;!; 101'" ~Tt 

Sw:l.;!;$ 101'" I"'t 

$w:l.;!;;!; 12b c~n 

Sw:1;!;;!; 12b ~Tt 

Sw:l.;!;$ 12b I"'t 

sw:1;!;;!; 121'" c~n 

Sw:l.;!;;!; 121'" ~Tt 

Sw:l.;!;$ 121'" I"'t 

1:a:b c~n 

Figure 1,' lnformatting forms, it helps to 
have a tag for each kind of alignment and 
typeface. 
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To create the fIrst tag, use the Box 
Text tool to draw a box containing text. 
Select the Tagging icon and tag the box. 
Select Add New Tag. Name the tag Swiss 
lOb 1ft (or Helv lOb bft). Set the font to 
lO-point bold Swiss (or Helvetica) and 
choose Left and Frame-Wide for Align
ment. Set In From Left and Above spac
ing at one pica (more or less depending 
on your taste) so that the text does not 
run into the edges of the box. 

Line and Fill Attributes 

Typically, you'll be drawing a number of 
boxes with the same line and fIll incre
ments. To make this easy, select the Save 
To option from the Line Attributes and 
Fill Attributes menu after drawing the 
first box. Remember that boxes don't 
have to have any lines, making the Box 
Text tool useful as well when you simply 
want to place a piece of text at an arbi
trary location on the page. 

Multiple Frames 

Once you've saved your line and fIll at
tributes, you can speed up the process 
even more by holding down the Shift key 
while you draw multiple frames. That 
way you won't have to reselect· the 
graphics tool each time. 

Grid Settings 

When cr~ating forms, it's a good idea to 
set the vertical grid setting to 1 pica. That 
way, the boxes you create will be on an 
invisible grid with 6 lines per inch, which 

just happens to match the line spacing 
used by typewriters, thus making it easy 
for anyone fIlling out the form with a 
typewriter to stay in alignment. 

Merging Data into Forms 

There are several ways to merge data 
from a database program into a form 
created with Ventura. One way is to use 
the mail merge feature of your word pro
cessor to place the data at the location on 
the page that aligns with the boxes. Use 
Ventura to print as many copies of the 
form as you need, then place them back 
in the paper tray. Then print the data into 
the boxes by running the same pages 
twice through the laser printer. 

A more sophisticated method is to 
take advantage of the fact that when you 
type text into a blank frame, Ventura 
stores that text in the Caption fIle (CAP). 
Caption files are simply ASCII fIles con
taining text divided by carriage returns. 
You can set up your form so that each 
box that is to hold merged data is actually 
a separate frame. Create as many blank 
pages as you need, then make all the 
frames in your form repeating frames so 
that they occur on every page. Set up the 
report generator of your database so it 
each record is separated by two hard car
riage returns and so that the tags you 
want to use are automatically inserted at 
the beginning of each one. Then print the 
database to a fIle and give the file the 
same name as the Chapter file containing 
your form (except for the CAP exten
sion). Finally, copy this new Caption file 



into the subdirectory containing the 
Chapter file. 

Document Layout Tips 

Tip: Headers, Footers, and Footnotes 
Headers and footers are not automatically 
stored with the style sheet. So when you 
are doing a book and create the master 
page and the style sheet, you still have to 
create the headers. and footers inde
pendently for each chapter. 

On the other hand, when you create 
headers and footers, Ventura automati
cally creates the tags Z_Header and 
Z_Footer. These tags, as well as any ad
justments you make to them, are stored 
with the style sheet. 

Tip: Form Letters 
Although Ventura lacks a mail merge 
feature, you can achieve the same effect. 
Use the mail merge feature of your word 
processor and print to disk. Then load the 
file into Ventura for formatting. 

Tip: Ventura's Default style sheet. 
Often it's easier to start from a scratch 
style sheet (Le., one containing no tags) 
than to adapt one of the style sheets pro
vided with Ventura. In that case use the 
DEFAULT. STY style sheet, located in 
the TYPSESET directory. Don't forget to 
rename it to preserve the original. 

Questions 

Q: I have created the first page of my 
newsletter and am now ready to create 
the second page. However, when I press 
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PgDn, Ventura won't go to the second 
page. Why not? 

A: PgDn will only take you to the next 
page if one exists. If not, you can create a 
new page using the InsertIRemove Page 
option of the Page menu. 

Q: I am creating a form using the Box 
Text feature of graphics mode. I want 
text in one box to be 12-point bold and 
centered, and text in another box to be 
10-point normal and left-aligned. How 
can text in one box be made different 
from text in another? Both have been 
automatically tagged with the 
Z_BOXTEXT tag. 

A: Z_BOXTEXT is the tag that is auto
matically assigned to any text type with 
the Box Text operation. However, it is 
perfectly all right to assign a different tag 
to text typed into a B ox Text box. Switch 
to tagging mode, select the text, select 
Add New Tag, name the new tag, and 
format it as you wish using the selections 
in the Paragraph menu. 

Q: How can I create a page that is 
entirely blank? 

A: You can create a new page using the 
InsertIRemove Page option of the Page 
menu. Make it blank by turning off head
ers and footers and removing any ruling 
boxes. 

Q: How do I change the order of 
framesi 

A: This might be desirable in order to 
change the way text flows from one 
frame to the next in a newspaper-style 
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layout. You change the order by selecting 
a frame, pressing Delete, and then imme
diately pressing Insert. The frame most 
recently inserted becomes the last frame. 
Note: you can't use this technique to 
flow text to an earlier page. 

Q: In a multiple-column layout, how 
can I make. a headline that goes across 
several columns? 

A: Select the Tagging icon. Tag the head
line. Select the Paragraph menu. Select 
the Alignment option. Select Overall 
Width: Frame-Wide. 

Q: What do "1st Match" and "Last 
Match" mean in the Headers & Footers 
dialog box of the Page menu? 

A: When you select 1 st Match, the fIrst 
occurrence of text tagged with the tag 
name you specify will be shown in the 
header or footer. This is useful for dic
tionary or phone book printing. 
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Special Topics 





CHAPTER THIR TEEN 

Adding New Fonts 
FOR THOSE PRINTERS that lack their own 
Times Roman and Helvetica fonts, Ven
tura provides a basic platform of 6,8, 10, 
12, 14, 18, and 24-point Swiss (similar to 
Helvetica), 8, 10, 12, 14, 18, and 24-point 
Dutch (similar to Times Roman), and 12-
point Symbol. For many documents that 
set of fonts will suffice; however, at some 
point you may want to add fonts to your 
system. 

Fortunately, the variety of fonts 
available for laser printers is surging and 
prices for those fonts are falling. One of 
Ventura's strongest features is that it lets 
you add fonts above and beyond the basic 
platform. What's more, you can use the 
utility programs supplied with Ventura to 
convert fonts from one printer format to 
another. 

Font Vendors 

An increasing number of companies are 
providing fonts for laser printers, and 
each company in the business is rapidly 
adding to its font library. A list of such 
companies, as well as notes on the fonts 

they provide, is included in the Product 
Information appendix. 

PostScript 

Currently, the best designs for PostScript 
printers are from Adobe Systems, which 
licenses typefaces from commercial font 
vendors, notably Allied. Besides using 
proven font designs, Adobe's own Post
Script fonts have an advantage over those 
of other vendors due to proprietary algo
rithms-sometimes referred to as 
"Adobe's font magic"-built into Post
Script.' Other font vendors, however, are 
competing against Adobe by supplying 
less expensive fonts as well as designs 
not found in the Adobe font library. In 
many cases, these vendors have not yet 
converted their fonts from Macintosh to 
PC disks; however, if you have access to 
a Macintosh you can make the conver
sion yourself. Specific vendors are listed 
in the "Product Notes" appendix. 
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Laser Jet Plus and Series II 

The best LaserJ et fonts are those de
signed by Bitstream, the company that 
created the fonts bundled with Ventura. 
These fonts are marketed . through 
Hewlett-Packard rather than directly by 
Bitstream. A number of other vendors are 
also producing LaserJet fonts, including 
VS Software, The Font Factory, Soft
Craft, Weaver Graphics, and Cono
graphics; these fonts vary in quality but 
are gener'!ily quite inexpensive. Note that 
with the LaserJet Plus there is a size limit 
on fonts of 30 points; with the Series II 
there is no limit on font size. 

AST ThrboLaser, JLaser, and 
Cordata 

With the AST and Cordata printers, and 
with printers retrofitted with the JLaser 
board, Ventura bypasses the font format 
used by the vendors themselves and in
stead uses its own format. In fact, you 
can't use the fonts provided by either 
AST or Cordata with Ventura. Instead, 
you have to use Ventura's conversion 
programs to convert fonts from LaserJet 
format. With the AST, fonts converted 
from LaserJet format may have somwhat 
lower quality, since they are designed for 
the write-black technology used ·by the 
Canon engine, rather than the white
white technology used by the Tur
boLaser. Some font vendors, such as The 
Font Factory (see "Product Notes" ap
pendix), are beginning to offer· fonts 
tuned for write-white printers. Note that 
the maximum size type that can be 

printed on the JLaser is 48 points. On the 
AST and the Cordata the limit is 30 
points. 

Xerox 4045 

There are two sources of fonts for the 
4045. One is Xerox itself. The other is 
the vendors who sell fonts in lIP LaserJet 
format, since you can convert these fonts 
to 4045 format using the HPTOXRX and 
HPTOXRXL utilities on Ventura's Utility 
Disk (#11). As is the case with the AST 
TurboLaser, the Xerox 4045 is a write
white printer, so fonts converted from 
LaserJet format (which uses write-black 
technology) may be slightly lower in 
quality. 

InterPress 

Currently the only source of InterPress 
fonts is Xerox itself. 

Font Generating Software 

Currently, most vendors of fonts in HP 
LaserJet format sell bit-mapped fonts, 
which means that you have to buy a sepa
rate font file for each size of a typeface 
you wish to use. New tools are emerging, 
however, that let you create any size type 
you want from a master file, a method 
that is similar to the way PostScript and 
InterPress handle fonts. 



A Low-End Font Generator: 
Glyphix 

An early example of such a program is 
Glyphix from SWFfE International. 

With Glyphix, you use a menu to 
select the typeface, size, fill pattern, 
orientation, degree of slanting, and other 
parameters of the font you wish to create. 
The program then automatically produces 
a test sample of the font and, if you wish, 
stores the font as a separate file on your 
hard disk. This program and others like it 
make using printers like the LaserJet 
vastly more convenient, because of the 
potential of being able to generate new 
fonts on the fly. 

As described at the end of this chap
ter, a new font can be created with Gly
phix, tested, and incorporated into Ven
tura in about eight minutes. That's no 
match for the convenience of PostScript 
and InterPress's flexible font scaling, nor 
is the quality of the fonts as good; 
however, it does represent a potential 
way of working with fonts that will no 
doubt be refined further over time. 

Since HP LaserJet fonts can be con
verted into other formats such as the 
JLaser, Cordata, AST TurboLaser, and 
Xerox 4045, Glyphix can be used to 
generate type for those printers as well. 

High-End Font Generators: 
Fontware and LM-Fonts 

While Glyphix provides an inexpensive 
and convenient way of generating an oc
casional large font on the fly, a much 
more sophisticated font generating sys-
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tern has been created by Bitstream, the 
company that created the Dutch and 
Swiss typefaces provided with Ventura . 
for the LaserJet and other printers that 
use bit-mapped fonts. The system is sold 
by LaserMaster Corporation along with· 
its raster image processor under the name 
LM-Fonts. Bitstream itself will be selling 
the system under the name Fontware 
beginning in the fall of 1987. 

Like Glyphix, Fontware generates 
bit-mapped fonts from master outlines. 
But the patented technology used by the 
system produces much better quality 
from those outlines, making it possible to 
produce quality type even at small point 
sizes (down to 3 points for a sans serif 
face like Swiss). Upon introduction of 
Fontware, 80 typeface outlines will be 
available, including roman, bold, italic, 
and bold italic variations for most type 
families. You can use these outlines not 
only to generate printer fonts but match
ing screen fonts as well. Finally, the sys
tem gives you the option of choosing the 
character set you wish to use--including 
Ventura's own International character set 
(which has more typographic characters 
than other character sets such as HP's 
Roman-8 set). 

Among the type families initially 
available are Bitstream's versions of 
Helvetica and· Times Roman, Century 
Schoolbook, ITC Galliard, and a variety 
of headline typefaces. New typeface 
families will be added in future releases 
until most of the extensive Bitstream li
brary of typefaces is available in Fon
tware form. 
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Sources of Font Information 

• Provided by vendor in cor
rectformat 

or 
• Converted with Ventura 

utilities from LaserJet to 
AST, Cordata, JLaser, or 
Xerox 4045 format. 

• Provided by vendor 

or 
• If not provided by vendor, 

Ventura substitutes its 
own serif or sans serif 
screen fonts. 

• Provided by vendor 

or 
• Generated from printer 

font using Ventura's utili
ties. 

Printer Font 

Screen Font 

Width Table 



To use Fontware you buy two things: 
the Fontware Installation Kit for Ventura 
and the specific typefaces you wish to 
use. When you install Fontware for Ven
tura, you tell the program what screen 
display and printer you are using, and 
which typefaces, type sizes and character 
sets you would like. You can create any 
type size the printer can produce (from 3 
to 120 points) and can choose from the 
ASCII, Windows/ANSI, mM PC, Ven
tura International, and lIP Roman-8 
character sets. Based on your specifica
tions, Fontware will create the appro
priate set of fonts for their screen and 
printer. The program will also support 
PostScript printers. 

Xerox has announced that it will 
send registered Ventura owners an invita
tion to purchase a Fontware sampler from 
Bitstream for $24.95, a substantial 
savings over the off-the-shelf price. The 
sampler includes a Fontware Installation 
Kit for Ventura and the roman (regular) 
weight of a new typeface family, Bit
stream Charter. During the introductory 
period, scheduled to run from September 
1 st through December 31, 1987, the pur
chase price of a Fontware sampler can be 
credited toward the purchase of a Fon
tware typeface package from Bitstream. 
Bitstream will provide telephone support 
for Fontware free of charge to Xerox 
Ventura Publisher users for a warranty 
period of 45 days. 

For reference information on Gly
phix, Fontware, and LM-Fonts, see the 
"Product Notes" appendix. 
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How Ventura Handles Fonts 

To understand how to add fonts to Ven
tura, you need to understand something 
about Ventura's font management sys
tem. Ventura stores font information in 
three types of files: printer font files, 
screeen font files, and width tables. 

PRINTER FONT FILES: Each such 
file holds the information needed by the 
printer to print one font. All printer font 
files are stored in the \ VENTURA sub
directory, except in the case of fonts that 
are already resident in the printer itself. 
At print time, Ventura automatically takes 
care of downloading the relevant printer 
font files needed for a particular docu
ment. In the case of PostScript and Inter
Press printers, which use outline fonts, 
only one file needs to be loaded into the 
printer and the printer generates various 
sizes from that master. With other print
ers, a separate font file must be 
downloaded for each size used. 

SCREEN FONT FILES: Because the 
resolution of the computer display is 
much lower than that of the laser printer, 
Ventura needs a separate screen font file 
for each printer font so that you can see 
what you're printing. If you install other 
fonts in your system, you'll also want to 
install matching screen fonts if these have 
been provided by the vendor who sup
plied you with the fonts. Ideally, every 
font that you purchase would come with 
a matching screen font. In reality, 
however, many font vendors supply 
printer fonts only. In that case, Ventura 
will use the most similar screen font al
ready installed. 
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If the vendor does not supply such 
fonts, you can go ahead and install a new 
printer font without installing a matching 
. screen font. Ventura will simply substi
tute its own generic serif or sans serif 
screen fonts. Line breaks shown on the 
screen will match those of the printed 
output even the screen fonts do not 
match, since Ventura takes the font width 
information it needs for the screen from a 
single width table. What you lose by not 
having a screen font to match your 
printer font is the ability to see symbols 
in the high-bit range. Instead, you'll see 
Ventura's own symbols in that range. 

Since most third-party LaserJet fonts 
are only 7-bit fonts (see "Character Sets" 
on page 204) , they do not include any 
high-bit symbols; hence, there is no par
ticular need for screen fonts and many 
vendors do not supply them. In the case 
of PostScript fonts, screen fonts are 
available but you may have to convert 
them from Macintosh format, as de
scribed below. 

WIDTH TABLES: In order to properly 
justify text on the screen and on the 
printed page, Ventura must know the 
width needed by every character of every 
font is installed for a particular printer. 
That information is all contained in the 
width table file. Both the printer font and 
the screen rely on the width table file, 
guaranteeing that the screen will really 
have a WYSIWYG relation to the printed 
page. When you initially install Ventura, 
the program generates a width table for 
each printer that you opt to use with the 
program. Later, when you decide to add 
more fonts to your system, you can need 

to revise that width table to incorporate 
the necessary information on the new 
fonts. The procedure for doing so is de
scribed below . 

Procedure for Installing Fonts: 
Overview 

The steps you need to take to add a set of 
new fonts to your system are as follows: 

• Use Ventura's utilities to convert the 
printer fonts to your printer's format. 
You can skip this step if the fonts are 
already in the proper format. The 
process of converting fonts is de
scribed later in this chapter. 

• Copy the printer font files to the 
\ VENTURA subdirectory. 

• Rename the printer font files, if nec
essary. JLaser and Cordata fonts 
must be given the extension B30, 
and AST TurboLaser fonts must be 
given the extension W30. PostScript 
fonts must renamed according to the 
instructions in Appendix K of the 
Ventura manual. They must be given 
the extension FIB (if not in ASCII 
format) or FIA (if in ASCII format). 

• Use Ventura's utilities to convert the 
screen fonts to EGA format. You 
can skip this step if the fonts are al
ready in that format. 

• Copy the screen font files (if availa
ble) to the\VENTURA subdirectory. 

• Use Ventura's utilities to create a 
width table. You can skip this step if 
a width table has been provided by 
the font vendor. The process of 



creating a width table is explained 
later in this chapter. 

• Copy the width table to the \VEN

TURA subdirectory. 

• Load Ventura. 

• From the Options menu select Set 
Printer Info. If using screen fonts 
with extensions other than EGA, 

backspace across the letters EGA in 
the dialog box and type the new ex
tension. Select the desired pt:inter 
and the width table that you wish to 
expand. 

• From the Options menu select 
AddlRemove Fonts. Select Merge 
Width Tables. 

• In the Item Selector dialog box, 
select the width table you wish to 
merge with the current width table. 

Converting Printer Fonts 

You can convert any fonts from HP 
LaserJet format to JLaser, Cordata, AST 
TurboLaser, or Xerox 4045 format. Copy 
the HPLTOFNT.EXE utility (for JLaser, 
Cordata, and AST) or the HPTOXRX.EXE 
and the HPTOXRXL.EXE (for Xerox 4045 
portrait and landscape fonts) from the 
Utilities Disk (#11) to the \VENTURA 
directory. 

To convert a font, the command 
from the DOS prompt is 
HPLTOFNT fontname.SFP [switches] 

The information needed for the 
switches is provided in Appendix F of the 
manual and is also shown if you type 
BPLTOFNT 
without naming a font. You'll also need 
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to provide an ID number from a chart of 
typefaces in Appendix F. 

If you are adding a number of fonts 
to your system at once, which is gener
ally the case, it's a good idea to create a 
batch file rather than attempting to enter 
the lengthy conversion syntax over and 
over directly from the DOS prompt. 
However, before you attempt to set up 
such a batch file, you should go through 
the entire process of adding just one font 
to the system. Once you've sorted 
through the process with a single font, 
you have a much greater chance of run
ning a batch file successfully. In other 
words, start simple before you get ambi
tious. 

Converting Macintosh Screen 
Fonts 

You can convert screen fonts from. Mac
intosh format to Ventura format. To do 
so, follow these steps: 

• Copy the ABFfOFNT.EXE utility 
from the Utilities Disk (#11) to the 
Ventura directory. 

• Transfer the Macintosh screen fonts 
on PC disks, using a connection such 
as TOPS or a telecommunications 
hookUp. 

• Rename the Macintosh screen fonts 
so that they have the extension ABF. 

• Type 
ABFTOFNT *. ABF 
Ventura will convert the files and 
give them the extension PSF. 

• Load Ventura 



204 VENTURA TIPS AND TRICKS 

Character Sets 

In deciding which fonts to purchase and add to your system, the most important fac

tors are obviously the design of the typeface and the point sizes available in that 

typeface. But don't overlook the matter of what character set is included in the font. 

Unless the font includes characters such as the cent sign ¢ or true quotation marks (" 

and "), there is no way that you'll be able to print those characters in the desired type

face. 

ASCII 
The most basic character set is the ASCII set (American Standard Code for Informa

tion Interchange). Numbers 0 to 31 of the ASCII set are reserved for unprintable con

trol characters. Numbers 33 through 127 include the standard upper- and lowercase 

letters of the English alphabet as well as the punctuation marks and symbols found 

on a standard computer keyboard-92 characters in all. All other character sets (ex

cept those made up entirely of special characters, like Ventura's Symbol font) are su

persets of the ASCII set. They fill out the ASCII set with characters in the range 

above 127. Because numbers up to 127 can be represented by 7 binary bits, the 

ASCII set is referred to as a 7-bit character set. To represent numbers above 128 

you need 8 binary bits; hence, such sets are referred to as 8-bit sets and the 

characters numbered above 127 are called "high-bit" or "extended ASCII" characters. 

Many fonts, especially in large point sizes, include only the ASCII character set. 

This applies to many third-party fonts for the HP LaserJet as well as to Hewlett-Pack

ard's own soft fonts numbered 33412AC (TmsRmn/Helv), 33412AE (TmsRmn/Helv), 

33412RA (ITC Garamond), 33412SA (Century Schoolbook), 33412TA (Zapf 

Humanist 601), and 33412UA (Headline Typefaces). 

Conspicuously absent from the ASCII set are any typographic characters not 

found on the keyboard. These include true right and left quotation marks (" and "), the 

em dash (-), copyright and trademark symbols (©, ®, and T~, European characters 

(such as a, a, and A), commercial symbols (such as ¢, £, and ¥), and typographic 

symbols (such as:l: and ~). 

The International Set 
The character set used by the printer and screen fonts provided with the Ventura 

package is referred to in the Ventura manual as the International set and by others 
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as either the International or the Ventura character set. It is an 8-bit character 

set that includes a full complement of typographic symbols missing from the 

standard computer keyboard as well as characters needed by some European 

languages: Spanish, French, Italian, and German. The full set is shown in Ap

pendix E of the Ventura manual. 

The Roman-8 Set 
The Roman-8 set is an 8-bit character set used by Hewlett-Packard for many of 

its cartridge and soft fonts. Since Roman-8 is the character set provided on the 

F cartridge, it is the only character set available to you if you use Ventura with a 

plain HP LaserJet. It is also the character set used on Hewlett-Packard's soft 

fonts numbered 33412AD (TmsRmn/Helv), 33412AF (TmsRmn/Helv), 33412DA 

(Letter Gothic), and 33412EA (Prestige Elite). 

The high-bit characters of the Roman-8 set are mainly European and cur

rency symbols. Missing are a number of important typographic and commericial 

symbols, including ", (170, §, ;, t, " ©, ®, and TM. Finally, the set lacks a satis

factory bullet character. 

The Symbol Font Character Set 
The Symbol font is also an 8-bit font. It includes a number of scientific and math

ematic symbols, the Greek alphabet (uppercase and lowercase), and a variety 

of miscellaneous symbols. The set matches Adobe's Symbol character set 

through character 207, at which point it diverges slightly. 

Font Generators 
Fortunately, new font generators such as Bitstream's Fontware and Laser

Master's LM-Fonts promise to sweep away some of the hassles created by the 

differences among character sets. For example, with LM-Fonts, you can select 

any character set you wish for your font from a list that includes the Roman-8 

s~t, Ventura's International set, the IBM Screen set (which assigns graphics 

symbols used for drawing lines and borders to its high-bit characters), and the 

Ventura screen character set. 
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• From the Options menu select Set 
Printer Info. Backspace across the 
letters EGA in the dialog box and 
type 

. PSI' 

Creating a Width Table 

In the unfortunate event that the font ven
dor has not supplied width tables for its 
fonts, you'll need to use several Ventura 
utilities to build these tables. The proce
dure is as follows: 

• Generate a VFM file for each font. 
To do this, copy the HPLTOVFM.EXE 

utility from the HPLJPLUS sub
directory of the Utilities Disk (#11) 
to the \ VENTURA subdirectory. The 
syntax used by this directory is 
shown in Appendix K of the manual; 
however, if you type 
BPLTOVFM 
without specifying a file to convert 
the utility will provide a more 
detailed set of instructions than the 
manual, including a number of op
tional override switches. 

• Using a word processor, create a list 
of the VFM files. Save it as an ASCII 

file. Give this file the same name as 
the width table you plan to create, 
except that the~xtension should be 
LST. -

• Type 
VFMTOWID filename.LST 
to convert the LST file to a new 
width table. 

VP/Fonts 

If you'd rather avoid the work of 
creating width tables for Lase rJ et 
fonts, you can automate the process 
with VP/Fonts, a utility developed by 
The Laser Edge, a desktop publish
ing service bureau in Oakland, Cal
ifornia. The utility prompts you for the 
names and sizes of the fonts you 
wish to convert for use with Ventura, 
and produces the Ventura WID ta
bles automatically. Currently, VP
IFonts works only with fonts sold by 
Hewlett-Packard. If you're using 
LaserJet fonts from other vendors, 

check with the Laser Edge to see if 
the program has been updated to 
handle other formats. 
The Laser Edge 

360 - 17th Street 

Oakland, CA 94612 

415/835-1581 

Example: Adding a LaserJet 
Plus Font 

The first time you attempt to add a new 
font to Ventura, you may be somewhat 
put off by a process that seems intimidat
ing and complex. Don't worry-it's not 
that hard. Probably the easiest way to 
master the procedure is to start by adding 
a single font. Once you've succeeded in 
doing that, you can then try using batch 
files to add multiple fonts. 



The following example of adding a 
new font is not intended to replace the in
structions in Appendix K of the Ventura 
manual, which cover all possible printers. 
Instead, it is provided to show a simple 
illustration with just one font. 

The fIrst series of steps is to copy the 
necessary font conversion utilities from 
Ventura's Utility Disk (#11) to the \VEN

TURA subdirectory on your hard disk. 

• Place the Utility Disk in drive A. 

• Type 
COpy A:\HPLJPLOS 
\HPLTOVFM.EXE C:\VENTURA 

• Type 
COpy A:\HPLJPLOS 
\VFMTOWID.EXE C:\VENTURA 

The next set of steps is to copy the 
3D-point bold Garamond font into the 
same directory and rename it to meet 
Ventura's specifIcations. 

• Put the disk the font (disk three of 
the Garamond font set) in drive A. 

• From DOS, type 
A:GA300BPN.OSP C:\VENTURA 

• Type 
RENAME GA300BPN.SFP 

HPLJG30B.SFP 
This is not documented in the 
manual, but it is necessary. The HPLJ 

must be the fIrst four characters of 
the font, the G stands for Garamond 
(the initials for other characters are 
on p. K-IO), 30 stands for the point 
size and b for bold. For additional 
instructions on renaming fonts, type 
HPLTOVFM 
without naming a font. Ventura will 
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produce a screen describing the cor
reet naming conventions. 

Now, we can run the conversion 
utilities to create a VFM fIle. 

• Type 
HPLTOVFM 
This produces a screen explaining 
what switches to add to the line to 
convert the font. 

• Type 
HPLTOVFM HPLJG30B.SFP 
/F=GARAMOND/N=22/T 

The N=22 is the typeface identifIca
tion number for Garamond, derived from 
a table in Appendix K of the manual. The 
T means that since there is no screen font 
for Garamond, Ventura is to use Times 
(i.e. Dutch) to represent it on screen. The 
result of this conversion is a fIle called 
HPUG30B.VFM 

Next, convert the VFM fIle to a WID 
fIle (a width table). 

• Type 
COpy CON HPLJG30B.LST 

• Type 
HPLJG30B.VFM 

• Type 
Ctrl-Z 

• Type 
VFMTOWID HPLJG30B.LST 

Now you can load Ventura, try out 
the new HPLG30B width table, and then 
merge it with the existing LaserJet Plus 
width table. 

• Type 
VP 
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• From the options menu select Set 
Printer Info. Next, select Load 
Different Width Table and select 
HPLJG30B.WID. 

• Type a word or two and print it out 
. to check that the width table was 

working. 

• Select Load Different Width Table 
and select HPLJPLUS.WID 

• From the Options menu selected 
AddlRemove Fonts 

• Select Merge Width Tables 

• Select HPLJG30B.WID 

• Select Save As New Width Table. 

You now will find that 3D-point 
Garamond Bold is one of the regular 
selections for fonts with your LaserJet 
Plus driver. 
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Screen Shots 
IN PREPARING TECHNICAL documenta
tion, training materials, and books about 
software (such as this one), a common 
task is to take snapshots of the computer 
screen-also known as screen shots-and 
insert them in documents. Fortunately, 
this proves to be relatively easy with 
Ventura. 

Let's start with an overview of the 
entire process of importing a screen shot 
into Ventura. This process is as follows: 

Load a screen shot utility into the 
computer's memory. Such utilities 
are small programs devoted specifi
cally to the task of capturing a 
screen; several are discussed below. 

Load the program you want to take a 
screen shot of, prepare the screen, 
and activate the screen shot utility. 
With some utilities a menu will be 
shown on screen; with others the key 
combination that activates the utility 
also automatically creates a file con
taining the screen shot on your hard 
disk. 

• In most cases, the screen shot utility 
will save the file with a PCX (PC 

Paintbrush) extension. In that case 
proceed to step 4. Otherwise, the 
screen shot program should provide 
a utility that you can now use to con
vert the file to PCX. 

• (Optional) Load PC Paintbrush Plus 
or Publisher's Paintbrush and edit 
the screen shot. The editing that can 
be done includes cropping (although 
that can also be done in Ventura it
selt) , alterations using Paintbrush's 
graphics tools, and using Zoom 
mode to edit individual pixels. Note 
that if you edit an image in PC Paint
brush, its extension may be changed 
toPCC. 

• Load Ventura. Open the document 
into which you want to load the 
screen shot. Create a new frame of 
approximately the right size for your 
screen shot. From the File menu 
select Load Text/picture. Select the 
PC Paintbrush file containing the 
screen shot. The file name contain
ing the screen shot will now appear 
in the Assignment List. Select the 
name; the screen shot will now load 
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onto the page. From the Frame 
menu, select Sizing and Scaling. In 
the Sizing and Scaling dialog box 
select By Scale Factors and Main
tained. 

• Adjust the size of the screen shot, 
following the instructions below. 

• Adjust the frame margins and pad
ding, using the Sizing and Scaling 
dialog box. Crop the screen shot if 
desired, either by entering values in 
the Sizing and Scaling dialog box or 
by holding down the Alt key while 
moving the image with the mouse. 

• Add enhancements such as borders, 
captions, arrows,_ background 
shades, and boxed text. 

Choosing a Screen Shot Utility 

In order to select a screen shot utility, you 
need to identify the mode of your sys
tem's display board-the circuit board in 
the computer that controls the monitor. 
The method employed for printing an 
image depends on how your screen dis
plays graphics and text. There are four 
major display standards: the IBM Mono
chrome Display Adapter (MDA), the 
Hercules Graphics Card (HGC), the IBM 
Color/Graphics Adapter (CGA), and the 
IBM Enhanced Graphics Adapter (EGA). 

Many video boards emulate two or 
more of these display standards. For ex
ample, IBM's EGA mimics the IBM 
MDA and CGA; some EGA clones also 
emulate the Hercules, Plantronics, and 
other standards. Because some boards 

offer a number of modes, you must 
match the utility to the correct mode. 

MDA Text Screens: Hotshot 

If you are taking shots of MDA screens, a 
utility for translating such screen shots 
into PCX format is Hotshot (available 
from Symsoft, P.O. Box 4477, Mountain 
View, CA 94040, phone: 415/962-9500). 

Once you install HotShot in mem
ory, the program's menu can be shown at 
any time by pressing Alt-H (this key 
combination can be redefined if neces
sary). At that point you can immediately 
store the screen shot to disk by pressing 
F3, F4, Enter, filename, and Enter. 

HotShot saves files in its own 
graphics format, which uses the exten
sion SCR. To convert these files to PCX 
format, type 
CVRT 

from the DOS prompt, enter the name of 
the file to be converted, and press Fl. 
HotShot will now create a new file with 
the PCX extension. 

You can also use HotShot to modify 
and annotate screen shots. Instead of im
mediately saving the screen shot to disk, 
experiment with adding text, arrows, 
boxes, and shaded areas to screen shots 
using HotShot's graphics tools (or wait 
and add these effects using Ventura's 
graphics tools). You can also erase por
tions of the screen or "paint" inverse 
video onto the screen to highlight partic
ular passages. The program gives you the 
option of printing or hiding the cursor. 

For quickly previewing your screen, 
Hotshot lets you send a screen shot 



directly to your laser printer. Printing 
takes about 20 seconds on a LaserJet Plus 
or LaserJet series II (parallel interface). 

Sidekick and Ventura's utility 

Provided on Ventura's Utility disk (#11) 
is a program called TXTIOPCX.EXE, 
which can be used to convert text files 
captured with Sidekick into PC Paint
brush (PCX) files. One limitation of the 
program is that it does not work in con
junction with the Hercules Graphics 
Board. 

To capture a screen, first pop up the 
Sidekick menu, then open Notepad with 
Alt-N. Press F4 and the original screen 
appears again. Press Ctrl-KB before 
moving the cursor away from the upper 
left comer, then cursor down to the lower 
right comer and press Ctrl-KK. Now 
you're back in Notepad with the image. 
Save it as a file and leave Sidekick. Type 
TXTTOPCX filename 

to convert the file into PC Paintbrush 
(PCX extension) format. Before loading 
Ventura, you should de-install Sidekick. 
To load the screenshot into a frame, use 
the PC Paintbrush option in the Load 
Text/pictures dialog box. 

Graphics Screens: Frieze, 
Hotshot, Univation 

Recently, an alternative program called 
Grab was added to the Hotshot package, 
specifically for capturing graphics 
screens including CGA, EGA, HGC, ATI 
6300, and Vega Deluxe (Video-7) for
mats. 
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For graphics screens, use In addition, 
Hotshot is also capable of making screen 
shots within Microsoft Windows. When 
you make screen shots of graphic 
screens, however, you won't have access 
to HotShot's popup menu and hence can't 
use the editing functions that utility pro
vides for enhancing MDA screens. 

For screen shots of graphics screens, 
another option is the Frieze utility, a 
built-in option of PC Paintbrush Plus and 
Publisher's Paintbrush. 

To use Frieze, you load PC Paint
brush Plus or Publishers Paintbrush and 
press Shift-PrtSc. A menu then appears at 
the top of the screen indicating your 
setup options. At this point Frieze is 
loaded into the computer's RAM. You 
can exit Paintbrush and load the program 
you wish to make the screen shots from; 
Frieze will remain loaded in RAM. When 
you have prepared the screen you wish to 
take a screen shot of, press Shift-PrtSc to 
see the Frieze menu again. Among your 
options will be to draw a border around 
the portion of the screen you want to cap
ture using the cursor keys. To speed this 
process up, hold down the Shift key 
while you move the cursor keys. After 
you have adjusted one border, press the 
Spacebar to adjust another, then push the 
Spacebar again, etc. 

Yet another utility for capturing 
screen shots in PCX format has been 
developed by Univation, which bundles 
the program with its Turbo board but 
does not sell it separately. The program 
doesn't provide any frills, but works 
simply and easily with the CGA, EGA, 
and HGC standards. Unlike Hotshot, it 
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converts screen shots directly into PCX 
format, thus saving a step. (Maybe Uni
vation can be persuaded to market it as a 
separate utility.) 

Keeping Track of Screen Shots 

Generally, it's convenient to create a set 
of screen shots in the program you are 
documenting, rather than creating only 
one. Most screen shot utilities, including 
Hotshot and Frieze, will automatically 
create sequentially numbered files, one 
for each shot. With Hotshot or Frieze, 
you can specify the subdirectory you 
want to store these in. 

A good way of working is to use one 
subdirectory as a staging ground to tem
porarily hold newly created screen shots 
and another subdirectory as a permanent 
storage location for keeping screen shots 
you intend to use later. If you use just one 
subdirectory both for initially creating 
and for storing screen shots, you may 
find that in making your second set of 
screen shots you have inadvertently 
copied over your first set (since the 
screen shot utility will restart its number
ing at 1 each time you use it). 

Scaling Screen Shots 

After you load a screen shot into a frame, 
you should use the Sizing and Scaling 
option of the Frame menu to set the pic
ture scaling to By Scale Factors and 
aspect ratio to Maintained. That way, the 
screen shot will be at its "true pixel 
count." True pixel count means that 
every pixel in the image as it appeared on 

the screen will be translated into one 
printed pixel by the laser printer. Since 
laser printer pixels are smaller than 
screen pixels (about 1/4 as wide+), this 
means the printed version of the screen 
shot, if shown at true pixel count, will be 
quite small. 

The best way to scale up the picture 
is to multiply the pixels by integer 
amounts. Otherwise, you'll notice stripes 
and moire patterns in the printout caused 
by the program's attempt to scale the pic
ture to fractional specifications. Scale the 
picture by entering new values for Scale 
Width ~nd Scale Height, after first noting 
the original values. Since some screens 
will appear too wide and flat when 
printed, you may want to scale the height 
by a greater factor than the width. You 
don't need to keep the aspect ratio con
stant as long as you work in integral 
amounts. For example, when originally 
loaded into frames, the screen shots in 
this book were 2.41 inches wide by 1.16 
inches tall. They were then doubled in 
width and tripled the height: 4.82 inches 
for width and 3.48 inches for height. 
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Encapsulated 
PostScript 

FOR THOSE WITH PostScript printers, the 
ability of Ventura Version 1.1 to import 
Encapsulated PostScript (BPS) files pro-
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Figure 1: Using the EPS format, you can 
take snapshots of pages and insert them 
within other pages. 

vides dramatic new capabilities. Encap
sulated PostScript merely means that a 
PostScript program is in a format that al
lows it to be embedded within another 
program. 

For creating special effects with both 
graphics and text, the capabilities of Post
Script are virtually unlimited. Currently, 
there are only a few PC programs that 
can produce files in EPS format, but even 
so there are several ways to take advan
tage of Ventura's EPS capability. They 
are as follows: (1) convert EPS files from 
Macintosh format, (2) use Ventura print 
files, and (3) create your own EPS files 
from scratch . 

Once you have created an EPS file 
using any of these methods, you can load 
it into Ventura. Draw a frame, select 
Load Text/Picture from the File menu, 
select Line Art and PostScript format, 
and select OK. The file will not be shown 
on the screen, but will be indicated with a 
large X; it will appear when printed. 
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Just like other graphics, EPS pictures 
can be scaled, cropped, and distorted by 
selecting the Sizing & Scaling option 
from the Frame menu. The only differ
ence is that you won't be able to check 
the appearance of the picture on screen. 

Converting Macintosh EPS 
Files 

Certain Macintosh programs, including 
Adobe Illustrator and Cricket Draw, pro-. 
duce EPS files. You can import such files 
into the PC using a link such as TOPS. 
After porting them to the PC, change the 
extension of the file to EPS. 

Using Ventura Print Files 

In this book, the illustrations of finished 
pages were all incorporated onto pages 
using Ventura's EPS capability and the 
program's ability to print to disk. 

This method can only be used for 
taking a snapshot of a single page. To 
print the page to disk, select Set Printer 
Info in the Options menu and the in the 
dialog box select Output To: Filename. 
(You don't name the print file yet; that is 
done later.) 

From the File Menu, select Print. 
Choose Selected rather than all pages, so 
that a single page will be printed to a file. 
Select OK. Ventura will prompt you to 
name the print file. Name it and type EPS 
as the extension. A typical page contain
ing no graphics takes up 20K when 
printed to disk as an EPS file. You can re
duce that amount by following the tip de
scribed below of removing the PS2.PRE 

file. Having created the print file on disk, 
you can load the EPS picture into a Ven
tura frame. 

Note that EPS files created through 
Ventura's print to disk option are not ac
tually true EPS files and hence cannot be 
loaded into other programs that handle 
EPS format. 

Figure 1 shows the result of per
forming the print to file and merge proce
dure and then repeating the procedure. 

The EPS Format 

You can write your own PostScript pro
grams to create special effects using a 
word processor or text editor, saving 
these effects in ASCII (i.e. nondocument) 
format and giving them the extension 
EPS. For diagnostic assistance while 
working with PostScript, the Ventura 
Utilities disk contains is a helpful file 
called Erhandlr.PS, located in the 
POSTSCPT subdirectory. Once you have 
copied that file to the printer, the printer 
will provide feedback on program errors. 

%!PS-Adobe-2.0 EPSF-1.2 
%%BoundingBox: 210 300 420 
420 
%%EndComments 
newpath 
250 320 rnoveto 
300 400 lineto 

Figure 2: This EPS file creates a 
diagonal line. 



When you create EPS files on your 
own, such as those shown in Figures 2 
and 4, you must make sure that the Post
Script program abides by the rules set 
forth for EPS files. 

The rules are explained in "Encapsu
lated PostScript File Format," a six-page 
document available from Adobe Systems. 
Call Adobe Technical Support at 
415/852-0271 or write to: 
Technical Support 
Adobe Systems 
1870 Embarcadero Rd. 
Palo Alto, CA 94303 

Basically, EPS files are normal Post
Script files, with these minor differences. 

%!PS-Adobe-2.0 EPSF-1.2 
%%BoundingBox: 180 300 350 520 
200 350 translate 
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• First, every EPS file is required to 
include the following two lines in its 
header: 
%!PS-Adobe-2.0 EPSF-l.2 
%%BoundingBox: xl yl x2 y2 
where xl and y1 are replaced by the 
lower left coordinates of the bound
ing box of the EPS file, and x2 and 
y2 are the upper right coordinates. 

• Second, every EPS file must end 
with a return or linefeed character. 

• If fonts are included in the EPS file, 
the following command may be nec
essary: 
%%DocumentFonts: fontl font2 

/Roman /Times-Italic findfont 6 scalefont def 
/Bold /Times-Bold findfont 200 scalefont def 
/strg (XEROX VENTURA PUBLISHER XEROX VENTURA PUBLISHER 
XEROX VENTURA PUBLISHER XEROX VENTURA PUBLISHER) def 
/crlf 
{ currentpoint 6 sub 
exch pop 0 exch moveto } def 
/prtstring { strg show crlf } def 
/Background 
{ 25 { prtstring } repeat } def 
gsave 
newpath 0 0 moveto 
8 setflat 
Bold setfont (V) true charpath clip 
o 133 moveto 
Roman setfont Background 
grestore 

Figure 3: This is the EPS file used to $enerate the graphic shown on the following page. 
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where fontl is replaced by a name 
such as Times-Roman or Helvetica. 

• Finally, the following PostScript 
operators should not be included in 
EPS files: grestoreall, initgraphics, 
initmatrix, initclip, erasepage, copy
page, banddevice, framedevice, 
nulldevice, renderbands, setpagepa
rams, note, and exitserver. 

Tip: Editing EPS Files Within Ventura 
Because EPS files are not WYSIWYG
all you see on the screen is a large X
you'll find it necessary in most instances 
to modify your program a few times 
before you have it completely to your 
liking. Unfortunately, exiting Ventura and 
loading your word processor merely to 
edit a line or two of the EPS file is a 
cumbersome procedure. An alternative is 
to load the EPS file as a PostScript 
graphic in Frame A and as a text file in 
Frame B. Although the file is in plain 
ASCII format, you should load it as a 
XyWrite file rather than as ASCII file, 
since Ventura strips carriage returns out 
of ASCII files but not out of XyWrite 
files, though the latter also use ASCII 
format. To change the appearance of the 
EPS graphic, you can make changes in 
the EPS listing with Ventura's text editing 
controls and save the chapter. The 
changes you make in the EPS listing in 
Frame B will then be reflected in the pic
ture itself in Frame A. 

Tip: Removing the PS2.PRE File 
-If you are creating print files, you can re
duce the amount of storage they require 
by temporarily renaming or deleting the 
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PS2.PRE file from the \ VENTURA 
directory. Renaming or deleting this file 
also allows your regular printing to go 
faster, since Ventura will no longer have 
to download PS2.PRE prior to printing a 
chapter. To provide your laser printer 
with the necessary preparatory informa
tion, you'll need to copy the file 
PERMVP.PS from the \POSTSCPT directory 
of the Utilities disk (#11) to the \VEN

TURA directory on your hard disk. Then, 
each time you turn the laser printer on, 
copy the file to the printer by typing 
COpy C:\VENTORA\PERMVP.PS COM1: 

Tip: PostScript Resources 
An increasing number of books, journals, 
and classes are available for those seek
ing to learn elementary and advanced 
PostScript. 

CLASSES: Adobe Systems (415/852-
0271) offers classes as well as courses on 
video tape. The introductory video is 
$100 ($150 including downloading soft
ware, a workbook, and PostScript refer
ence materials. Others offering classes in
clude Electronic Directions in New York 
New York (212/533-9651); Graph-Tech 
in Yuma, Arizona (602n26-4671); No
table Systems in Madison, Wisconsin 
(608/238-6220); and MasterPlan in 
Haslett, Michigan (517/339-2478). 

BOOKS: PostScript Language Refer
ence Manual by Adobe Systems (Addi
son-Wesley, Reading, Massachusetts), 
1985; PostScript Language Tutorial and 
Cookbook by Adobe Systems (Addison
Wesley, Reading, Massachusetts), 1985; 
and How to Run PostScriptfrom DOS by 
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Gary Glover (LaserS oft Press, Cleveland, 
Tennessee), 1987. 

PUBLICATIONS: Colophon, pub
lished by Adobe Systems and free upon 
request (415/852-0271); PostScript Lan
guage Journal, published by Pipeline As
sociates four times per year (201/334-

. 0772); The Computer Shopper, which 
contains a regular column on PostScript 
(305/269-3211). 

ELECTRONIC BULLETIN BOARDS: 
CompuServe has an extensive PostScript 
forum run under the auspices of Adobe 
Systems (800/848-8199). Other bulletin 
boards include the Byte Information Ex
change or BIX (603/924-9281), and the 
National Independent PostScript Support 
Board (409/224-4075). 
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Lotus Worksheets and 
Graphics 

THE PURPOSE OF this chapter is to sum
marize a variety of techniques for im
porting Lotus worksheets and charts into 
Ventura. Many of these techniques, espe
cially those pertaining to charts, are ap
plicable to other graphics programs as 
well. 

1m porting Lotus Charts 

Use 1-2-3' s Graph command to choose 
the type of chart and the title, legend, and 
labels. Use the Graph View command to 
preview the chart and the Graph Save 
command to save the chart as a PIC file. 
There's no need to go through the Print
Graph module. 

Importing Charts Via PC 
Paintbrush 

PC Paintbrush Plus and Publisher's 
Paintbrush both include a command 
called Merge Pic (accessed through the 
Page menu). You can use this option to 

load a Lotus PIC file and then edit it with 
PC Paintbrush's variety of graphics tools. 
The chart will then be saved as a PCX or 
PCC file, and you can load it into Ven
tura by selecting PC Paintbrush format 
(not Lotus PIC format). 

Placing a White Background 
Behind a Chart 

For added emphasis, you can place a 
chart with a white background in the 
middle of a shaded frame. First, draw a 
frame exactly covering the frame con
taining the imported chart. Apply a pat
terned background to this frame. Draw 
another frame over this frame, covering 
only the chart itself. Apply a solid white 
background to the frame you just drew. 
Now, hold down the Ctrl key while you 
click with the mouse until the frame 
holding the graphic is selected. Press Del 
and then Ins to bring this frame to the 
front. 
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Centering a Chart Within a 
Frame 

When you load a chart into a frame it 
will run up against the edge of the frame 
and may not be properly proportioned. 
To correct the proportions of the frame, 
select the Sizing and Scaling option from 
the Frame menu and select Fit in Frame 
and Distorted. To center the chart within 
the frame, select Margins and Columns 
from the Frame menu and enter equal 
values for top, bottom, left, and right 
margins. 

Adding Labels with Box Text 

If you're not satisfied with the quality 
and letter spacing of the fonts that Ven
tura automatically applies to an imported 
Lotus chart, you can cover these with 
your own labels. Use box text for that 
purpose, specifying None for Line At
tributes and opaque white for Fill At
tributes. Use the Save To option to avoid 
re-specifying these attributes each time 
you draw a labeling box. Use grid snap to 
make sure that all your labels line up 
with each other. (Note that the small 
square next to the words in the box actu
ally marks the edge of the text.) 

Saving a Chart Without Labels 

If you're not satisfied with the quality of 
the labels and titles automatically 
generated for charts by Ventura, you may 
want to import a chart devoid of any 
titles, legends, and labels, and do all the 
labeling in Ventura with the Box Text 

tool. That way you'll be able to use any 
of Ventura's fonts, rather than the 
Helvetica font automatically used by 
Ventura when it translates 1-2-3's labels. 
The steps to follow in preparing a Lotus 
graphic are as follows: First, set up the 
bar, line, or pie chart. Don't give it a title. 
1-2-3 will automatically label the X and 
Y axes of a graph. You need to remove 
these labels so that you can add better 
labels once you've imported the chart 
into Ventura. To remove the Y-axis 
labels, select Graph Options Scale Y scale 
Format Hidden. To remove the X -axis 
labels, select Graph Reset X. For 
legends, you may want to preserve 1-2-
3' s legend boxes and leave room to for 
placing the labels of these boxes using 
Ventura. Select Options Legend A and 
insert enough blank spaces (a dozen or so 
should do) to allow you room to add your 
own labels using Ventura's box text fea
ture. Select Options Legend B and again 
insert blank spaces. 

Screen Shots of Worksheets 

To generate screen shots of Lotus 
screens, use the HotShot utility described 
in Chapter 14, "Screen Shots." before im
porting the screen shots into Ventura, 
convert them to PCX format using Hot
Shot's CVRT utility. If desired, you can 
enhance them using HotShot's editing 
tools or with PC Paintbrush. 

Importing Worksheets 

You can't load Lotus WKS files directly 
into Ventura. To load a worksheet, first 



print it to a disk file, setting the margins 
to 0, then load that file into Ventura, 
selecting XyWrite as the type of file. 
Since the columns in this imported file 
are separated by spaces rather than tabs, 
they won't align properly if formatted 
with a proportional font. Note: Helvetica 
and Swiss are proportional fonts-Cour
ier is not. 

A more sophisticated solution is to 
use a utility that can convert the spaces 
between the columns to tabs. One such 
utility is the CONVERTD program on the 
Microsoft Word utilities disk. To prepare 
a file for CONVERTD, first print your 
spreadsheet to disk. To use CONVERTD, 

you must enter the name of an input file, 
an output file, a list of the column widths 
of the spreadsheet, and a delimiter 
character (Tab). CONVERTD also lets you 
indicate a list of rows you wish to con
vert, and this can be any combination of 
rows and columns, for example: rows 5, 
8, and 16-22. When the program prompts 
you for the type of file, select the second 
option (Delimited text file). 

VP/Tabs 

A more sophisticated utility than CON
VERTD for importing spreadsheets is 
Vprrabs from the Laser Edge. To use the 
program, you first create a print file in 
Lotus, then process the print file with 
VPrrabs. The program automatically 
converts spaces into tabs. It also aligns 
dollar signs and parentheses around num
bers according to accounting conven
tions. Vprrabs is available from The 
Laser Edge, 360 17th Street, Suite 203, 
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Oakland, CA 94612, phone: 415/835-
1581. 
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HyphelUltion 
WITH VENTURA, YOU can have two hy
phenation algorithms installed at once. 
One of these can be for English and the 
other for a foreign language. Or you can 
have the two English algorithms installed 
at the same time. This is not recom
mended, however, since it uses up RAM 
that otherwise would be allocated to 
documents and pictures. 

You should therefore decide whether 
you want to use the faster algorithm 
(prone to missing many hyphenation op
portunities and sometimes gUilty of in
correct breaks) or the slower algorithm 
(much more complete, but requiring 
about four times as much time every time 
you load a chapter). When you frrst in
stall Ventura, the faster algorithm is auto
matically installed in the \VENTURA 

directory. Its name is USENGLISH.HYI. 
To replace the faster algorithm with 

the slower one, copy the file 
USENGLS2.HY2 from the Utilities disk 
(# 11) into the \ VENTURA directory and 
rename it USENGLS2.HYl. Delete USEN
GLISH.HYI (if you need it again, a copy is 
stored on the Utilities disk. If you want to 
have both algorithms available, make 

sure that one has the extension HYI and 
the other HY2. 

Hyphenation is set on a tag by tag 
basis (using the Alignment option of the 
Paragraph menu), which means that you 
might have an English algorithm running 
in one column and a French algorithm 
running side by side in the adjacent 
column. It also means that you can have 
hyphenation running for some tags and 
not for others. 

Many professional typographers 
eschew hyphenation algorithms alto
gether, preferring dictionary-based hy
phenation routines, which are inherently 
more accurate than algorithms. If you 
prefer this additional margin of accuracy, 
you can turn off automatic hyphenation 

Electric Webster 

Cornucopia Software, Inc. 

PO Box 6111 

Albany, CA 94706 

415/524-8098 
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and instead use the dictionary method 
with Ventura. 

Basically, the technique to follow is 
to use a utility that automatically inserts a 
discretionary hyphen at every possible 
hyphenation point in every word of a text 
file. When you then load the text file into 
Ventura, only those discretionary hy
phens that fall at the ends of lines will be 
printed. For English, a useful utility is 
Electric Webster from Cornucopia Soft
ware. The program provides a 50,000-
word dictionary derived by researchers at 
the University of California. 

To use Electric Webster, fust save 
your text file in ASCII or WordStar for
mat. Create a subdirectory, for instance 
HYPHEN, and copy all the files on the 
Electric Webster disk to the subdirectory. 

To set up Electric Webster, type 
EWCONFIG 

This starts the configuration program, 
which will ask you to specify a character 
to use to represent hyphens in the docu
ment. A good choice is the tilde (-), since 
that is not likely to appear in your docu
ment. Electric Webster will expect you to 
enter a three-digit ASCII code for the 
character. The ASCII code for - is 126. 

Save the configuration, then type EW 

to run Electric Webster. Assuming you're 
just using the program's hyphenation fea
tures, you can skip the proofing and spel
ling options and go directly to hyphena
tion. Electric Webster will insert the 
character you have chosen for the discre
tionary hyphen at every possible location. 

When Electric Webster is finished 
inserting hyphens, exit the program and 
go back to your word processor. Load the 

document and use the Search & Replace 
option to change all your - signs to Ven
tura's mark for discretionary hyphens, 
which is a hyphen surrounded by angle 
brackets «-». Now you can load the 
document into Ventura and the hyphena
tion will be more complete. 
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Two-Up, 
Saddle-Stitch, and 

Other Formats 
Among the utilities that have been 
developed by The Laser Edge for enhanc
ing Ventura is VP/Saddle, which pro
vides the printing enhancements de
scribed below. Note that the techniques 
described below all require that you have 
a PostScript printer. 

Two-Up Format 

Many manuals use a "two-up" format, in 
which pages that are half of letter size or 
half of legal size paper are 3-hole drilled 
for use in ring binders. Because the 
method allows placing two pages on one 
sheet of standard paper, it is an economi
cal format that lends itself to photocopy
ing or quick printing. To have the same 
page printed side by side on a single 
sheet of paper, you create your document 
as usual in either landscape or portrait 
mode, print to a file, and process the file 

with VP/Saddle. The utility makes an 
exact copy of the original and prints the 
two side by side, ready for two-up print
ing. 

Saddle-Stitch Format 

A saddle-stitch booklet is one in which 
pages are folded in half and then stapled 
in the middle. If you simply run off pages 
in order, the numbering will not be cor
rect once you assemble the booklet and 
staple it. VP/Saddle corrects this problem 

VP/Saddle 

The Laser Edge 

360 - 17th St. 

Oakland, CA 94612 

415/835-1581 
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by pairing up the pages so that after they 
are assembled and stapled the pages will 
be in the right order. 

Enlarged Format 

One way to enhance the quality of laser 
printing is to create oversized masters 
and then have your printer reduce the 
image when shooting the negative. VP
Saddle can enlarge either half-page (5.5 
by 8.5 inches) or trade-paperback-size (6 
by 9 inches) pages by 122 percent, so 
that they fill a letter-size sheet of paper. 
The printer would then shoot the page at 
82 percent (the inverse of 122 percent). 
The effect of reducing the page is to 
sharpen the characters, since it increases 
the number of dots per inch. This book is 
an example of a reduction to 82 percent 
of the original size (although VP-Saddle 
was not used). 
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Speed Tips 
ALTHOUGH VENfURA IS a fast program 
to start with, you may want to make it 
even faster. This chapter is intended as a 
miscellany of tips for getting better speed 
performance out of the program. 

Use a Disk Caching Utility. 

Try this experiment. Load Ventura so that 
you have a blank chapter on the screen. 
Now switch to a different mode from 
whatever mode you happen to be in by 
clicking on that mode's icon. As you do 
so, notice that your hard disk light flashes 
momentarily. Now select any option from 
any menu and notice that the same thing 
occurs-the light goes on. What's hap
pening is that all the program information 
Ventura needs cannot fit in RAM and still 
leave room for documents, so the pro
gram stores some of that information on 
the hard disk and accesses it frequently. 
Disk reads are even more frequent in 
Ventura 1.1 than in Ventura 1.0, and such 
reads are many times slower than ac
cessing information from RAM. For this 

reason, a disk caching utility is a perfect 
complement to Ventura. 

Here's how disk caching works. The 
disk caching program intercepts blocks of 
data that are frequently read from the 
hard disk or written to the hard disk and 
stores them in a RAM buffer. At the 

Disk Caching Utilities 

Flash 

Software Masters 

6223 Carrollton Ave. 

Indianapolis, IN 46220 

317/253-8088 

Lightning 

Personal Computer Support Group 

Inc. 

11035 Harry Hines Blvd. 

Suite 207 

Dallas, TX 75229 

214/351-0564 
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beginning of your computer session, 
there is no speedup since the first blocks 
of data must be accessed, as usual, from 
the hard disk. However, after your com-

. puter session has gone on for a while the 
.improvement caused by the disk caching 
program will become quite noticeable. 
The advantage of a disk caching program 
over a RAM disk is that with a caching 
program you don't have to decide which 
files to store in RAM-the caching pro
gram does this automatically. Two popu
lar disk caching programs are Lightning 

Defragmenting Utilities 

The Norton Utilities, version 4.0 

and Advanced Edition 

Peter Norton Computing, Inc. 

2210 Wilshire Blvd. 

Santa Monica, CA 90403 

213/453-2361 

Mace Utilities 

Paul Mace Software, Inc. 

123 First St. 

Ashland, OR 97520 

800/523-0258 

Disk Optimizer 

SoftLogic Solutions 

520 Chestnut Street 

Manchester, NH 03101 

Phone: 800/272-9900 

and Flash (see the reference box on the 
previous page). 

I used Flash to set up a 1024 K buffer 
in extended memory. To activate the util
ity only required typing the following 
line: 
c:\£lash\£lash 512/m=a 

Once the disk cache was created, I 
found that within a minute or two of the 
time I loaded Ventura, hard disk ac
cessing by the program was much less 
frequent. The speed of scrolling, moving 
between reduced and expanded mode, 
paging through a document, and other 
functions was increased by 50 percent or 
more. Loading Ventura itself took only 4 
seconds, compared to 9 seconds prior to 
using the disk cache. Other Ventura users 
report similar performance gains with 
Lightning. 

When you install a disk caching pro
gram, you usually have to specify on the 
command line the amount of memory 
you want devoted to the cache. This 
memory can be in the lower 640K of 
memory accessible to DOS. However, 
since that diminishes the amount availa
ble for documents, it's recommended that 
you use such programs in conjunction 
with extended or expanded memory. 

As you might guess, an additional 
benefit of using a disk caching utility is 
that it increases the life of your hard disk. 

Consolidate Files on Your 
Hard Disk 

A class of programs called defragmenting 
utilities is available for the special pur-



pose of reorganizing the files on a hard 
disk so that files that have been frag
mented over time into numerous storage 
locations on the disk can be consolidated. 
One way to tell if defragmenting is in 
order is if your hard disk light turns on 
and off rapidly while loading files; each 
time the light turns on, DOS is accessing 
a new portion of the disk. 

Defragmenting programs include 
CONDENSE from the Mace Utilities, 
Disk Optimizer from Softlogic Solutions, 
Disk OrGanizer (DOG) in the public 
domain, and Speed Disk from the Norton 
Utilities Advanced Edition (see reference 
box below). Running a defragmenting 
utility is easy. For example, to run Speed 
Disk from the Norton Utilities, you 
merely type SD n: where n: is the drive 
that you want to defragment. The pro
gram takes 20 minutes or so to rearrange 
the drive, and as it works it provides you 
as it works with a graphic report on your 
progress. Not only does consolidating a 
disk speed up program operations, but it 
also extends the life of the disk. 

Use a RAM Disk for Running 
Ventura or for Holding Spill 
Files 

When you are working with pictures or 
text files that exceed the RAM available 
to Ventura for holding such files, the pro
gram "swaps them out" to the hard disk. 
When this happens, you notice that per
formance slows down considerably, as 
Ventura continually reads and writes data 
to the hard disk. 
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If you have installed a RAM disk, 
you can use it to catch the spill files that 
would otherwise be written to the hard 
disk. You can use any RAM disk program 
to set up the RAM disk, such as DOS's 
VDISK. You'll also need to add /O=D at. 
the end of your VP.BAT file (assuming 
your RAM drive has been set up as drive 
D). For example, . 
DRVRMRGR VP %1 
/S=SD_BERCS.EGA/M=11/0=D: 

Another use for a RAM disk is to 
hold Ventura itself. In theory this should 
speed things up as dramatically as a disk 
caching utility. My own experience. is 
that loading Ventura onto a RAM disk 
does not reduce hard disk reads and so I 
hesitate to recommend this option. 
However, in the interest of completeness, 
the steps to take are described in Chapter 
20, "Memory Limitations and Diagnos
tics." 

Speed Up Your Mouse 

In most mice, the speed at which you can 
move the cursor across the screen is set in 
the factory but can easily be adjusted 
with software commands. On a normal 
graphics monitor, the default setting 
should be about right; obviously you 
don't want your mouse to be too fast 
since then it will be difficult to position it 
precisely. On a large screen monitor, 
however, you may find that it takes too 
long to drag the cursor over to the sidebar 
or up to the top of the screen to make 
menu selections. In that case, you may 
want to experiment with different speed, 
or "sensitivity" settings. Normally this is 
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. easily done by typing a few characters in 
the config.sys file. 

Use a Parallel Printer Interface 

With many printers, including the lIP 
LaserJet Plus and Series II, you have the 
option of connecting it to your computer 
via a serial or a parallel interface. If you 
currently are making the connection with 
a serial interface, you'll find that per
formance improves greatly once you 
switch to a parallel interface. The differ
ence in speed is especially noticeable for 
pages that include multiple fonts or 
graphics. 

Install a JLaser or 
LaserMaster Board. 

While PostScript printers have the best 
selection of fonts among laser printers, 
they also are the slowest because of the 
overhead of the PostScript language and 
because they use a serial cable. A good 
way to have the best of both worlds
speed and quality-is to install a JLaser 
or LaserMaster board in your computer 
and use it in conjunction with your Post
Script printer. These boards provide their 
own cables that connect through the back 
of the laser printer directly into the laser 
engine's video interface. You can install 
Ventura both for PostScript and for the 
JLaser or LaserMaster boards (Laser
Master provides its own Ventura driver). 
That way, when you want to print quick 
drafts, you can use the faster option; for 
final copies you can select PostScript as 
the printer. 

Download Fonts Prior to Using 
Ventura 

With the LaserJet Plus or Series II, you 
can download all the fonts you need for 
the day and then turn off Ventura's auto
matic downloading. The method is de
scribed among the tips in Chapter 9, 
"Using Fonts." 

Text to Greek 

Greeking refers to the technique of repre
senting areas of text on the screen with 
horizontal lines, a method that reduces 
the time it takes for the program to draw 
the screen. Under the Set Preferences 
selection of the Options menu, the set
tings range from None to All. Note that 
the numbers 2, 4, 6, 8, 10 don't refer to 
the point sizes of the text that is to be 
greeked, but rather the pixel height of 
characters as shown on the screen. For 
example, if you select 10, then all 
characters 10 pixels in height or smaller 
are greeked. Greeking only applies to the 
Reduced or Facing Pages views. 

Don't Save Backup Files 

Another option in the Set Preferences 
dialog box is "Keep Backup Files." You 
can speed up operations slightly by 
selecting No. This means that Ventura 
will only save a single copy of each 
chapter, style sheet, and any other 
generated file. Caution: not keeping 
backup files means you'll probably have 
to create your chapter from scratch if 
your chapter files are lost or are become 



unusable, so use this option only if you're 
willing to take that chance. 

Select a Fast Double Click 
Speed 

Interestingly enough, increasing the 
double click speed not only makes mouse 
operations faster but also speeds up 
operations when you use keyboard alter
natives to the mouse, such as pressing the 
Enter key instead of pressing OK. The 
reason is that even if you don't use the 
mouse itself, Ventura still waits the dura
tion of the two clicks before it executes a 
command. 

Don't Use On-Screen Kerning 

The effect of on-screen kerning is to give 
you some feedback on the appearance of 
lines of text when automatic kerning is in 
effect. You needn't pay attention to this 
option at all unless the fonts you are 
using include kerning information. 
Adobe's PostScript fonts do provide such 
information, the fonts supplied with Ven
tura for other laser printers do not. Unless 
you are using a high-resolution monitor, 
on-screen kerning is not sufficieJ?t1y pre
cise to be depended on anyway, so you'll 
still need to check the printed copy. 
Therefore, you're best off selecting only 
the largest point sizes for on-screen kern
ing, or simply specifying no on-screen 
kerning. Even when you do turn off auto
matic on-screen kerning in the Prefer
ences dialog box, you'll still be able to 
view the results of any manual kerning 
you do with the Set Font option. 
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Use Keyboard Shortcuts 

A table of keyboard shortcuts is provided 
in Chapter 7, "Preparing, Loading, and 
Tagging Text." Some of the most· useful 
of these are: 

Pressing Enter· instead of selecting 
OK with the mouse. 

• Saving with Ctrl-S. 

• Using Ins, Del, and Shift-Insert to 
insert, delete, and copy. 

• Using Ctrl-F and Ctrl-L for fill and 
line attributes. 

• Using Ctrl-Shift-[ for left quotation 
marks and Ctrl-shift-] for right quo
tation marks. 

• Using Ctrl-Shift-M for Em spaces 
and Ctrl-Shift-N for En spaces. 

Use Ctrl-X 

This is probably the most useful 
shortcut of all. It causes the most recent 
dialog box you accessed to appear again. 
If you're trying out different settings for 
a particular specification, such as the 
cropping of a graphic or the amount of 
spacing between two paragraphs, you'll 
find work goes faster if you press Ctrl-X 
rather than pull down the menu and select 
the option. 

Use the Backup Box 

To change the filter on the Directory line, 
it's quicker and more accurate to use the 
Backup Box than to the erase the line and 
then type a new one. The use of the 



232 VENTURA TIPS AND TRICKS 

Backup Box is· explained in Chapter 6, 
"Managing Files." 

Double-Clicking 

When you selecting file names from lists, 
it's much quicker to double-click on a 
name than to click once to highlight the 
name and then select OK. 

Pretag Text 

It's faster to tag your text files with a 
keyboard macro program such as Super
Key than to use Ventura's Tagging mode. 
The pretagging method is described in 
Chapter 7, "Preparing, Loading, and Tag
ging Text." 

Use the Esc Key to Clear Lines 

In dialog boxes, rather than backspacing 
across a line you wish to erase, you can 
place the cursor anywhere on the line and 
press Esc. 

Hide Pictures 

Redrawing pictures when the page is 
scrolled or frames are moved is one of 
the biggest slowdowns in Ventura. To 
avoid this bottleneck, select Hide Pic
tures from the Options menu. 

Avoid Swapping to the Hard 
Disk 

When your documents include graphics 
or text files that are too large for Ventura 

to store in RAM all at once, it "swaps 
out" the excess to the hard disk. When 
this happens, all operations take signifi
cantly longer. You can avoid swapping 
out by freeing up additional RAM or by 
reducing the size of the files. For more 
information, see Chapter 20, "Memory 
Limitations and Diagnostics." 

Use the Shift Key 

When using a graphic tool several times, 
hold down the Shift key to avoid having 
to reselect the tool each time you use it. 
Holding down the Shift key while select
ing paragraphs in Tagging mode also al
lows you to select multiple paragraphs to 
tag at once. 

Store Graphic Defaults 

Generally it is the case that when you are 
using the graphic tools you will be creat
ing more than one object with the same 
characteristics. Rather than going 
through the process of selecting Line and 
Fill attributes each time you create a 
graphic, use the Save To option to create 
default settings that you can use over and 
over. 

Faster Hyphenation 

If you've been using the faster of the two 
hyphenation algorithms and then switch 
to the slower but more accurate one, 
you'll notice immediately how much 
longer it takes to load a chapter. I timed 
how long it took to load one of the longer 
chapters in this book (Chapter 5, "Hard-



ware") with no hyphenation installed, 
with the fast algorithm, and with the slow 
algorithm. The results were: 

No hyphenation: 18 seconds 
USENGLSH algorithm: 22 seconds 
USENGLS2 algorithm: 96 seconds 
As you can see, USENGLS2 is over 

four times slower than USENGLSH 

though also signficantly better in findin~ 
hyphenation points and avoiding incor
rect breaks. 

I recommend that you keep both the 
USENGLSH and the USENGLS2 algorithm 
in your \ VENTURA directory. To keep 
track of which is which, rename them 
both so that USENGLSH is called FAST 

and USENGLS2 is called SLOW. One of 
them should be given the extension HYI 

and the other the extension BAK. This 
will cause Ventura to use the one with 
HYI and ignore the other. Unless you're 
producing multilingual documents and 
really must have two hyphenation algo
rithms installed at the same time, it's 
never a good idea to keep two hyphena
tion algorithms active as HYI and HY2 

since Ventura will load them both int~ 
RAM and you will have less memory 
available for holding text and pictures. 

Probably the best way to work is to 
have the FAST algorithm active as 
FAST.HYI while you're first setting up a 
document, then rename it to FAST.BAK 

and rename SLOW.BAK to SLOW.HYI 

when you get into the late stages with a 
document. Changing tag names like this 
is better than trying to tum off hyphena
tion on a tag-by-tag basis. 
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8087 Coprocessor? 

Since Ventura does not use floating 
point arithmetic, it has no need for the 
8087 coprocessor. Having that chip in
stalled in your computer will not enhance 
the program's performance. 

Loading a Chapter Directly 
from DOS 

You can speed up the getting-started 
process by typing the path and name of 
the chapter you are working on at the 
command line, like this: 
VP C:\BOOKDOCS\CHAPTER1.CBP 

Pre-loading the PostScript 
Prologue 

Each time it prints a file on a PostScript 
printer, Ventura transmits a prologue, 
PS2.PRE, containing various PostScript 
definitions. You can save time by 
downloading the file PERMVP.PS each 
time you tum on the printer and deleting 
or renaming PS2.PRE from the \VENTURA 

directory. The location of PERMVP.PS is 
on the \POSTSCPT directory of the Utility 
disk (#11). Eliminating the need for Ven
tura to transmit the PS2.PRE prologue 
shaves about 10 seconds off the time re
quired to print a chapter. Remember to 
restore PS2.PRE to the \VENTURA 

directory before you create print files for 
printing on other printers or typesetters. 
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Memory Limitations 
and Diagnostics 

ALTHOUGH VENTURA IS designed to 
handle very long documents, there are 
times when you will run up against 
memory limits caused by a document that 
is too long or a page that is too complex. 
Although there do exist certain absolute 
limits on document size and complexity, 
by understanding how Ventura handles 
computer memory and storage you can 
usually manage to produce almost any 
document. 

What Are the Limits? 

The following limits are imposed by Ven
tura: 

• Size of text files: With Version 1.0 
the limit on such files was 150K. 
Now it is 500K. Ventura handles a 
long text file by holding as much as 
possible in RAM and "swapping 
out" the overflow to temporary files 
on the hard disk. Even if the file you 
are working with is well within the 
500K limit, you'll probably want to 

keep it small enough enough to 
avoid disk swapping, which slows 
operations down considerably. 

• Number of tags: In Version 1.1 you 
can have 128 tags in a style sheet. In 
Version 1.0 the limit was 64. 

• Number of chapters: In Version 1.1 
the limit is 128 per publication. In 
Version 1.0 it was 64. 

• Number of text and picture files: In 
Version 1.1 the limit is 128 per pub
lication; previously it was 64. 

• Number of paragraphs per chapter: 
In Version 1.1 the limit is 8,000, up 
from 3,000 in Version 1.0. 

• Number of line elements per frame: 
725. Line elements are explained 
below. 

• Maximum size of a paragraph: 8,000 
bytes. 
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Figure 1: To 
access the 

Diagnostics 
report, select 

. Publisher 
information 

from the Desk 
menu, then point 
the mouse at the 

word Ventura 
and click. 

Figure 2: The 
Ventura 

Publisher 
Diagnostics 

report. 

MUdl1ne 

ToUe Text I 

Toble Text 2 

Toble Title 

Title 

Z_IOXTEXT 

Xerox Desktop Publishing Series: 
Ventura Publisher Edition 

Version 1.1 - (B4/1B/B7) 
Serial UW·BOOBOB 

Uentulla 
Software~ Inc. 

Copyright (c) 19B6 

Don Heiskell 
Lee Jay Lorenzen 

John Grant 
John Heyer 

Total line Elelllents: 713/ 725 elelllents 

Total Internal I1elllory: 23006 / 26000 bytes 

Total External Helllory: 153624 bytes 
Still Available: 126032 

Alllount Swapped Out: B bytes 
Width Table Size: 9126 

Graphics Buffer Size: 4BOOO bytes 
Screen Fonts Size: 5200B 

HYPHEN Overlay Size: 460B 
Hyph. Dictionary Size: 5356 

Perlll. Strings Size: 4593 
FARCODE Overlay Size: 17552 

o 



Diagnostics Status Box 

The first step in understanding Ventura's 
memory limits is to look at the diagnos
tics status box. To do so, select Publisher 
Info in the Desk menu and then click 
directly on the word Ventura in the box. 
(See Figures 1 and 2.) 

Total Line Elements 

There are two numbers separated by a 
slash. The number to the right of the 
slash (normally 725) is the maximum 
number of line elements that are allowed 
in the current frame. The number to the 
left of the slash is the number that are re
maining. (Subtracting the two numbers 
tells you how many line elements have 
been used up in the current frame.) 
Every line of text counts as two line ele
ments, and additional line elements are 
used up by changes in type, tabs, and 
especially leader tabs (a line containing a 
leader tab counts as six line elements). 
Note, however, that the number of para
graph breaks does not affect the number 
of line elements. If you have too many 
line elements in a frame, you'll get the 
error message "This frame is too complex 
to completely format." Steps to take to 
simplify a frame are described below. 

Totallnternal~emory 

The number on the right side of the slash 
is the amount of RAM reserved for inter
nal program functions; the number on the 
left is the amount actually used. These 
numbers can't be changed by the user. 
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Total External Memory 

On a machine with 640K of RAM and no 
RAM resident utilities or device drivers 
installed, this number should be about 
170K. It represents the maximum amount 
of document information that Ventura 
can work with in RAM. Exceeding this 
amount will not prevent you from loading 
or working with a document, but it will 
slow operations down considerably be
cause Ventura will resort to disk swap-
ping. . 

Still Available 

This is the amount of RAM still unused 
and available for storing document infor
mation without resorting to disk swap
ping. The following steps can be taken to 
increase the amount of still available 
memory: 

• De-install RAM-resident utilities 
such as SideKick or disk caching 
programs that reserve caching 
buffers in lower 640K territory. 

• Remove unnecessary device drivers 
from your Config.sys file. 

• When you load Ventura, type 
VP /A=16 

(or any integer between 1 and 32 in 
place of 16). Note that this reduces 
the amount of memory available for 
printing and for the graphics buffer. 
Thus, it will slow down cropping 
and moving by forcing disk swap
ping, and may interfere with the 
operation of printer drivers. 
However, it will allow you to work 
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with larger text files without disk 
swapping. 

• If you have two hyphenation algo
rithms installed in the \ VENTURA 

directory • as HYI and HY2, remove 
, one of them or change its extension 
, ,to BAK. 

" Amount Swapped Out 

This is the. ~mount of document informa
t~on that exceeds the available RAM and 
therefore . has been written to the hard 
disk. Swapping out significantly reduces 
Ventura's performance. 

Width Table Size 

This is the amount of RAM taken up by 
the portion of the font width table used 
. by the screen display. It can be as little as 
lK and as much as 35K, depending on 
how many fonts are installed. 

Graphics Buffer Size 

This is the size of the picture file that 
Ventura can handle without swapping out 
to a hard disk. The limitation applies 
most frequently to images, i.e. bit
mapped graphics such as files with the 
IMG extension. Cropping and moving 
bit-mapped pictures will go much faster 
if you keep the size of files smaller than 
the graphics buffer. 

Screen Fonts Size 

This is the amount of RAM reserved for 
storing the bit maps used by Ventura to 
display fonts on screen. 

HYPHEN Overlay Size 

This is the sum of the hyphenation algo
rithms currently installed. You can have 
two such algorithms installed at any time. 
The term "overlay" is somewhat mislead
ing here, since this is actually a program 
file that must remain in RAM rather than 
being kept on disk like traditional over
lays. 

Hyph. Dictionary Size 

This is the size of the hyphenation dic
tionary for the algorithms currently in
stalled. (Is this the sum of the two 
dictionaries 1) 

Perm. Strings Size 

This is RAM that must remain allocated 
at all times to certain essential informa
tion such as error messages. 

FARCODE Overlay Size 

The C compiler used in the development 
of Ventura allows program segments of 
up to 64K. FARCODE is program infor
mation outside that limit, which Ventura 
needs speedy access to and therefore 
maintains in RAM. 
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Tips on Memory 

Tip: Overcoming Line Element Limits 
The limit of 725 line elements per frame 
is most likely to cause problems if you 
are creating a multi-column document in 
a small point size such as a phone 
directory. Let's assume you are creating a 
three-column directory. To place more 
than 725 line elements on a page, draw 
two frames over the second and third 
columns. Load the document into the 
base page as normal, then select the sec
ond frame and click on the name of the 
text file in the sidebar. Text will now 
flow into the third column. Repeat the 
procedure to flow text into the third 
frame. Now mark the two frames as re
peating frames. Ventura will automati
cally repeat the format for as many pages 

MD D:\VENTURA 
COPY \VENTURA\VP*.* D:\VENTURA 

as necessary to contain the whole docu
ment. 

Tip: Loading Ventura Onto a RAM 
Disk (Note: Approach With Caution) 
There are two ways you can use' a RAM 
disk with Ventura. One way is to store.the 
entire program on the RAM disk~ The 
other way, using the RAM disk for spilL: 
files, is described below. Loading Ven
tura onto a RAM disk will only work if 
you have 1.3Mb or more of RAM in your 
computer and have already used a pro
gram such as DOS's VDISK utility to set 
up the RAM disk. In theory,. loading the 
program onto a RAM disk will speed up 
operations by reducing the need for Ven
tura to frequently look on the hard disk 
for overlay files. 

CAUTIONARY NOTE: In my own ex
periments with using Ventura on a RAM 

COpy \VENTURA\OUTPUT.WID D:\VENTURA 
PATH=D:\VENTURA 
COPY C:\VENTURA\*.INF D:\VENTURA 
COPY C:\VENTURA\*.HY? D:\VENTURA 
COPY C:\VENTURA\screendriver D:\VENTURA 
CD \VENTURA 
DRVRMRGR D:\VENTURA\VP etcetera 
COPY D:\VENTURA\*.INF C:\VENTURA 

Table 1: The commands for starting Ventura from a RAM disk. The word 
Bcreendriver should be replaced by the name of your screen driver, such as 
SD _HEReS.EGA (Hercules monitor) or SD _EGAHS.EGA (EGA board and monitor) 
and etcetera is replaced by your particular screen and mouse settings, which can be 
copiedfrom VP.BAT. 
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disk, I was unable to confmn that there 
. are any performance improvements to be 
. gained from this method. Besides that, 
the· method is more complicated than 
using a disk caching utility such as Flash 
or Lightning (see Chapter 19, "Speed 
rips.") I'm including this tip in the inter
est of completeness-perhaps you'll h':!ve 
better luck. 

Assuming that your RAM disk is D 
and that Ventura 1.1 is installed in 
. C:\ VENTURA, the commands listed in 
Table 1 will install the program on the 
RAM disk and boot it up. 

Tip: Using a RAM Disk for Spill Files 
One of the. biggest performance degrada
tions with Ventura occurs when a docu
ment exceeds available memory and 
must be swapped out to the hard disk. If 
you have a RAM disk, you can have the 
RAM disk used for the spill files. Simply 
add /O=D: at the end of your VP.BAT 
line, where D: is replaced by the designa
tion of your RAM drive. For example: 
DRVRMRGR VP %1 /S=SD_VIK01.EGA 
/M=ll/O=D: 

Tip: Minimizing the Size of Database 
Output 
Every paragraph, no matter how long, 
consumes at least 64 bytes of RAM. So a 
one-word will take up 64 bytes, the same 
as a paragraph with nine words. You can 
reduce the amount of RAM consumed by 
a document by setting up your database 
program to generate two consecutive line 
breaks rather paragraph breaks to start 
each new line. (You need two consecu
tive line breaks because Ventura will ig
nore single line breaks). To generate a 

line break, set up your database program 
to emit an R surrounded by angle brack
ets (<R». Of course, you still have to in
sert a paragraph mark occasionally, to 
avoid violating the 8,000 byte limit for 
paragraphs. 
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Using Ventura 
Without a Mouse 

THE PREMISE OF this chapter-that 
anyone would even consider using Ven
tura without a mouse-may strike you as 
silly. Frequently, however, people want to 
start using the program before they have 
had time to purchase a mouse, or they're 
having some difficulty configuring Ven
tura for use with a particular mouse and 
want to get started anyway. This chapter 
is intended for anyone who finds them
self sans mouse, for whatever reason. 

General Operations 

• To get around the screen without a 
mouse, use the up and down cursor 
keys. The cursor will move in dis
crete jumps. To get more precise 
positioning, hold down the Shift key 
while you move the cursor keys. The 
cursor will move much more slowly 
and in smaller increments . 

• In situations where you'd need to 
click the button on the mouse, press 
the Home key. 

• In situations where you'd need to 
hold down the button on the mouse, 
such as dragging a frame or a 
graphic, press End. Then to "release" 

Select Frame function .......... Ctrl-U 

Select Tagging function .......... Ctrl-I 

Select Text function .............. Ctrl-O 

Select Graphics function ...... Ctrl-P 

Select Reduced view ........... Ctrl-R 

Select Normal view .............. Ctrl-N 

Select Enlarge view .............. Ctrl-E 

Save chapter ......................... Ctrl-S 

Assign function keys ............. Ctrl-K 

Call up most recent menu ..... Ctrl-X 

Selection button .................... Ctrl-2 

Go to page ........................... Ctrl-G 

Table 1: Keyboard equivalents for mouse 
operations. 



242 VENTURA TIPS AND TRICKS 

the button on the mouse, press 
Home. 

•. Use keyboard equivalents shown in 
Table 1 to avoid continually travel
ing to the menu line. 

Special Techniques 

• When you fIrst boot up the program, 
you should be able to move the cur
sor around the screen using the cur
sor keys instead of the mouse. If not, 
hold down the Shift key on the right 
side of the keyboard while pressing 
Ctrl. 

• To create a new tag, press Ctrl-I to 
select the Tagging function. Move 
the cursor on top of a paragraph and 
press Home to select the paragraph. 
Then press Ctrl-2 to select Add New 
Tag. 

• To get rid of a menu you have pulled 
down, move the cursor outside the 
menu and press Home. 

• To draw a frame, select the Frame 
function with Ctrl-U, press Ctrl-2 to 
select Add New Frame, move the 
cursor to the upper left comer of the 
new frame, press End, cursor to the 
lower right comer, press Home 
again. 

• To move a frame, move the cursor 
inside it and press End, move it to its 
new location and press Home. 

• To stretch a frame, place the cursor 
over one of the small black squares 
that function as grabber marks. Press 
End--the cursor should change to a 

pointing finger, allowing you to 
stretch the edge of the frame by 
moving the cursor keys. If it does 
not, hold down the Shift key while 
you move the cursor more carefully 
on top of the grabber mark. Inciden
tally, it is easier to select the comer 
grabber marks than the side marks. 
When you've finished stretching the 
frame, press Home. 

• In text editing mode, you need to use 
the cursor keys to move the special 
text editing cursor, which is different 
from the normal cursor. The text 
editing cursor holds your place in the 
text while the other cursor is used to 
select operations from menus. To 
change the cursor keys so that they 
move the text editing cursor rather 
than the regular cursor, hold down 
the Shift key on the right side of the 
keyboard while pressing Ctrl. 

• To activate Set Font in text editing 
mode, press Ctrl-2. 
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APPENDIX A 

Product Notes 

Graphics 
Software 

1-2-3, Freelance, Symphony, 
Graphwriter 
Lotus Development Corporation 
55 Cambridge Parkway 
Cambridge, MA 02142 
617/577-8500 
There are various ways to import graphics 
generated by these programs into Ventura. 
From 1-2-3, you can save graphics with the 
PIC extension, and then load them into Ven
tura as line art (i.e. object graphics). 
Freelance and Graphwriter also produce files 
in VideoS how format, and Freelance also can 
produce files in CGM format; both the 
VideoS how and CGM fonnats have been 
added as line art graphic options in Ventura 
1.1. For details on preparing charts with 1-2-
3, see Chapter 16, "Lotus Worksheets and 
Graphics. " 

AutoCAD 
Autodesk, Inc. 
2320 Marinship Way 
Sausalito, CA 94965 
415/332-2344 
There are several ways to import AutoCAD 
files into Ventura. One is to create them in 
SLD (slide) fonnat using the ADE-2 Package 
and the AutoCAD MSLIDE command. In 
~is fonn they can be imported them directly 
mto Ventura. A second method is to save 
them in AutoCAD in DXF fonnat and then 
use Ventura's DXFTOGEM utility, located 
on the Utilities disk (#11), to convert them to 
GEM format. They can then be imported into 
Ventura, but will not include a number of at
tributes including shape entity, text mirror
ing, curve fitting, 3D rendering, and and 
tapering widths in polylines. A third avenue 
is via HPGL format. If you have created a 
picture in AutoCAD in landscape mode, 
make sure that you rotate it before importing 
it into Ventura. 
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GEM Draw Plus 
Digital Research, Inc. 
60 Garden Court 

'Monterey, CA 93942 
800/443-4200,408/649-3896 
Graphics created with GEM Draw Plus are 
created :with the GEM extension and im
ported into Ventura as line art (i.e. object 
graphics), hence they 'do not degrade in reso
lution when they are scaled and distorted. 
The program ,provides tools for creating 
geometric shapes such as rectangles and 
circles; it, also includes an extensive library 
of images that can be,cropped and adapted. A 
panning feature lets you defme a portion of 
the screen to work with at various levels of 
magnification. Among the features of the 
program are several fonts for incorporating 
text into graphics; however, spacing seems to 
be somewhat unpredictable when GEM 
Draw text is imported into Ventura. 

GEM Paint 
Digital Research, Inc. 
60 Garden Court 
Monterey, CA 93942 
800/443-4200,408/649-3896 
Not as powerful as PC Paintbrush Plus, 
GEM Paint offers a similar set of drawing 
tools and saves its files with the IMG exten
sion in image (i.e. bit-mapped) format. It al
lows pixel editing, but at the resolution of 
the screen rather than at the 300-dpi resolu
tion allowed by Paintbrush. 

Halo DPE 
Media Cybernetics, Inc. 
8484 Georgia Ave. #200 
Silver Spring, MD 20910 
3011495-3305 
Besides being sold as Halo DPE by Media 
Cybernetics, this program is also marketed 

by its developer, IMSI, as the Desktop Pub
lishers' Graphics program. It creates files in 
IMG format, which can be imported into 
Ventura as images (i.e. bit-mapped graphics). 
You can operate scanners directly from 
within Halo DPE, including the Canon IX-
12, Ricoh IS-30, mM 3117, CompuScan 
PCS 240, and the Microtek MS-300A. In ad
dition to normal painting features such as 
circles and shading, the program works with 
extended memory, provides image rotation, 
and has a zoom feature for pixel editing. 

Illustrator 
Adobe Systems, Inc. 
1870 Embarcadero Rd. 
Palo Alto, CA 94303 
415/852-0271 
Although lliustrator is still available only on 
the Macintosh, it is nevertheless an impor
tant piece of graphics software to be con
sidered in conjunction with Ventura. You can 
load scanned images into lliustrator to use as 
templates, and then use its powerful drawing 
tools to trace over them. Unlike other draw
ing programs, Illustrator lets you draw true 
curves, making whole new areas of graphic 
illustration accessible from a personal com
puter. lliustrator saves its images as resolu
tion-independent object graphics; once trans
ferred to a PC they can be imported into 
Ventura as Encapsulated PostScript files. 

PC Paintbrush Plus, Publisher's 
Paintbrush 
ZSoft Corporation 
1950 Spectrum Circle 
Suite A - 495 
Marietta, GA 30067 
404/980-1950 
Perhaps the most popular graphics program 
on the PC, PC Paintbrush Plus is a close rela-



tive of Wmdows Paintbrush. Both create files 
with the PCX or PCC extension, which can 
be imported into Ventura as images (i.e. bit
mapped graphics). For drawing, PC Paint
brush Plus provides tools such as a paint
brush, a paint roller, boxes, circles, pattern 
fills, cutting and pasting, and an eraser. It 
provide controls for operating a variety of 
scanners from within the program, allowing 
you to store scanned images in PCX format. 
Among the scanners supported are Dest PC 
Scan Plus, the ShapeScan, the Datacopy 730, 
the Canon IX-12, and the HP ScanJet. Once 
saved in PCX format, a scanned image can 
be edited or cleaned up using PC Paintbrush 
Plus's editing tools, including two levels of 
zoom for pixel editing. The PC Paintbrush 
Plus package also includes the Frieze screen 
shot utility (see Chapter 14, "Screen Shots"). 
An excellent configuration is the inexpensive 
Canon IX-12 scanner and the JLaser board in 
conjunction with PC Paintbrush Plus. 

Publisher's Paintbrush starts with the 
features of PC Paintbrush Plus and adds a 
few more. Tools can be used in any of four 
zoom modes-unlike PC Paintbrush, which 
limits use of the tools to a single mode. 
Another addition is a set of text features that 
allow characters to be slanted and the base
line to be placed at an angle. The program 
supports both expanded AT memory and 
LotuslIntellMicrosoft EMS memory, making 
it possible to create large bit-mapped images. 
Like PC Paintbrush Plus, Publisher's Paint
brush includes the Frieze screen shot utility 
and provides controls for a variety of scan
ners. 
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Perspective 
Three D Software Inc. 
860 Via de la Paz 
Pacific Palisades, CA 90272 
2131459-8525 
As its name implies, this increasingly popu~ 
lar program is used for creating three-dimen
sional charts. It lets you import WKSfiles· -
from 1-2-3, convert them- into three-dimen
sional format, and apply functions such as 
tilting, rotating, stretching, and compressing 
along any of the axes. You can import them 
into Ventura as image (i.e. bit-mapped) files 
in IMG format. 

Clip Art 

Digit-Art LaserGraphics 
Image Club 
#206 - 2915 -19th St. NE 
Calgary, Alberta 
Canada T2E 7 A2 
4031250-1969 
The Digit-Art collection is created in Mac
Draw rather than MacPaint format, allowing 
it to be scaled without any reduction in reso
lution. Image Club plans to also have a 
volume of clip art available soon in Encapsu
lated PostScript Format. 

DrawArt 
Desktop Graphics 
8001541-0900, California 8001334-3030 
Unlike most clip art collections, which are in 
MacPaint format, this one is in MacDraw 
format. The difference is that MacDraw im-
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ages are object graphics, which means that 
they can be scaled without any reduction in 
resolutiqn. The DrawArt collection is in two 

. volumes, the fIrst containing 150 images, the 
second 300 im·ages. 

. LaserCraft Images 
Nikrom· 
176 Fort Pond Rd.· 
Shirley, MA 01464 
800/835-2246 
This is a collection of PostScript routines for 
special text and graphics effects. Currently 
the collection is on Macintosh disks but can 
be transferred to PC disks and then con
verted into Encapsulated Posts.cript Format 
for importing into Ventura. Text routines in
clude cylindrical, elliptical, rotated, shaded, 
and shadowed type. Graphics techniques in
clude borders, brushed-metal effects, curves, 
and scroll designs. 

Mac-Art Library 
CompuCra!t 
P.O. Box 3155 
Englewood, CO 80155 
303/850-7472 
This is a library of MacPaint clip art on Mac
intosh disks. Topics include animals, farm 
life, geography, kitchen, sports, tools, build
ings, flowers, trees, plants, greeting cards, 
people, transportation, signs, symbols, and 
borders. 

MacMemories 
ImageWorld 
P.O. Box 10415 
Eugene, OR 97440 
800/457-6633 
This is a large clip art collection based on 
tum-of-the-century book, magazine, and 

greeting card illustrations. 

PC Quik-Art 
PC QUIK, Inc. 
394 S. Milledge Ave. #200 
Athens, GA 30606 
800/523-1796 
PC Quick-Art is a very large library (over 
50,000 images) of commercial clip art 
created by SCW Services, which has been 
translated into PC Paintbrush PCC format. It 
can be loaded into Ventura directly as a PC 
Paintbrush image, or loaded into PC Paint
brush Plus or Publishers Paintbrush for 
editing. Each disk provides approximately 
50 images and is devoted to a particular topic 
including ad tools, maps, borders and mor
tises, activities and events, services and mer
chandise, holidays, recreation, food services, 
cartoons, dingbats, computers, drafting tools, 
math and science, emblems and logos, 
sports, and religion. 

PostScript 
Printers (300 
dpi) 

LaserWriter, LaserWriter Plus 
Apple Computer Inc. 
20525 Mariani Ave. 
Cupertino, CA 95014 
408/996-1010 
The LaserWriter was the ftrst PostScript 
printer, and it and the LaserWriter Plus con-



tinue to be the most popular. Both use the 
Canon LBP-CX engine, which is reliable and 
has excellent type quality but in solid areas 
produces a mottled gray rather than black. 
The difference between the LaserWriter and 
the LaserWriter Plus is in the number of 
fonts built into the printer. The LaserWriter 
includes Helvetica, Times Roman, Courier, 
and Symbol. In addition to those fonts, the 
Plus includes Avant Garde Gothic, ITC 
Bookman, Helvetica Narrow, New Century 
Schoolbook, Palatino, ITC Zapf Chancery, 
and ITC Zapf Dingbats. 

LZR-2665 
Dataproducts Corp. 
6200 Canoga Ave. 
Woodland Hills, CA 91365 
818/887-8000 
This is a 26 page-per-minute PostScript 
printer that uses the Toshiba engine. It can 
print on letter, legal, and 11- by 17-inch 
paper. 

OmniLaser 2000 Series 
Texas Instruments 
Data Systems Group 
P.O. Box 809063 
H-860 
Dallas, TX 75080 
800/527-3500 
There are three laser printers in this series. 
The 2108 and the 2115 include the Post
Script page description language. HP Laser
Jet emulation is also available. The Om
niLaser printers use the 8 page-per-minute 
Ricoh 4080 engine (for more details on the 
Ricoh engine, see Chapter 5, "Hardware.") 
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PS Jet and PS Jet Plus 
The Laser Connection, Inc. 
P.O. Box 850296 
Mobile, AL 36689 
205/633-7223 
PS Jet and PS Jet Plus are kits that convert 
an HP LaserJ et or other printer using the 
Canon LBP-CX engine into the equivalent of 
a PS 800 or PS 800 Plus PostScript printer. 
Newer versions of these kits also include an 
HP LaserJet emulation, allowing you to con
tinue using software packages that lack Post
Script drivers. Details on the installation 
process are provided in Chapter 5, "Hard
ware." 

PS 800, PS 800 Plus, PS 1200, PS 
2400 
QMS,lnc. 
P.O. Box 81250 
Mobile, AL 36689 
All these QMS printers offer 300-dpi resolu
tion; the difference is speed. The PS 800 and 
PS 800 Plus are rated at 8 pages per minute, 
the PS 1200 at 12 pages per minute, and the 
PS 2400 at 24 pages per minute. The PS 800 
and PS 800 Plus are quite similar to the 
LaserWriter and LaserWriter Plus, with the 
same Canon LBP-CX engine and providing 
the same internal fonts. However, both have 
an additional 512K of RAM. 

Qume Script Ten 
ITrQume 
2350 Qume Dr. 
San Jose, CA 95131-1893 
408/942-4144 
This is an 8 page-per-minute PostScript 
printer that uses the Genicom engine. Al
though bulky, the printer produces good print 
quality, with crisp type and black solid areas. 
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PostScript 
. Printers and 
Typesetters 
(Above 300 dpi) 

CG400-PS 
Compugraphic Corp. 
200 Billardvale St. 
Wilmington, MA 01887 
800/822-5524 
This is a 400-dpi printer capable of printing 
up to 18 original pages per minute. The addi
tional 100 dots per horizontal and vertical 
inch actually increases the quality of output 
considerably (160,000 dots per square inch, 
in contrast to the 90,000 dots per square inch 
produced by most laser printers). The printer 
uses Adobe's Atlas controller, which uses the 
Motorola 68020 chip and is faster than the 
controllers used in most PostScript printers. 
One reason for the increased speed of the 
Atlas controller is that while one page is 
being printed, the next page is being pre
pared. The printer includes a 20 Mb hard 
disk for storing fonts, a 1 Mb font cache, and 
2 Mb of bit map memory. The built-in type
face families are the same as in the Laser
Writer: Times, Helvetica, Courier, and Sym
bol. The difference between the 300 dpi of 
most laser printers and the 400 dpi level 
marks a remarkable improvement in quality 
that may be more suitable for publications 
that require sharper type than most laser 
printers can produce. 

Linotronic 100, Linotronic 300 
Allied Linotype Co. 
425 Oser Ave. 
Hauppauge, NY 11788 
516/434-2016 
The resolution of the Linotronic 100 is 1270 

. dpi, that of the Linotronic 300 is 2540 dpi. 
Both print on paper or f11m up to 12 inches 
wide. With bit-mapped and object graphics, 
the 300 is two to three times faster than the 
100; with halftones the two are roughly com
parable in speed. Both can be used with the 
full library of PostScript fonts. Typically, 
service bureaus provide access to Linotronic 
printers on a per hour and per page fee basis. 
In the past year, the sluggish performance of 
the Linotronic typesetters has been im
proved. The most dramatic improvement has 
been in the area of bit-mapped images: an 
image that used to take 27 minutes to print 
on the Linotronic 300 now takes just under 2 
minutes. 

Printware 720 IQ 
Printware 
1385 Mendota Heights Rd. 
St.Paul,MN 
612/456-1400 
Scheduled for introduction in September, 
1987, the Printware 720 IQ is a 1200 dpi 
(horizontally) by 600 dpi (vertically) laser 
printer that uses Printscript, a PostScript
compatible page description language.!t also 
emulates an HP LaserJet Plus. The printer is 
rated at a maximum of 8 pages per minute 
and accepts plain paper stock up to 8.5 by 11 
inches, transparencies, and labels via a To
shiba paper transport mechanism. The 720 
IQ contains allows on-line selection of black 
and one other color, such as red, brown, or 
blue. A Ventura driver is report being pre
pared by the manufacturer. 



VT600 
Varityper 
1 Mount Pleasant Ave. 
East Hanover, NJ 07936 
800/631-8134 
This is a 600-dpi PostScript printer, rated at a 
maximum of 10 pages per minute. Like the 
Agfa P400PS, it uses the fast Atlas control
ler. Built into the printer is a 20 Mb hard disk 
for storing typefaces. The VT600 uses plain 
paper (up to 10 by 14 inches) and provides 
serial and parallel ports. Resident fonts are 
Varityper Times Roman, Varityper Helvetica, 
and Adobe Courier and Symbol; more fonts 
can be loaded onto the printer's 20 Mb hard 
disk. The width tables for the Varityper 
TImes Roman and Helvetica do not match 
those of Adobe's Times Roman and Helvet
ica; thus, you will not be able to justify type 
set in these typefaces until Adobe provides 
those fonts on disks so that they can be 
downloaded into the printer. 

LaserJet 
Compatible 
Printers 

Kyocera F.I0I0, F·2010 
Kyocera Unison Inc. 
3165 Adeline Ave. 
Berkeley, CA 94703 
415/848-6680 
The Kyocera printers can be operated in 
several modes, the most useful of which is 
LaserJet Plus emulation. The controller of 
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the Kyocera is similar to the Oasys design. 
used in the Oasys LaserPro, and it is one of 
the best emulations of the LaserJet Plus. 
There are some slight incompatibilities, 
however: (1) slight streaking may show upin 
bit-mapped graphics, and (2) light shades of 
gray tend to be too faded. In general, 
however, these problems are inconsequential. 
The speed of the Kyocera is somewhat better 
than the LaserJet Plus, and the amount of 
RAM is 1 Mb rather than 512K. Print quality 
of the Kyocera FBP-01 engine is excellent. 
In addition to emulating the LaserJet Plus, 
the printer emulates the Diablo 630, Qume 
Sprint n, Epson FX-80, NEC Spinwriter, and 
IBM Graphics Printer. 

LaserJet 
Hewlett-Packard Co. 
11 000 Wolfe Rd. 
Cupertino, CA 95014 
800/367-4772 
The basic LaserJet can only use font car
tridges, not downloadable fonts on floppy 
disks. Although more than a score of such 
cartridges are available, with Ventura you 
can only use the F cartridge, which provides 
one display font (14.4-point Helv), three text 
fonts (lO-point TMS RMN in regular, italic, 
and bold) and one footnote font (8-point 
TMS RMN). Though limited, this range of 
sizes is suitable for letters, memoranda, 
simple business reports, and some technical 
documentation. 

With the LaserJet, you cannot print text 
in landscape mode, and graphics are severely 
limited by the 59 Kb of printer memory 
available for storing graphics. If you select 
other fonts and try to print them on the 
LaserJet, Ventura will render them at a crude 
75-dpi resolution. Despite its drawbacks, you 
can use the LaserJet as a draft printer in con
junction with a PostScript phototypesetter. 



252 VENTURA TIPS AND TRICKS 

This is done by selecting the LaserJet as the 
printer and then specifying a PostScript 
width table. If you are using a LaserJet, you 
have several· upgrade options: the JLaser or 
LaserMaster boards (see below), the PS Jet 
(see above), or an upgrade to a LaserJet Plus. 

LaserJet Plus, LaserJet·500 Plus, 
. LaserJet Series II 
Hewlett-Packard Co. 
11000 Wolfe Rd. 
Cupertino, CA 95014 
8001367-4772 
These printers differ from the basic LaserJ et 
in that they include more memory (512K in 
the Plus and the 500 Plus, 512K to 4.5 Mb in 
the Series II). This memory allows larger 
graphic images to be printed, as well as al
lowing fonts to be downloaded into the 
printer. The Plus and the 500 Plus use the 
same Canon LBP-CX engine used by the 
basic LaserJet; the Series IT uses the new 
Canon LBP-SX, which is lighter and pro
vides blacker blacks. Other than the differ
ence in the engine that they use and the new 
control panel on the Series II, operation of 
all these printers is basically the same. With 
the 500 Plus, you have access to two printer 
trays; with the other printers, only one tray is 
provided. 

When setting up these printers, make 
sure you select a parallel interface rather than 
a serial one; with serial transmission, 
downloading of fonts and graphics is con-
siderably slower. ' 

Besides the Bitstream-designed Dutch 
(Roman) and Swiss (Helvetica) fonts pro
vided by Ventura for the LaserJet, numerous 
other fonts are available from HP and third
party vendors (see below). 

LaserPro 
Office Automation Systems, Inc. 
8352 Clairemont Mesa Blvd. 
San Diego, CA 92111 
6191576-9500 
The controller used in this printer is quite 
similar to that used in the Kyocera. Like the 
Kyocera, the LaserPro is highly compatible 
with the LaserJet Plus. It includes a full Mb 
of RAM. The printer is especially good at 
printing bit-mapped graphics. The LaserPro 
uses the Ricoh 4080 engine. Besides Laser
Jet Plus emulation, the LaserPro emulates 
the Diablo 630, Qume Sprint IT, and NEC 
Spinwriter. 

MT-910 
Mannesman Tally 
8301 S. 180th St. 
Kent, WA 98032 
2061251-5524 or 2061251-5500 
The MT-910 uses the same Kyocera FBP-Ol 
laser printer engine as the Kyocera. It is 
capable of emulating an HP LaserJet Plus, 
and it is in this capacity that it can be used 
with Ventura. Among the LaserJet Plus com
patibles, the MT-910 excels in featuring mul
tiple paper trays, good quality graphics, and 
smooth, quiet operation. Its manual is one of 
the clearest and most complete of any laser 
printer on the market. A useful control panel 
assists in selecting printer defaults. An op
tional feature is a four-user port. The big 
drawback of the MT-910 is that it is slower 
than other LaserJet Plus compatibles. It took 
over three times as long to print a scanned 
image as a LaserJet Plus, a Kyocera F-I0I0, 
or an Oasys LaserPro. The standard memory 
configuration of the MT-910 is only 512K, 
the same as the minimum configuration of 
the LaserJet Plus or the LaserJet series II. 
However, a 2Mb expansion board is availa
ble for a very reasonable $495. When not 



being used with Ventura, the MT-910 can 
emulate the Epson FX printer, IBM Pro
Printer, Diablo 630, and Qume Sprint. 

QuadLaser 
Quadram Corp. 
One Quad Way 
Norcross, GA 30093 
404/564-5566 
Recently, the QuadLaser was upgraded so 
that it emulates all the functions of the Laser
Jet Plus. However, whereas the Plus has only 
512K of memory, the QuadLaser comes 
standard with 2 Mb, enough for storing 
plenty of fonts as well as printing large bit
mapped graphics without a hitch. The printer 
uses the Ricoh 4080 engine. Besides the 
LaserJet Plus, the QuadLaser can emulate the 
Qume Sprint 5 and the Epson FX-80. 

Other Printers 

Cordata laser printer 
Cordata 
275 E. Hillcrest Dr. 
Thousand Oaks, CA 91360 
805/495-5800 
Like the HP LaserJet and the Apple Laser
Writer, the Cordata laser printer uses the 
Canon LBP-CX engine; however, it differs 
from those printers in that its controller is lo
cated on a board installed in the computer, 
rather than in the printer. The controller 
board assembles a bit map of the entire page 
and then sends this bit map over a high
speed interface to the printer. Ventura substi-
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tutes its own raster image processor for that 
of the Cordata, writing the bit map of the 
final page directly to the Cordata's memory. 
Thus, Cordata's own fonts can not be used 
with Ventura. On the other hand, fonts in HP 
LaserJet format can be used after being con
verted with Ventura's font conversion utili
ties (see Chapter 13, "Adding Fonts). The 
maximum font size that can be printed ,with , 
Ventura on the Cordata is 30 points. When 
you use the Cordata with Ventura, you must 
place the following command in your Con
fig.sys file: 

DEVICE=LLD.SYS 
In addition, you must run the RIM.EXE 

program before running Ventura. 

JLaser Plus 
Tall Tree Systems 
1120 San Antonio Rd. 
Palo Alto, CA 94303 
415/964-1980 
Like the LaserMaster CAP Card, the JLaser 
board is installed in the computer and con
nected via a cable connected through the 
back panel of the printer. It can be used with 
printers that have the Canon LBP-CX or the 
Ricoh 4080 engine. You can continue to 
operate your printer as usual through its nor
mal cable, using your old word processing or 
other software. But if a software program is 
designed to be used with the JLaser board (as 
is Ventura), it will automatically bypass the 
old cable and instead make use of the JLaser 
board. 

The board has several advantages. One 
is that it allows much faster printing of pages 
with bit-mapped graphics. Another is that the 
memory on the board can be used for other 
purposes, for example as a RAM disk, when 
not being used for printing. Finally, the 
JLaser board can be used to support very fast 
scanning in conjunction with a Canon IX-12 
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, , scanner. The operation of the Canon IX -12 is 
so fast in conjunction with the JLaser board 
,that you can use the combination for routine 
photoc9Pying, feeding pages into the scanner 
and having copies immediately emerge from 
the printer.In,Version 1.1, Ventura's JLaser 
'driver, which was already extremely fast, has 
been speeded tip 30 percent. 

In essence, ,theJLaser board is nothing 
but 1 to 2 megabytes of blank memory. Un
'like the controllers of other laser printers, it 
lacks any microprocessor or page description 
la~guage to process high level commands. 
Instead, that work must be, done by the com
puter's own microprocessor under the direc
tion ,of .the software package, in this case 
Ventura. Unfortunately, most software pack
ages lack drivers to JLaser, but Ventura's is 
excellent. It offers extremely fast printing, 
especially of scanned images. 

The, fonts for the JLaser are also pro
vided by Ventura and are identical designs 
and selections to those provided by Ventura 
for the LaserJet Plus. Using utilities supplied 
by Ventura, you can convert any LaserJet 
font for use with the JLaser (see Chapter 13, 
"Adding Fonts"). Ventura's JLaser driver, 
however, is limited to printing fonts no larger 
than 48 points. 

KISS, Big KISS 
QMS 
P.o. Box 81250 
Mobile, AL 36689 
2051633-4300 
On their own, neither the KISS nor the Big 
KISS can be used with Ventura; however, 
there are several ways of upgrading these 
printers. The first is via a PS Jet retrofit 
($2995); the second is by adding a JLaser 
Plus or LaserMaster board (approximately 
$1000). 

TurboLaser 
A8T Research, Inc. 
2121 Alton Ave. 
Irvine, CA 92714 
7141863-1333 
This printer is one of the fastest laser printers 
for use with Ventura, especially in conjunc
tion with AST's 10 Mhz, no-wait-state Pre
mium 286 computer and its TurboScan scan
ner. The speed comes from the fact that the 
controller for the printer resides in the com
puter. The TurboLaser uses a Ricoh 4080 en
gine, the same as the Quadram QuadLaser 
and the Texas Instruments OmniLaser. For 
details on the Ricoh engine, see Chapter 5, 
"Hardware." AST's own fonts for the Tur
boLaser cannot be used with Ventura; 
however, Ventura does provide virtually 
identical Swiss (Helvetica), Dutch (Times 
Roman), and Symbol fonts. Additional fonts 
can be converted from HP LaserJet format 
using utilities supplied with Ventura, as de
scribed in Chapter 13, "Adding Fonts." 
Since the AST printer uses write-white tech
nology, the quality of fonts converted from 
LaserJet format (tuned for black-white tech
nology) is not as good as fonts tuned specifi
cally for use on write-white devices. 

The largest size type that can be printed 
with Ventura on the AST TurboLaser is 30 
points. 

Xerox 4020 Color Inkjet 
Xerox Corporation 
800 Long Ridge Rd. 
P.O. Box 1600 
Stamford, CT 06904 
Although this printer cannot rival laser print
ers in speed, its color capabilities are excel
lent. With Ventura, you can assign color at
tributes to type, frame backgrounds, ruling 
lines, and graphic fills. Imported graphics, 
such as Lotus charts, are also automatically 



assigned colors. With the 4020, both text and 
pictures print at in 240 by 120 dots per inch, 
and eight colors are available. Swiss (Helvet
ica) and Dutch (TImes Roman) are available 
in sizes from 8 to 36 points; there is no Sym
bol font. 

Xerox 4045 Laser CP 
Xerox Corporation 
800 Long Ridge Rd. 
P.O. Box 1600 
Stamford, CT 06904 
This is a 10-ppm printer with 300-dpi output. 
It also includes an optional copier. It is rated 
for print volumes of 2,000 to 10,000 pages 
per month, significantly greater than the 
3,000 page per month duty cycle listed for 
printers that use the Canon LBP-CX engine. 
Basic memory is 128K, but can be expanded 
to 512K to allow more typefaces per page 
and larger graphics. Ventura provides two 
drivers for the 4045, one for 300-dpi 
graphics and the other for 150-dpi graphics. 
The latter can be used to print a page that 
exceeds the memory of the 4045 if printed at 
300 dpi. The 4045 cannot print white text on 
a black background. It is compatible with the 
Diablo 630 and the Xerox 2700 II laser 
printer. Fonts can be converted from LaserJet 
format using Ventura's font conversion utili
ties; however, since the 4045 uses write
white technology rather than the write-black 
technology used by the LaserJet, converted 
fonts may suffer in quality. Look for fonts 
specifically tuned for use with a write-white 
device. 
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XT/CP CAPCard, XT/RP CAPCard" " 
LaserMaster Corp. 
7156 Shady Oak Rd. 
Eden Prairie, MN 55344 
612/944-6069 
LaserMaster originally made a name for it-" " 
self providing fast output for AutoCAD 
users, and now provides an extremely fast 
driver for Ventura. Like the JLaser board, the 
CAP Card is a"laser·printer controller that is 
installed as a board in the computer and con
nected to any laser printer that uses the 
Ricoh 4080 or 4081 engine or the Canon 
LBP-CX engine. The speed of the product is 
largely due to fast font downloading and bit
mapped graphics transfer. After you install 
the card, you can still use your retrofitted 
printer as before; however, the controller is 
also capable of emulating an HP LaserJet 
Plus. LaserMaster also sells a version of the 
Bitstream font compiler (see Font Generators 
below). 

Monitors 

Amdek 1280 Graphics Subsystem 
AmdekCorp. 
2201 Lively Blvd. 
Elk Grove Village, IL 60007 
312/364-1180 
This monitor is identical to the WY-700. 
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. Cono Vision 2800 
Conographic Corporation 
17841 Fitch 
Irvine, CA 92714 
7141474~1188 
The board for' the Conovision 2800 is 
theoretically. capable of driving a display of 
up to 2880 by 1024 pixels. Currently, it is 
used with the Moniterm monitor, the same 
14- by 11-inch monitor used by the Viking I 
and the LaserView (see Chapter 5, "Hard
ware," for more on the Moniterm monitor). 
In conjunction with that· monitor, the full 
theoretical resolution of the Conovision is 
not yet available; the maximum available 
now is 1,440 by 720 pixels. The 2800 can 
display Hercules graphics and can function 
as a plain character display, although re
viewers have complained that the emulation 
software for using it in Hercules or MDA 
mode is still somewhat problematic, and 
CGA emulation is not available. Some re
viewers have criticized the image quality of 
the Conovision 2800 as "jittery" and some
what prone to flicker. 

Desktop 1280 
Verticom, Inc. 
545 Weddell Dr. 
Sunnyvale, CA 94089-2114 
4081747-1222 
The Desktop 1280 uses the Intel 82786 
graphics coprocessor, which offers extremely 
fast Bit Blit operations (cutting and pasting 
of arbitrary regions from one part of the 
screen to another). 

GeniusVHR 
Micro Display Systems Inc. 
1310 Vermillion Street 
P.O. Box 455 
Hastings, MN 55033 
6121437-2233 
The most notable feature of the Genius is 
that it is taller than it is wide, with a screen 
size of 8 by 10.5 inches. Resolution is 736 
by 1008 pixels (100 pixels per inch). Pixels 
are square, which makes the aspect ratio of 
the image the same as that of the printed 
page. 
Like the WY-700, the Genius has been on 
the market long enough to have built up a 
solid base of drivers for a variety of software 
programs. Compatible programs include Mi
crosoft Windows, Microsoft Word, GEM, 
and 1-2-3. In Ventura's Normal view, the 
Genius displays about half of a page hori
zontally and two thirds vertically. When used 
with a word processing program with the ap
propriate driver, the monitor can display 66 
lines by 80 columns. With applications that 
do not have drivers, it uses the top half of the 
screen to display monochrome text and the 
bottom half to display CGA graphics. No 
Hercules or EGA emulation is provided. 

This monitor was selected as the 
favorite display in an informal survey con
ducted by by Desktop Publishing newsletter. 
It was also chosen by PC Magazine in its 
"Best of 1985" awards. 

Users of the Genius are unanimously 
pleased by the crisp, flicker-free quality of 
its non-interlaced display. The only problem 
is at the edges of the screen, where some dis
tortion occurs. Although the documentation 
is reportedly poor, the monitor.is easy to in
stall. One drawback is that the the cables are 
so short that you have to put the monitor on 
top of your computer. 

Some compatibility problems have been 
noted with the Genius for 8088 computers 



with memory above 640K. Also, the. Genius, 
which occupies two slots, is reported to draw 
a good deal of power and consequently to 
run quite hot. 

Laser View Display System 
Sigma Designs 
46901 Landing Parkway 
Fremont, CA 94538 
4151770-0100 
To use the LaserView you must also have 
another monitor installed simultaneously 
with your system. In addition to Ventura, 
drivers are available for Windows, GEM, 
AutoCAD, 1-2-3, Symphony, Dr. Halo, and 
PC Paintbrush Plus. When using the La
serView with other software, you must use 
your regular monitor. 

The LaserView adapter can be used 
with several different monitors, including 
Sigma Design's own IS-inch (diagonal) 
monitor, the 19-inch (diagonal) Moniterm 
monitor used by the Viking I and the Cono
Vision 2800, and Princeton Graphics' moni
tors. At $2395, the LaserView ranks with the 
Viking I as one of the most expensive dis
play systems. With Ventura, the adapter pro
vides 1664 pixels horizontally by 1200 pix
els vertically, or 110 square pixels per inch. 
It has about twice as many dots on the screen 
as the Genius and the Wyse, but the density 
of dots is about 50 percent greater because 
the size of the screen is larger. 

Magna-4 
DBM,lnc. 
634 Georgia Avenue 
Palo Alto, CA 94306 
4151494-2094 
This monitor is 14 by 11 inches in size and 
can display 1280 pixels horizontally by 980 
vertically. It provides emulation of the CGA 
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andMDA. 

Viking I 
Moniterm Corporation 
5740 Green Circle Drive 
Minnetonka, MN 55343-9990 
6121935-4151 
To run the Viking I, you must have a Her- . 
cules or EGA graphics board installed in . 
your computer in addition to the Viking I 
board. You' can have either the Viking· I 
monitor installed alone and use it both for .' 
Ventura and for other applications, or you 
can have two monitors installed, using the 
VIking I for Ventura and the plain monitor 
for regular applications. A drawback of the 
Viking I setup is that you must always turn 
the monitor on before turning the computer 
on, or tum the two on simultaneously. The 
reason is that the VIking I board draws its 
power from the monitor (since its power re
quirements are too large to be handled by the 
computer). 

Aside from its bizarre (and risky) power 
supply setup, the Viking I is an excellent 
monitor both for Ventura and for regular 
word processing. With Ventura you can see a 
whole page in Nonnal view except for a thin 
strip along the bottom of the page. Thus, you 
rarely have to use the scroll bars. With regu
lar applications, you get a crisp emulation of 
a nonnal monochrome display or of EGA or 
Hercules graphics. When emulating other 
monitors, the Viking I only uses the central 
portion of the screen, however, the size of 
characters is quite legible and the overall re
sult is a much more readable display than 
that of text on an EGA or Hercules monitor. 
With Ventura, type can be read in Nonnal 
view at any size, and you rarely need any 
other view. 

Although some reviewers have com
plained about the Viking I's image quality, 
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difficulty of installation, and software com
patibility, those problems all seem to have 
been taken care of in the latest revisions of 
the drivers. 

,At $2395 and with a 14- by ll-inch 
monitor, the Viking I belongs-along with 

,the LaserView and,the Conovision 2800-to 
the higher tier of large'screen displays. Reso
lution is 1280 by 960 pixels. The Moniterm 
monitor used by all these systems is dis
cussed in Chapter 5, "Hardware." In addition 
to drivers for Ventura, the VIking I includes 
drivers for AutoCAD and Microsoft Win
dows. The refresh rate of the monitor is 66 
Hz, which is is lower than the refresh rate of 
the IBM Monochrome monitor (50 Hz) and 
the IBM Color Graphics Adapter (60 Hz); 
however, the image qUality of the VIking I is 
excellent and there is no flicker. 

Wyse WY-700 (same as Amdek 
1280) 
l-VYse Technology 
3571 N. First St. 
San Jose, CA 95134 
800/GET WYSE 
The WY-700 which is identical to the Amdek 
1280, is extremely popular due to its afforda
bility (list price $999) and its extensive soft
ware support, due to the fact that the monitor 
has been on the market longer than most 
other large-screen displays. It sports drivers 
for PC Paintbrush, 1-2-3, Symphony, Win
dows, GEM, and AutoCAD, among others. 

The WY-700 is slightly larger than a 
standard display: 10 inches wide by 7.5 in
ches tall. Maximum resolution is 1280 by 
800, which means that the density of pixels 
is more than four and a half times that of the 
EGA. The aspect ratio of pixels is 1.2, which 
means that they are slightly taller than they 
are wide. Hence the proportions of a docu
ment on the screen will be different than on 

the printed page. 
The image quality of the WY-700 is 

sharp and flicker-free: you can read 8-point 
type even in Ventura's double-page mode. In 
Ventura's Normal view you can see about 60 
percent of the length of the page and 95 per
cent of its width. The monitor cannot be used 
with systems that have EGAs installed and it 
requires a full-length XT-height slot. Installa
tion is simple: you merely copy a set of utili
ties onto your hard disk. 

Xerox 6068 Full Page Display 
Xerox Corp. 
Xerox Square 
Rochester, NY 14644 
716/423-5078 
Like the Genius, the Xerox display is taller 
than it is wide: 8.5 by 10.5 inches. The reso
lution is 720 pixels horizontally by 992 verti
cally (90 by 100 pixels per inch). Its image 
quality is crisp and flicker-free, the price is 
low, and the documentation is excellent. The 
drawback of the Xerox display, beside the 
fact that the pixels are not quite square, is 
that few drivers are available for programs 
other than Ventura and Xerox Writer. You 
can run normal text-based DOS applications 
with the display, but they are shown in very 
small letters in the top half of the screen. 
Running Ventura, the Xerox display cuts off 
a small portion of the right side of the page. 



Scanners 

Abaton Scan 300 
Abaton Technology 
7901 Stoneridge Dr. #500 
Pleasanton, CA 94566 
415/463-8822 
This scanner is the same as the MicroTek. 

Canon IX-12 
Canon USA 
Lake Success, NY 11042 
516/488-6700 
At a list price of $895, the Canon IX-12 
sheet-fed scanner is about $1000 less expen
sive than others on the market. It has the 
same Canon engine used by much more ex
pensive scanners such as the Hewlett-Pack
ard JetScan and the Princeton Graphics LS-
300. To drive the scanner you need PC Paint
brush Plus or Publisher's Paintbrush. The 
IX-12 really shines in conjunction with the 
JLaser Plus board. Using utilities provided 
by Tall Tree Systems, you can use the scan
ner and the JLaser as a pseudo-photocopying 
machine, getting a laser printed copy of your 
document in about 30 seconds. 

Datacopy Model 730 
Datacopy Corp. 
1215 Terra Bella Ave. 
Mountain View, CA 94043 
415/965-7900 
Datacopy is one of the most experienced 
companies in the scanner market. The com
pany makes its own scanner engines, 
whereas most scanner manufacturers use an 
engine from another supplier, such as the 
Canon scanner engine. The flatbed feed 
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mechanism used by the Model 730 is supe
rior to the roller-feed mechanism of tlleJet 
Reader, since it can handle pictures in books 
or mounted on thick backing, and it also has 
fewer alignment problems. . . . 

Although Datacopy sells a package 
called WIPS (Word Image Processing Soft
ware) for driving the scanner (which is being 
modified to produce the PCX format needed 
for import into Ventura), you can also drive it 
using PC Paintbrush Plus or Publisher's 
Paintbrush. Another software package that 
drives this scanner is PC Image, which runs 
under Windows and produces Datacopy for
mat, TIFF format, and PCX format. 

As extras, Datacopy scanners can be 
outfitted with a Fax board and optical 
character recognition software is available. 
The OCR Plus software can actually learn to 
read a new typeface-the first time it en
counters a new character it displays the 
character on the screen for your confirma
tion. 

Dest PC Scan Plus 
Dest Corporation 
1202 Cadillac Court 
Milpitas, CA 95035 
408/946-7100 
A sheet-fed scanner, the Dest forces sheets 
through a sharp U-turn, which may limit 
your ability to scan certain material, although 
photographs do feed through satisfactorily. 
Installation of the Dest is somewhat more 
complex than other scanners, requiring ad
justment of DIP switches on the scanner and 
your computer's Config.sys file. 

Included with the scanner is Publish Pac 
and PC Paintbrush Plus software. The Pub
lish Pac software allows you to scan images 
and save them in PCX format. Unlike soft
ware for other scanners, the Publish Pac soft
ware provides only a single half toning pat-
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tern. You can then edit the PCX images pro
duced by Publish Pac using PC Paintbrush or 
else load the PCX files directly into Ventura. 
Also included with Publish Pac is OCR soft
ware for automatically converting text on 
paper and into ASCII fues. 

MicroTek scanners 
MicroTek Lab, Inc. 
16901 South Western Ave. 
Gardena, CA 90247 
213/321-2121 
The MicroTek scanners include their own 
software, which can save files in either GEM 
or PC Paintbrush (PCX) format. You can 
then import these files into Ventura. 

ScanJet 
Hewlett-Packard 
1820 Embarcadero Rd. 
Palo Alto, CA 94303 
800/3674772 
The ScanJet uses the same sheet-fed Canon 
engine as the Canon IX-12 (which happens 
to be a good deal less expensive). The differ
ence between the two is HP's Scanning Gal
lery software. It saves images in TIFF 
(tagged image file format), but lets you con
vert images from that format into PC Paint
brush PCX files or GEM Paint IMG files. 
Files in either PCX or IMG form can in tum 
be imported into Ventura. 

ThrboScan 
AST Research, Inc. 
2121 Alton Ave. 
Irvine, CA 92714 
714/863-1333 
This is the same as the Microtek scanner. 

Non-PostScript 
Fonts 

ConoFonts 
Conographic Corporation 
17841 Fitch 
Irvine, CA 92714 
714/474-1188 
ConoGraphic's ConoFonts for the HP Laser
Jet include CG Times, Triumvirate, ITC Sou
venir, Triumvirate Condensed, Old English, 
Raphael, Uncial, Commercial Script, CG 
Palacio, Trade Bold Ultracondensed, Trium
virate Ultracompressed, ITC Zapf Chancery, 
ITC LSC Manhattan, ITC \ Benguiat Bold, 
Uncle Sam Open, Dom Casual, American 
Classic Bold, Globe Gothic Outline, Borders, 
and General Symbols. 

FontCenter fonts 
lim Boemler 
509 Marin St. #121 
Thousand Oaks, CA 91360 
805/373-1919 
These fonts are designed for printer and 
screen use with the LaserJet printer. Also 
available from FontCenter is the Poems Font 
Editor. 

Font Factory fonts 
P.O. Box 5429 
Kingwood, TX 
713/622-1930 
The company markets 300 fonts, which have 
been fine tuned for use with write-white or 
write-black laser printers. It also provides 
screen fonts for use with Ventura. 



Hewlett-Packard Soft Fonts 
Hewlett Packard 
P.O. Box 3640 
Sunnyvale, CA 94088-3640 
8001538-8787 
HP's high-quality fonts were developed by 
Bitstream. Some of the newer soft font disks 
include ITC Garamond, Century School
book, Zapf Humanist 601 (all in 6, 7, 8, 9, 
10, 11, 12, 14, 18,24, and 30 point Medium, 
Bold, and Italic using the USASCn symbol 
set); Broadway, University Roman, Coronet 
Bold, Cooper Black, and Bodoni Black (14, 
18, 24, and 30 point Bold using the USAS
crr symbol set); TmsRmn and Helv (6, 7, 8, 
9, 10, 12, 14, 18, 24, and 30 point Medium, 
Bold, and Italic using either the USASCn or 
Roman8 symbol sets). Note that the USAS
crr symbol set only includes keyboard 
characters; the Roman-8 symbol is somewhat 
different than the International symbol set 
used by Ventura, lacking certain typographic 
symbols (see Chapter 13, "Adding Fonts"). 

LaserFonts 
So/tCre:z/t 
222 State St. #400 
Madison,.Wl53703 
8001351-0500, 6081257-3300 
SoftCraft has a large library of fonts in 
LaserJet format. Typefaces include Roman, 
Fixed Width, Classic, Sans Serif, Tall, Olde 
English, Formal, Script, Calligrapher, Twist, 
~hadow, Computer, Math Symbols, Copy
nght and Symbols, Chess, Accents and Liga
tures, Cyrillic, French Roman, Spanish 
Roman, International Phonetic, German, 
Indic, Proto-IndoEuropean, Greek, Sans 
Serif Greek, Hebrew, Nouveau, Modem, 
LCD, Roman Shadow, Outline, Bard 
Cod.e/OC~, Vertical Borders, Elegant Script, 
OrbIt, OptIcal, Hershey Oriental, and Music. 
In the less common typefaces, point sizes are 

quite limited. 

LJ Fonts 
Weaver Graphics 
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Fox Pavillion Box 1132 
Jenkintown, PA 19046 
2151884-9286 
Weaver's fonts in LaserJet downl~adable fori. 
mat include sizes from 6 to 30 points. 

MagicFont collection 
CES 
509 Cathedral Parkway#10-A 
NewYork,NY 10025 
8001251-2223,2121222-8148 
The MagicFont collection of LaserJet fonts 
includes business logos, math symbols, 
border lines, decorative symbols, and jumbo 
fonts larger than 30 points. 

PrintR Fonts 
R.M.C. 
12046 Willowood Dr. 
Woodbridge, VA 22192 
7031494-2633 
These are fonts in HP LaserJet format. They 
include character sets for French, German, 
and Spanish. Among the typefaces is an out
line rendition of Helvetica. 

Vinh fonts 
Vinh Company 
5 South 2nd St. 
Alhambra, CA 91801 
8181576-0488 
These are LaserJet fonts that include faces 
similar to Times and Helvetica in 6 7 8 9 
10, 11, 12, 14, 18, and 24 points. The' c~m~ 
pany also creates custom fonts, logos~ and 
signatures. 
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VS Library of Fonts 
VS Software ' 
P.O. Box 6158 

, Little Rock, AR 72216 
5011376-2083 
VSmarkets an extensive library of fonts in 
LaserJ et downloadable format. These include 
VS Fonts, VS International Font Collection, 
Compugraphic Font Library, and ITC Font 
Library. VS also markets the Fontgen 4 font 
editor. Its VS Laser Word Processor Toolkit 
allows drivers to be generated for popular 
word processors. 

. PostScript Fonts 

Adobe Type Library 
Adobe Systems, Inc. 
1870 Embarcadero Rd. 
Palo Alto, CA 94303 
4151852-0271 
The Adobe Type Library is growing rapidly 
and is being converted to PC disks. Fonts are 
licensed from the Allied and ITC collections 
and include ITC American Typewriter, ITC 
Avant Garde, ITC Benguiat, ITC Bookman, 
Courier, ITC Fritz Quadrata, ITC Galliard, 
ITC Garamond, Glypha, Goudy Old Style, 
Helvetica, Helvetica Black, Helvetica Con
densed, Helvetica Light, Helvetica Narrow, 
ITC Korinna, ITC Lubalin Graph, ITC Ma
chine, Melior, ITC New Baskerville, New 
Century Schoolbook, Optima, Palatino, 
Sonata, ITC Souvenir, Symbol, Times, 
Trump Medieval, ITC Zapf Chancery, and 
ITC Dingbats. A complete catalog is availa
ble from Adobe for $15. 

Allotype Typographies fonts 
1600 Packard Rd. #5 
Ann Arbor, MI 48104 
3131663-1989 
These are specialized PostScript fonts on 
Macintosh disks. Typefaces include classical 
Greek, chemical structures, Polish, and mod
ern Greek. 

Altsys font library 
Altsys Corp. 
720 Ave. F #108 
Plano, TX 75074 
2141424-4888 
Altsys, developers of the Fontographer font 
editing software for the Macintosh and 
authors of Encapsulated PostScript format, 
have a library of fonts on Macintosh disks . 

Faney Fonts 
Genny Software Research and Development 
P.O. Box 5909 
Beaumont, TX 77706 
4091860-5817 
Genny's Fancy Fonts are PostScript fonts on 
Macintosh disks. They include keyboard and 
international symbols. 

Fluent Fonts 
Casady Company 
P.O. Box 223779 
Carmel, CA 93922 
8001331-4321,8001851-1986 
Casady's Fluent Fonts are PostScript fonts 
on Macintosh disks. They include Cyrillic, 
Hebrew, Polish, Greek, circuit design, math
ematical, and architectural symbols. Type
faces include Bodoni, Sans Serif Book, 
Right Bank, Ritz, Monterey, Regency Script, 
Calligraphy, Prelude Script, Coventry Script, 
Zephyr Script, Dorovar, Gregorian, Bodoni 



Ultra, Sans Serif Bold, Sans Serif Extra 
Bold, Gatsby Light, Micro, and Micro Ex
tended. 

Foreign Language Fonts 
Linguists' Software 
106R Highland St. 
South Hamilton, MA 01982 
617/468-3037 
These are PostScript fonts on Macintosh 
disks. Included are Arabic, Hebrew, Greek, 
Hindi/Sanskrit, and Egyptian hieroglyphics. 

GreekKeys 
SMK 
5760 Blackstone Ave. 
Chicago, IL 60637 
312/947-9157 
These are PostScript fonts on Macintosh 
disks for the Greek language. 

Hot Type 
Image Club Graphics Inc. 
#206 - 2915 -19th St. NE 
Calgary, Alberta 
Canada T2E 7A2 
800/661-9410, 403/250-1969 
Image Club sells four sets of PostScript fonts 
on Macintosh disks. Most are highly unusual 
typefaces such as Brass, Surfstyle, Com
pacto, Scoreboard, Rubber Stamp, and Sofa. 

LaserFonts 
Century Software, Inc. 
2483 Hearst Ave. #175 
Berkeley, CA 94709 
415/549-1901 
Century's fonts are for PostScript printers, 
which means that they can be printed at any 
size up to 255 points. At the time this was 
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written they were available on Macintosh 
disks only, but could be transferred into PC 
disk format and then downloaded into a 
PostScript printer from a PC. Over 125 type
faces are available from Century including 
five symbol fonts, Willamette, Thames, 
Congo, Hudson, Seine, Columbia, Colorado, 
Trent, Saratoga, Manistee, Styx, Spokane, 
Devoll, Cumberland, Rhine, Yukon, Po
tomac, and Neosho. Some of the faces were 
licensed from lTC, others were original de
signs by Century. In addition to new type
faces, LaserFonts also includes expanded, 
condensed, extra-small, and shadow versions 
of Times and Helvetica. 

MacBeLingual 
Ecological Linguistics 
P.O. Box 15156 
Washington, DC 20003 
202/546-5862 
202/546-5862 
These are PostScript fonts on Macintosh 
disks. Included are Armenian, Bengali, Cam
bodian, Georgian, Greek, Gujarati, Gur~ 

mukhi, Hindi/Sanskrit, Annada, Laotian, Cy
rillic, sign language, Slavic Latin, Tamil, 
Teluga, and Thai. 

Neoscribe fonts 
Neoscribe International 
P.O. Box 633-MD 
East Haven, CT 06512 
203/467-9880 
These are PostScript fonts on Macintosh 
disks. Typefaces include MacSlab (a square 
serif face), MacSans (sans serif), LaserHe
brew, Devangari, Bembo, and OCR-A. The 
company also creates custom characters and 
fonts. 



264 VENTURA TIPS AND TRICKS 

Organic Fonts 
· Modern Graphics 

P.O. Box 21366 
. Indianapolis, IN 46221-0366 
· 31712534316 
· These are PostScript fonts on Macintosh 
d~sks. They include characters for chemical 
, structures. 

· SciFonts and ElectroFont 
Paragon Courseware 
4954 Sun Valley Rd. 
DelMar, CA 92014 

· 6191481-1477 
These are two collections of math and scien
tific fonts on Macintosh disks for PostScript 
printers. 

Software Complement fonts 
Software Complement 
P.O. Box 1123 
Milford, PA 18337 
7171686-5592 
These are PostScript fonts on Macintosh 
disks. A variety of decorative border type
faces are available. 

UItraFonts 
Century Software 
2483 Hearst Ave. #175 
Berkeley, CA 94709 
4151549-1901 
These are PostScript fonts on Macintosh 
disks. Typefaces include Greek, math and 
engineering, chess, astrology, Shadow Ef
fects, Willamette, Thames, Congo, Hudson, 
Seine, Columbia, Colorado, Trent, Saratoga, 
Manistee, Styx, Spokane, Devoll, Cumber
land, Rhine, Yukon, Potomac, Neosho, Fat
Times, ThinTimes, FatCourier, FatHelvetica, 
ThinCourier, and ThinHelvetica. 

Font 
Generators and 
Editors 

Bitstream Fontware Installation Kit 
Fontware 
Bitstream 
215 First St. 
Cambridge, MA 02142 
6171497-6222 
Fontware is a program that makes bit-map 
fonts on the IBM PC or compatibles in vir
tually any size and for most popular printers 
and monitors. The program creates fonts that 
are optimized for professional quality at all 
sizes and resolutions, so that what is seen on 
the screen matches printed output. Once 
created, the fonts are stored on hard disk and 
are accessible from the Xerox Ventura Pub
lisher screen menu. 

Initially, the Fontware Library will fea
ture 80 professional quality typefaces in a 
variety of weights and styles. Each Fontware 
typeface package will contain four individual 
typefaces: some have four weights of one 
typeface family (roman, italic, bold, and bold 
italic), others have a combination of two or 
more faces in one or more weights. Each 
typeface package will retail for $200. Even
tually, most of the extensive Bitstream Li
brary of typefaces will be available in Fon
twareform. 



LaserMaster Font 
Compiler/Ventura Outline Font Kit 
LaserMaster Corp. 
7156 Shady Oak Rd. 
Eden Prairie, MN 55344 
612/944-6069 
The LaserMaster Font Compiler uses Bit
stream's patented technology for converting 
outlines into bit-mapped fonts for use by the 
LaserJet and other laser printers that use bit
mapped fonts. There are two versions of the 
compiler for use with Ventura. Ventura Out
line Font Kit #1, priced at $495, includes the 
font compiler and four typefaces (Century 
Schoolbook roman, italic, bold, and bold
italic). Ventura Outline Font Kit #2, priced at 
$795, also includes Swiss and Dutch in 
roman, italic, bold, bold-italic; Swiss Con
densed in roman, italic, and bold; Swiss 
Light; Swiss Black; and Swiss Black Con
densed. 

Bitstream's font technology produces 
better results than less expensive font com
pilers (such as Glyphix) by using sophisti
cated algorithms to smooth out the jaggies 
and even up the stroke weights of type at any 
size. The result is excellent type even at the 
difficult text sizes. With the Swiss typeface, 
even 4-point type is crisp and legible. 

Fontgen IV 
VS Software 
P.O. Box 6158 
Little Rock, AR 72216 
501/376-2083 
This is a font editing program that can be 
used to create fonts in LaserJet format. It 
provides a window in which you work with 
one character at a time, using various editing 
tools to generate and manipulate character bit 
maps--down to the level of a single pixel. 

PRODUCT NOTES 265 

SoftCraft Font Editor 
SoftCraft 
16 N. Carroll St. 500 
Madison, WI 53703 
609/257-3300 
This program can be used to edit any fonts in 
HP LaserJet format. It provides two win
dows, one showing the font at actual size and 
the other zoomed in for editing individual 
pixels. The program can draw lines, curves, 
circles, and rectangles, and can also. auto
matically slant a character," enlarge or reduce 
it, rotate it, and make it bold. 

Glyphix 
SWFTE International 
P.O. Box 219 
Rockland, DE 19732 
800/237-9383,302/658-1123 
Like the more sophisticated Fontware pro
gram from Bitstream, Glyphix is a program 
that generates LaserJet fonts from outlines. 
You create, test, and save fonts using a 
simple one-screen menu. On the right side of 
the menu you designate the parameters for 
the font you desire: typeface (Helvetica 
comes with the package; Times Roman, 
Schoolbook, and Optima are an additional 
$25 each), point size (up to 60 points), orien
tation, fill pattern (vertical, horizontal, or di
agonal stripes; five shades of gray, cross 
hatching), obliquing slant, amount of hori
zontal compression or expansion, and 
weight. Once you have picked your parame
ters, you can select Test Print to get an in
stant type sample. Alternatively, you can 
name the font and store it on your hard disk. 

The quality of the fonts is not good 
enough for text fonts (smaller than 18 
points). But for display faces, especially 30 
to 60 point type, the results are only slightly 
less smooth than PostScript fonts of com
parable size. Since fonts larger than 30 points 
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: in LaserJet ,fonnat are quite scarce, Glyphix 
fills·a big hole quite inexpensively. 

':'Helvetica is fine (the lack of serifs 
makes it easier for Glyphix to handle). Times 
Roman and Schoolbook are also acceptable. 
Avoid "Optimis," the name used by Glyphix 
for Optima. 

Typesetting 
Services 

Alphagraphics 
845 E. Broadway 
Tucson, AZ 85719 
60218224100 
This company operates a Linotronic L100 
and accepts Ventura files by modem or disk. 
Prices: $7.50 to $10 per page. 

Ampersand Typographers 
176 Wicksteed Ave. 
Toronto, Ontario M4G 2B6 
4161422-1444 
This company operates a Linotronic 300 and 
charges $10 to $30 (Canadian) per page, de
pending on the resolution. 

Da Vinci Business Services 
6175 N.W. 57th St. #213 
Fort Lauderdale, FL 33319 
3051721-0216 
This company can convert files from Macin
tosh to PC disks. Useful for getting clip art 
and PostScript fonts onto PC disks. 

Laser Printing Services 
26058 W.12-Mile Rd. 
Southfield, MI48034 
3131356-1004 (M!), 8001722-3475 
This company operates a Linotype 100 and 
accepts Ventura files by modem or on disk. 
Since they're also Ventura dealers, they may 
be in a better position to solve Ventura
specific technical problems than shops that 
specialize in Macintosh software. Prices: 
$3.50 to $5 per page. 

MacTypeNet 
P.O. Box 52188 
Livonia, MI48152-0188 
3131477-2733 
This typesetting service can receive files 
either on disks or via modem. Output options 
include laser printer and Linotronic 300. 
Prices: $6 to $10 per page. 

Rapid Transmit 
8007 Douglas Ave. 
Racine, WI 53402 
This company operates a Linotronic 300 and 
accepts Ventura files by modem or disk. 

TypeIine 
170 State Street 
Teaneck, NJ 07666 
201/837-9839 
This company operates several Linotronics 
and accepts Ventura files by modem or disk. 
Prices: $6 to $8 per page. 



M.iscellaneous 

Inside Xerox Ventura Publisher 
Micro Publishing and New Riders 
Publishing 
21150 Hawthorne Blvd. #104 
Torrance, CA 90503 
James Cavuoto and Jesse Berst, the authors 
of this book, are the editors of microPublish
ing Report, a newsletter reporting on the 
desktop publishing market. The two worked 
with Xerox during the development of Ven
tura Publisher and are responsible for some 
of the style sheets provided with the pro
gram. The book includes a thorough explica
tion of the options in Ventura's dialog boxes 
and is particularly helpful on the subject of 
pre tagging text flies. 

Personal Publishing 
P.O. Box 390 
Itasca, IL 60143 
312/250-8900 
Published monthly, this is the oldest desktop 
publishing magazine, with consistently top
notch editorial content that covers both Mac
intosh and PC hardware and software. The 
magazine also runs the "Personal Publishing 
Bookshelf," a mail order service for hard-to
find books on desktop publishing and 
graphic arts. Magazine sUbscriptions: 
$30/year. 

Publish! 
501 Second St. #600 
San Francisco, CA 94107 
415/546-7722 
Owned by PC World Communications, this 
magazine is a design and graphics showcase, 
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with somewhat more emphasis on the Mac-. 
intosh than on the PC. Not to be missed is 
Charles Bigelow's monthly column . on, type
faces. Subscriptions: $39.90/year. 

Ventura Publisher for the IBM PC 
John Wiley & Sons 
605 Third Ave. 
New York, NY 10158 
212/850-6000 
This book was not yet. available at the time 
this was written. Author Richard Jantz has 
written numerous articles on desktop pub
lishi~g and business graphics for PC World, 
PublIsh! and other magazines. 

Ventura Publishes 
Ventura Publisher Users Group (VPUG) 
675 Jarvis Dr. 
Morgan Hill, CA 95037 
408/778-1125 
This is the newsletter of VPUG. Each issue 
is devoted to a special topic, such as fonts, 
databases, and newsletters. Regular features 
include Workshop, New Products, Q&A, and 
News. According to a rumor (published in 
the very same newsletter), some ·of the un
signed articles are penned by the reclusive 
Ventura Software programmers under pseu
donyms like "Link." 
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Charl of Operations 

General 

CLEAR A MENU THAT HAS 
DROPPED DOWN 

CREATE A NEW FRAME 

ADD A NEW TAG 

CHANGE MEASUREMENT 

UNITS 

JUMP TO THE FIRST PAGE OF 

A CHAPTER 

JUMP TO THE LAST PAGE OF 
A CHAPTER 

JUMP TO THE NEXT PAGE 

Drag the cursor outside the menu and click the left button. 

Activate Frame mode by pressing Ctrl-U or by clicking on the 
Frame icon, then select Add New Frame. Move to the upper left 
corner of the area you wish to enclose within the frame, hold 
down the mouse button, and pull the cursor to the lower right 
corner, then release the button. 

Activate Tagging mode by Pressing Ctrl-I or selecting the Tagging 
Icon, then click on Add New Tag. 

Point at the unit of measurement and click with the mouse. 

Press Home. 

Press End. 

PressPgDn. 
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JUMP TO THE PREVIOUS 
··P~GE, 

CREATE A NEW PAGE 

MOVE IMAGES WITHIN A 
FRAME 

SELECT MULTIPLE PARA

GRAPH~FRAME~OR 

GRAPHICS 

DRAW MULTIPLE LINES, 
BOXES, OR FRAMES 

USING THE CURSOR KEYS IN
STEAD OF THE MOUSE 

SELECT FRAMES THAT ARE 
HIDDEN 

COPY A FRAME TO THE CLIP
BOARD 

PASTE A FRAME FROM THE 
CLIPBOARD ONTO A NEW 
PAGE 

COPY A FRAME OR A 
GRAPHIC 

SAVE THE CHAPTER 

ACTIVATE THE SELECTION 
BUTTON 

Press PgUp. 

From the Page menu select Insert/Remove Page. 

Hold down the Alt key while moving the mouse. 

Hold down the Shift key while selecting them with the mouse. 

Hold down the Shift key while using the graphic tool or the Add 
New Frames option. 

Hold down the right Shift key and the Ctrl key simultaneously. 
You'll hear a beep. Now you can use the cursor keys instead of 
the mouse. Pressing Home substitutes for clicking with the 
mouse. Pressing the End key is like holding down the button on 
the mouse. To release the button press Home. 

Select Frame Mode, then hold down the Ctrl key while selecting 
the frame. 

Select the frame or graphic and press Del. 

Press Ins. The frame or graphic will reappear in exactly the 
same position on the page. This command cannot be used to 
paste a graphic to a new position on the same page. 

Select the frame or graphic. Press Shift-Del (use the Del key that 
is on the numeric keypad and make sure that Numlock is turned 
Off). Then drag the frame or graphic to a new location. When you 
press Ins it will reappear in the old location. 

Press Ctrl-S. 

Press Ctrl-2. 



CHANGE MODES 

CHANGE VIEWS 

SEE (OR EDIT) THE LIST OF 

FUNCTION KEY TAG ASSIGN· 
MENTS 

HIDE/SHOW THE SIDE BAR 
(TO SEE MORE OF THE PAGE) 

GO TO A NEW PAGE 

PLACE A FILE LISTED IN THE 
ASSIGNMENT LIST INTO A 
FRAME 

PLACE TWO FILES IN A 
FRAME 

STRETCH A FRAME 

MOVE A FRAME ON THE 

SAME PAGE 

MOVE A FRAME TO A DIFFER· 
ENTPAGE 
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Press Ctrl-U for Frame mode, Ctrl-I for Tagging mode, Ctrl~O for 
Text mode, and Ctrl-P for Graphics mode. (These key combina- . 
tions can be remembered because they're adjacent to each other 
in the same relative positions as the frame icons.) 

Press Ctrl-R for Reduced view, Ctrl-N for Normal view,. Ctrl-E for 
Enlarged view (remember as R for Reduced, N for Normal, and E 
for Enlarged). 

Press Ctrl-K (remember as K for Key). 

Press Ctrl-W (remember as W for Wide view). 

Press Ctrl-G. 

Select Frame mode. Select the frame you want to place the file 
into. Select the name of the file from the assignment list. 

You cannot place two files in a single frame. When you select the 
a new file from the assignment list, it replaces the old one. 

Place the cursor on the edge or on a corner (corners are more re
liable). Hold down the mouse button (the cursor should change to 
a pointing finger). While holding down the mouse button, drag the 
edge of the frame to its new location. Alternatively, select the 
Sizing and Scaling option of the Frame menu and type new 
measurements for Upper Left X, Upper Left Y, Frame Width, and 
Frame Height. 

Place the cursor anywhere in the frame and hold down the 
mouse key. The cursor should take the shape of a cross. Pull the 
frame to its new location. Alternatively, select the Sizing and Scal
ing option of the Frame menu and type new measurements for 
Upper Left X and Upper Left Y. 

Select the frame, press Del to copy it to the clipboard, move to 
the new page, and press Ins to copy it from the clipboard. 
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Dlalog Boxes 
. RECALL THE MOST RE

'CENTLY USED DIALOG BOX 

~HANGEMEASUREMENT 

UNITS 

MOVE TO A HIGHER. 
DIRECTORY LEVEL 

LIST THE FILES IN A 
DIRECTORY THAT MATCH 
THE FILE FILTER ON THE 
DIRECTORY LINE 

CLEAR A LINE IN A DIALOG 
BOX 

SELECT A FILE WITHOUT 
PRESSING OK 

Text Mode 
SEE (OR EDIT) THE LIST OF 
FUNCTION KEY TAG ASSIGN
MENTS 

TYPE A SYMBOL THAT IS 

NOT ON THE KEYBOARD 

SELECT MULTIPLE PARA
GRAPHS, FRAMES, OR 
GRAPHICS 

Press etrl-x. 

Point at the unit of measurement and click with the mouse. 

Press the Backup Button (the square black box) at the top of the 
list of files. 

Select the directory name in the list of files. 

Place the cursor on the line and press Esc. 

Highlight the file name and click twice rapidly with the mouse. Or 
highlight the file name and press Enter. 

Press etrl-K (remember as K for Key). This is a quick way to re
member what the tag assignments were when you're tagging in 
text mode. 

Hold down the Aft key while typing the number corresponding to 
the symbol on the keyboard. To find out that number, see the 
chart in Appendix E of the manual. 

Hold down the Shift key while selecting them with the mouse. 



TAG PARAGRAPHS 

INSERT A NON-BREAKING 
SPACE IN TEXT 

INSERT A FIGURE SPACE 
(MEANING: THE WIDTH OF A 
NUMBER) 

INSERT A THIN SPACE 

INSERT AN EM SPACE 

INSERT A LINE BREAK 
(STARTS A NEW LINE 
WITHOUT STARTING A NEW 
PARAGRAPH) 

INSERT A DISCRETIONARY 
HYPHEN (A HYPHEN THAT 
ONLY APPEARS WHEN IT IS 
AT THE END OF A LINE) 

SHOW/HIDE TAB AND RE

TURN SYMBOLS 

MOVING THE TEXT CURSOR 

CHANGE THE FONT OF A LET
TER, WORD, OR GROUP OF 
WORDS WITHIN A PARA
GRAPH. 
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Select Tag mode. Select the paragraph. Select the appropr!ate 
tag. Or select Text mode, place the cursor within the paragraph, 
and press the function key assigned to a tag (limited .to use with 
10 tags). 

Press Gtrl-Spacebar. 

Press Gtrl-Shift-Spacebar. 

Press Gtrl-Shift-T. 

Press Gtrl-Shift-M. 

Press Gtrl-Enter. 

Press GtrI-Hyphen. 

Press Gtrl-T (Remember T for Tab). 

You can do this either by using the cursor keys (which move it for
ward and backward, up and down one character or one line at a 
time) or by pointing and clicking with the mouse. 

Select Text mode. prag the cursor across the letter, word, or 
group of words. Glick on the Addition Button (it should read: Set 
Font). Fill in the desired settings in the dialog box. 
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MANUALLY KERN TWO LET
. TERS. 

Graphics IV10de 
SELECT MULTIPLE 
GRAPHICS 

SELECT ALL GRAPHICS 

SELECT LINE ATTRIBUTES 
OR FILL ATTRIBUTES 

BRING A GRAPHIC TO FRONT 

DRAW MULTIPLE LINES, 
BOXES, OR FRAMES 

PLACE A GRAPHIC IN THE 
.... CLIPBOARD 

PASTE A GRAPHIC FROM 
THE CLIPBOARD ONTO A 
NEWPAGE 

COpy A GRAPHIC 

Select Text mode by pressing Ctr/-O or clicking on the text icon. 
Drag the cursor across the letter to the right of the space you 
wish to close up. Select Set Font. Type in the desired amount of 
kerning (the distance you want the two letters to be tightened up). 
Generally a value of 2 to 6 points is appropriate for 36-point type. 

Hold down the Shift key while selecting them with the mouse. 

Press Ctrl-Q. 

Press Ctr/-L (Remember L for Line) or Ctr/-F (F for Fill). 

Select the graphic and press Ctr/-A. An alternative is to select the 
graphic, press Del, and immediately press Ins. 

Hold down the Shift key while using one of the graphic tools or 
the Add New Frames option. 

Select the frame or graphic and press Del. 

Press Ins. The frame or graphic will reappear in exactly the same 
position on the page. This command cannot be used to paste a 
graphic to a new position on the same page. 

Select the frame or graphic. Press Shift-Del (use the Del key on 
the numeric pad and make sure that Numlock is Off). Use the 
DThen drag the frame or graphic to a new location. When you 
press Ins it will reappear in the old location. 



APPENDIX C 

r - - ., r - .., r ..., 

/-:Ji~ 

Glossary 
alley The space between columns in a 
multi-column document. Ventura refers 
to this as the gutter. 

ascender The part of a lowercase letter 
that extends above the body of the letter 
(as in b or d). 

ASCII American Standard Code for In
formation Interchange. It refers to a type 
of file that contains only the characters of 
a standard computer keyboard. 

attribute Variations applied to plain 
type, such as boldface, underlining, or 
strikethrough. 

backup button A small black box con
tained in dialog boxes. Selecting it moves 
you one step up in the hierarchy of direc
tories. 

base line The invisible line on which 
type rests and below which descenders 
hang. 

batch pagination An approach toward 
computer typesetting in which formatting 
commands are embedded in text and then 
formatting and text are both executed as 
the document is printed. 

body text The name of the default style 
applied to plain text in a document. 

box text A tool available in Graphics 
mode that allows you to draw a box on 
the screen and then type text into that 
box. Unlike text contained in frames, box 
text can be moved anywhere on the page 
without disturbing the underlying text or 
graphics. It is useful for labelling 
graphics and for creating tables. 

break A point at which a new line, 
column, or page begins. 

chapter A document, consisting of text, 
pictures, formatted by means of a style 
sheet. Also refers to the file that contains 
pointers to text, graphic, style sheet, and 
other files generated by Ventura. 

clipboard A buffer that stores the most 
recently deleted material. There are actu
ally three separate clipboards, the first for 
holding the most recently deleted frame, 
the second for the most recently deleted 
picture, and the third for the most re
cently deleted text passage. 

cropping Cutting off an unwanted por
tion of a picture. 
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.. deleted picture, and the third for the most 
recently deleted text passage. 

· cropping Cutting off an unwanted por
· 'tion of a picture .. 

. crop mark A small mark that indicates 
a comer of the final document. 

current selection box A small box at 
. the lower 16ft co;rner of the screen that 
displays the current file (in Frame.-inode), 
tag (in Tagging mode), and location of 
text attributes (in Text mode). 

descender The part of a lowercase let
ter that extends below the baseline (as in 
p and q.) The size of a font is measured 
from ascenders to descenders. 

dialog box A box that appears on the 
screen when you select an item from a 

. menu, allowing you to enter settings. 

discretionary hyphen A hyphen that is 
embedded in a text file and is only dis
played if it coincides with a line break. If 
a discretionary hyphen is contained in a 
word, Ventura's hyphenation algorithm 
will not perform any additional hyphena
tion on that word. 

. dithering In computer graphics, using 
. . dot patterns to simulate gradations of 
· .gray. 

.• Em A unit of measurement equal to the 
number of points of the type being set 
(i.e., 12 points for 12-point type). 

En A unit of measurement equal to half 
an em. 

extension The three letters to the right 
of the period in a file name. Indicates the 
type of file. 

feathering The addition of small 
amounts of leading to make a column 
justify vertically. 

filter A file designation containing the 
characters * and ? The * holds the place 
of any number of characters, while the? 
holds the place of a single character. For 
example, when Ventura encounters the 
filter P?C. *, it will produce the following 
matching files, among others: PIC.TXT, 
POC.TXT, PAC.DOC, PXC.ASC, 
PIC.GEN. 

font The complete set of characters, in
cluding punctuation symbols, for a type
face. In traditional typography this meant 
the actual metal type. With the advent of 
computer "fonts" it refers files stored on 
disks or on ROM cartridges. 

footer A design element repeated at the 
bottom of each page of straight text, 
often incorporating the page number. 

frame A container drawn on the page 
in order to load a text or graphic file. In 
addition, Ventura automatically creates 
an underlying frame for each page. 

frame handles The eight small black 
boxes located at the comers and on the 
sides of a frame. By placing the cursor on 
one of these and holding down the mouse 
button while dragging the mouse, you 
can stretch a frame. 

global Referring to any operation that 
applies to the entire document. 

Greeking The technique of speeding up 
the display by representing small text on 
the screen with dummy type or straight 
lines. 



grid The design "skeleton" on which a 
document is built; includes design stand
ards for columns and frames, margins, 
leading and tracking, justification, head
ers and footers, and graphics. 

gutter In traditional typography, the 
space on the page between the inside 
edge of the type and the spine of a bound 
book. As used in Ventura's Margins and 
Columns dialog box, gutter refers to the 
alley between two columns of text. 

header A design element repeated at 
the top of each page of straight text; can 
include chapter titles, book title, and/or 
page numbers. 

images In Ventura, images refer to pic
tures stored as bits (O's and 1 's). Such 
pictures cannot be enlarged without a re
duction in quality. 

imagesetter A phototypesetting ma
chine that can handle pictures and text on 
the same page. 

indent The horizontal offset of the first 
line (or designated number of lines) of 
text. 

interline spacing The amount of verti
cal space between lines of text, measured 
from baseline to baseline. The default is 
1.2 times the point size of the current 
font. 

italic Slanted style of a given typeface, 
used for emphasis, for instance to offset 
book titles from the main text. 

item selector The name for a type of 
dialog box used to load text, picture, or 
chapter files. 
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justified type A line of type that is pre
cisely spaced so that it rests flush against 
both margins of the column. . 

kerning Moving two letters closer to~ 
gether to give them a closer fit. 

landscape Refers to printing a page so 
that when positioned for reading, the 
page is wider than it i~ long. 

leader~haracters Characters . (usually 
period~) used to fill up the space between 
tabs. Frequently used. in tables of con
tents. 

leading The space, in points, between 
lines of type and measured from baseline 
to baseline. For example, a 10/12 specifi
cation for type means 10-point type on 12 
points of leading (6 lines to the inch). 

letter spacing Adjusting the space 
within words to assist line justification. 

line art In traditional graphic arts, line 
art refers to pictures that use no shading. 
In Ventura, line art refers to. graphics 
stored as mathematic descripti9ns, which 
can be scaled with no reduction in qu
ality. 

mode One of the four ways of working' .... :. 
in Ventura, selected by means of the four . 
icons in the upper left corner of the. 
screen. The four modes are Framing, 
Tagging, Text Editing, and Graphics. 

orphan The first line of a paragraph sit
uated on the last line of a column. Tradi
tional page layout calls for avoiding or
phans. 

paragraph A block of text ended by a 
hard carriage return (pressing Enter). 
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pica Typographic unit of measurement 
equal to 12 points or 1/6 inch. 

pixel The smallest unit of a digitized 
· picture, either on the screen or printed. 

point Typographic unit of measurement 
equal to 1/12 pica or 1n2 inch. The 

· "point size" of a font is measured from 
the bottom of the descenders to the top of 
the ascenders. 

portrait Refers to printing a ip~ge so 
· that when positioned for reading, the 
page is longer than it is wide. 

proportional spacing The method of 
setting type in which wide letters, such as 
W, receive more space and thin letters, 
such as i, receive less space. 

publication A file containing informa
tion about a sequential group of chapter 
files. 

· ragged Unjustified type, that is, 
.. centered or flush to one side but not to 

the other. 

rule A line used as a design element on 
the page. 

sans serif A typeface designed without 
serifs, such as Helvetica. 

scaling Enlarging or reducing a picture. 

selection The term for choosing a menu 
option, a command, or an element on the 
page by moving the cursor on top of it 
and then clicking with the mouse. 

serifs Small counter strokes that "finish 
off' the ends of the body strokes of a let
ter; also, typefaces that incorporate such 
strokes. In theory, serifs help the eye to 

recognize the shapes of different letters, 
thus aiding readability. 

spaceband The spacing between words 
in a passage of text. In Ventura you can 
enter a minimum, a maximum, and an 
optimum setting. 

spine The back of a bound book. 

style sheet A collection of tags con
tained in a computer file. 

tag A set of formatting instructions for 
a type of paragraph. Up to 128 different 
tags may be stored in a style sheet. 

thin space A space the width of a pe
riod. 

tracking The spacing of the letters 
throughout a passage of text. Typically 
loosened or made tighter to accommo
date justification or enhance readability, 
while still maintaining an overall effect 
of uniformity . 

typeface A particular type design, such 
as Palatino or Goudy. 

underlying page The frame that Ven
tura automatically generates for each 
page in a chapter. 

widow The last line of a paragraph sit
uated on the first line of a column. In 
traditional page layout, widows were 
avoided. 

WYSIWYG "What You See Is What 
You Get"; a description of programs, 
such as Ventura, in which the picture on 
the screen is an accurate representation of 
the page that is ultimately printed. 



$ files, 90, 92 
$HP file, 104 
1-2-3, See Lotus 1-2-3 
1st Match, 154,194 
386 computer, 71 
8087 coprocessor, 233 

Abaton Scan 300, 259 
Above Board memory, 85 
Above Board memory, conflicts 

with large-screen monitors, 85 
abovelbelow spacing, 130 
active area, 185 
adapters, 82 
Add New Frame, 30 
Add New Tag, 31,49, 51 
add-in RAM, 70 
adding a LaserJet font, 206 
adding fonts, see Fonts, adding 
Addition Button, 57 
Adobe Illustrator, 79 
Adobe Type Library, 79, 262 
Agfa P400PS, 251 
alignment, frame-wide, 141 
alignment, see Paragraph menu 
alley, 185 
Allotype Typographic Fonts, 262 
Alphagraphics, 266 
Altsys font library, 262 
Amdek 1280 Graphics Subsystem, 

83,255 
Ampersand Typographers, 266 
anchor, see Frame menu 
Apollo,83 
Apple Laserwriter, 70, 72, 74, 75, 

78,79,81,145 
Apple LaserWriter Plus, 71, 75, 

79,82,145 
AppleTalk port, 72 
archiving documents, 100 
ASCII, 23, 40, 90, 107, 108, 111, 

201, 204, 217, 224, 260, 21, 
275 

aspect ratio, 165 
Assignment List, 40, 43, 57 

Index 

AST Premium 286 computer, 68, 
254 

Atlas PostScript controller, 78, 82, 
250,251 

attaching arrows to pictures, 175 
attaching graphics to frames, 167 
attributes, see text attributes 
AutoCAD SLD format, 23, 90, 164 
AutoCAD, 23, 65, 90, 159, 164, 

245,255,257,258 
automatic downloading, turning 

off,230 
automatic kerning, 126, 127, 136 
automatic text insertion, 157 
autonumbering, 154-156 

Backing up chapters, 100-101 
Backup Button, 32, 38, 45, 94-96, 

231,232, 
backup file, 90, 92,230 
ballot box, 173-174 
base page layout strategy, 179-

180 
batch pagination, 55 
beep, 121 
big first character, 150-151 
Big KISS, 254 
bit map fonts, 144 
bit map fonts, storage problems, 

144 
bit map, full-page, 81 
bit maps, 79 
bit maps, encoding, 80 
Bitstream Fontware Installation Kit, 

see Fontware 
Bitstream Library, 199, 264 
BIX, see Byte Information Ex-

change 
blank page, 193 
Body Text 28 
boldface, 110 
books about graphic design, 181 
books and manuals, layouts, 186-

189 
boo~s,267 

Box Text style sheet, 191 
Box Text versus frames, 168-169 
Box Text, 33, 43, 45, 48-50, 166-

168 
Box Text, tagging, 191 
boxes, 55 
boxes, in forms, 50 
boxes, moving groups of, 51 
boxes, saving types, 50 
breaks versus tabs, 133 
breaks, see Paragraph menu 
bullet, 139 
business report, 19 
Byte Information Exchange, 218 

eGA, see IBM Color Graphics 
Adapter 
character sets, IBM Screen, 205; 

see also ASCII; International; 
and Roman-S 

Color Graphics Adapter, see IBM 
Color/Graphics Adapter 

COO file, 90, 93; see also print file 
CAD, 58,159 
Canon IX-12 scanner, 160, 246, 

247,253,254,259 
Canon LBP-CX laser printer en

gine, 72, 74, 75, 77, 249, 252, 
253, 255, 260, 

Canon LBP-SX laser printer en-
gine, 75, 77, 252 

Canon LBP-8, 72 
CAP file, 90, 92 
CapabilLCHP, 76, 123 
caption file, 90, 92 
captions, padding, 176 
captions, see Frame menu, An-

chors & Captions 
centering a graphic, 174 
Cent ram TOPS, 169, 214 
CGA, see IBM Color Graphics 

Adapter 
CGM format, see Computer 

Graphics Metafile 
chaining, of chapters, 55 
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changing font, 29 
changing measurement unit, 29, 

57 
changing the order of frames, 193 
chapter 

file size limitations, 109 
template, 44 
archiving, 100 
file, 65, 90, 91 
naming, 27, 38, 48 
saving 27, 48 

. saving as template, 44 
character attributes, 110, 112 
character counts per pica, 186 
character sets, 204; see also Inter-

national character set, Roman-
8 character set, ·IBM character 
set, ASCII character set 

Charset.CHP, 113 
chart of operations, 269-274 
CHP file, 65, 90, 91 
circle, 174 
clearing lines with Esc, 232 
clip art, 169, 247-248 
clones, 68, 70, 71 
code-based approach, 58 
Colophon, 218 
Color Graphics Adapter, see IBM 

Color Graphics Adapter 
column guides, 35, 57 
column guides, hiding, 61 
Column Snap, see Options menu 
columns, 186 
columns, establishing, 39 
combining files, 35 
Compaq DeskPro, 68, 69 
Compugraphic CG 400-PS laser 

printer, 79, 250 
Compugraphic, 78 
CompuScan, PCS 240, 246 
CompuServe, 218 
computer configurations, 69-74 
Computer Graphics Metafile, 23, 

90,161-164,245 
computer-based publishing, history 

of,58 
The Computer Shopper, 218 
CONDENSE, 229 
ConoFonts, 260 
Conographics, 198 
ConoVision 2800 monitor, 83, 256, 

257 
converting fonts, 203 
converting Macintosh screen fonts, 

203-204 
Copy to Facing Page, 30 
copying multiple graphics, 174 
copyright symbol, 116 

Cordata laser printer, 75, 78, 80, 
81,145,198-200,203,253 

creating a new directory, 38, 95 
creating a width table, 206 
creating multiple frames, 192 
Cricket Draw, 79, 214 
crop marks, 183 
cropping graphics, see Frame 

menu, Sizing & Scaling 164, 
171-173 

Current Page Box, 56 
Current Selection Box, 56 
cursor keys, 116 

\, 

D~Sh,114 
database output, 240 
Datacopy 730 scanner, 160, 247, 

259 
Dataproducts LZR-2665, 249 
DaVinci Business Services, 266 
dBase files, 107 
DCA format, 90, 107 
DCA, see Document Content Ar

chitecture 
DOL, see Document Description 

Language 
de-selecting boxes, 51 
decimal tab characters, 139 
decorative typeface, 143 
default style sheet, 45, 47, 119, 

193 
Default.STY, 119, 193 
defragmenting utilities, 228-229 
Del key, 115 
design, 181-182 
design, books on, 181 
Desk menu, 62 
Desktop Publishers' Graphics, 246 
desktop publishing services, 69 
Dest PC Scan Plus, 160,247,259 
device independence, 79 
Diablo 630 emulation, 251-253 
diagnostics report box, 236-237 
Digit-Art LaserGraphics, 247 
digitizers, see scanners 
digitizing a logo, 160 
directories, 37, 95 
directories, creating, 47, 61, 95 
directory structure, see file man-

agement 
disappearing footer, 123 
disappearing rules, 140 
disappearing text, 121 
discretionary hyphen, 110, 116, 

121 
disk caching 69, 227-228 
Disk Optimizer, 228, 229 

Disk OrGanizer, 229 
display font, 143 
displays, large-screen, 58 
displays, see monitors 
DisplayWrite, 23, 90, 107 
dithering, 87-88 
DOC files, 90 
Document Content Architecture, 

23,107 
Document Description Language, 

78 
document layout procedure, 19, 

182-183 
document layout strategies, 179-

194 . 
document, revision, 65 
document, specifications, 63 
documents, multiple generations, 

65 
DOG,229 
DOS, 89, 93-95, 100 

Copy command, 89, 100 
file extensions, 95 
filters, 95 

DOS File Ops, see File menu 
double click speed, 231 
double clicking to select 27 
double spaces, 121 
double underline, 110 
downloading fonts, 147-148 
downloading LaserJet fonts, 149 
Dr. Halo, 257 
draft versus ultimate printing, 148 
DrawArt, 247, 248 
drives, 95 
DXF format, 245 

Edit menu, 62 
Remove TexVFile 44 

EGA, see IBM Enhanced Graphics 
Adapter 

Electric Webster, 223 
ElectroFont, 264 
Electronic Directions, 217 
Em dash, 23, 116 
Em space, 110, 116, 129 
embedded codes, 110 
EMS, 247 
En space, 110, 116, 129 
Encapsulated PostScript, 23, 79, 

90, 164, 213-218,246-248,262 
Enhanced Graphics Adapter, see 

IBM Enhanced Graphics 
Adapter 

enlarged format, 225 
EPS, see Encapsulated Postscript 
Epson CO-3500, 77 



Epson dot matrix, 70 
Epson FX emulation, 251, 253 
Epson,80 
erasers, 173 
Everex AT clone, 68, 69 
exceptions dictionary, 55 
expanded memory, 247 
extension, 95 
external memory, 237 
Eye-Star, 160 

F font cartridge, 143 
facing pages, headers and footers, 

30 
Fancy Fonts, 262 
feathering, 136-137 
figure space, 110, 116, 129 
file management, 89-104 

deleting chapters, 89 
DOS filters, 95 
organization strategies, 26, 47, 
97-99 

types of files 90 
File menu, 62 

DOS File Ops, 47, 95 
Load Ditt. Style, 37, 45 
Load TexVPicture 28, 32, 40, 41, 
114 

File menu, Open Chapter, 96 
Save As New Style, 38, 47 
Save As, 44, 48 
Save, 41, 52 
Sizing & Scaling, 32 
To Print, 52 

file structure, see file management 
files, types of, 90 
Fill Attributes, see Graphic menu 
filters, 95 
fine lines, 75 
First Match, 154, 194 
fixed spaces, 128, 129 
fixed spaces versus tabs, 137 
Flash, 69, 227, 228, 240 
flicker, see monitors 
Fluent Fonts, 262 
font cartridge, 143, 145 
Font Factory, 198, 260 
font generating programs, 145, 

198-201,264-266 
font selection, see Paragraph 

menu 
font terminology, 143-144 
font vendors, 197-198 
FontCenter fonts, 260 
Fontgen IV, 265 
fonts, 143-151, 260-264 

adding, 197-208 

AST Tu rbo Laser, 198 
Cordata, 198 
decorative, 143 
downloading, 147-148 
InterPress, 198 
JLaser, 198,204,261 
LaserJet 145, 198, 199, 202, 
254,260,261,265,266 

monospaced, 78 
outline, 79 
PostScript 197, 202, 231, 262-
266 

selecting, 146 
soft,145,204,261 
storage requirements 
Xerox 4045, 198 

Fontware, 199, 201, 205, 264, 265 
footers, see Page Menu, Headers 

& Footers 
footers, creating 29 
footnotes, 110, 193 
Foreign Language Fonts, 263 
form letters, 193 
form, 45-52 
formatting, 61 

document, 63 
newsletter, 43 
paragraph,63 
words within a paragraph, 117 

forms, 190-193 
frame anchoring, see Frame menu 
Frame Background, see Frame 

menu 
frame break, 139 
Frame menu, 62 

Anchors & Captions 26, 42, 110, 
156 

Frame Background, 33 
Margins & Columns, 39 
Ruling Box Around, 30, 31 
Ruling Line Below 29 
Sizing & Scaling 31, 164, 165 

Frame mode, 60 
frames, 64' 

base page, 39, 63, 64 
Add New Frame, 30 
changing size, 40 
creating, 39 
moving, 40 
padding, 134, 165, 171 
versus Box Text, 168-169 

free-form layout strategy, 180-181 
Freelance, 245 
Frieze utility, 211-247 
Full Box, 56 
full-screen monitors, see monitors 
function key assignments, 118 
function keys, tagging with, 117 
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GEM, 23, 90, 160, 164, 256-258 
GEM Draw Plus, 246 
GEM Draw, 90 
GEM format, 90, 246, 260 
GEM IMG format, 87 
GEM Paint, 23, 90, 246, 260 
GEN file, 65, 90, 92 
generated files, 90,92 
generated tags, 117 
generated tags, changing, 119 
Generated Tags: Shown, 30 
Genicom engine, 249 
Genicom,80 
Genius monitor, 83, 85-86, 258 
Genius VHR, 256 
global controls, 60 
global kerning, ·126 
glossary, 275-278 
Glyphix, 199, 201, 265 
Graph-Tech,217 
graphic defaults, 232 
graphic design, books on, 181 
Graphic menu, 62 

Fill Attributes, 33, 50, 192 
Grid Settings, 50 
Grid Snap, 50 
Line Attributes, 33, 43, 50, 192 
Select All, 51 

graphics, 159-177 
attaching to frames, 167 
buffer, 238 
file formats, 90, 164 
Graphics mode, 60 
graphics software, 245-247 
importing, 23 
limits on size, 176 
loading 26 
Lotus, 26 
operations, 61 
positioning, 32, 64 
precise positioning of, 169 
scaling and stretching, 55, 64 

Graphwriter, 245 
Greeking, 230 
GreekKeys, 263 
grid settings, 192 
Grid Snap, see Graphic menu 
grid,183-184 
Grouped Box Text method, 45 
gutter, 185 

Halftones, 71, 87, 88 
Halo DPE, 87, 90, 160, 246, 
Halo, 23 
hard disk 

management, see file manage
ment 
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defragmenting, 228-229 
speed,68 

hardware, 67-88 
Header, see Page Menu, Headers 

& Footers 
headers & footers, see Page menu 
headline, 194 
Helvetica, character counts, 186 
Hercules Graphics Card, 70, 71, 

82-84,210,211,256,257 
Hewlett-Packard Graphics Lan-

guage, 23, 73,90,164,245 
Hewlett-Packard PCLPak, 149 
HGC, see Hercules Graphics Card 
hidden text, 110 
Hide Column, 57 
Hide Ruler, 57 
hiding pictures, 173, 232 
history of computer-based publish-

ing, 58 . 
Hitachi graphics coprocessor, 86 
Hot Type, 263 
HotShot, 210, 211, 220 
How to Run PostScript from DOS, 

217 
HP JetScan, 259 
Hewlett-Packard LaserJet printer 

family, see LaserJet, LaserJet 
Plus, LaserJet Series II, Laser
Jet 2000 

HP LaserJet cartridges, 143, 145 
HP Printer Command Language, 

see Printer Command Lan
guage 

HP soft fonts, 204, 261 
HP Vectra, 68, 69 
HPG format, 90 
hyphenation, 55, 223-224 

faster, 232-233 
suppressing, 121 

IBM AT, 68 
IBM Color Graphics Adapter, 67, 

82, 210, 256-258 
IBM Enhanced Graphics Adapter, 

83,85,210,256-258 
IBM Graphics Printer emulation, 

251 
IBM Monochrome Display Adapter, 

210,258 
IBM PC, 69, 176, 201, 264 
IBM Personal Pageprinter, 78, 79 
IBM ProPrinter emulation, 253 
IBM XT, 68 
icons, 56 
Illustrator, 246 
Imagen, 78 

images, 159 
IMG format, 246, 247, 260 
indenting, see Paragraph menu, 

Alignment 
index generation, 55 
indexes and tables of contents, 90 
INF file, 65, 90, 92, 103 
Ins key, 115 
Insert/Remove Page, see Page 

Menu 
Inside Xerox Ventura Publisher, 

267 
installing fonts, procedure, 202 
Intel 82786, 256 
Intel graphics coprocessor, 86 
intenace, customizing, 60-61 
interline spacing, 130, 131 
internal graphics, 55, 90, 165 
internal memory, 237 
Internal RIP, 80 
International character set, 199, 

201,204,205 
interparagraph spacing, 130 
InterPress, 58, 78, 79, 144, 146, 

198,201 
italics, 110 
Item Selector dialog box, 37, 40, 

41,45 

J Laser board, 73, 80-82, 145, 
150,177,198-200,203,230,247, 
252,254 
JLaser Plus board, 71, 253, 254, 

259 
justified text, 128 
JustText, 58 

Kerning, 55, 125 
automatic, 126, 127, 136 
global,126 
manual,126 
onscreen, 61, 231 

keyboard shortcuts, 231,241 
KISS, see OMS KISS 
Kyocera 74, 77, 80, 251,252 

Labeling graphics, 168 
labels, 26 
large-screen monitors, cursor 

problems, 120 
Laser Connection, 72 
laser printers, 74 

capabilities, 76 
engines, 74, see also Canon 
LBP-CX, Canon LBP-SX, Geni-

com, Kyocera, Ricoh 1060, 
Ricoh 4080, Toshiba, and Xerox 
4045 

300 dpi, 78 
400 dpi, 78 
600 dpi, 78 
comparative factors, 74-75 
compatibility with typesetters, 75 
controllers, 74 
intensity of solid blacks 74, 75, 
77 

paper handling, 74 
quality of gray shades, 74 
speed,75,81 
write-black, 75 
write-white, 75 

laser printing services, 266 
LaserCraft Images, 248 
LaserFonts, 261, 263 
LaserJet, 72, 74, 75, 80, 144, 145, 

150, 200, 203, 204, 249, 251, 
252 

LaserJet 2000 printer, 149 
LaserJet 500 Plus, 75, 252 
LaserJet compatible printers, 73, 

78,80,249,250-253,255 
LaserJet fonts, 145, 198, 199, 202, 

254,260,261,265,266 
LaserJet fonts, downloading, 149 
LaserJet Plus, 72, 75, 80, 81, 145, 

149, 176, 198, 206, 230, 251, 
252,254 

LaserJet Series II, 70, 71, 77, 145, 
148,149,198,230,252, 

LaserMaster, 70, 81, 82, 177,230, 
252-255, 265, 

LaserPro, 75, 80,251,252 
LaserView Display System, 83, 

256,257 
LaserWriter, 79, 81,248-250,253 
LaserWriter Plus, 248, 249 
Last Match, 154, 194 
layouts, see documents layouts 
LBP-CX, see Canon LBP-CX 
LBP-SX, see Canon LBP-SX 
leader characters, 141 
leading, 55 
letterspacing, 55, 125, 127, 142 
letterspacing versus tracking, 137 
Lightning, 227, 228, 240 
line art, 159 
Line Attributes, see Graphic menu 
line break, 55,110,116, 
line elements, 237 
line endings, 108, 110 
line snap, 137-138 
line snap versus grid snap, 175 



Linotronic 100 imagesetter. 69. 70. 
79.250.266 

Linotronic 300 imagesetter. 79. 81. 
250 

LJ Fonts. 261 
LM-Fonts. 199. 201. 205 
Load Diff. Style. see File menu 
Load TexUPicture. see File menu 
loading a chapter directly from 

DOS. 233 
loading a style sheet. 115 
loading chapters. problems with. 

89.103-104 
loading document. speed of 69 
loading graphics. 160-161 
loading multiple files. 122 
loading pictures. 40. 41 
loading text. 40. 114 
loading Ventura. speed of. 69 
loose lines. 61.122 
Lotus 1-2-3. 19.23.90. 107.219-

221.245.247.256-258 
Lotus 1-2-3 graphics. 26. 32. 33. 

171.176.220 
Lotus 1-2-3. replacing type. 33 
Lotus Manuscript. 107 
Lotus PIC. 164 

MDA. see IBM Monochrome 
Display Adapter 
Monochrome Display Adapter. seo 

IBM Monochrome Display 
Adapter 

Mac-Art Library. 248 
MacBeLingual. 263 
MacDraw. 23. 169. 176 
MacDraw format. 247 
MacDraw PICr, 164 
Mace Utilities. 228. 229 
Macintosh. 58. 169. 176. 246. 267 
Macintosh EPS files. 214 
Macintosh screen fonts. 203 
MacMemories. 248 
MacPaint format. 247. 248 
MacPaint. 23. 87. 90. 160. 169. 

176. 
MacTypeNet. 266 
magazines. 267 
MagicFont fonts. 261 
Magna-4.257 
MagnaType.58 
Mannesman Tally MT-910 laser 

printer. 77. 80.252.253 
manual kerning. 126 
Margins & Columns. see Frame 

menu 
margins. 131-132. 185 

marker characters. 138 
MasterPlan. 217 
MDA. 82. 256. 257. 
measurement units. meaning of 

--.--. 142 
measurement units. out of range. 

142 
memory limitations and diagnos-

tics. 235-240 
Mentor Graphics. 23. 90. 164 
Menu Line. 62 
menu. making disappear. 37 
merging data into forms. 192 
microPublishing Report. 267 
Microsoft Windows. 211. 256. 258. 

259 
Microsoft Word. 23. 71. 107. 118. 

221.256 
Microtek scanners. 71. 160. 246. 

259.260 
mode icons. 56 
Moniterm monitor. 83. 86. 256. 

257 
monitors. 55. 82. 83. 255-258 

aspect ratio of pixels. 84 
cabling. 85 
compatibility with mouse. 86 
computer compatibility. 85 
contrast. 85 
edge effects. 86 
flicker. 85 
full-page display. 83 
Genius. 83 
graphics coprocessors. 86 
heat and power. 85 
installation. 85 
large screen. 83 
orientation. 86 
primary. 85 
resolution. 82 
screen fonts. 84 
secondary. 85 
size of display. 84 
software compatibility. 85 
speed factors. 86 
standards. 82 

Monochrome Display Adapter. see 
IBM Monochrome Display 
Adapter 

monospaced fonts. 78 
Motorola 68020 chip. 250 
mouse. 86.229.241-242 

adjusting speed. 61 
sensitivity factor. 86 

moving blocks of text. 115 
moving graphics between docu

ments.174 
moving graphics without distortion. 
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171 
moving groups of boxes. 51 
Multichapter. see Options menu 
MultiMate. 23. 35; 107. 119 
multiple selection with the Shift 

key. 232 

Neoscribe fonts. 263 
newsletters. 35.189-190 
newspaper-style layout strategy. 

180 
nonbreaking space. 110. 116 
nonkeyboard characters. 113-114 
Norton Utilities. 228. 229 
numbering chapters. 188 

OCR Plus.'259 
Office Writer. 107 
OmniLaser 2000 Series. 249 
OmniLaser.254 
on-screen kerning. 61. 231 
open systems concept. 65 
operations. 269-274 
Options menu. 37. 47. 62 

Column Snap. 40 
Generated Tags: Shown 30 
Multi-Chapter. 92. 100. 101 
Set Printer Info 42. 52. 82 
Show Loose Lines. 128 
Turn Column Snap On. 30 

Organic Fonts. 264 
outline fonts. 79. 144 
Overall Width. see Paragraph 

menu. Alignment 
overlapping pictures. 176 
overscore. 110 

Padding captions. 176 
padding. 32. 134. 165. 171 
page description language. 78-81. 

144 
page layout. 60 
page makeup. 58 
Page menu. 62. 63 

Headers & Footers. 29. 30. 153-
155.188.193 

InserURemove Page. 43 
page numbering. 55 
PageMaker. 35. 58. 67. 93 
·PageMakering." 35 
pagination. 60.153-157 
paragraph break. inserting. 116 
paragraph limitations. 109 
Paragraph menu. 62 
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Alignment, 31, 49, 51, 128, 131-
132 

Breaks, 110,112,133-135 
Font 29, 31,49 . 
Ruling Line Below 29 
Spacing, 29, 31, 51 
Special Effects, 139, 150-151 
Typographic Controls, 122, 127 

paragraphs per chapter, maximum, 
109 

parallel printer interface, 81,230 
paths, 56, 95 
PC Image, 259 
PC MacBridge, 169 
PC Magazine, 256 
PC Paintbrush, 23, 102,159-161, 

211,258 
PC Paintbrush Plus, 59, 84, 87, 

90, .160, 209, 211, 219, 220, 
246-248,257,259,260 . 

PC Ouik-Art, 169, 248 . 
PC World, 267 
PCC format, 209-212, 247, 248 
PCl, see Printer Command lan-

guage 
PClPak,149 
PCT format, 90 
PCX format 23, 59, 90, 160, 220, 

247,259,260 
POL, seepage description lan-

guage,81 . 
periodicals,' 267 
Personal Pageprinter, 78, 79 
Personal, Publishing Bookshelf, 

267 
Personal Publishing, 267 
Perspective, 247 
PIC format, 32, 90, 219 
picas and points, 30, 144 
picas and poit"!ts, advantage over 

other measurement units, 30 
pictures 

hiding, 61 
loading, 40-41, 61 
removing, 61 

pixel editing, 160-161 
placing and removing graphics, 

173 
PNT format, 90 
point size, 110 
point size, how determined, 144 
point, 30 
positioning graphics, 164 
PostScript, 71, 72, 78, 79, 144-

146, 150, 197, 213, 214, 217, 
218,250,251 

Atlas controller, see Atlas con
troller 

PostScript clone, 78 
files, 73, 215 
fonts, 202, 231, 262-266 
graphic effects with type, 79 
prep file, 72, 217 
printers, 79, 81, 177, 230, 248, 
249 

printers (300 dpi), 248-249 
printers (above 300 dpi), 250-
251 

prologue, 233-234 
resources, 217 

, routines, 248 
'. .speeding up, 177 
type library, see Adobe Type li
brary 

typesetters, 58, 81 
width table, 81, 252 

PostScript Language Journal, 218 
PostScript Language Reference 

Manual,217 
PostScript Language Tutorial & 

Cookbook,217 
preformatting text files, 110 
preparing text, 107 
pretagging text, 232 
Princeton Graphics 257, 259 
print files, 90, 93, 214 
print files, setting margins to zero, 

107,109 
print quality, 74 
print to disk file, 90, 93, 214 
printer capabilities, 76 
Printer Command language, 78, 

80 
printer font, 200-201 
Printer Information box, see Op-

tions menu 
printer settings, see Options menu 
printing, 52 
PrintR Fonts, 261 
Printscript, 250 
Printware 720 10 printer, 78, 250 
problems 

changing text attributes, 121 
creating a blank page, 193 
disappearing footer, 123 
disappearing graphic, 176 
disappearing rules, 140 
drawing arrows, 177 
graphic doesn't fit in frame, 177 
isolated paragraph mark, 121 
kerning, 141 
line element limits, 239 
loading a chapter, 89, 103-104 
loading text or pictures, 122 
mistakes with picas and points, 
140 

moving small graphics, 175 
positioning the cursor, 120 
selecting graphics, 171, 175 
Shift-Del doesn't work, 174 
text disappearing, 121 
text selection won't go away, 
121 

type on a lotus graphic, 176 
program status files, 90 
PS Jet, 72, 73, 79, 80, 82, 249, 

252,254 
PS Jet Plus, 73, 79, 80, 82, 249 
PS2.PRE, 233-234 
PUB file, 90, 92 
publication file, 90, 92 
Publish Pac, 259, 260 
Publish!, 267 
Publisher's Paintbrush, 65, 87, 

160, 209, 211 219, 246, 248, 
259 

OMS KISS, 70, 72, 74, 254 
OMS PS 1200 printer, 249 
OMS PS 2400 printer, 249 
OMS PS 800 and 800+ printer, 71 

74,75,79,80,82,249 
OMS SmartWriter, 72, 74 
Ouadlaser, 75, 80, 253, 254 
Oume laserTEN, 80 
Oume Script Ten, 249 
Oume Sprint II emulation, 251-253 
quotation marks, 114, 116 

Rag left, 128 
rag right, 128 
RAM disk, 229, 239, 240 
Rapid Transmit, 266 
raster devices, 144 
raster image processors, 78 
readability, 143-144 
ReadySetGo!,58 
recalling the previous dialog box, 

231 
reference points, 134-135 
registered trademark symbol, 116 
Remove TextIFile, see Edit menu 
removing tag names from text files, 

118 
Resize Button, 56 
resolution-independence, 144 
restoring chapters to a hard disk, 

101 
reusing a layout, 119 
reversed type, 140 
Ricoh 1060 laser printer engine, 

77 



Ricoh 4080 laser printer engine, 
74,75,249,255 

Ricoh, IS-30, 246 
Ricoh, PC Laser 6000, 77 
RIP, see raster image processor 
ROM cartridges, 143, 145 
Roman-8 character set, 199, 201, 

205,261 
rule to end, 140 
Ruler, 57 
Ruler, hiding, 61 
rules, 125 
Ruling Box Around, see Frame 

menu 
Ruling Line Below, see Frame 

menu 
ruling lines, 55,135-136 
ruling lines, width, 130 

Saddle-stitch format, 225 
Samna Word, 23, 107 
Samsung,83 
saving a chapter, see File menu 
saving a file, see File Menu 
saving a style sheet, see File 

menu 
scaling graphics, 164, 165 
ScanJet, 160,247,260 
scanned images as tracing tem-

plates, 170-171 
scanners, 259-260 
scanners, drawbacks of, 159 
Scanning Gallery, 260 
scanning images, 159 
ScenicWriter, 58 
SciFonts, 264 
screen font, 120, 200, 201, 238 
screen shots, 209-212 
screen, magnification, 61 
screens, see monitors 
Scroll Bar, 56, 61 
Scrolling Arrow, 56 
search and replace, 114 
selecting, 37 

a group of graphics, 173 
a printer 81 
boxes,52 
by double clicking 27 
by pressing Enter 27 
fonts, 146-147 
graphics, 167 
groups of boxes, 51 
multiple paragraphs, 120 

Selection Boxes, 57 
serial cables, 81 
serif versus sans serif type, reada

bilityof, 143-144 

serif, 75, 143 
Set Font, 64, 117 
Set Printer Info, see Options menu 
shading a chart 33 
shading, 33 
ShapeScan, 160,247 
SideKick note files, 107 
SideKick, 211 
Sigma LaserView monitor, see La

serView 
Sizing & Scaling, see Frame 

menu, Sizing & Scaling 
sizing a frame, 164 
skewed margin, 138 
SLD format, see AutoCAD SLD 

format 
small type, 110 
soft fonts, 145,204,261 
SoftCraft Font Editor, 265 
Software Complement fonts, 264 
solid box, 139-140 
Space Above, see Paragraph 

menu, Spacing 
space width, maximum, 122 
spaceband control, 55, 125 
spaces, 112 
spacing; also see Paragraph 

menu 
between letters, 125-128 
between words, 128 
between paragraphs, 130 
between lines and paragraphs, 
131 

Special Effects, see Paragraph 
menu 

speed tips, 173, 227-233 
speed, computer tests, 69 
still available memory, 237 
STY file, 90, 92 
style sheet, 28, 37, 56, 63 

archiving, 102 
contents of 28 
loading, 37, 45 
protecting, 102 
saving, 27 
selecting 27 

sub-paragraph specifications, 64 
subdirectories, 95 
subdirectories, creating, 26, 61 
subscript, 110 
SuperKey, 117, 232 
superscript, 110 
swapping out, 232, 238 
Symphony PIC files, 164 
Symphony, 245,257, 258 

T able of contents, generation, 55 
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tables, formatting, 23,31, 168 
tabs, 132-135 

as indents, 23 
versus breaks,'133 
versus fixed spaces, 137 

tag, contents of 28 
tagging, 28, 115 

Add New Tag, 31, 49, 51 
Box Text, 191 
document, 28 
headers and footers, 154 
icon, 28 
procedure for, 115 
with a word processor, 117 
with function keys, 117 
with Microsoft Word, 117 

tags per chapter, maximum, 109 
tags, 63 

contents, 28 
creating new, 31 
types of, 28 

TeX, 58 
text attributes that carry over into 

Ventura, 108-109 
text attributes that Ventura ig

nores, 108-109 
text editing in Ventura, 55, 115 
text editing, chart of operations 

116 
text file, size limits, 23, 109 
Text mode, 60, 115 
text preparation, guidelines for, 

108 
text 

flowing around graphics, 55 
importing, 23 
jumping, 35 
loading, 40, 61 
operations, 61 
preparing in word processor 23, 
24,25 

removing, 61 
thin space, 110, 116, 129 
TIFF format, 259, 260 
Times Roman, character counts, 

186 
titles, creating, 48 
toner intensity control, 77 
TOPS, 169, 214 
Toshiba engine, 249 
tracing template, 170-171 
tracking, 55, 125, 127 
tracking versus letterspacing, 137 
tracking versus space width, 141 
trademark symbol, 116 
transferring documents, 100 
trim size, 184 
trouble-shooting, see problem 
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TurboLaser, 74-75, 78, 80-82, 144, 
145, 198-200,203, 254 

TurboScan,254,260 . 
Turn Column Snap On, see Op-

tions menu 
turn off special attributes, 110 
tutorials 19-52 
two~up format, 225 
type size, limitations of non-Post-

Script printers, 40 
type, graphic effects, 79 
typeface, 71, 110; also see fonts 
typeface, decorative 143 
typefaces, families, 73 
Typeline, 266 
TYPESET directory 27 
TYPESET directory, caution stor-

ing documents to, 96 . 
typesetter proofing, 81 
typesetting services, 69, 266-267 
Typographic Controls dialog box, 

128 
typographic controls, 55 
typographics and ruling lines, 125-

142 
Samna,90 
scanner, quality limitations, 88 
scanners, 86-88 
scanning software, 87 
Sigma LaserView, see LaserView 
spiral dithering, 88 

Ultimate versus draft printing, 
148 
UltraFonts, 264 
underline, 11 ci 
Univation screen shot utility, 211, 

212 
Univation Turbo board, 211 
USASCII, see ASCII 
USENGLS2, 233 

. USENGLSH, 233 
user group, 267 

Vari-Tab,112 
Varityper VT600 laser printer, 78, 

251 
Vega Deluxe format, 211 
Ventura 1.1, changes from Ventura 

1.0,26 
Ventura Publisher for the IBM PC, 

267 
Ventura Publisher Users Group, 

267 
Ventura Publisher 

"bridging operations," 61 
as software hub, 64 
capabilities of 55 
chart of operations, 269-274 
diagnostics report box, 236-237 
editing tools, 65 
file size limitations of, 109 
file structure in, 89 
formatting in, 61 
interface of, 61 
keyboard shortcuts, 231 , 241 
limit on line elements per frame, 
235 

limit on number of chapters, 235 
limit on number of tags, 235 
limit on number of text and pic
ture files, 23, 109,235 

limit on paragraphs per chapter, 
235 

limit on size of a paragraph, 235 
limit on size of files, 235 
merits of file management 
scheme, 93 

modes of, 60 
operations of, 60 
parts of the screen, 57, 58 
scenario of use, 59 
speed tests, 69 
structure, 60 
text and graphics operations, 61 
text editing it, 55, 115 
using without a mouse, 241-242 
use by a work group, 112 

Ventura Publishes, 267 
Ventura Scoop, creating, 35-44 
Ventura's POL, 81 
vertical dashed lines, 140, 175 
VGR file, 90, 93 
Video-7 format, 211 
VideoS how format, 23, 90, 162-

164,163,245 
View menu, 30, 62 
Viking I monitor, 69, 71, 82, 83, 85, 

86,256-258 
Vinh Fonts, 261 
Volkswriter 3, 107 
VP.lNFfile, 92,103 
VP/Fonts, 206 
VP/Saddle, 221 
Vprrabs, 221 
VPUG,267 
VS Library of Fonts, 262 
VS Software, 198 

Weaver Graphics, 198 
Whereis.COM utility, 101 
wide headline, 194 
widows and orphans, 155 
width table, 200-202, 238 
wildcard characters, 95 
Windows Paintbrush, 246 
Windows Write, 107 
Windows, 257 
WIPS, 259 
Word Image Processing Software, 

259 
word processor formats, 23 
word processor, formatting in, 23 
WordStar, 23, 35, 59, 71, 90, 102, 

1 03, 111, 112 
WordPerfect, 23, 35, 65, 71, 90, 

107,119 
WordStar 2000, 107 
WordStar 3.3, 107 
WordStar 3.4, 107 
WordStar UK, 107 
Wo rd Star, handling of tabs by Ven-

tura 23 
WordStar, Vari-Tab, 23 
work groups, 112 
WPfiles, 90 
write-black, 75 
write-white, 75 
WS files, 90 
Wyse WY-700 monitor, 70, 71, 83, 

85,255,256,258 
WYSIWYG,58 

Xerox 2700 printer, 79 
Xerox 4020 Color Inkjet, 254, 255 
Xerox 4045 laser printer, 75, 81, 

198-200, 203, 255 
Xerox 6068 Full Page Display, 83, 

85,86,258 
Xerox 9700 printer, 79-80 
Xerox Ventura Publisher, see Ven-

tura Publisher 
Xerox Writer III, 107 
Xerox Writer, 23, 90 
XT, see IBM XT 
XWP files, 90 
XyWrite, 23, 65, 90, 107,217,221, 

Z Boxtext.STY, 193 
Zj5aption, 123 
Z_Footer, see Page Menu, Head

ers & Footers 



Get the Mostfrom Ventura 
Publisher with These Utilities, Style 

Sheets, and Books 

Award Winning Designer Stylesheets 
by BGA / Desktop Designs 

Specially designed to take advantage of Ventura 
Publisher 1.1, each disk contains at least three 

I 

style sheets and is devoted to a single pu~lica-
tion category, such as newsletters, magazines, 

and brochures. Sandi Baker and Carl Ballay, the 
creators of the style sheets, have over 22 years 

of graphic design experience and have won 
numerous art design contests. Each Award Win

ning Designer Style sheet is accompanied by a 
sample formatted chapter to provide an actual 

template for applying the style sheet. 

LaserJet Unlimited 
by Ted Nace and Michael Gardner 

A comprehensive training and reference guide to 

the HP LaserJet family of printers, LaserJet Un
limited was described by the Erik Sandberg-Di

ment of the New York Times as "a gold mine of 
ideas." 

How to Run PostScript From DOS 
by Gary Glover 

Now that Ventura Publisher can accept Encapsu

lated PostScript files, it's time to learn how to 

create your own special effects. Published by 

LaserSoft Press, this book/disk combination uses 
the see-and-do method of instruction, walking 

you you step by step through a variety of same 

PostScript programs. The accompanying disk in

cludes over 100 ready-to-use programs. 

VPlTabs 
by "}Ie Laser Edge 

This utility eliminates the frustration of printing 
Lotus worksheets with Ventura. Just print your 
worksheet to a file, run the file through VPITabs, 
and load it into Ven~ura. That's all you have to do 

to make columns ·Iine up correctly, with figures, 

dollar signs and par~ntheses in. correct position 
according to accounting convention. 

VP/Fonts 
by The Laser Edge 

Just type VPFONTS. That's all you have to do to 

convert all your HP soft fonts for use with Ven
tura. No more batch files or painstaking typing

this utility makes it all automatic. VP/Fonts works 
with soft font diskettes from Hewlett-Packard and 

Bitstream. 

VP/Saddie 
by The Laser Edge 

If you have a PostScript printer, this utility can 
save you money at the printer. The two-up option 

prints two copies of the same page side-by-side 

on one sheet of paper. The saddle-stitch option 

prints two pages paired up so they will fall in the 

proper order when the sheets are folded in half to 

form a booklet. The enlarged option lets you blow 
up small pages, allowing them to be photographi

cally reduced at the printer for higher quality. 
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Order Form 
Quantity Item 

Ventura Tips and Tricks 

LaserJet Unlimited 

How to Run PostScript From DOS (disk and book) 

Award Winning Designer Stylesheets· 

VPfTabs .. 

VP/Fonts 

VP/Saddie 

Tax of 7% applies to California residents only. 

U.S. shipping: $3.50 first item, $.50 each additional. 
Canadian shipping: $5.00 first item, $1.00 each additional. 
Overseas shipping: $8.00 first item, $2.00 each additional. 

·Price is for one disk with three st lesheets and sam Ie cha ters. y p p 

Name 

Company 

Address 

City 

State 

Check 

Card Number 

Card Holder 

Exp. Date 

Visa MasterCard 

I Phone Number 

PEACHPIT PRESS 
2127 Woolsey St. 

Berkeley, CA 94705 
41 5/843-6614 

Unit Price Total 

$15.95 

$24.95 

$39.95 

$24.95 

$89.00 

$79.00 

$79.00 

Subtotal 

Tax 

Shippinglhandling 

Total 

I Zip 



TIP' S AND T R ICKS 

The book includl;ts: 

Explicit step-by-step techniques for formatting bopks, manuals 
newsletters, forms, brochures, and business repo\1s. 

Precautions for using Ventura intensively without clog§jng your 
hard disk. " 

,: ' . 

. . 
Hidden commands and shortcuts for more efficient document 
formattinq . 

Notes on choosing laser printers and large-screen monitors. 

Guidance on buying, installing, and using iQ8xpensive third
pei rty fonts. 

. 
An introduction to utilities for, enhancing Ventura, such as 
HotShot, The Missing Link, a~d Electric Webster. 

O . 
PEA~-jpIT PRESS 
2127Woolsey St. 
Berkeley, CA 94705 
415/843-6614 

ISBN 0-938151 -01-0 $15.95 

Here is your unique guide 

to Xerox Ventura Publisher, 

the remarkable program 

that has made effective 

desktop publishing a reality 

on IBM XT and AT 

computers and clones. 

Compiled from the 

.suggestions of numerous 

early testers of the 

program, Ventura Tips and 

Tricks is a must for your 

desktop publishing library. 

Ted Nace is the author of over 
fifty articles and columns on 
desktop publishing, as well as 
coauthor of two books: Desktop 
Publishing Skills and LaserJet Un
limited. He is a Contributing Editor 
for Publish! and PC World 
magazines. 

Cover Design: Dennis McLeod 


